Cashier’s Guide
Microsoft Dynamics – Point of Sale
# Contents

The Basics.................................................................................................................. 1

Working with POS Hardware.................................................................................. 13

Performing Sales Transactions ........................................................................... 21

Working with Your Register .............................................................................. 37

Finding What You Want...................................................................................... 51

Working with Advanced Transactions............................................................ 75

Handling Inventory.............................................................................................. 97

Handling Customer Information...................................................................... 109

Customizing the POS View Screen ................................................................. 119

Printing from POS View .................................................................................... 129

Employee Roles, Appendix A............................................................................ 137

Function Keys and Tasks, Appendix B............................................................. 145
Introducing the *Cashier’s Guide* _________________

This guide was designed primarily for cashiers to learn about using POS View of Microsoft Dynamics - Point of Sale. With the *Cashier’s Guide* you can quickly learn to:

- Process a transaction using POS View
- Accept various methods of payment, including credit and debit cards
- Find items, transactions, and customers in the store database using basic and more advanced search tools
- Use various tools to speed up your work, such as the currency calculator.
- Process refunds and exchanges
- Issue gift cards
- Receive inventory at the register
- Customize the POS View screen for your register
- Check prices and inventory availability

Things to know...

As a manager or supervisor, do I need to know the information in the *Cashier’s Guide*?

Yes, the *Cashier’s Guide* provides the information that you will need to use POS View. There is little duplication of information with the *Manager’s Guide*. 
Use the Cashier's Guide for information about all of the aspects of running your register and making sales transactions. Often there is more than one way to accomplish a task.

A number of cues throughout the book will help you easily find what you are looking for:

- Each chapter begins with its own table of contents of topics and subtopics.
- Page 2 of every chapter lists additional information in the “For Information related to this chapter” section. You will find keywords to search for information in POS View Help (Press F1.)
- In the blue sidebar on the left labeled “Things to know…,” you will find general conceptual information along with questions and answers about the topic.
- Topics include highlighted information where appropriate, either a Tip (Important), or a Note (Important).

Other than the Cashier’s Guide, should I be familiar with any other information if I am a cashier.

While nearly everything that you need to know is most likely in the Cashier’s Guide, several other resources may prove helpful:

- Quick Reference Card
- POS View Help (Press F1.)

Is there a way to practice without interfering with store operations?

Point of Sale offers a practice mode. It must first be set up in Manager View by someone with an Owner’s role permissions.
In this chapter

Starting and exiting Point of Sale
   Start and logon to Point of Sale
   Exit or log off Point of Sale

Switching users

Introducing the POS View screen

Using a keyboard, mouse, or touch screen

Switching between Manager and POS Views

Changing your password

Getting Help

Using practice mode
   Enter practice mode
   Exit practice mode
Starting and exiting Point of Sale

To start and log on to Point of Sale

1. On the Start menu, point to (All) Programs, select Microsoft Dynamics - Point of Sale, and then select Point of Sale.

2. In the Logon dialog box, type your employee ID and password, and then press ENTER.

To exit or log off Point of Sale

- Press Tasks, and then press Exit.
- F6, then 8

Point of Sale confirms that you want to exit the program.

Note

Only employees assigned to the Owner or Manager security roles can exit Point of Sale.
Switching users

Things to know

Why log on and off?
Logging on and off provides a secure way for individual cashiers to work.

What is required to log on?
Before you can log on, you must be assigned an employee ID, a password (which you will change), and a security role—Owner, Manager, Supervisor, or Cashier.

What is the best way to complete tasks in Point of Sale?
It depends on the hardware you have installed and your personal preference. There is more than one method of completing the cashier’s tasks. You can use a keyboard, mouse, or a touch-screen keyboard.

Is switching users the same procedure as locking a register?
Yes, they are the same procedure used for different purposes.

To switch users

1. Press Tasks, and then press Switch User.

   -or-

   In the tray, choose the Switch User button.

   The original employee is automatically logged off and Point of Sale displays the Logon dialog box.

2. (New user) Enter your employee ID and password, and then press ENTER.

   Tip
   You can also use the Switch User command to lock the register. For more information, see “Locking the register.”
Introducing the POS View screen

POS View delivers power, speed, and flexibility at the point of sale. These are its main parts:

1. **View tabs** – Displays POS View or Manager View.

2. **Search box** – Provides a place to type search words to quickly find an item by description or item number or a customer by name or number.

3. **Custom pane** - Displays an HTML file with information, such as store name or store logo.

4. **Task pane** - Displays related tasks or information. For example, if you are searching for a customer, the task pane displays a customer list.

5. **Transaction pane** - Displays transaction information, such as items, prices, sales tax, sales total, customer name, and customer address. If an item is displayed in boldface (darker text) in the transaction pane, a discount has been applied to that item.

6. **Tray** - Contains buttons for Help, Switch User, and Exit commands. Also contains buttons for hiding and showing the function bar and the touch-screen keyboard.

7. **Function bar** – Provides menus that are displayed by pressing function keys. For example, pressing F8 displays a menu of commands related to returns.

8. **Status bar** - Displays status information, such as the date and time.

9. **Window controls** – Minimizes, maximizes, and closes the POS View screen.

**Things to know**

**What if my screen looks different from the picture in this topic?**

You can customize POS View to work the way you do; for example, you can show or hide Windows controls, status bar, task pane, and other features. For more information, see Chapter 9 “Customizing POS View” later in this book.

Also, certain settings in Manager View will affect how POS View appears. For example, different screen arrangements and task pads are possible.
Using a keyboard, mouse, or touch screen

Using a keyboard

If you use a keyboard with POS View, these are the most common actions with their corresponding keys.

- **To move around the screen** – Use the TAB key or a keyboard shortcut. See Appendix B for a complete list.
- **To move to a specific row in a list** – Use the TAB key to move to the list, and then use the DOWN ARROW and UP ARROW keys.
- **To scroll a pane** – Use the TAB key to move to the pane you want, and then use the arrow keys.

Using a touch screen

Use a finger to tap the screen. The following list provides specifics of how to do this.

- **To move around the screen** – Tap the part of the screen you want to work with or tap the TAB key on the touch-screen keyboard.
- **To display or hide the touch-screen keyboard** – In the tray, tap the touch-screen keyboard button.
- **To scroll a pane** – Tap one of the touch screen navigation buttons, tap a scroll arrow, tap the blank area of a scroll bar, or drag a scroll bar.
- **To enter or edit text** – Tap the TAB key to move to where you want to enter text and then tap the keys on the touch-screen keyboard.
- **To select text** – Tap one end of the text, and then drag your finger to the other end. This requires practice to do quickly.

Things to know

Do I need a mouse to use Point of Sale?

You will find that POS View is easy to use regardless of whether you use a keyboard, mouse, or a touch screen.

What are “touchless transactions?”

Touchless transaction are transactions in which the cashier does not have to use the keyboard or touch screen.

Why don’t my touch screen navigation buttons show?

The touch-screen navigation buttons haven’t been turned on. Someone with an Owner or Manager security role can turn them on in Manager View.

Why are the procedures written for touch screens or keyboards instead of a mouse in POS View?

Many cashiers use a touch screen or keyboard, rather than a mouse.
Switching between Manager and POS Views

Things to know

When I press the Manager View tab, nothing happens. Am I doing something wrong?
Only those with Owner or Manager security roles can use Manager View. The option will not be available to those with other roles.

To switch to Manager View

- Press Tools, and then press Manager View.
  F7, then 8
- or-
  In the tray, select the Manager View tab.

To switch to POS View

- In Manager View, click POS View on the View menu.
- or-
  In the tray, click the POS View tab.

Note

Only employees assigned to the Owner or Manager security roles can switch between Manager and POS Views.
Changing your password

To change your password

1. Open the Logon dialog box either by restarting Point of Sale or by pressing Tasks and then Switch User.
   
   F6, then 7

2. Choose Change Password.

   ![Change Password dialog box]

3. In the Employee ID box, type your employee ID.

4. In the Old Password box, type your old password.

5. In the New Password box, type your new password.

6. In the Confirm New Password box, type your new password again, and then press ENTER.

Things to know

Can another user take over my register?
To allow a different employee to use Point of Sale, the new user must log on. The current transaction is not affected by switching users.
For more information, see “Switching users.”

How can I keep anyone else from knowing my password?
The owner or manager provides a temporary password for your use. To keep your register secure, you must change your password to one that only you know. Blank passwords are not permitted.
Getting Help

To get Help

1. In the tray, choose the Help button, or press F1.

   ![F1]

   Point of Sale displays POS View Help.

2. To display a topic, select a topic button.

3. To display the Contents, select the Contents button. See the Help topic, “Use the Contents.”

4. To display the Index, choose the Index button. See the Help topic, “Use the Index.”

5. To print a topic, choose the Print button. See the Help topic, “Print a Help topic.”

6. To close Help, choose the Close button.

Things to know

Besides POS View Help, what other resources are available?

See the following for other means of finding information:

- POS View Quick Reference Card
- Your manager, who has access to other references and online resources, if needed.
You can practice using POS View in practice mode without affecting the information in your store database.

**To enter practice mode**

- Select **Tools**, and then select **Enter Practice Mode**.
  
  F7, then 6

**To exit practice mode**

- Select **Tools**, and then select **Exit Practice Mode**.
  
  F7, then 6

**Things to know**

In practice mode, does everything in POS View work normally?

Most features work normally. However, the sales you ring up in practice mode will not be kept, the cash drawer will not open, and credit card, debit card, and check transactions will not be processed.

How will I know that I am in practice mode?

The practice mode screen is noticeably different.

How can I use practice mode?

You can only use it if your manager has set it up in Manager View. See your manager if you would like to learn Point of Sale in practice mode.

**Note**

An employee assigned to the Owner or Manager security role must provide access to practice mode in Manager View before you can use it in POS View.
In this chapter

Adding and removing hardware
  Add POS hardware
  Remove POS hardware
  Stop using a specific device

Testing your hardware

Turning the receipt printer off and on
Adding and removing hardware

You can connect one or more POS hardware devices to your computer; for example, a cash drawer, receipt printer, bar code scanner, check reader (MICR), PIN pad, magnetic stripe reader (MSR), or signature capture device.

To add POS hardware

1. Connect the device to the register computer according to the manufacturer’s instructions.
2. Configure and test the device using the device’s configuration utility.
3. Start Point of Sale, and log on with your employee ID and password.
   
   The Register Properties dialog box appears.
4. In the Available devices list, select the new hardware using the arrow buttons in the dialog box, and then set the properties for each device.
5. Test the hardware.

**Note**

Only employees assigned to the Owner, Manager, or Supervisor roles can add hardware.

---

**Things to know**

Do I need to install software for each device?

Typically, the device’s manufacturer provides OPOS software and configuration software on a CD that accompanies the device.

Why don’t I see the hardware that I want to add in the “Available devices” list?

The device might not be connected properly to your computer.

Can the hardware be unplugged and plugged back in during a transaction?

During a transaction, do not unplug a POS hardware device and then plug it in again. This will cause errors in the transaction.

**For more information...**

View the tutorial “Setting Up POS Hardware,” which is included on the Point of Sale CD.
Can I connect a device to another device rather than directly to the computer?
Some hardware devices can be connected to a second device, which is then connected to the computer. For example, you can connect:
- a cash drawer, line display, or MICR/printer to a receipt printer.
- an MSR or PIN pad to a signature capture device.
If a device is not working, you may have too many secondary connections.

Should I install my hardware devices or my Point of Sale software first?
Install your hardware first. While you can add and remove hardware devices at any time, installing them before installing Point of Sale can make the installation process go more smoothly.

To remove POS hardware
1. Disconnect the hardware device from the computer.
2. In Windows Control Panel, double-click Add or Remove Programs, and then remove the device’s software.
3. Restart Point of Sale.

To stop using a specific device
1. Press Tools, and then press System, or press F7, then 7
2. Press Register Properties, or press CTRL+2
3. In the Selected devices list, select the device you want, and then select the left-arrow button to move the device to the Available devices list.
4. Restart Point of Sale.
Testing your hardware

It is a good idea to test your hardware before trying to use it in your store operations.

Note
Only employees assigned to the Owner, Manager, or Supervisor roles can test hardware.

To test POS hardware

1. Press Tools, and then press System.
   - F7, then 7

2. Press Test Hardware.
   - CTRL+3

Point of Sale displays the Test Hardware dialog box with a list of the devices connected to the computer.

3. Select the device you want to test, and then click Test:
   - Cash drawer – Select Open Cash Drawer and check that the cash drawer opens properly.
   - Line display – Check that the line display displays the test message correctly.
   - Magnetic ink character recognition device (MICR) – Check to see that the account number displays in the Account number box.
• Magnetic stripe reader (MSR) – Swipe a credit card to see if the credit card number displays correctly in the Account number box.

• PIN pad – Perform a debit transaction to check if the PIN pad is working correctly. There is no test available.

• Receipt printer – Perform a transaction to see that the printer prints receipts properly.

• Scanner – Scan a bar code to see if correct data appears in the Scanner data box.

• Signature capture device – Write your signature on the device, and then choose Stop Capture to check that the device is working correctly.

4 If any of the hardware does not work correctly, run the setup and configuration utility provided by the device’s manufacturer.

Things to know

When I run a test on my magnetic stripe reader (MSR), the number appears masked with X’s in place of digits. Is that a successful test or not? Yes, this also means that the stripe reader read the credit card number.

For more information...

View the tutorial “Setting Up POS Hardware,” which is included on the Point of Sale CD.
Turning the receipt printer on and off

Things to know

Why can’t I print a receipt? My hardware test indicates that it is working.
You may not have turned the printer on in Point of Sale. If this does not solve the problem, check your connection.

• Press Tasks, and then press Printer On/Off.
  F6, then 5
Performing Sales Transactions

In this chapter

Processing a sales transaction
   Process a sales transaction
   Add an item by scanning
   Add an item by item number
   Add an item with a serial number
   Add an item by description
   Change the quantity
   Add a new item to inventory
   Remove an item

Checking prices and other information
   Find item information by item number
   Find item information by description
   Find item information in the item list (mouse only)

Accepting cash payment

Accepting a check as payment
In this chapter, continued

Accepting a credit card as payment

- To accept a credit card as payment if the customer is paying the full amount by credit card and the store uses a MSR device with online approval
- To accept a credit card as payment if the customer is paying a partial amount by credit card and the store uses a MSR device with online approval
- To accept a credit card as payment if you call the bank to receive voice authorization

Accepting a debit card as payment

Accepting a gift card as payment

Accepting a traveler’s check as payment

Accepting a money order as payment

Accepting multiple payment methods
Processing a sales transaction

Adding items is the first step in processing a sales transaction. There are several ways to add items to a transaction:

- Scan the item’s bar code.
- Type all or part of the item number.
- Type all or part of the item’s description.

To process a sales transaction

1. Scan an item’s bar code.
   -or-
   Type the item number in the search box, and then press ENTER.
   Point of Sale adds the item to the transaction and displays a “1” in the Quantity column.

2. If there are two or more units of an item, choose Edit Qty. on the line item and type the quantity.
   You can also scan the item repeatedly to increase the quantity.

3. Repeat Steps 1 and 2 for each item.

4. Total the transaction in one of the following ways.
   - Cash or check: Press Total (F12), type the amount paid in the box for the payment method, and then press ENTER.
   - Credit card or debit card: Swipe the card, press Total (F12), type the amount of the sale next to the payment method used, and press ENTER.

Things to know

If the customer or I are not able to swipe a card, what do I need to enter manually?
You will need to type the account number, expiration date, and approval code in the Verification dialog box.

Is there a shortcut to totaling a transaction?
Yes, if the customer pays the exact amount, you can total the transaction by pressing Total and then a plus (+) sign regardless of the payment method.

If the customer or I are not able to swipe a card, what do I need to enter manually?
You will need to type the account number, expiration date, and approval code in the Verification dialog box.

Is there a shortcut to totaling a transaction?
Yes, if the customer pays the exact amount, you can total the transaction by pressing Total and then a plus (+) sign regardless of the payment method.
To post the transaction, choose Close or press ENTER.

**Note**
When voiding a previous transaction, Point of Sale displays the Post Transaction dialog with the original payment amount.

**To add an item by scanning**
- Scan the item's bar code.

**To add an item by item number**
- Type the item number in the search box, and press ENTER.

**To add an item with a serial number**
- When Point of Sale asks you to enter the serial number type the serial numbers into the appropriate boxes (if store policy allows serial numbers to be created at the register), or choose Find No. to select from a list of serial numbers.

**To add an item by description**
1. Press Items, and then press **By Description**.
2. F2, then 5
3. Find the item in the Items By Description list and select it.
4. Choose **Add** or press ENTER.

**Things to know**

What should I do if the bar code scanner does not read the item number?
You can type the item number in the Search box and press ENTER.

What if I do not know the item number and there is no bar code on the item?
You can add the item by its description.

What should I do if the item is not yet in inventory?
You can easily add the item during the transaction. For more information, see “To add a new item to inventory” in this topic.

For more information...
See “Process a sales transaction” in POS View Help.
What should I do if I have already added an item that the customer no longer wants?
It is easy to remove items from the transaction at any time. For more information, see “To remove an item” in this topic.

When the customer decides to buy more of an item, how can I change the quantity of a line item in the transaction?
See “To change the quantity” in this topic on the right.

How will my time on a register be tracked?
Any employee who uses a register must clock in and out to show when they were at a particular register.

To change the quantity

1. In the transaction pane, select the line item whose quantity you want to change.

2. Do one of the following:
   - On the line item, choose Edit Qty., and then type the new quantity.
   - (Mouse users only) Click the number in the Quantity column, and then type the new quantity.

To add a new item to inventory

- Press Items, and then press New.

F2, then 1

To remove an item

1. Select the line item you want to remove.

2. On the line item, choose Remove.

   - (Mouse users only) Click the number in the Quantity column, and then type the new quantity.

F5, then 3
Checking prices and other information

**Things to know**

How do I remove an item from the transaction, if after I check the price, the customer doesn’t want the item?

Choose Remove on the line item.

**How can I help customers find more information about an item?**

Use the instructions in this topic to find information about an item. You can look for an item by scanning its bar code or by entering its item number or description.

**How do I find out how many of an item is in stock?**

Use the instructions in this topic. You can see the in-stock quantity in the search results and in the item information.

**How can I find out if a particular item is on sale?**

Choose More at the bottom of the task pane, and then choose the Pricing tab.

---

**To find item information by item number**

1. Scan the item’s bar code.
   
   -or-
   
   Type the item number in the search box and press ENTER.

2. In the transaction pane, select the line item and choose **View**.

3. To view more information, choose **More** in the task pane.

**To find item information by description**

1. Type the item’s description in the search box, and then press ENTER.

2. Select the item in the **Search Results** list.

3. Select **View/Edit**, and if applicable, view more information by choosing **More**.

**To find item information in the item list (mouse users only)**

1. Select **Items**, and then select **By Description**.

   F2, then 5

2. In the **item** list, click the column headings to sort the list by item number, description, or price.

3. Type all or part of an item number, description, or price.
Accepting cash payment

To accept cash

1. Scan or enter the customer’s items.
2. Press Total.
   
   F12
3. In the Payment list, type the amount paid by the customer in the Cash box, and then press ENTER.
   -or-

   In the Payment list, select the cash payment method, and then press the plus (+) key to automatically enter the exact amount of the sale and post the transaction.

Tip

If the customer pays with the exact amount, you can select the payment method and then press the plus key (+) to automatically enter the exact amount of the sale and post the transaction.

Things to know

What payment methods are accepted by Point of Sale?
The store’s manager or owner will have decided which payment methods are accepted by your store and will have set them up in Manager View. These payment methods can include:
- Cash
- Check
- Credit card
- Debit card
- Gift card

What about money orders and traveler’s checks?
These payment methods are usually considered as cash payments. Check your store’s policy for more information.

For more information...
See “Process a sales transaction” in POS View Help.
Accepting a check as payment

To accept a check

1. Scan or enter the customer’s items.
2. Press Total.
   -or-
3. In the Payment list, select Check, type the amount paid, and then press ENTER.
   -or-
   In the Payment list, select Check, and then press the plus (+) key to automatically enter the exact amount of the sale. If your store uses a check verification service or check reader (MICR), enter the information required.
   
   If you have a MICR device (check reader), the transit number, account number, and check number will be entered automatically when you insert the check into the device.

Things to know

If I have a check reader, will I need to enter anything manually when processing checks for payment?
If you have a check reader (MICR), information will be entered automatically when you insert the check into the device.

What should I do if I have already chosen OK, and then I change my mind about contacting the check processor?
Choose Abort.

Why can’t I view a Check Verification dialog box?
The Check Verification dialog box will only appear if check processing has been set up in Manager View.

Tip
If the customer writes the check for the exact amount, select the payment method and then press the plus key (+) to automatically enter the exact amount of the sale and post the transaction.
Accepting a credit card as payment

To accept a credit card as payment if the customer is paying the full amount by credit card and the store uses a MSR device with online approval

1. Scan or enter the customer's items.

2. Do one of the following:
   - Swipe the customer’s credit card.
     Point of Sale displays the Electronic Draft Status dialog box during the approval process.
   - Press Total.
   - In the Payment list, select the box for the appropriate credit card, and then press the plus (+) key to automatically enter the exact amount of the sale, and then swipe the customer’ credit card when Point of Sale displays the Credit Card Verification dialog box.

To accept a credit card as payment if the customer is paying a partial amount by credit card and the store uses a MSR device with online approval

1. Scan or enter the customer’s items.

---

**Things to know**

**Which credit cards can I accept?**
The cards that you can accept depends on your store’s policy. Payment methods for each particular card will have been set up beforehand in Manager View.

Each of these card types will appear in the Total pane along with the other payment methods your store accepts.

**Can I accept multiple credit cards or a credit card and another payment method?**
Yes. For more information, see “Accepting multiple payment methods” in this chapter.
What happens if I type the verification information incorrectly for a credit card?
Errors in the verification dialog box could lead to lost revenues for the store. If you type the information yourself, carefully review the data you’ve entered. When you are sure the information is accurate, press ENTER to begin processing the transaction.

For more information...
See “Process a sales transaction” in POS View Help.

2 Press **Total**, F12

3 In the **Payment** list, type the partial payment amount in the box for the appropriate credit card, and then press ENTER.

4 When Point of Sale displays the **Credit Card Verification** dialog box, swipe the customer’s credit card.

To accept a credit card as payment if you call the bank to receive voice authorization

1 Scan or enter the customer’s items.

2 Press **Total**.

3 In the **Payment** list, type the sale amount in the box for the appropriate credit card and press ENTER.

4 When Point of Sale displays the **Credit Card Verification** dialog box, type the approval code you received from the bank, and then either swipe the customer’s credit card or type the credit card number and expiration date.
Accepting a debit card as payment

**To accept a debit card**

1. Scan or enter the customer’s items.
2. Press **Total**.
3. In the **Payment** list, select **Debit card**, and then press the plus key (+).
   - or -
   In the **Payment** list, select **Debit card**, and then enter the amount of the sale.
4. Type the cash back amount, if applicable.
5. Swipe the debit card.
6. Ask the customer to use the PIN pad to enter a PIN and okay the amount.
7. (If applicable) Pay the customer the cash back amount.

**Note**

If the payment method is a debit card, Point of Sale displays a verification dialog box in which you must enter information or swipe the card to enter the information automatically. After approval, Point of Sale returns to the Payment list.

**Things to know**

What is the difference between the two types of debit cards that customers use?

One of them is usually referred to as an ATM card for which the customer must enter a PIN. With other debit cards, commonly referred to as **check cards** and usually bearing a card association logo, the card can be accepted using either a debit card or credit card payment method. Customers can choose which way they want to pay.
Accepting a gift card as payment

To accept a gift card as payment

1. Scan or enter the customer's items.
2. Press **Total**.
3. Swipe the gift card.
   -or-
   In the **Payment** list, select the gift card payment method, and then type the amount the customer wants to pay by gift card.
   -or-
   In the **Payment** list, select the gift card payment method, and then enter the amount paid.
4. If Point of Sale displays the **Gift Card Verification** dialog box, type the gift card number or swipe the gift card, and then press ENTER.

Things to know

Will the balance left on the gift card appear on the receipt for the transaction?

It depends on how this option was set up in Manager View, but the built-in receipt formats support printing the card’s remaining balance on the receipt.
Accepting traveler’s checks as payment

To accept traveler’s checks

1. Scan or enter the customer’s items.
2. Press Total.
3. In the Payment list, type the check amount in the box for the appropriate payment method (Cash or Check, according to store policy), and then press ENTER.
   -or-
   In the Payment list, select the box for the appropriate payment method, and then enter the amount tendered and post the transaction.

Tip
If the customer pays with the exact amount, you can select the payment method and then press the plus key (+) to automatically enter the exact amount of the sale and post the transaction.

Things to know

Does it matter whether I enter Cash or Check for a traveler’s check as payment?
Yes, you must follow your store’s policy. Ask your manager if you aren’t sure.
Accepting a money order as payment

To accept a money order

1. Scan or enter the customer’s items.
2. Press **Total**.
3. In the **Payment** list, type the check amount in the box for the appropriate payment method (**Cash** or **Check**, according to store policy), and then press **ENTER**.

   -or-

   In the **Payment** list, select the box for the appropriate payment method, and then enter the amount tendered and post the transaction.

**Tip**

If the customer pays with the exact amount, you can select the payment method and then press the plus key (+) to automatically enter the exact amount of the sale and post the transaction.

---

**Things to know**

Does it matter whether I enter **Cash** or **Check** for a money order as payment?

Yes, you must follow your store policy. Ask your manager if you aren’t sure.
Accepting multiple payment methods

To accept multiple payment methods

1. Scan or enter the customer’s items.
2. Press Total.
3. In the Payment list, select the first payment method, and then type the amount paid with that method.

Note
If the payment method is a credit or debit card, Point of Sale displays a verification dialog box in which you must enter information or swipe the card to enter the information automatically. After approval, Point of Sale returns to the Payment list.

4. Select the second payment method, and then type in the amount paid with that method.
5. If there are other payment methods, enter them in the same way.
6. When finished entering payments, press ENTER.
In this chapter

Changing register settings

Clocking in and out

Locking the register

Using the cash drawer
  Make a cash drop
  Make a cash payout
  Open the cash drawer

Opening and closing a register
  Specify opening and closing amounts
  Close the register (batch)

Using the calculators
  Use the Windows calculator
  Use the currency calculator while totaling a transaction
  Use the currency calculator when entering opening and closing amounts

Creating a sales graph
Changing register settings

Each computer in your store that has Point of Sale installed is a register. You can change the settings for each register. These settings include the register number and description, audio settings, and hardware devices in use at the register.

Register 1 is usually your store's main computer and the location of your store database. It may not actually be used to process transactions, but it is still considered a register.

**To change register settings**

1. Press Tools, and then press System.

   F7, then 2

2. Press Register Properties.

   CTRL+2

3. Change the settings you want.

   - To specify what sounds are played for certain register events, select a setting in the Audio settings list.
   - To select or remove a hardware device for use on the register, use the arrow buttons under Devices on this register to move the device from one list to the other.

**Things to know**

Who can change register settings?

Only employees assigned to the Owner, Manager, or Supervisor roles can change register settings.

Are there any precautions that I need to take when using my register?

Yes, during a transaction, do not unplug a POS hardware device and then plug it in again. This could cause errors in the transaction.
If my register is not set up in the best configuration for me, what can I do if I am not allowed to change the settings?
Discuss with your manager or store owner the various ways POS View can be customized for your needs.

Why doesn’t Microsoft recommend using keyboard POS hardware devices?
They might not work correctly with Point of Sale. See the note on the right.

**Note**
Select USB Keyboard MSR, Wedge Keyboard MSR, or Wedge Keyboard Scanner only if OPOS software is not available for your device. Microsoft does not recommend using keyboard POS hardware devices. Depending on the device, keyboard devices might not work properly with Point of Sale.

If OPOS software is available for your device, ensure that it is installed properly. Make sure the device is connected and configured properly, restart Point of Sale, and then select the device in the “Available devices” list.

- To change the settings of a hardware device (such as selecting a receipt format for a printer), select the device, and then choose **Properties**.
- To save in the store database copies of receipts for this register’s transactions, choose **Save electronic copies of receipts**.

4  Press ENTER, and then restart Point of Sale for the changes to take effect.
Clocking in and out

To clock in and out

1. On the function bar, press **Tools**, and then press **Time Clock**.

2. F7, then 2

3. In the **Time Clock** dialog box, type your employee ID in the **Employee ID** box.

4. In the **Password** box, type your password, and then press ENTER.

5. Under **Time Clock**, make sure that your name appears.

6. Choose **IN** to clock in, or choose **OUT** to clock out.

**Things to know**

How will my time on a register be tracked?

Depending on your store’s policies, cashiers should clock in and out to record when they use a particular register.

What if I forget to clock in or out?

Let your manager know. Your manager can correct the problem in Manager View.
Locking the register

To lock the register

1. Press Tasks, and then press Switch User.

- F6, then 7
- In the tray, choose the Switch User button.

The employee is automatically logged off and Point of Sale displays the Logon dialog box.

2. When you are ready to resume, enter your employee ID and password.

Things to know

When should I lock my register?
When you need to interrupt a transaction or step away from the register for some reason, lock the register for security.

Will it affect a transaction if I lock the register in the middle of a transaction?
The current transaction is not affected by locking the register.

Is locking a register the same procedure as switching users?
Yes, they are the same procedure used for different purposes.

Note
You cannot cancel the Logon dialog box. You must enter an employee ID and password to resume use of Point of Sale. Only employees assigned to the Owner, Manager, or Supervisor roles can exit Point of Sale.
Using the cash drawer

The cash drawer opens automatically at the end of a sales transaction, but you can also open it whenever you need to.

**Note**

Only employees assigned to the Owner, Manager, or Supervisor roles make cash drops or cash payouts.

**Things to know**

**When can the cash drawer be opened?**

The cash drawer automatically opens at the end of a transaction. But, there are three other situations that also involve opening the cash drawer:
- When making a cash drop
- When making a cash payout
- When no cash will be removed from the cash drawer

**What is a cash drop?**

Cash drop refers to reducing the amount of cash in the cash drawer.

**To make a cash drop**

1. Press **Tasks**, and then press **Drop/Payout**.
   - F6, then 2

2. Press **Cash Drop**.
   - CTRL+1

3. Under **Cash Drop**, type the amount of cash that was removed, and then type a comment.
What is a cash payout?
Cash payout refers to removing a small amount of money from the cash drawer for a specific purpose, such as to pay for a minor expense.

Can I open the register when I don’t intend to remove cash from it?
There may be times that you need to open the cash drawer that does not involve removing any cash. In those situations, opening the cash drawer is considered a “No Sale” transaction. Only those with Owner, Manager, or Supervisor roles can remove cash for cash drops or payouts, however.

To make a cash payout
1. Press Tasks, and then press Drop/Payout.
   
   F6, then 2

2. Press Payout.
   
   CTRL+2

4. Under Payout, type the amount of cash that was removed, enter who was paid in the Paid to box, and type a comment.

To open the cash drawer
- Press Transactions, and then press No Sale.
  
  F5, then 6
Opening and closing a register

Things to know

Why is it necessary to specify an opening amount when switching users or beginning to use my register?
It is important so that Point of Sale can track how much money is added to the cash drawer during the current batch.

How do you open the register?
Closing the register closes one batch and automatically opens a new batch.

What’s the best way to count currency when opening and closing?
If denominations (such as $0.10, $0.25, $5.00, and $10.00) have been set up for a cash payment method, you can select the Calculator button to display the currency calculator and quickly count various denominations of currency. If denominations have not been set up, pressing the calculator button displays the Windows Calculator.

Note
Those with the Cashier’s role cannot enter opening or closing amounts.

To specify opening or closing amounts

1. Press Tasks, and then press Open/Close.
   F6, then 1

2. Press Opening Amounts or Closing Amounts.
   CTRL+1 for opening
   CTRL+2 for closing.

   If an amount has already been entered, a message will ask if you want to overwrite it.

3. Select a payment method, type the amount that is in the cash drawer, and then press ENTER or choose OK.
To close a register (batch)

1. Press Tasks, and then press Open/Close.
   - F6, then 1

   - CTRL+4

What is the difference between opening a register and opening the cash drawer?
Opening the register is an automatic process that happens when you print a Z report (close the previous batch).
The cash drawer opens automatically at the end of a sales transaction, but you can also open it whenever you need to, if you are assigned to the Owner, Manager, or Supervisor roles. Cashiers will need to ask someone assigned the Owner, Manager, or Supervisor role to do it for them.

What does closing the register mean?
When you close the register you print a Z report to view the end of day statistics for a register. You must enter a closing amount before you close the current batch with a Z report showing the total amount added.
Using the calculators

You can use Point of Sale’s currency calculator or the Windows calculator to save time counting currency during a transaction and while entering opening or closing amounts.

The currency calculator automatically adds the value of each denomination and then gives you a total amount.

To be able to use the currency calculator, denominations must be set up in Manager View, and the currency calculator must be enabled. For more information, see the Manager’s Guide or Manager View Help.

To use the Windows calculator

1. Press Tools, and then press Calculator.

   

   F7, then 1

2. On the View menu of the Calculator, select a view (Standard or Scientific).

To use the currency calculator while totaling a transaction

1. In a transaction, press Total, and then choose the currency calculator button.

   F12

2. Enter the quantities for each denomination.

   Point of Sale automatically calculates the value for each denomination, as well as the total amount.

Things to know

Why don’t I see the currency calculator button?

If denominations (such as $0.10, $0.25, $5.00, and $10.00) have been set up for a cash payment method, the Calculator button displays the currency calculator. If denominations have not been set up, the calculator button displays the Windows Calculator.
How does the currency calculator save me time?
The currency calculator saves time because it automatically adds the value of each denomination and then gives you a total amount in the cash drawer when opening or closing a batch or when tendering a transaction.

To use the currency calculator while entering opening and closing amounts

1. Press Tasks, and then press Open/Close.
   ![F6, then 1]

2. Press Opening Amounts or Closing Amounts.
   ![CTRL+1 (Opening) or CTRL+2 (Closing)]

3. Choose the currency calculator button.

   ![Note]
   To be able to use the currency calculator, denominations must be set up in Manager View, and the currency calculator must be enabled. For more information, see the Manager's Guide or Manager View Help.

4. Enter the quantities for each denomination in your cash drawer.
   Point of Sale automatically calculates the value for each denomination, as well as the total amount in your drawer.
Creating a sales graph

Things to know

What purpose does the sales graph serve?
A sales graph shows you how sales were distributed during a specific period of time, for a specific group of items.

For example, you can create a sales graph that shows current sales in each department. Another graph might show year-to-date sales by register.

Can I see the sales information in numerical form?
Each graph shows sales information both as a set of numbers and as a graph.

Note
Only employees assigned to the Owner, Manager, or Supervisor roles create a sales graph.

To create a sales graph

1. Press Tools, and then press Graphs.

2. In the Group data by box, choose Browse to select a data grouping.

3. In the Show totals for box, choose Browse to select a general time period.

4. In the Date box, type a date as mm/ dd/yyyy, and then press ENTER.
In this chapter

Using the search box to find information
   Find information about items or customers
   Find information in lists using the search box

Finding items
   Find an item by number
   Find an item by description
   Find an items purchased by a customer
   Find a substitute item

Finding customers
   Find a customer by name
   Find a customer by customer number
   Find a customer by phone number

Finding transactions
   Find and view a transaction’s receipt
   Find a transaction by using a receipt’s bar code
In this chapter, continued

Using a basic search to find information
  Find items with a basic search
  Find customers with a basic search
  Find transactions with a basic search

Using advanced searches to find information
  Find items with an advanced search
  Find customers with an advanced search
  Find transactions with an advanced search
Using the search box to find information

The search box located at the top of the task pane can help you quickly find:

- Items
- Customers
- Information in lists

Use the search box to find items and customers when Point of Sale displays a menu of commands in the task pane. (These commands have CTRL+number buttons.)

You can also use the search box to find information when Point of Sale displays a list in the task pane. Lists include items, customers, receipts, batches, customers' shipping addresses, transactions in customers' purchase histories, transactions on hold, and time clock entries.

To find information about items or customers using the search box

1. Type all or part of an item number, item description, customer number, or customer name.

2. Press ENTER.

-or-

To search only for items or customers, press Items or Customers, and then press Search.

F2 for items or F3 for customers

Things to know

Will the search find only key words or any word in a description, number, or name?

The characters you type can appear anywhere in the item description, item number, customer name, or customer number. For example, if you type "ball," the results displayed by Point of Sale could include the following:

- Blue Ball (item description)
- Ball Carrier (item description)
- Frank Ballwright (customer name)
How do I find information in lists using the search box?
The information that Point of Sale searches for depends on how the list is organized. For example, if a list of items is sorted by item number, you can only search for an item by typing its item number.

To search in a list using different information, click or press a column heading to sort the list by the information in that column, and then type the information you are searching for. For example, to search for an item description in a list of items, press the Description heading to sort the list by description, and then type the description of the item you are searching for.

Point of Sale displays a list of items and/or customers whose names or numbers contain the characters you typed.

3 Select an item or customer, and then choose View/Edit to view information about the item or customer.

-or-

Choose Add (or press ENTER) to add the item or customer to the current transaction.

To find information in lists using the search box

- Type all or part of the information you are looking for in the search box.

For example, if you are looking for a receipt in a list of receipts organized by transaction number, type all or part of the transaction number.

Point of Sale moves the selection in the list as you type.
Finding items

To find items by number

1. In the search box, type all or part of the item number, and then press ENTER.
   -or-
   Scan the item's bar code.
   If your store issues customer cards with bar codes, you can also scan a customer's bar code.
   -or-
   Press Items, and then press By Item Number, and then type all or part of the item number.

2. Select the item in the list.
   If multiple matches were found, select the item you were searching for.

3. To view detailed information, choose View/Edit.
   -or-
   To add the item to the current transaction, choose Add (press ENTER).

To find items by description

1. In the search box, type all or part of the item number, and then press ENTER.

Things to know

If I only know the item number, how can I find the item?
There are several ways to find an item using the item number:
• Search box
• Function keys
• Scanning a bar code

Use the instructions on the right in “To find items by number” to find the item. After you have located the item that you want, you can add the item to the transaction.

If I know the item description but no other information, how can I find the item?
There are two ways to find an item using its description:
• Search box
• Function keys

Use the instructions on the right in “To find items by description” to find the item. After you have located the item that you want, you can add the item to the transaction.
What are my options if I tried everything and I am still not able to find a match?

You can:
- Create a new item.
- View all the items in inventory

How far back does a customer’s purchase history go?

The History tab displays customer purchases made within the time period specified in Manager View, such as the last 30, 60, or 90 days.
A customer’s complete purchase history is available in Manager View.

When viewing the History tab, will Point of Sale create a transaction for a returned item if I press ENTER instead of ESC?

Yes, you must be careful to always press the key that you want.

-or-

Press Items, and then press By Description, and then type all or part of the item number.

F2, then 5

2 Select the item in the list.
If multiple matches were found, select the item you were searching for.

3 To view detailed information, choose View/Edit.
-or-
To add the item to the current transaction, choose Add (press ENTER).

To find items purchased by a customer

- If the customer has already been added to the transaction, choose Purchase History in the transaction pane to display the History tab.
-or-

1 In the search box, type the customer name or customer number, and then press ENTER.

2 Select the customer, choose the View/Edit button next to the customer’s name, and then choose the History tab.
After you finish viewing the customer’s purchase history, press ESC.

**Warning**
If you press ENTER or the Return button when viewing the History tab for a selected item, Point of Sale begins a return for the item.

### To find a substitute item

1. In the transaction pane, select the item that you want to find a substitute for.
2. Press Items, and then press Substitutes.
   
   F2, then 6

3. In the list of substitutes, select a substitute item, and then choose Replace.

**Note**
If a line item is selected but not highlighted, the button in the list of substitutes will say Add. In that case, choose Add to add the substitute item to the transaction without replacing the original item.

The substitute item appears in place of the original.
Finding customers

There are several ways to find customers in POS View:

- By name
- By customer number
- By phone number

**To find customers by name**

1. In the search box, type all or part of the customer’s name, and then press ENTER.
   - or -
   Press Customer, press By Name, and then type all or part of the customer’s name.
   
   F3, then 5

2. In the list, select the customer.

3. To view the customer's information, choose View/Edit.
   - or -
   To add the customer to the current transaction, choose Add (press ENTER).

**To find customers by customer number**

1. In the search box, type all or part of the customer’s number, and then press ENTER.
   - or -
   Press Items, and then press By Customer No., and then type all or part of the customer’s number.

---

**Things to know**

If I only know the customer’s name, how can I find the customer’s record?

There are two ways to find customers by name:

- Search box
- Function keys

Use the instructions on the right in “To find customers by name” to find the customer. After you locate the customer, you can view or edit the information or add the customer to a transaction.

How can I find a customer’s record if I only know the customer’s customer number?

There are several ways to find a customer by customer number:

- Search box
- Function keys

Use the instructions on the right in “To find customers by name” to find the customer. After you locate the customer, you can view or edit the information or add the customer to a transaction.
If I know the customer’s telephone number, how can I find the customer’s record?

There are several ways to find a customer using the customer number:

- Search box
- Function keys

After you have located the customer that you want, you can view or edit the customer information or add the customer to the transaction.

What are my options if I tried everything and I am still not able to find a match?

You can:

- Create a new customer.
- View all the customers in the customer list.

To find a customer by phone number

1. In the search box, type all or part of the customer’s phone number, and then press ENTER.

   -or-

   Press Customer, press By Phone Number, and then type all or part of the customer's phone number.

2. In the list, select the customer.

3. To view the customer's information, choose View/Edit.

   -or-

   To add the customer to the current transaction, choose Add (press ENTER).
Finding transactions using a receipt

There may be times that you need to see information that is on a receipt. You can find a receipt by searching:

- Today's receipts (only those for the current date)
- Receipts within a date range
- Receipts in a batch (a list of receipts by batch number)

**To find and view a transaction’s receipt**

1. Press Tasks, and then press Find Receipts.
   
   F6, then 3

2. In the task pane, under Find, do one of the following:

<table>
<thead>
<tr>
<th>To find</th>
<th>Press</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td>Today's receipts</td>
<td>CTRL+1</td>
<td>Search for the receipt by time of day.</td>
</tr>
<tr>
<td>Receipts by date</td>
<td>CTRL+2</td>
<td>Type a start date and an end date, and then press ENTER.</td>
</tr>
<tr>
<td>Receipts by batch</td>
<td>CTRL+3</td>
<td>Select a batch, and then press ENTER.</td>
</tr>
</tbody>
</table>

**Things to know**

What can I do with a receipt once I have found it?
When you have found the receipt that you want, you can do any of the following:
- Print the information
- View the information
- Recall it to void the transaction
- Recall it for a return or exchange

How do I void the transaction after finding it?
After you find the transaction, choose Select, and then press Recall for Void. You can void a previous transaction only on the originating register and in the current batch. If the transaction is from a closed batch, you must process it as a return.
If I have a receipt, can I scan its bar code to locate the transaction?

If you have a scanner attached to your register, and you have a receipt for the transaction you are looking for, you can scan the receipt's bar code to find the transaction in Point of Sale. If the bar code is missing or unreadable, you can look up the receipt using one of the methods explained in this section. When you have found the receipt that you want, you can view or print the information, void the transaction, or recall it for a return or exchange.

3 Press the following keys to select a receipt, and then press ENTER.

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll down one line</td>
<td>↓ (DOWN ARROW)</td>
</tr>
<tr>
<td>Scroll up one line</td>
<td>↑ (UP ARROW)</td>
</tr>
<tr>
<td>Scroll down one page</td>
<td>PgDn (PAGE DOWN)</td>
</tr>
<tr>
<td>Scroll up one page</td>
<td>PgUp (PAGE UP)</td>
</tr>
</tbody>
</table>

4 Press TAB, and then press the following keys to change the view of the receipt.

<table>
<thead>
<tr>
<th>To</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Zoom in or out</td>
<td>+ (PLUS SIGN),</td>
</tr>
<tr>
<td></td>
<td>- (MINUS SIGN)</td>
</tr>
<tr>
<td>Scroll up or down</td>
<td>↑ (UP ARROW)</td>
</tr>
<tr>
<td></td>
<td>↓ (DOWN ARROW)</td>
</tr>
<tr>
<td>Scroll right or left</td>
<td>→ (RIGHT ARROW)</td>
</tr>
<tr>
<td></td>
<td>← (LEFT ARROW)</td>
</tr>
<tr>
<td>View the next or previous page of the</td>
<td>PgDn (PAGE DOWN),</td>
</tr>
<tr>
<td>current receipt</td>
<td>PgUp (PAGE UP)</td>
</tr>
</tbody>
</table>

5 You can also choose one of the following receipt options. (These options will vary depending on the type of receipt you are viewing.)
How can I print the receipt after I find it?
Once you have the receipt that you want, select it, and then under Receipt Options, press Print (CTRL+1)

How can I find the receipt if the bar code is missing or unreadable?
Use the previous procedure, “To find and view a receipt.”

To find a transaction using a receipt’s bar code

1. Scan the bar code on the receipt.
   Point of Sale displays the receipt and Receipt Options.

2. You can choose one of the following receipt options.
   - Press Print (CTRL+1) to print the receipt.
   - Press View Payment Information (CTRL+2) to view the receipt's transaction number, payment method, and payment amount.
   - Press Printer Setup (CTRL+3) to display printer settings.
   - Press Recall for Return (CTRL+4) to recall the transaction for a return or exchange.
   - Press Recall for Void (CTRL+5) to void the transaction.
Using a basic search to find information

There may be times that you need to look for more detailed information than the search box can provide. The basic and advanced searches fulfill this need. In a basic search, you can limit your search to certain kinds of information; for example, search only suppliers or specific categories. In an advanced search, you can be even more specific using Boolean search criteria.

After you have search results, you can then edit, view, or select items in the list of results.

To find items with a basic search

1. Press Tools, and then press Find.

F7, then 5

The Find dialog box displays as shown.

2. In the Look for list, select Items.

3. On the Basic tab, in the Search for this text box, type some text such as an item name, a supplier item number, or an item description.

Things to know

What do the options in the Find window do?
The following describes what you do for each option

- **Look for**: Select what you want to search for.
- **Search for this text**: Enter text that may help you find the results you are searching for.
- **In these fields**: Limit your search to certain kinds of information.
- **All items, Only these departments, Only these categories, Only these suppliers**: Select one of these to further limit your search.
- **Find Now**: Starts the search.
- **New Search**: Clears the current search criteria, so you can start a new search.
4 In the In these fields box, select the fields you want to search, such as All item fields, Supplier item numbers, or Description fields only.

5 To narrow the search further, select Only these departments, Only these categories, or Only these suppliers, and then select one or more departments, categories, or suppliers.

6 Choose Find Now.

7 (If applicable) To stop the search, choose Stop.

8 (If applicable) To clear the search results and begin a new search, choose New Search.

9 To add one of the items in the results list to the current transaction, select the item, and then choose Add to Order.

What can I do with the search results?

You could do one of the following:

- **Edit:** You can select a customer, item, or transaction from the results list, and then click Edit to edit the selected customer or item.

- **View Receipt:** You can view the selected transaction’s receipt.

- **Search results list:** Click a column heading to sort the results list by the information in that column. You cannot edit any information in this list.

**Tip**

Use the None or All buttons to speed your selection.
Why do I either get too many results or none at all?
If you are getting too many results, narrow your choices further. If you are not getting any results, broaden the search to include more possibilities.

To find customers with a basic search

1. Press **Tools**, and then press **Find**.
   
   F7, then 5

2. In the **Look for** list, select **Customers**.

3. On the **Basic** tab, in the **Search for this text** box, type some text, such as **All customer fields**, **Company field only**, **Name fields only**, or **Company text field only**.

4. In the **In these fields** box, select the fields you want to search, such as **All customer fields**, **Company field only**, **Name fields only**, or **Company text field only**.

5. To narrow the search to a specific date range, select the **Last visit between** check box, and then select start and end dates.

   -or-

   To expand the search to all dates, clear the **Last visit between** check box.

Finding What You Want 65
What is the quickest way to start a new search if my results are returning too many choices, and I know I need to narrow the search further?

You can stop the search by choosing Stop. Then, you can clear the search to begin a new one by choosing New Search.

6 Choose Find Now.
Customers matching the text that you searched for appear in the results list at the bottom of the window.

7 (If applicable) To stop the search, choose Stop.

8 (If applicable) To clear the search results and begin a new search, choose New Search.

9 To add one of the customers in the results list to the current transaction, select the customer, and then choose Add to Order.

To find transactions with a basic search

1 Press Tools, and then press Find.

2 In the Look for list, select Transactions.

3 On the Basic tab, in the Search for this text box, type some text that you are looking for, such as Transaction detail fields only, Customer fields only, or Item fields only.

4 In the In these fields box, select the fields you want to search, Transaction detail fields only, Customer fields only, or Item fields only.

5 To narrow the search to a specific date range, select Transactions between, and then select start and end dates from the drop-down calendars.
What is being searched when I enter search criteria?
Point of Sale searches the lists, records, and receipts in the store database for information that matches your criteria.

6 Choose Find Now.
Transactions matching the text that you searched for appear in the results list at the bottom of the window.

7 (If applicable) To stop the search, choose Stop.

8 To recall one of the transactions in the results list, select the transaction, and then choose Recall.

9 (If applicable) To clear the search results and begin a new search, choose New Search.
Using advanced searches to find information

Things to know

What information can I find about items through searches?
Here is some of information you can find:

- **Price**: The regular price that your customers will pay for an item.
- **Cost**: The amount that your store pays for an item.
- **In stock**: The in-stock quantity of an item. Point of Sale updates the in-stock quantity through purchase orders and transactions.
- **Item quantity**: The item quantity can include decimal values for items that are sold by weight or in bulk quantities. For example, a store might sell items such as candy by the pound.
- **Bar code number**

To find items with an advanced search

1. Press **Tools**, and then press **Find**. F7, then 5

2. In the **Look for** list, select **Items**.

3. Under **Define more criteria**, select what you are looking for in the **Field** list, such as **Item No.**, **Department**, **Price**, **Last Sold**, or **Sale Price**.

4. In the **Condition** list, select a required condition, such as that it contains, is exactly, or does not contain some specific value.

5. In the **Value** box, type the specific value you are looking for.
   
   For example, if you selected the Sale Price field, the condition is exactly and the value $29.99, Point of Sale will search for items that have a sales price equal to $29.99.

6. Choose **Add to List**.
Repeat Steps 2 to 5 for each criterion you want to create.

(If applicable) To remove a search criterion, select it in the Find items that match these criteria box, and then choose Remove.

Choose Find Now.

Items matching your appear in the results list at the bottom of the window.

(If applicable) To stop the search, choose Stop.

To add one of the items in the results list to the current transaction, select the item, and then choose Add to Order.

(If applicable) To clear the search results and begin a new search, choose New Search.
What do the options in the Find window under Define more criteria do?

You can do the following with these options:

- **Field**: Select what you are looking for from the list.
- **Condition**: Select a condition from the list, such as contains, is exactly, is not, and so on.
- **Value**: Type a specific value in this box.
- **Add to List**: Add the criterion that you created to the list.
- **Remove**: Remove the selected criterion from the list.
- **Find Now**: Start the search.
- **Stop**: Stop the current search in progress.
- **New Search**: Clear the current search criteria so you can start a new search.

To find customers with an advanced search

1. Press Tools, and then press Find.
   
   F7, then 5

2. In the Look for list, select Customers.

3. On the Advanced tab under Define more criteria, select what you are looking for in the Field list, such as Customer Number, City, State, First Name, or Last Name.

4. In the Condition list, select a required condition, such as that it contains, is exactly, or does not contain some specific value.

5. In the Value box, type the specific value that you are looking for.

   For example, if you selected the Total Sales field, the condition "is greater than," and the value is $500, then Point of Sale will search for customers who have made purchases totaling more than $500.

6. Choose Add to List.
What information can I find out about customers through searches?

Here is some of the information that you can find:

- **Customer number**
- **Title**
- **First name**
- **Last name**
- **Company**
- **E-mail**
- **Picture**
- **Phone numbers**
- **Address**
- **Price level**: Special pricing for some customers
- **Discount (%)**: Discounts that some customers receive
- **Tax ID Number**: A customer’s resale tax status number
- **Customer is employee**: Whether a customer is also an employee
- **Customer is tax exempt**: Whether a customer is exempt from sales tax
- **Notes**: Additional information about a customer

7. Repeat Steps 2 to 5 for each criterion you want to create.

8. (If applicable) To remove a search criterion, select it in the **Find items that match these** criteria box, and then choose **Remove**.

9. (If applicable) To expand the search to all dates, clear the **Last visit between** check box.

10. Choose **Find Now**.

Customers matching your criteria appear in the results list at the bottom of the window.

11. (If applicable) To stop the search, choose **Stop**.

12. To add one of the customers in the results list to the current transaction, select the customer, and then choose **Add to Order**.

13. (If applicable) To clear the search results and begin a new search, choose **New Search**.
To find transactions with an advanced search

1. Press Tools, and then press Find.

   F7, then 5

2. In the Look for list, select Transactions.

3. Under Define more criteria, select what you are looking for in the Field list, such as Customer Number, Transaction Number, Date/Time, or Item Description.

4. In the Condition list, select a required condition, such as that it contains, is exactly, or does not contain some specific value.

5. In the Value box, type the specific value that you are looking for.

   For example, if you selected the Transaction Date field, the condition is "in the last 7 days," and the date is 3/22/05, then Point of Sale will search for transactions that have been completed seven days earlier than 3/22/05.

6. Choose Add to List.

Things to know

How is the advanced search different from the basic search?
Use an advanced search to narrow your search or to find more specific information. You can search in specific fields or search for a variety of dates or date ranges. You will need to define criteria for your search. Define as many criteria as you want for a single search. When you choose Find Now, Point of Sale searches for results that meet all of your criteria.

What information can I find about transactions through searches?
Depending on what has been set up in Manager View, you can find a transaction's line items, total, payment method, date and time, the transaction number, customer number, amount saved on the transaction, and other information.
Finding What You Want

How can I get the best results from my advanced search?
Searching for a phrase will find records that contain any of the words in the phrase. For example, a search for "large red" will find records that contain "large" and records that contain "red". To search for records that contain both "large" and "red", enter "large and red" in the “Search for this text” box. Searching for "large red" gives the same results as searching for "large or red".

7 Repeat Steps 2 to 5 for each criterion you want to search for.

8 (If applicable) To remove a search criterion, select it in the Find items that match these criteria box, and then choose Remove.

9 (If applicable) To expand the search to all dates, clear the Last visit between check box.

10 Choose Find Now.

11 Transactions matching your criteria appear in the results list at the bottom of the window.

12 (If applicable) To stop the search, choose Stop.

13 To recall one of the transactions in the results list to the current transaction, select the transaction, and then choose Recall.

14 (If applicable) To clear the search results and begin a new search, choose New Search.
In this chapter

Adding and removing transaction information
  Add a customer to a transaction
  Remove a customer from a transaction
  Add details to a transaction

Creating or viewing an item comment
  Create or view an item comment
  View an item comment from a previous transaction

Holding and recalling a transaction
  Place a transaction on hold
  Recall a transaction

Canceling and voiding a transaction
  Cancel a transaction
  Void a previous transaction
In this chapter, continued

View a customer’s purchase history
  View purchase history if a customer has been added to a transaction
  View purchase history if a customer has not been added to a transaction

Substituting items in a transaction

Checking a price during a transaction
  Check a price by item number
  Check a price by description

Applying or removing taxes
  Apply or remove a tax from a line item
  Apply or remove a specific tax from a line item
  Apply or remove a tax on a transaction

Discounting line items

Handling returns and exchanges
  Process a return or an exchange with a receipt and using a scanner
  Process a return or exchange by looking up a receipt in a customer's purchase history
  Process a return or exchange without purchase verification

Issuing gift cards
  Issue or add to a gift card
  Issue a gift card instead of a refund
Adding or removing transaction information

To add a customer to a transaction

1. In the transaction pane, choose Select Customer.
2. In the Customers by Name list, select the customer you want.
3. Press ENTER or choose Add.

To remove (clear) a customer from a transaction

- Press Customer, and then press Clear.

F3, then 8

Things to know

Why can’t I add a customer to a transaction?

A customer must be in the customer list before you can add the customer to a transaction. Add the customer to the customer list and then you can add the customer to the transaction.

Tip

To quickly find a customer, type all or part of the customer’s name in the search box. As you type, Point of Sale selects the closest match in the list.
What should I include in the transaction details?
Transaction details consist of a reference number and comments. Comments can include miscellaneous information about a transaction, such as delivery instructions.

Can I print transaction details on the receipt?
Depending on the receipt formats in use at your store (set up in Manager View), transaction details may be printed on the receipt.

To add details to a transaction

1. Press **Transaction**, and then press **Edit Transaction**.
   - F5, then 1

2. Press **Details**.
   - CTRL+1

3. In the **Reference number** box, type a reference number.
   This can include numbers, letters, and symbols.

4. In the **Comments** box, type a comment, and then choose **OK**.
Creating or viewing an item comment

Can I include the item comments on the receipt?
Depending on the receipt formats in use at the store (set up in Manager View, item comments may appear on receipts.

To create or view an item comment

1. In the transaction pane, select an item.
2. Press Transaction, and then press Edit Line Item.
   - F5, then 2
3. Press Add Comment.
   - CTRL+5
4. Type the comment, and then press ENTER.

To view an item comment from a previous transaction

1. Find the receipt for the transaction.
2. If the receipt doesn’t contain the item comment, you can view the comment by recalling the receipt:
   - Under Receipt Options, press Recall for Return, and then press Return All Items.
     - CTRL+4, and then CTRL+2
   The transaction appears as a return in the transaction pane. You can view the item comment there, and then cancel the return transaction (if applicable) by pressing Transaction, and then Cancel Transaction.
Holding and recalling a transaction

To place a transaction on hold

1. Press **Transaction**, and then press **Hold**.

   F5, then 4

   **Note**
   
   If you are not in the middle of a transaction, Point of Sale displays the Recall command in place of the Hold command on the menu. If you are in the middle of a transaction, it displays the Hold command.

2. In the **Comments** box, add a comment that helps you identify the transaction; for example, why the transaction is on hold, and then press ENTER.

To recall a transaction

1. Press **Transaction**, and then press **Recall**.

   F5, then 4

2. In the **Transactions on Hold** list, select the transaction you want, and then choose **Recall**.

**Things to know**

Why won’t Point of Sale always let me put a transaction on hold?

You can hold a sales transaction *only* after you have added at least one item to it. Add an item, and then you will be able to place the transaction on hold. Once a transaction is on hold, you can recall it when you are ready.

Can I recall a previous transaction while I am making another transaction?

No, you cannot recall a transaction while another transaction is in progress.
Cancelling and voiding a transaction

To cancel a transaction

- Press **Transaction**, and then press **Cancel Transaction**.
  
  F5, then 5

To void a previous transaction

1. Find and view a receipt.

2. Choose **Select**, and then press **Recall for Void**.

   CTRL+5

   -or-

   Press **Tasks**, and then press **Void**.

   F6, then 6

2. In the **Receipts by Date/Time** list, select the receipt you want, choose the **Select** button, and then press ENTER.

   The **Refund** pane displays the original payment method and payment amount.

3. Refund the correct amount to the customer, and then choose **OK** or press ENTER.

   -or-

   If the transaction was paid for with a debit card, swipe the debit card.

   Point of Sale displays the **Post Transaction** dialog with the original payment amount.

---

**Things to know**

Can I cancel a transaction in progress?

If you are assigned to the Owner, Manager, or Supervisor roles, you can cancel a transaction in progress after you have scanned or entered at least one item and before you have totaled the transaction.

How is cancelling a transaction different than voiding it?

All roles can void a previous transaction if it is on the originating register and in the current batch. If the transaction is from a closed batch, you must process it as a return.
Viewing a customer’s purchase history

Things to know

How far back in times does the purchase history go?
The History tab displays purchases made within the time period specified in Manager View, such as the last 30, 60, or 90 days.

What is the difference between the History tab and the Purchase History tab?
The History tab only shows the recent purchases. The Purchase History tab shows a complete history of purchases for the customer up to the time limit specified in Manager View.

Is it possible to initiate a return from the History tab?
Yes, if you choose the Return button or press ENTER, you will initiate a return for the selected item.

To view a purchase history if a customer has been added to a transaction
• In the transaction pane, choose Purchase History.

To view a purchase history if a customer has not been added to a transaction
1 In the search box, type the customer name or customer number, and then press ENTER.
2 Select the customer, choose View/Edit next to the customer’s name, and then choose the History tab.
3 If you want to view all of the customer’s purchase history, choose More.
4 After you finish viewing the customer’s purchase history, press ESC.

Caution
If you press ENTER or choose the Return button, POS begins a return for a selected item.
Substituting items in a transaction

To add a substitute to a transaction

1. Select the line item that is out of stock.
2. Press Transaction, and then press Edit Line Item.
   - F5, then 2
3. Press Select Substitute.
   - CTRL+8
   Point of Sale displays a list of substitute items.
4. Select the substitute item you want, and then choose Replace.
   Point of Sale removes the out-of-stock item and adds the substitute item to the transaction.

Things to know

Why can’t I find any substitutes for an item?
Two things must be in place before you can make a substitution:

• The original item must be out of stock.
• The substitute item must have been designated as a substitute for the out-of-stock item in Manager View.
Checking a price during a transaction

Check a price by item number

1. Scan the item, or type the item number in the search box and then press ENTER. The item will be added to the transaction, where you can view the item’s current price.

2. (If applicable) To remove the item from the transaction, choose Remove on the line item.

Check a price by description

1. Type the item’s description in the search box, and then press ENTER.

2. Select the item in the Search Results list.

3. Choose View/Edit to view the item and see its price.

Things to know

If I type in a description that is only partly correct, will the search still be able to find the item?

If you misspell the word that you type in, the search will not return results with the item you are searching for. However, if you have one incorrect word, it will still find anything that matches. For example, if you type in “red helmet” and there is no red helmet in inventory, the search could turn up “red ball” or “blue helmet,” which are in inventory.
Applying or removing taxes

To apply or remove (clear) a tax from a line item

1. Select the line item.
2. Press Transaction, and then press Edit Line Item.
   - F5, then 2
   - CTRL+7

One of the following will occur:

- If the line item has a tax already applied, Point of Sale clears the tax from the line item.
- If the line item does not currently have a tax applied but previously had a tax, Point of Sale applies the previous tax.
- If the line item never had a tax applied, Point of Sale displays a list of taxes to choose from.

Things to know

Who can apply or remove taxes on items and transactions?
You can apply or remove individual taxes from a single item or an entire transaction if you are assigned to an Owner, Manager, or Supervisor role.

How do I know if an item or transaction is taxable?
A check mark in the Tax column of the Transaction pane indicates that an item is taxable and not affected by tax changes applied to the entire transaction.
For each tax in the Taxes list, Point of Sale displays a check mark in the Applied column if the tax is applied to the transaction.
To apply or remove (clear) a specific tax from a line item

1. Select the line item.
2. Press **Transaction**, and then press **Edit Line Item**.
   - F5, then 2
3. Press **Select Sales Tax**.
   - CTRL+6
4. Press **CTRL** plus the number next to the tax you want to apply.
   - or-
   Press **No Tax** to remove any tax from the selected line item.
   - CTRL+1

**Note**
Point of Sale displays a check mark in the line item if the item is taxable.

How do I handle situations in which there are multiple sales taxes defined?

If you have multiple sales taxes defined, you can choose which one to apply or remove on a line item.

Should I make tax exceptions for customers who are not residents of the state or who are buying for resale?

Customers who are not residents of your state or who are buying for resale may not have to pay sales tax on some items. Check to see if your state requires retailers to record proof of tax-exempt status with each tax-exempt transaction; for example, a tax-exempt ID number or an out-of-state ID. A customer’s tax ID number can be added to the transaction as a detail or comment, or it can be entered in the customer’s record. After a customer’s tax-exempt status has been entered in the customer’s record, no tax will be applied when that customer is added to a transaction.
How can a cashier tell if a tax has been applied to a transaction?

For each tax in the Taxes list, Point of Sale displays a check mark in the Applied column if the tax is applied to the transaction. Check marks in the Taxable column of the Transaction pane refer to whether a line item is taxable or not, and they are not affected by tax changes applied to the entire transaction.

To apply or clear taxes from a transaction

You can apply or clear individual taxes on an entire transaction.

Customers who are not residents of your state or who are buying for resale may not have to pay sales tax. If a customer’s tax-exempt status has been entered in the customer’s record, no tax will be applied when that customer is added to a transaction.

1  Press Transaction, and then press Edit Transaction.

   F5, then 1

2  Press Taxes.

   CTRL+3

3  In the Taxes list, select the tax you want to apply or clear, and then choose Apply/Clear.

4  When you are done applying or clearing taxes, choose OK.
Discounting line items

To apply a discount to a line item

1. In the current transaction, select the line item you want to discount.

2. Press Transaction, then press Edit Line Item, and then press Discount Item.

   F5, then 2, CTRL+3

   -or-

   Choose Discount on the line item.

3. Press one of the following:
   - Percent Off Regular Price (CTRL+1)
   - Percent Off Current Price (CTRL+2)
   - Amount Off Current Price (CTRL+3)
   - Markup from Cost (CTRL+4)
   - Set Profit Margin (CTRL+5)

Things to know

Who can apply a discount to a line item?

Those with Owner, Manager, or Supervisor role can apply discounts to line items. If your role is Cashier, you cannot. All roles can apply preset discounts.

What are the discounts and how do the discounts vary from one another?

These five discounts can be applied to a line item:

- Percent Off Regular Price—Sets the price to a percentage off of the regular price of the item.
- Percent Off Current Price—Reduces the current price by the percentage you specify.
- Amount Off Current Price—Reduces the current price by the dollar amount you specify.
- Markup from Cost—Sets the price to a percentage above the item’s cost (the price paid to the supplier).

Note

The current price differs from the regular price in that it might already have been discounted or changed.
• **Set Profit Margin**—Sets the price to an amount that reflects the percentage of profit margin you specify, based on the item’s cost (the price paid to the supplier).

  Is it possible that a discount could have the effect of increasing the item’s price in some instances?
  Yes, depending on prices levels that may have been set previously for a customer.

  4 Type a percentage or an amount, and then press ENTER.

  **Note**
  Type a percentage as a whole number plus a decimal fraction (such as 8.25 not .0825 for 8 ¼%).
Handling exchanges and returns

Things to know

If a customer wants to return an item without a receipt, but the customer knows the date of the transaction, how do I process the return?

You can verify the original purchase by looking up the receipt by its date. Press Return, press By Receipt, and then press Receipts by Date and Time.

To process a return or an exchange with a receipt and a scanner

1. Scan the bar code on the receipt.

Point of Sale displays the receipt and Receipt Options.

2. Press Recall for Return to recall the transaction for the return or exchange.

CTRL+4

3. Press Return Some Items or press Return All Items.

CTRL+1 or CTRL+2

Note

If the bar code is missing or unreadable, you can look up the receipt. See Chapter 6, “Finding What You Want” for instructions.
If I know which register handled a transaction, can I use the batch number to help find a receipt for a return?

Yes, you can find receipts by batch number for a register. It would also help to have an approximate date.

4 If you are returning only some items, select the items to return, choose Add, and then choose Close when finished adding items.

5 If you are making an exchange, scan or enter the new items.

6 Press Total and complete the transaction.

To process a return or an exchange by looking up a receipt

1 Press Return, and then press By Receipt.

2 Press Today’s Receipts, Receipts By Date/Time, or Receipts By Batch.

Yes, you can find receipts by batch number for a register. It would also help to have an approximate date.
If our store keeps track of customer’s purchases, can I look up a transaction for a return or exchange using that information?

Yes, process the return or exchange by customer name or number. Press Return, press By Customer, and then select the customer. Look on the History tab to find all of the customer’s purchases.

When do I need to use Return Mode?

You only need to use Return Mode if a customer wants to return items for which there is no verification of purchase. Your store policies may not allow such returns, however.

3 Locate and select the receipt, and then press ENTER or choose Select.

4 Press Return Some Items or Return All Items.

CTRL+1 (Return Some Items)

CTRL +2 (Return All Items)
Can I add items to a transaction and then accept a return at the same time?
Yes, you can enter the return first or after the other items are added to the transaction.

How does handling returns paid with a credit or debit card differ from a cash transaction?
You can scan the credit or debit card to help find a receipt. You must also refund the amount by placing the refunded amount on the debit or credit card.

How does handling returns paid with a check differ from a cash transaction?
A check would be treated like cash unless the store’s policy requires that the check has cleared the bank before cash can be refunded. Check with your manager about store policy for these situations.

5. If you are returning only some items, select the items to return, choose Add, and then choose Close when finished adding items.

6. If you are making an exchange, scan or enter the new items.

7. Press Total and complete the transaction F12.

To process a return or an exchange by looking up a customer’s purchase history

1. Press Return, and then press By Customer.

2. In the Customers by Customer No. list, select the customer, and then chose View/Edit.

3. On the History tab, select an item to return, choose Return, and when you’ve finished adding returned items to the transaction, choose OK or press ENTER.

Can I add items to a transaction and then accept a return at the same time?
Yes, you can enter the return first or after the other items are added to the transaction.

How does handling returns paid with a credit or debit card differ from a cash transaction?
You can scan the credit or debit card to help find a receipt. You must also refund the amount by placing the refunded amount on the debit or credit card.

How does handling returns paid with a check differ from a cash transaction?
A check would be treated like cash unless the store’s policy requires that the check has cleared the bank before cash can be refunded. Check with your manager about store policy for these situations.
What is the best option to select for a return if the store does not track purchases by customer and there is no receipt?

In this situation, look up the receipt. Press Tasks, and then Find Receipts. Once you have the receipt, you can add it to the transaction.

4 If you are making an exchange, scan or enter the new items.

5 Press **Total** and complete the transaction.

   F12

**To process a return or an exchange without purchase verification**

1 Press **Return**, and then press **Enter Return Mode**.

   F8, then 3

2 Scan each returned item, or type its item number in the search box and then press ENTER.

   A negative quantity will show for each item in the transaction pane.

3 If you are making an exchange, exit return mode by pressing **Return** and then **Exit Return Mode**, and then scan or enter the new item.

   F8, then 3

4 Press **Total** and complete the transaction.

   F12
Issuing gift cards

To issue or add to a gift card

1. Choose the **Issue Gift Card** button on the task pad.

   **Note**
   
   The button is customizable and might be called something else. Check with your manager if you are not sure which button to use.

2. Type the gift card number or swipe the gift card.

3. Type the amount that should be added to the gift card.

4. Press **Total** (F12) to complete the transaction.

   F12

To issue a gift card instead of a refund

1. Process the return as usual.

2. On the task pad, choose **Issue Gift Card**.

3. Type the gift card number or swipe the gift card.

4. Type the amount of the refund, and then press **ENTER**.

5. Press **Total (F12)** to complete the transaction.

   F12

The transaction balance will be zero.
7

Handling Inventory

In this chapter

Adding inventory at the register
Receiving inventory
Viewing and changing inventory information
Changing the cost an item
Adding inventory at the register

To add an item to inventory

1. Press Items, and then New.
   
   F2, then 1

2. On the General tab, specify an item number, description, price, cost, and quantity in stock.

   Note
   An item number and description are required. Item numbers require at least 3 characters to scan correctly.

3. If the item will be a serial-numbered or noninventory item, choose Browse next to Item type, and then press Serial numbered or Non-Inventory.

   CTRL+2 for serial-numbered item
   -or-

   CTRL+3 for noninventory item

4. Next to Department/Category, choose Browse, and then do one of the following:

   - Select an existing department, and then select a category, create a new category, or select Not Assigned.

Things to know

When is it possible to add an item to inventory at the register in POS View?

There are two situations in which you can add inventory at the register:

- You can add a new item to inventory at the register. For example, if a customer wants to buy an item that has not yet been added to the store's inventory, you can quickly type a description and item number for the item, and then add it to inventory and the transaction.

- You can receive inventory that has been delivered to the store. For example, when you receive a shipment from a supplier, you can receive it against an existing purchase order in POS View rather than using Manager View. See “Receiving inventory.”
Can I change the cost or item type if I make a mistake?
You can specify the cost and item type only when creating an item. They cannot be changed later.

When creating a new item, do I need to specify everything in the New Item window?
An item number and a description are required. It is best to fill as much as possible, however.

- Select **New Department** and type a name and code.
- Select **Not Assigned** if you do not want to assign the new item to a department.

5 Next to **Sales tax**, choose **Browse**, and then select the sales tax appropriate to the item.

6 To specify other information about the item, choose **More**.

7 When you have finished specifying information about the item, press ENTER.
Point of Sale adds the new item to inventory and asks if you want to add it to the current transaction.
To receive inventory

1. Press Items, and then press Receive Inventory.
   - F2, then 7

2. Select an existing item receipt and choose View/Edit, or choose New to create a new item receipt.
   - Point of Sale switches to Receive Inventory mode.

3. If a purchase order number is not yet shown, choose Browse next to the PO No. box, and then on the left, select the purchase order for the shipment that you are receiving.
   - If no purchase order is associated with this shipment, you can skip this step.
   - To select a purchase order, press the arrow keys or type a PO number, supplier name, or date in the search box. The supplier on the purchase order will automatically be filled in.

4. To sort the purchase order list by PO number, supplier name, or date, select a column heading.

5. If a supplier is not yet shown, choose Browse next to the Supplier box, and then on the left, select the supplier that sent the shipment that you are receiving.

Things to know

What is the item receipt in Point of Sale?
An item receipt is a document, often based on a purchase order, which is used to record quantities of items received and update the store database. You can receive inventory in POS View either using a new item receipt or one that was created previously.
My list of suppliers is long. Is there a way that I can quickly find the supplier that I want? There are several ways of locating the supplier that you want, but typing in the name, supplier code, or account number in the search box and pressing ENTER is usually the quickest.

You can also sort the columns by clicking the column headings:
- Code
- Name
- Acct. No.

To select a supplier, press the arrow keys or type a code, name, or account number in the search box.

To sort the supplier list by code, name, or account number, select a column heading.

---

6 Enter the items you’ve received in the shipment. Scan the items or add them to the item receipt manually:

- To select items from the item list, press Items, and then press By Item Number or By Description.
  
  F2, then 4 (item number), or F2, then 5 (description)

- Select an item, and then press ENTER to add it to the item receipt.
7 For each item you add, choose Edit Qty., and in the Quantity box, type the quantity you received. If the item is a serial-numbered item, enter a serial number or numbers for each received unit.

- Choose New.
- Type the serial number or numbers, and then press ENTER.

Repeat for each received unit.

The quantity in the item receipt will increase by 1 for each serial number (or set of serial numbers) that you create.
When would I use an existing item receipt rather than creating a new one?

You would select an existing item receipt if you had already received a partial shipment from a supplier. Otherwise, create a new one.

8 When you finish adding the items you received, do one of the following:

- To save the item receipt without updating your inventory, choose **Save and Close**.
- To save the item receipt, update your inventory, and mark the item receipt as closed, choose **Update Inventory**.

9 If Point of Sale displays a message that some serial numbers are needed, choose **Edit Qty.** next to each serial-numbered item in the item receipt to add the serial numbers for that item.
Viewing or changing inventory information

To view or change inventory information

1. In the search box, type all or part of an item number or an item’s description, and then press ENTER.
   -or-
   Press Items, and then press By Item Number or press By Description.
   - F2, then 4 (item number)
   -or-
   F2, then 5 (description)

2. In the list, select an item, and then choose View/Edit.

   **Note**
   You can also view item information for a line item in a transaction. Select the item, and then choose View.

3. Choose the General tab and edit, modify, or view its information as needed, including:
   - The item number
   - The description
   - Department and category (Change by choosing Browse.)
Why don’t I see a Serial Numbers tab for the item I wanted to view?
Most items don’t have serial numbers. You will only see the Serial Numbers tab if the item was created as a serial-numbered item.

- Sales tax (Change by choosing Browse.)
- Price, cost or quantity in stock (depending on your role permissions)

**Note**
The item type is specified when the item is created and cannot be changed.

4. Choose the History tab to see historical information about the item, such as the date the item was last ordered.

5. Choose the Serial Numbers tab for items that have a serial number to see the serial numbers assigned to the item and whether they have been sold or are in stock.

   For each serial number that has been sold, the tab lists the customer number of the customer who purchased it (when available).

6. Choose the More button to see the Item window, which shows all of the information available for a given item.

   For more information on the options in the Item window, press F1 (Help) from the window.
What does the cost of an item have to do with its price?
Cost is added into the price of an item. The cost of an item is the amount the store pays for it.

When does the cost of an item need to be changed?
You need to update the Cost box on the General tab when what your supplier charges your store for the item changes. However, only employees assigned to the Owner, Manager, or Supervisor roles can change the cost of an item.

To change the cost of an item

1. Press Items, press By Description.
   F2, then 5

2. Select the item whose cost you want to change, and then choose View/Edit.
- or -
   In the transaction pane, select the line item whose cost you want to change, and then choose View.

3. On the General tab, in the Cost box, type the new cost of the item, and then press ENTER.
Handling Customer Information

In this chapter

- Adding a customer to the customer list
- Viewing and editing customer information
- Viewing a customer’s purchase history
- Handling shipping addresses
  - Create a new or additional shipping address
  - View or edit a customer’s addresses
  - Delete a shipping address
Adding a customer to the customer list

To add a customer to the customer list

1. Press Customer, and then press New.

2. On the General tab, type the information you want about the customer, and then press ENTER.
   If you want to add detailed customer information, choose More.

Things to know

What is a customer number?
Each customer who is added to the customer list must have a unique customer number. Normally, this would already be set up in Manager View to automatically generate numbers. You can, however, change the number in POS View.

Can I create a new customer record even if I don’t have all of the information about the customer?
A customer number, first name, and last name are required.

Are customers in the customer list automatically added to transactions?
A customer is not automatically added to a transaction just because you add it to the customer list. You must choose Add Customer.
Viewing and editing customer information

**Things to know**

What is the **customer list**?
The **customer list** contains your customer records. If you are sending advertising or mailing purchases, this list must be accurate and up-to-date. You can view, edit, inactivate, and delete customers from the list.

Where can I view or change information about my customers?
View information in the Customer window on these tabs:

- The **General** tab displays the customer’s number along with the customer’s name and contact information.
- The **Shipping** tab displays any addresses that have been created for the customer.
- The **History** tab shows all of a customer’s past transactions. You cannot edit the History tab information, but you can view the receipt and add it to a returned item.

**To view or edit a customer’s information**

1. In the search box, type all or part of a customer’s name, customer number, or phone number, and then press ENTER.

   - or -

   Press **Customer**, and then press **By Customer No.**, **By Name**, or **By Phone Number**.

   F3, then 4, (customer number)
   
   F3, then 5, (name)
   
   F3, then 6 (phone number)

2. In the list, select the customer, and then choose **View/Edit**.

Point of Sale displays the View/Edit Customer window.
3. View or make any needed changes on the General or Shipping tabs or view the customer’s purchase history on the History tab, and then click OK when finished.

4. To view or change other customer information, choose More at the bottom of a tab.

5. When finished with your changes, click Save and Close in the Customer window.

Can I print shipping labels for a customer using the Print Labels button on the toolbar of the Customer window?

It depends on what address is used as the customer's main address on the General tab of the Customer window. Only the address on the General tab can be printed using the Print Labels command (available on the Tools menu). For this reason, the types of mailings and shipments that you send to your customers will dictate which address you enter as the customer’s main address. For example, if you regularly send flyers or other mailings to your customers, you will want to enter the customer’s standard mailing address as the main address. But, if you will only print labels for package shipments, then you might want to enter the customer’s primary shipping address as their main address. This distinction will be especially important for customers with post office boxes.
Viewing a customer’s purchase history

Things to know

Where do I find information about a customer’s purchase history?
The History tab displays customer purchases made within the time period specified in Manager View, such as the last 30, 60, or 90 days.

Is it possible to view a customer’s purchase history beyond the time period shown for the History tab?
Yes, the complete purchase history of the customer can be found by choosing More at the bottom of the History tab.

To find an item purchased by a customer

- If the customer has already been added to the transaction, choose the Purchase History button to display the customer's information.

-or-

1. In the search box, type the customer name or customer number, and then press ENTER.

2. Select the customer, choose the View/Edit button next to the customer's name, and then choose the History tab.
Is there a summary of information about a customer’s purchases?
On the Purchase History tab, choose More to view the following:

- **Last visit**: Date and time of the customer’s last transaction
- **Total sales**: Total amount of sales for the customer
- **Total visits**: Number of transactions for the customer
- **Savings**: Total amount of savings for the customer resulting from discounts

Can I access the purchase history for a customer directly from the POS View screen?
A customer’s purchase history is available at the register by choosing Purchase History in the transaction pane when a customer has been added to a transaction.

3. (If applicable) If you want to add the transaction as a return, choose **Return** and then choose **OK** or press ENTER unless you want to view further information.

4. (If applicable) To view the complete customer history, choose **More**.

5. (If applicable) On the **Purchase History** tab, to view the receipt for a transaction, double-click the transaction in the list.

6. After you finish viewing the customer’s purchase history, press ESC.
Handling shipping addresses

As a cashier, can I see the customer’s shipping address from the POS View screen?

A customer’s primary shipping address, if available, is displayed at the register when the customer is added to a transaction by choosing Select Customer. Choose Add after the customer’s name in the task pane. You can then select a different shipping address or add a new one by choosing Shipping Address.

To create a new or additional shipping address

1. In the transaction pane, choose Select Customer to add a customer to the transaction.
2. In the task pane, choose Add after the customer’s name.
3. In the transaction pane, choose Shipping Address.
4. If the customer has one or more existing shipping addresses, select an address on the Shipping tab, and then choose New.
5. Under New Shipping Address, type the shipping address.
6. If this is the primary address for the customer, choose Set Primary.

**Note**

If this is the customer’s only shipping address or if this is already the primary shipping address, Set Primary is not available.

To view or edit a customer’s addresses

1. In the transaction pane, choose Select Customer to add a customer to the transaction.
2. In the transaction pane, choose Shipping Address.
Do I have to designate a primary shipping address?
You must designate a primary shipping address if there is more than one address. If there is only one address for the customer, it automatically becomes the primary address.

3 On the Shipping tab, select the address you want to edit, and then choose View/Edit.

4 Edit the address as required.

5 If this is the primary address for the customer, choose Set Primary.

Note
If this is the customer's only shipping address or if this is already the primary shipping address, Set Primary is not available.

6 When finished with your changes in the Edit Shipping Address window, choose OK or press ENTER.
If a customer is no longer a customer, what is the best way to handle the record?

You may want to inactivate rather than delete a customer, so that the customer history is preserved. If you delete a customer, you will also delete the history of that account, which may be needed later on. Changes that involve deleting or inactivating a customer are made in Manager View.

To delete a shipping address

1. In the transaction pane, choose Select Customer to add a customer to the transaction.
2. In the transaction pane, choose Shipping Address.
3. In the task pane, choose More.
4. On the Shipping tab, select the address you want to delete, and then press DELETE.
Customizing the POS View Screen

In this chapter

Changing display settings

Creating a custom pane
  Create a custom pane using an HTML file
  Create your own custom pane

Resizing the panes and touch-screen keyboard
  Resize the transaction pane and task pane (using a mouse)
  Resize the touch screen keyboard or custom pane
Things to know

Can I personalize screen settings in POS View?

Although many of the screen settings and other options are set in Manager View, some can be customized in POS View. For example, you can increase the size of the text and numbers in the Totals area, hide the customer address bar, or increase the font size. See procedures on the right to learn how to customize the POS View.

Note

Some POS View display options are set in Manager View. For more information, see "Customize your registers" in Manager View Help.

To change display settings

1. Press Tools, and then System.
   
   F7, then 7

2. Press Display.
   
   CTRL+4

5. Under General:

<table>
<thead>
<tr>
<th>Select or clear this check box:</th>
<th>To show or hide this feature:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display function bar</td>
<td>The row of function buttons at the bottom of the window.</td>
</tr>
<tr>
<td>Display customer address bar</td>
<td>The customer address portion of the transaction pane</td>
</tr>
<tr>
<td>Show window controls</td>
<td>The Windows Minimize, Maximize/Restore, and Close buttons</td>
</tr>
</tbody>
</table>
What changes can I make in the Display Settings window?

You can make some general changes including the following:

- Position and size windows
- Choose which function buttons to display
- Show or hide the customer address bar
- Show or hide Windows controls for easy access to the desktop
- Show or hide the touch screen keyboard
- Show or hide the touch screen navigation arrows
- Show or hide the custom pane and change its size
- Return settings to their original (default) settings.

4 Under General, choose the Window Position and Size button.

5 In the Position and Size dialog box, type the position for Left and Top in pixels.

6 Type the Width and Height in pixels, and then choose OK.
In what way are the touch-screen navigation keys helpful?
When enabled, these navigation buttons provide a way to move up and down lists in the task pane and the list of line items in the transaction pane.

How can I restore my settings to what they were originally in the Display Settings dialog box?
At the bottom of the dialog box, choose Restore Default Settings.

<table>
<thead>
<tr>
<th>7 Under Touch screen:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select or clear this check box:</strong></td>
</tr>
<tr>
<td><strong>Display touch screen keyboard</strong></td>
</tr>
<tr>
<td><strong>Enable touch screen navigation buttons</strong></td>
</tr>
</tbody>
</table>

**Note**
The “Use international keyboard layout” option is not available in this release of Point of Sale.

<table>
<thead>
<tr>
<th>8 Under Custom Pane:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select or clear this check box:</strong></td>
</tr>
<tr>
<td><strong>Display custom pane</strong></td>
</tr>
</tbody>
</table>
Creating a custom pane _________________________

To create a custom pane using an HTML file

1. Press **Tools**, and then **System**. F7, then 7

2. Press **Display**. CTRL+4

3. Select the **Display custom pane** check box, and then in the **Height** box, indicate the height as a percentage of the POS View window.

Things to know

Are there files that I can use as a template for customizing the custom pane?

The custom pane displays an HTML file that can be customized for your store. You can use the supplied HTML file as a template for creating your own file. The supplied file is located on your hard drive. (C:\Program Files\Microsoft Dynamics - Point of Sale\Content\HtmlStatusPane\StatusBar.html)
Can I create a custom color for my background?
Yes, select “Use a solid color,” and then from the drop-down list, select Custom.

4 If you want to show an HTML file in the custom pane, select Show an HTML file in the custom pane, and then choose Browse and then select either the HTML file that is supplied with Point of Sale (C:\Program Files\Microsoft Dynamics - Point of Sale\Content\HtmlStatusPane\StatusBar.html) or an HTML file that has been customized for your store.

Point of Sale displays the selected file name in the File name box.

To create your own custom pane

1 Press Tools, and then System.
   F7, then 7

2 Press Display
   CTRL+4

3 Under Custom Pane, select the Display custom pane, and then in the Height box indicate the height as a percentage of the POS View window.

4 Select Create my own content for the custom pane, and then in the Text box, type the text that you want to appear in the custom pane.

5 Choose the Font button to select font options for the text.
Can I use an image and a color for the background?
You must choose one or the other.

6 Choose the **Browse** button next to the **Logo** box to select a logo to show in the custom pane.

7 To set a background, choose **Use a solid color** and then select a color, or choose **Use this image** and choose **Browse** to select the background image.

8 When finished, choose **OK** or press ENTER.
Resizing the panes and touch-screen keyboard

Things to know

Can I move the task pane to the left or right side of the screen?
The task pane can be displayed on the right side or the left side of the POS View window, but this option is set in Manager View. If you are using a mouse, however, you can resize the transaction and task panes. The touch-screen keyboard and custom screen can be customized with a mouse, keyboard, or touch screen.

Can I hide the custom pane to make more room for the transaction pane?
If you need more room for the transaction pane, you can hide the custom pane. Choose Tools, System, and then Display.

To resize the transaction pane and the task pane (Mouse users only)
- Drag the border between the task pane and the transaction pane left or right.

Note
The task pane can be displayed on the right side or the left side of the POS View window. This option is set in Manager View.

To resize the touch-screen keyboard or custom pane (All users)

1. Press Tools, and then press System.
   
   F7, then 7,

2. Press Display.
   
   CTRL+4

3. Under Touch screen, select the Display touch screen keyboard check box, and then in the Height box, type a percentage of the total screen height.

Important
Type the percentage as a whole number plus a decimal fraction, such as 20.5, not as .205 to mean 20 ¼%.
4. In the **Custom pane area**, select the **Display custom pane** check box, and then in the **Height** box, type a percentage of the total screen height.

**Note**

Type this percentage as a whole number plus a decimal fraction (if there is one), such as 8.0, not .8 to mean 8%.

---

**Can I resize the Help window?**

Yes, point to a border or corner of the window until the pointer appears as a double-headed arrow, and then drag the border until the window is the size you want.
In this chapter

Printing receipts
   Reprint the last receipt
   Find and print any receipt
   Print a gift receipt

Printing a Help topic

Printing POS View reports
   Print an X report
   Print a Z report
   Print a ZZ report
Printing receipts

**Things to know**

**What can I print?**
Printing could include printing the last receipt and any receipt by date or batch. You can also print a Help topic. If the store offers gift receipts to customers, they must be set up in Manager View before you can print them in POS View. Certain reports can also be printed from POS View.

**To reprint the last receipt**
- Press **Tasks**, and then press **Reprint Last Receipt**.

  F6, then 4

**To find and print any receipt**

1. Press **Tasks**, and then press **Find Receipts**.

  F6, then 3

2. Under **Find Receipts**:

<table>
<thead>
<tr>
<th>Press</th>
<th>Then</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Today’s Receipts</strong> (CTRL+1)</td>
<td>Search for the receipt by the time of day or amount.</td>
</tr>
<tr>
<td><strong>Receipts By Date/Time</strong> (CTRL+2)</td>
<td>Type a start date and an end date, and then press ENTER.</td>
</tr>
<tr>
<td><strong>Receipts By Batch</strong> (CTRL+3)</td>
<td>Select a batch, and then press ENTER</td>
</tr>
</tbody>
</table>

3. Select the receipt you want, and then press ENTER.
What do I need to do to be able to print gift receipts for customers?

Printing gift receipts is the same as reprinting any last receipt. The reprinted receipt is the gift receipt. See instructions on the right, “To print a gift receipt.”

4  Under Receipt Options, press Print.

CTRL+1

To print a gift receipt

•  Press Tasks, and then press Reprint Last Receipt.

F6, then 4
Printing a Help topic

1. Display a Help topic.
2. On the Help window button bar, choose Print.

Why print a Help topic?
You do not need to print Help topics to use them, but some people find it easier to follow instructions from the printed page especially for complex procedures.
Printing POS View reports

Things to know

What is an X report?
An X report is a “snapshot” of a register’s activity since it was opened, and it is printed on the register’s receipt printer. An X report displays information such as sales, the sum of all discounts given, and a customer count so far in the current batch.

Does printing an X report close the current batch?
Printing an X report does not close the current batch, but printing a Z or a ZZ report does. The Z and ZZ reports also automatically open the next batch.

What is a Z report?
The Z report provides end-of-day statistics for a register, and it is printed on the register’s receipt printer. The Z report displays information, such as batch number, sales, amount of cash dropped, sales tax, and the closing total.

To print an X report

1. Press Tasks, and then press Open/Close.


CTRL+3

Note
Only employees assigned to the Owner, Manager, or Supervisor roles can print X reports.

To print a Z report

1. Press Tasks, and then press Open/Close.


CTRL+4
What is a ZZ report?
The ZZ report shows the statistics from a register's Z reports generated since the last ZZ report. The report is printed on the register's receipt printer.

To print a ZZ report

1. Press Tasks, and then press Open/Close.

CTRL+5
Appendix A

Employee Roles
About employee roles

Microsoft Dynamics - Point of Sale provides a permission hierarchy for accessing your company’s data. This ensures that sensitive financial data is not visible to the people who do not need to view it and that only authorized users can carry out specified business functions. Roles for the POS View are assigned, changed, or removed in Manager View. The roles include:

- Owners—have access to all functions of POS View and Manager View.
- Managers—have access to most functions available to the Owner role but do not have access to use most database commands except Backup. Managers cannot add, update, and delete an employee or setup Practice mode. Additionally, an employee assigned the Manager role cannot view or edit the time clock information, create a time clock entry for an employee, or delete any time clock record.
- Supervisors—have access to almost the same functions in POS View as the Manager role, but Supervisors do not have access to Manager View. Additionally, in POS View, employees assigned the Supervisor role cannot run the Store Setup Wizard, delete customers, delete items, and view the time clock information for any employee or create a time clock entry for any employee.
- Cashiers—have basic role permissions that relate to operating their registers. See specifics in the following chart.

All employees assigned to each role will have the same rights. For this reason, you may be assigned a role despite a difference between your actual job title and the name of the role in Point of Sale. For example, you may be a cashier assigned to the Supervisor role in order to give you access to more Point of Sale functionality than other cashiers, even though your job titles are the same.

Know your security role rights and permissions

The following chart provides details of actions allowed for each role. All employees, including those assigned to the Cashier role, can perform register tasks not listed in the rights table, such as processing basic sales transactions.
<table>
<thead>
<tr>
<th>This right</th>
<th>Allows employees in these roles</th>
<th>To take this action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Access to Manager View</td>
<td>Owner, Manager</td>
<td>Open Manager View. This provides security for your store database in addition to protecting your privacy.</td>
</tr>
<tr>
<td>Access to Store Setup Wizard</td>
<td>Owner, Manager</td>
<td>Run the Store Setup Wizard.</td>
</tr>
<tr>
<td>Customers: add and update</td>
<td>Owner, Manager, Supervisor, Cashier</td>
<td>Create or modify customer records.</td>
</tr>
<tr>
<td>Customers: delete</td>
<td>Owner, Manager</td>
<td>Delete customer records.</td>
</tr>
<tr>
<td>Database menu: access to Backup command</td>
<td>Owner, Manager</td>
<td>Use the Backup command on the Database submenu (available from the Tools menu).</td>
</tr>
<tr>
<td>Database menu: access to commands other than Backup</td>
<td>Owner</td>
<td>Use the other commands on the Database submenu (available on the Tools menu).</td>
</tr>
<tr>
<td>Employees: add, update, and delete any type</td>
<td>Owner</td>
<td>Create, modify, or delete employee records. Note: Managers will be able to view employee information in Manager View. Any employee can change their password from the Logon dialog box.</td>
</tr>
<tr>
<td>Items: delete</td>
<td>Owner, Manager</td>
<td>Delete item records.</td>
</tr>
<tr>
<td>Practice mode: access to setup</td>
<td>Owner</td>
<td>Set up practice mode.</td>
</tr>
<tr>
<td>Practice mode: enter and exit</td>
<td>Owner, Manager, Supervisor</td>
<td>Enter or exit practice mode.</td>
</tr>
<tr>
<td>Register: change in-stock quantities in item properties manually</td>
<td>Owner, Manager, Supervisor</td>
<td>At the register, change the in-stock quantity of an item.</td>
</tr>
<tr>
<td>This right</td>
<td>Allows employees in these roles</td>
<td>To take this action</td>
</tr>
<tr>
<td>------------------------------------------------</td>
<td>--------------------------------</td>
<td>-------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Register: change prices or apply discounts</td>
<td>Owner</td>
<td>At the register, change item prices, set price levels, or manually discount line items or transactions.</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>At the register, mark apply or clear taxes on a line item or transaction.</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>Close the batch (and open a new one) at a register.</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>Set up the hardware devices on a register so that they will work with Point of Sale.</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>View an item’s cost at the register. For employees without this right, cost information will be hidden.</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>Access sales graphs at the register.</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>Access the Receipt Viewer at the register.</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>Entering closing amounts at the register.</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>Enter opening amounts at the register.</td>
</tr>
<tr>
<td></td>
<td>Owner</td>
<td>Close Point of Sale at a register.</td>
</tr>
<tr>
<td>This right</td>
<td>Allows employees in these roles</td>
<td>To take this action</td>
</tr>
<tr>
<td>---------------------------------------------------------</td>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Register: generate X reports</td>
<td>Owner</td>
<td>Run an X report.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td>Register: generate Z and ZZ reports</td>
<td>Owner</td>
<td>Close the batch (and open a new one) on a register by running</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cashier</td>
<td></td>
</tr>
<tr>
<td>Time clock: display and add entries for any employee</td>
<td>Owner</td>
<td>View the time clock information for any employee, or create a time clock entry for any employee.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td>Time clock: display, add, update, and delete entries for any employee</td>
<td>Owner</td>
<td>View or edit the time clock information for any employee, create a time clock entry for any employee, or delete any time clock record.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td>Transactions: cancel transactions</td>
<td>Owner</td>
<td>Cancel a transaction that's in progress at the register.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cashier</td>
<td></td>
</tr>
<tr>
<td>Transactions: perform cash drops</td>
<td>Owner</td>
<td>Perform a cash drop at the register.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td>Transactions: perform No Sales</td>
<td>Owner</td>
<td>Perform a No Sale at the register and open the cash drawer.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td>Transactions: perform payouts</td>
<td>Owner</td>
<td>Perform a cash payout at the register.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td>Transactions: perform returns</td>
<td>Owner</td>
<td>Process a return transaction.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cashier</td>
<td></td>
</tr>
<tr>
<td>This right</td>
<td>Allows employees in these roles</td>
<td>To take this action</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------------------------------</td>
<td>------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Transactions: perform voids</td>
<td>Owner</td>
<td>Void a previously completed transaction</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cashier</td>
<td></td>
</tr>
<tr>
<td>Transactions: place holds</td>
<td>Owner</td>
<td>Put a transaction on hold.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Cashier</td>
<td></td>
</tr>
<tr>
<td>Transactions: post empty</td>
<td>Owner</td>
<td>Post a transaction even when it does not contain any items or payment information.</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
<tr>
<td>Transactions: sell items to employees with discounts</td>
<td>Owner</td>
<td>Process a sales transaction with a discount when the customer is an employee</td>
</tr>
<tr>
<td></td>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Supervisor</td>
<td></td>
</tr>
</tbody>
</table>
Function Keys and Tasks
## Function keys and tasks

The following chart provides a list of all function keys and what they do.

<table>
<thead>
<tr>
<th>Function category</th>
<th>To do this</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Help</td>
<td>Access Help</td>
<td>F1</td>
</tr>
<tr>
<td>Items</td>
<td>Open the Items menu</td>
<td>F2 Items</td>
</tr>
<tr>
<td>Items</td>
<td>Enter information about a new item</td>
<td>F2+1 New</td>
</tr>
<tr>
<td>Items</td>
<td>View or edit an item already added to a transaction</td>
<td>F2+2 View/Edit</td>
</tr>
<tr>
<td>Items</td>
<td>Search for an item in the Item list</td>
<td>F2+3 Search</td>
</tr>
<tr>
<td>Items</td>
<td>Locate an item by its number in ascending numerical order</td>
<td>F2+4 By Item Number</td>
</tr>
<tr>
<td>Items</td>
<td>Locate an item by its description in alphabetical order</td>
<td>F2+5 By Description</td>
</tr>
<tr>
<td>Items</td>
<td>Locate a substitute item, if available</td>
<td>F2+6 Substitutes</td>
</tr>
<tr>
<td>Items</td>
<td>Receive items to add to inventory</td>
<td>F2+7 Receive Inventory</td>
</tr>
<tr>
<td>Customer</td>
<td>Open the Customer menu</td>
<td>F3 Customer</td>
</tr>
<tr>
<td>Customer</td>
<td>Add information about a new customer</td>
<td>F3+1 New</td>
</tr>
<tr>
<td>Customer</td>
<td>Edit or view information about an existing customer</td>
<td>F3+2 Edit/View</td>
</tr>
<tr>
<td>Customer</td>
<td>Search for an existing customer record by typing in the Search box.</td>
<td>F3+3 Search</td>
</tr>
<tr>
<td>Customer</td>
<td>Locate a customer record by customer number</td>
<td>F3+4 By Customer No.</td>
</tr>
<tr>
<td>Customer</td>
<td>Locate a customer record by name</td>
<td>F3+5 By Name</td>
</tr>
<tr>
<td>Customer</td>
<td>Locate a customer record by phone number</td>
<td>F3+6 By Phone Number</td>
</tr>
<tr>
<td>Function category</td>
<td>To do this</td>
<td>Press</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Customer</td>
<td>Add a new shipping address to a transaction</td>
<td>F3+7 Shipping Address</td>
</tr>
<tr>
<td>Customer</td>
<td>Remove a customer from a transaction</td>
<td>F3+8 Clear</td>
</tr>
<tr>
<td>Transaction</td>
<td>Open the Transaction menu</td>
<td>F5 Transaction</td>
</tr>
<tr>
<td>Transaction</td>
<td>Edit a transaction</td>
<td>F5+1 Edit Transaction</td>
</tr>
<tr>
<td>Transaction</td>
<td>View or edit transaction details</td>
<td>F5+1, then CTRL+1 Details</td>
</tr>
<tr>
<td>Transaction</td>
<td>Apply a discount</td>
<td>F5+1 then CTRL +2 Discounts</td>
</tr>
<tr>
<td>Transaction</td>
<td>View or edit a sales tax</td>
<td>F5+1, then CTRL +3 Taxes</td>
</tr>
<tr>
<td>Transaction</td>
<td>Edit only the line item for a transaction</td>
<td>F5+2 Edit Line Item</td>
</tr>
<tr>
<td>Transaction</td>
<td>Remove the selected line item from the transaction</td>
<td>F5+2, then CTRL+1 Remove Item</td>
</tr>
<tr>
<td>Transaction</td>
<td>Mark the selected line item for return (adds a minus sign to the quantity)</td>
<td>F5+2, then CTRL+2 Return Item</td>
</tr>
<tr>
<td>Transaction</td>
<td>Discount the selected line item</td>
<td>F5+2, then CTRL+3 Discount Item</td>
</tr>
<tr>
<td>Transaction</td>
<td>Change the quantity of the selected line item</td>
<td>F5+2, then CTRL+4 Change Quantity</td>
</tr>
<tr>
<td>Transaction</td>
<td>Add a comment to the selected line item</td>
<td>F5+2, then CTRL+5 Add Comment</td>
</tr>
<tr>
<td>Transaction</td>
<td>Apply or clear a particular sales tax from the selected line item</td>
<td>F5+2, then CTRL+6 Select Sales Tax</td>
</tr>
<tr>
<td>Transaction</td>
<td>Apply or clear all sales tax from the selected line item</td>
<td>F5+2, then CTRL+7 Apply Tax/Clear Tax</td>
</tr>
<tr>
<td>Transaction</td>
<td>View substitutes for an item</td>
<td>F5+2, then CTRL+8 Select Substitute</td>
</tr>
<tr>
<td>Transaction</td>
<td>Remove a line item from a transaction</td>
<td>F5+3 Remove Line Item</td>
</tr>
<tr>
<td>Transaction</td>
<td>Place a transaction on hold or recall the transaction when ready to continue</td>
<td>F5+4 Hold/Recall</td>
</tr>
<tr>
<td>Transaction</td>
<td>Cancel a transaction</td>
<td>F5+5 Cancel Transaction</td>
</tr>
<tr>
<td>Function category</td>
<td>To do this</td>
<td>Press</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Transaction</td>
<td>Open the cash drawer without a transaction</td>
<td>F5+6 No Sale</td>
</tr>
<tr>
<td>Tasks</td>
<td>Open Tasks menu</td>
<td>F6 Tasks</td>
</tr>
<tr>
<td>Tasks</td>
<td>Specify an opening or closing amount</td>
<td>F6+1 Open/Close</td>
</tr>
<tr>
<td>Tasks</td>
<td>Enter opening amounts</td>
<td>F6+1, then CTRL+1 Opening Amounts</td>
</tr>
<tr>
<td>Tasks</td>
<td>Enter closing amounts</td>
<td>F6+1, then CTRL+2 Closing Amounts</td>
</tr>
<tr>
<td>Tasks</td>
<td>Print an X report</td>
<td>F6+1, then CTRL+3 X Report</td>
</tr>
<tr>
<td>Tasks</td>
<td>Print a Z report</td>
<td>F6+1, then CTRL+4 Z Report</td>
</tr>
<tr>
<td>Tasks</td>
<td>Print a ZZ report</td>
<td>F6+1, then CTRL+5 ZZ Report</td>
</tr>
<tr>
<td>Tasks</td>
<td>Specify a drop or payout</td>
<td>F6+2 Drop/Payout</td>
</tr>
<tr>
<td>Tasks</td>
<td>Make a cash drop</td>
<td>F6+2, then CTRL+1 Cash Drop</td>
</tr>
<tr>
<td>Tasks</td>
<td>Make a payout</td>
<td>F6+2, then CTRL+2 Payout</td>
</tr>
<tr>
<td>Tasks</td>
<td>Find a receipt</td>
<td>F6+3 Find Receipts</td>
</tr>
<tr>
<td>Tasks</td>
<td>Look only in today’s receipts</td>
<td>F6+3, then CTRL+1 Today’s Receipts</td>
</tr>
<tr>
<td>Tasks</td>
<td>Look for receipts by date and time</td>
<td>F6+3, then CTRL+1 Receipts By Date/Time</td>
</tr>
<tr>
<td>Tasks</td>
<td>Look for receipts by batch number</td>
<td>F6+3, then CTRL+1 Receipts By Batch</td>
</tr>
<tr>
<td>Tasks</td>
<td>Reprint the last receipt</td>
<td>F6+4 Reprint Last Receipt</td>
</tr>
<tr>
<td>Tasks</td>
<td>Turn the printer on or off</td>
<td>F6+5 Printer On/Printer Off</td>
</tr>
<tr>
<td>Tasks</td>
<td>Void a previous transaction</td>
<td>F6+6 Void</td>
</tr>
<tr>
<td>Tasks</td>
<td>Switch to a different user</td>
<td>F6+7 Switch User</td>
</tr>
<tr>
<td>Tasks</td>
<td>Exit Point of Sale</td>
<td>F6+8 Exit</td>
</tr>
<tr>
<td>Tools</td>
<td>Open Tools menu</td>
<td>F7 Tools</td>
</tr>
<tr>
<td>Tools</td>
<td>Display one of the calculators</td>
<td>F7+1 Calculator</td>
</tr>
<tr>
<td>Function category</td>
<td>To do this</td>
<td>Press</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------</td>
<td>------------------------------</td>
</tr>
<tr>
<td>Tools</td>
<td>Logon for the Time Clock</td>
<td>F7+2 Time Clock</td>
</tr>
<tr>
<td>Tools</td>
<td>Display a graph</td>
<td>F7+3 Graphs</td>
</tr>
<tr>
<td>Tools</td>
<td>Display the currency list</td>
<td>F7+4 Currency</td>
</tr>
<tr>
<td>Tools</td>
<td>Selects the Default currency</td>
<td>F7+4, then CTRL+1 Default Currency</td>
</tr>
<tr>
<td>Tools</td>
<td>Selects Canadian dollar</td>
<td>F7+4, then CTRL+2 Canadian Dollars</td>
</tr>
<tr>
<td>Tools</td>
<td>Selects US dollar</td>
<td>F7+4, then CTRL+3 US Dollars</td>
</tr>
<tr>
<td>Tools</td>
<td>Display the Basic and Advanced find window</td>
<td>F7+5 Find</td>
</tr>
<tr>
<td>Tools</td>
<td>Enter Practice Mode</td>
<td>F7+6 Enter Practice Mode</td>
</tr>
<tr>
<td>Tools</td>
<td>View or change system information,</td>
<td>F7+7 System</td>
</tr>
<tr>
<td>Tools</td>
<td>Display version and product support information</td>
<td>F7+7, then CTRL+1 About</td>
</tr>
<tr>
<td>Tools</td>
<td>Displays register properties</td>
<td>F7+7, then CTRL+2 Register Properties</td>
</tr>
<tr>
<td>Tools</td>
<td>Test POS hardware devices</td>
<td>F7+7, then CTRL+3 Test Hardware</td>
</tr>
<tr>
<td>Tools</td>
<td>View or change POS display settings</td>
<td>F7+7, then CTRL+4 Display</td>
</tr>
<tr>
<td>Tools</td>
<td>Switch to Manager View</td>
<td>F7+8 Manager View</td>
</tr>
<tr>
<td>Return</td>
<td>Open Return menu</td>
<td>F8 Return</td>
</tr>
<tr>
<td>Return</td>
<td>Return item by receipt</td>
<td>F8+1 By Receipt</td>
</tr>
<tr>
<td>Return</td>
<td>Return item by customer</td>
<td>F8+2 By Customer</td>
</tr>
<tr>
<td>Return</td>
<td>Enter Return Mode</td>
<td>F8+3 Enter Return Mode</td>
</tr>
<tr>
<td>Total</td>
<td>Total the transaction</td>
<td>F12 Total</td>
</tr>
<tr>
<td>Total</td>
<td>Automatically enter the exact amount of the sale in the selected payment method and post the transaction</td>
<td>+</td>
</tr>
</tbody>
</table>
Manager’s Guide
Microsoft Dynamics – Point of Sale
## Contents

Getting Started with Manager View.................................................................7  
Using Manager View .........................................................................................21  
Customizing Manager View and POS View .....................................................35  
Managing Taxes .................................................................................................43  
Managing Payment Methods ............................................................................59  
Managing Payment Processing ..........................................................................79  
Managing the File Center ..................................................................................95  
Managing Register and Peripheral Settings .....................................................109  
Working with Receipt Formats ........................................................................119  
Working with Line Display Messages .............................................................129  
Working with Task Pads ..................................................................................137  
Working with Items .........................................................................................151  
Working with Item Settings ............................................................................161  
Managing Inventory Quantities ........................................................................171  
Working with Aliases, Substitutes, and Tagalong Items ..................................177  
Managing Departments and Categories .........................................................183  
Managing Supplier Information .......................................................................191  
Managing Item Messages ................................................................................199  
Managing Purchase Orders, Inventory Transfers, and Item Receipts ...............205  
Managing Physical Inventories ........................................................................237  
Managing Customers ......................................................................................251  
Managing Employees ......................................................................................269  
Managing Store Transactions ..........................................................................283  
Managing Reports ............................................................................................291  
Displaying Reports .........................................................................................301  
Filtering Reports ..............................................................................................309  
Managing Custom and Capsule Reports .........................................................317  
Managing Prices and Costs ............................................................................325  
Managing Discounts .......................................................................................337  
Integrating with Accounting ...........................................................................357  
Creating and Working with the Store Database .............................................389  
Working with Labels .......................................................................................411  
Names and Paths for POS View Function Task Pad Buttons, Appendix A ......421  
Payment Card Industry Data Security Standard, Appendix B .........................427
Introducing the Manager’s Guide

Manager’s Guide is designed to work with Getting Started and the Cashier’s Guide to provide answers to questions about Microsoft Dynamics™ - Point of Sale from initial installation and store setup to making sales transactions, purchasing, and running an efficient and profitable retail operation.

Manager’s Guide is divided into twelve parts, each describing important features and telling you how to complete the tasks associated with each part:

- **Part 1— The Basics.** Helps you get Point of Sale up and running quickly, explains the most important screen elements, and shows you how to customize your Point of Sale screen for accessibility and ease of use.

- **Part 2—Store Management.** Focuses on setting up your store in the important areas of taxes, payment processing, and payment methods. It also shows you how to keep all of your database files and folders organized and accessible in File Center.

- **Part 3—Register Management.** Assists you in setting up store registers and peripherals to work with Point of Sale. It shows you how to design your own receipt formats and create customized task pads to suit your inventory and procedures.

- **Part 4—Inventory Management.** Focuses on tracking and managing your inventory efficiently through purchase orders, inventory transfers, item receipts, and physical inventories. It shows you how to set up departments and categories within your store along with how to label items and catalog their locations.

**Things to know…**

**Why use Microsoft Office Accounting Professional 2007 with Point of Sale?**

If you want to synchronize your store’s accounting with the sales and inventory management in Point of Sale, install Office Accounting 2007, a powerful accounting solution included with Point of Sale.

With your accounting managed in Office Accounting 2007, you can set up Point of Sale to seamlessly interact with your accounting information so that changes in sales, inventory, and other information in Point of Sales are reflected in the records of your income, expenses, assets, and liabilities in Office Accounting 2007. And from the other direction, changes you make in Office Accounting 2007 ripple through to Point of Sale so that the two are always in agreement.

Manager’s Guide is designed to work with Getting Started and the Cashier’s Guide to provide answers to questions about Microsoft Dynamics™ - Point of Sale from initial installation and store setup to making sales transactions, purchasing, and running an efficient and profitable retail operation.
• Part 5—Customer Management. Provides you ways to track customer information and to set discounts and price levels for specific customers.

• Part 6—Employee Management. Shows you ways to record employee information, track hours worked, generate reports on your employees’ register activity, assign employee security roles, and control employee workflow.

• Part 7—Transaction Management. Provides suggestions for “touchless” transactions to speed up transactions and explains how to work with batches, transactions, and journal receipts.

• Part 8—Report Management. Shows you how to monitor every aspect of your store by creating interactive real-time report and how to filter and customize those reports to find exactly what you are looking for and in the way you want to see it.

• Part 9—Price and Cost Management. Assists you in determining profit margins, creating price levels, setting sale prices, and determining various kinds of discounts.

• Part 10—Accounting Integration. Helps you set up accounting integration and synchronize your accounting data with Point of Sale and QuickBooks.

• Part 11—Database Management. Provides you with all the information that you will need to set up your store database, avoid database disasters, and query your database for information.

• Part 12—Label Management. Provides you with quick and easy steps for printing labels for price tags, inventory control stickers, and customer or supplier addresses.

Where can I find out what’s new in this version of Point of Sale?

You asked for some new features and we listened! Both Manager View Help and Getting Started provide a complete list of innovations and improvements.

Is there a way to set up an internet store or use online invoicing?

You can use Online Sales in Office Accounting 2007 to set up an Internet store, list items on Internet marketplaces like eBay, track auctions in real time, and make and receive payments through PayPal. You can also take advantage of online invoicing.
Use the Manager’s Guide for information about using Point of Sale for all your back-office store operations. A number of cues throughout the book will help you easily find what you are looking for:

- Each chapter begins with its own table of contents of topics and subtopics.
- Page 2 of every chapter lists other additional information in the “For Information related to this chapter” section.
- In the blue sidebar on the left labeled “Things to know...,” you will find general conceptual information along with questions and answers about the topic.
- Topics include highlighted information where appropriate: either a Tip, a Caution (Important), or a Note.
- Some topics include cross-reference to additional information in Manager View Help. These are indicated by a Help button: or .
- Instructions generally use the menus in Point of Sale. At times, alternate instructions appear with an icon (for example, for the Customer Center).

There is lots of information in the Manager’s Guide, but first, things first – make sure to start by reading Getting Started, located in the Point of Sale CD folder.
PART 1: THE BASICS

1

Getting Started with Manager View

In this chapter

Getting started
  Install Point of Sale
  Set up your hardware
  Begin store setup process using the Activation Wizard
  Start and log on

Creating and changing a password or ID
  Change password when logging on
  Change password from the Employee window
  Change an employee’s ID

Accessing and exiting Point of Sale
  Switch to Manager View from POS View
  Switch to POS View from Manager View
In this chapter continued

Exit Point of Sale from POS View
Refresh Manager View window
Log off or switch users

Setting up your store
Start the Store Setup Wizard
Set up your store using a checklist
Enter basic store information

Uninstalling Point of Sale
Uninstall Point of Sale without removing the store database
Uninstall Point of Sale including removing the store database
Reinstall Point of Sale

Using practice mode
Set up practice mode
Enter and exit practice mode
Getting started

To install Point of Sale
• See *Getting Started* located in the Point of Sale CD folder.

To set up your hardware
• See *Getting Started* located in the Point of Sale CD folder.

To begin the store setup process using the Activation Wizard
• See *Getting Started* located in the Point of Sale CD folder.

To start Point of Sale and logon
1. On the Start menu, point to (All) Programs, point to Microsoft Dynamics - Point of Sale, and then click Point of Sale.
2. In the Logon dialog box, type your employee ID and password.

**Things to know**

Why do I need to use passwords?
Passwords provide the first line of defense against unauthorized access to your store information. For this reason, Microsoft recommends the use of *strong passwords*. Strong passwords contain a mix of uppercase letters, lowercase letters, numbers, and special characters. The complexity of a strong password makes it considerably harder for hackers to "crack," even with the powerful automated password-cracking software that is available today.

Requiring strong passwords in your store is key to protecting your store information, assets, and inventory. You can do this in Control Panel by using Administrative Tools to modify your Local Security Settings.

For more information...
Click Help in the Logon dialog box.
Creating and changing a password or ID

Things to know

You can change an employee’s password in two places:

- From the Employee window in Manager View
- From the Logon dialog box

Passwords can be up to 9 digits long. You cannot log on to Point of Sale with a blank password even though you may be able to create one with your security settings.

The passwords entered for new employees need to comply with the Windows security setting and password policy that is in place for your store. For example, some organizations require strong passwords or passwords of a certain minimum length. Some set limits on length. Others set limits on the number of times a password can be used or changed in a given timeframe.

The employee ID can only be changed in the Employee window. The changes will take effect when the computer is restarted.

To change an employee’s password when logging on

1. Exit and then restart Point of Sale.
2. In the Logon dialog box, click Change Password.
3. In the Employee ID box, enter the Employee ID.
4. In the Old password box, type the employee’s existing password.
5. In the New password and Confirm password boxes, type the new password for the employee, and then click OK.

To change an employee’s password from the Employee window

1. On the People menu, click Employees.

Or use the Employee Center

In the Views area, click Employees.
2. Double-click the employee whose password you want to change.

3. In the **Employee** window, click **Password**, type the new password in both the **New password** and **Confirm password** boxes in the **Employee Password** dialog box, and then click **OK**.

4. Click **Save and Close**.

---

**Keep it secure!**

A strong password:

- Is at least four characters long.
- Does not contain the person's name, company name, employee ID, or any other easily obtainable personal information.
- Does not contain a complete dictionary word.
- Is significantly different from previous passwords. Incremental passwords (Password1, Password2, Password3 ...) are not strong.
- Contains characters from each of these four groups: upper case, lower case, numerals, and symbols.

---

**Use all of the following to create a strong password:**

<table>
<thead>
<tr>
<th>Character Group</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Uppercase letters</strong></td>
<td>A B C D E</td>
</tr>
<tr>
<td><strong>Lowercase letters</strong></td>
<td>a b c d e</td>
</tr>
<tr>
<td><strong>Numerals</strong></td>
<td>0 1 2 3 4</td>
</tr>
<tr>
<td><strong>Symbols</strong></td>
<td>` ~ ! @ # $ % ^ &amp; * ( ) _ + - = { } [ ] \ &quot; ; ' &lt; &gt; ? , . /</td>
</tr>
</tbody>
</table>

What is an example of a strong password?

*Pa$sw0rD* is a strong password, even with its similarity to the very weak *Password*, because of its mix of uppercase and lowercase letters and the way the dictionary word is "disguised" using symbols and numerals.

**For more information...**

Click **Help** in the Change Password or Employee Password dialog boxes.
To change an employee’s ID

1. On the People menu, click Employees.

   ![People menu with Employees selected]

2. Double-click the employee whose ID you want to change.

3. In the Employee ID box, enter the new ID.

   ![Employee ID input field]

4. Click Save and Close.

   ![Save and Close button]

---

**Why am I locked out when I try to log on after several failed attempts?**

The passwords in Point of Sale must comply with the current Windows security settings on your computer or network. If an account lockout policy is in place, you will not be able to log on after a certain number of failed attempts. Contact your network administrator to have your user account unlocked.

---

**Are there requirements for Employee IDs?**

Employee IDs are often numeric, but you can use letters in your Employee IDs. The following IDs are reserved for system purposes and cannot be used:

- AdvancedManager
- Cashier
- Cashier0
- Cashier1
- Cashier2
- Cashier3
- Cashier4
- Owner

---

**Important**

If you change the employee ID, you must also change the password.
Accessing and Exiting Point of Sale views

Things to know

When you start Point of Sale, it opens in POS View. People assigned to the Owner or Manager security roles can switch to Manager View by clicking the Manager View tab.

When I click the Manager View tab, nothing happens. Am I doing something wrong?
You probably don’t have the role assignment that allows you to access Manager View. Only those assigned to the Owner or Manager security roles can use Manager View.

To switch to Manager View from POS View

- Press **Tools**, and then press **Manager View**.

  F7, then 8

  -or-

  In the tray, select the **Manager View** tab.

To switch to POS View from Manager View

- On the **View** menu, click **Point of Sale View**.

  -or-

  In the tray, click the **POS View** tab.

To exit Point of Sale from Manager View

- On the **File** menu, click **Exit**.
Can my cashiers exit Point of Sale?
Cashiers do not use Manager View, so they cannot exit from it. Although the cashiers use POS View, their permissions do not allow them to exit from Point of Sale.
The data in the Manager View window is automatically refreshed whenever you change views or update a record. However, because cashiers can ring up sales while you are performing administrative tasks on another computer, you might want to refresh manually from time to time. For example, you might want to see the latest sales data in your capsule reports.

How do I log on using a touch-screen device?
If you are logging on using a touch-screen, press the touch-screen keyboard button to display the touch-screen keyboard.

To exit Point of Sale from POS View
1. If you need to switch to an employee who has the right to exit Point of Sale, press Tasks, and then press Switch User and then enter the employee’s employee ID and password.

F6, then 7

2. After you have switched users, press Tasks, and then press Exit.

F6, then 8

To refresh the Manager View window
• On the View menu, click Refresh.

To log off or switch users
• Press Tasks, and then press Switch User.

F6, then 7
-or-

In the tray, press the Switch User button .
Point of Sale displays the Logon dialog box, ready for you or another user to log on.

Tip
You can also use the Switch User command to lock the register.
Setting up your store

The Store Setup Wizard makes getting up and running with Point of Sale easy. In the wizard, you can enter enough information to get started processing transactions right away. Then, as time allows, you can enter more detailed store information until Point of Sale becomes an integral part of your store’s daily operations.

If you follow the store setup checklist, it can make the store-setup process faster and easier because the information that you will need to complete later steps will already be in place.

To start the Store Setup Wizard

- On the **Settings** menu, point to **Store Settings**, and then click **Store Setup Wizard**.

To set up your store using a checklist

- See *Getting Started* for a checklist to help set up your store.

To enter basic store information

1. On the **Settings** menu, point to **Store Settings**, and then click **Store Information**.
2. Enter your store’s address, phone numbers, and other information.
3. To use File Center to select or change your store logo, double-click the logo.

For more information...

Click Help in any of the Store Setup Wizard pages or ? in the Store Information dialog box.
Uninstalling Point of Sale

To uninstall Point of Sale *without* removing the store database

1. Back up your store database, and then copy the backup (.bck) file to a location other than your hard drive.
2. Exit Point of Sale, including all Help windows.
3. On the Start menu, click Control Panel.
4. Open Add or Remove Programs.
5. Click Microsoft Dynamics - Point of Sale, and then click Remove.
6. Follow the instructions on your screen.

Keep it secure

It is essential to back up your database. You will be prompted to do so when you exit Point of Sale from Manager View. When you are going to uninstall Point of Sale, save your existing backup file to a location that is not on your local hard drive.

Things to know

Won’t I lose my store database if I uninstall Point of Sale?

When you uninstall Point of Sale, your store database is not removed. This means that you can safely uninstall and reinstall Point of Sale for troubleshooting purposes without harming or changing your store information. If you want to completely uninstall Point of Sale, you must perform some additional steps.

Is there any way to repair damaged files instead of uninstalling?

Possibly, before uninstalling, try using the Installation Wizard to repair your program files. Open Control Panel, double-click Add or Remove Programs, click Microsoft Dynamics - Point of Sale, and then click Change. In the wizard, select Repair.
Can I remove the Point of Sale database?
Although it is not what you would normally want to do, you can remove the database along with the Point of Sale program. Follow the procedure on the right to do so.

What is the default location of the Point of Sale database and log files?
The default folder is c:\Program Files\Microsoft Dynamics - Point of Sale. If you specified a different location during installation of Point of Sale, the path to this folder will vary.

How can I view the License Agreement?
In Manager View Help, click About Point of Sale, and then click the License Agreement link at the bottom of the dialog box.

To completely uninstall Point of Sale including the database

1. Back up your store database, and then copy the backup (.bck) file to a location other than your hard drive.
2. Exit Point of Sale, including all Help windows.
3. On the Start menu, click Control Panel.
4. Open Add or Remove Programs.
5. Click Microsoft Dynamics - Point of Sale, click Remove, and then follow the instructions on the screen.
6. If it is present, click Microsoft Office Accounting 2007 Redistributable Package, and then click Remove.
7. If it is present, click Microsoft Office Small Business Connectivity Components, and then click Remove.
8. Click Microsoft Visual Studio 2005 Tools for Applications Runtime, and then click Remove.
9. Click Microsoft SQL Server 2005, and then click Remove.
SQL Server displays the Microsoft SQL Server Uninstall Wizard.
10. Select the Remove SQL Server 2005 instance components check box.
11 Select **MSPOSINSTANCE: Database Engine**, and then click **Next**.

![Caution]

Do not remove other instances of Microsoft SQL Server.

12 Click **Finish**.

13 In Windows Explorer, delete this folder:

```
c:\Program Files\Microsoft Dynamics - Point of Sale
```

![Warning]

Deleting the Microsoft Dynamics – Point of Sale folder might send your customized report, receipt format, import settings, and other files to the Recycle Bin.

---

**To reinstall Point of Sale**

- Place the Point of Sale CD in your CD drive, click **Install Point of Sale**, and then follow the instructions in the Installation Wizard.

---

**How can I view system information?**

In Manager View Help, click About Point of Sale, and then click System Info.

**Why can’t I find my Microsoft Dynamics - Point of Sale folder that you say is located in the Program Files folder?**

Unless you placed it elsewhere, Program Files is the default location of the Point of Sale database and log files. If you specified a different location during installation of Microsoft Dynamics - Point of Sale, the path to this folder will be where you designated it during installation.
Using practice mode

To set up practice mode

1. On the Tools menu, click Practice Mode Setup.
2. Select the data that you want to use while you practice.
   - Store database - Some of your own store information will be copied into the practice mode database. No changes will be made to your actual store database. This option is especially useful for training new employees.
   - Sample database - The practice database will use information from the sample database that you specify.
   - Blank database - The practice database will be an empty store database where you can enter data from scratch.
3. Click OK.
   It may take several minutes for the practice database to be created.

Things to know

In practice mode, you can enter data and process transactions without modifying your actual store information or corrupting your store’s records and reports. It is a way to become familiar with the features and functionality of Point of Sale and can be used as a tool for training new employees.

When you set up practice mode, Point of Sale creates a special database for your practice information. This database, named MSPOSPractice, is separate from your regular store database. There is a noticeable difference in screens to ensure that you will always know that you are in practice mode.

Before you can switch to practice mode, you will need to set up the practice mode database.

For more information...
Click Help in the Practice Mode Setup dialog box.
When I am done practicing, how do I return to normal operations?
When you are done practicing, you can return to normal operations by clicking the Practice Mode command again and then restarting Point of Sale on your main computer and all registers.

How will I know what mode I am operating in?
Prominent screen changes in both Manager View and POS View ensure that you will always know when Point of Sale is operating in practice mode. If you switch to practice mode while in Manager View, POS View will also open in practice mode on all registers. Alternatively, you can switch to practice mode from POS View by pressing F7 (Tools), and then pressing 6 (Enter Practice Mode).

Can I put my actual store information into practice mode even though it is a practice database?
Yes, you can.

To enter and exit practice mode

1. Set up the practice mode database as described on the previous page.

2. On the Tools menu, click Practice Mode. Point of Sale will automatically close. Open the program again to use it in practice mode.
Using Manager View

In this chapter

Using the Manager View
Using the navigation pane
Using Manager View toolbars
  Use the main toolbar
  Use the Edit Item toolbar
  Use the Report toolbar
Using the Manager View task centers
Looking for a central location to view all of your store information? Manager View offers several ways to access the info you use most often. Check it out here:

1. **Using Manager View**
2. **My Store**
3. **Items**
4. **Description**
5. **Extended Description**
6. **More Options**

The numbers correspond to descriptions on the following pages.
1 – Menus and toolbar
The menus provide access to all of your store information and to tools and wizards that help you manage that information and run your store. The toolbar is most useful when there is a list of information in the content pane. With one click, you can create and delete records in the current list or gain access to other useful functions.

2 – The tray
The tray contains tabs that you can click to switch between Manager View and POS View. The tray also contains buttons for starting Help and closing Point of Sale. Other functions can only be selected from POS View.

3 – The navigation pane
The tree in the navigation pane provides an overview of your store information, in a familiar and easy-to-use folder arrangement. You can use the large buttons at the bottom of the pane to view your most used information with a click of the mouse.

Things to know
What are the disabled (gray) buttons in the tray used for?
The disabled (gray) buttons in the tray are only available in POS View. There, you can use these buttons to switch users and turn the function bar and touch-screen keyboard on and off.

What does the “+ Add a new item” at the top of each list do?
The “+ Add a new...” is a quick way to create a new record. When you click it, Point of Sale displays a new record for that list.

In the list view, can I sort the lists differently?
To sort the list into a different order, click the header of the column that you want to sort by. For example, to sort customers by their last names, click the Last Name column header. Clicking the header again will reverse the sort and put the Z’s first and the A’s last.
4 – The content pane

In the content pane, you can view task centers or lists of the various kinds of information in your store database, or you can use the My Store capsule reports to get an overview of the activity in your store. To view a task center, click the folder or navigation button for the task center you want to work with. To open a list view, click the task center button, menu command, or subfolder for the type of list that you want to display. To open the My Store view (not shown in the example), click the My Store button in the navigation pane.

5 – The preview pane

When a list appears in the content pane, you can preview a record by selecting it in the list. The preview pane shows general information about the selected record.

6 – The status bar

The status bar shows who is currently logged into Point of Sale, information about the current list in the content pane, and the current date and time.

Why don’t I see the preview pane or navigation pane?

If the preview pane or navigation pane is not showing, click Preview Pane or Navigation Pane on the View menu.

How do I get a record to display in the preview pane?

Click a record once to preview it; double-click it to open it.
Using the navigation pane

The navigation pane appears on the left side of the Manager View screen. It is designed to give you quick, easy access to the most frequently used information and tasks in your store.

The navigation pane contains a folder tree that represents most of the information and settings for your store. You can expand and collapse folders by clicking the plus (+) and minus (-) signs next to the folders and subfolders.

Clicking a top-level folder displays a task center in the right side of the screen. Task centers provide quick access to lists, options, and tasks related to the information in the folder.

For example, if you click the Employees folder, you will see the Employee Center, with buttons that display the list of employees, the Role Settings dialog box, and the list of time clock entries.

Click one of the large buttons at the bottom of the navigation pane to display that task center.
Using Manager View toolbars

Several of the windows in Manager View have toolbars. The most frequently used toolbars are described in this topic. Depending on what task you are performing, the toolbars on your screen might vary slightly from those shown here.

Using the Main toolbar

The numbers above correspond with the descriptions below.

1. **New** - Creates a new record in the current list. For example, if you are viewing the list of customers, clicking New will create a new customer record. Clicking the arrow next to the button opens a menu of record types that you can create, so you don’t have to change to another list to create a different kind of record.

2. **Duplicate** - Makes a copy of the selected record in the current list. Make use of information you have already entered in one record to quickly and easily create another record with similar properties.

3. **Cut** - Cuts selected text to the Windows Clipboard. You can then paste the text in another window or program.

4. **Copy** - Copies the text of the selected line in the list. For example, if you have an item selected in the Items list, the basic information about that item that appears in the list entry will be copied to the Windows Clipboard. You can then paste the text in another window or program.

5. **Paste** - Inserts copied or cut text at the cursor. This button will only be available if the cursor is in a location that will accept text.

6. **Refresh** - Refreshes the screen’s contents to show up-to-the-minute information.

7. **Delete** - Deletes the selected record.

8. **Find** - Opens the Find dialog box, where you can search for items, customers, suppliers, or transactions.

9. **Help** - Opens Manager View Help.
Using the Edit Item toolbar

1 **Save and Close** - Saves the current item and closes the item window.

2 **Save and New** - Saves the current item and opens a new, blank item window.

3 **Cut** - When text is selected, extracts the selected text to the Windows Clipboard. You can then use the Paste button or command in another window or application to insert the cut text.

4 **Copy** - Cuts selected text to the Windows Clipboard. You can then paste the text in another window or program.

5 **Paste** - Inserts copied or cut text at the cursor. This button will only be available if the cursor is in a location that will accept text.

6 **Print Labels** - Opens the Print Labels window, pre-filled with the information for the selected item.

7 **View Item Movement Report** - Generates the Item Movement report for the selected item.

8 **Help** - Opens the Help topic for the current tab of the Item window.

---

How can I remove some of the screen elements from view?
You can “hide” the navigation pane, toolbar, preview pane, and status bar. On the View menu, click the names of the ones you want to hide.

How can I view the screen elements that are hidden?
You can show them the same way that you hid them. On the View menu click the names of the ones that you want to show.
Using the Report toolbar

1. **Save Settings** - Saves any changes made to the report columns, sorting, grouping, filter, and so on.
2. **Save Settings as Custom Report** - Opens a dialog box where you can specify a name for the report and set it up as one of your custom reports.
3. **Print Preview** - Opens the Print Preview window.
4. **Print** - Sends the report to the printer.
5. **Export** - Exports the report to Microsoft Office Excel (if installed), or opens a menu of export options.
7. **Show/Hide Header** - Turns the report title and date information on or off.
8. **Choose Columns** - Opens a dialog box where you can select the columns that you want to appear in your report.
9. **Group by Columns** - Groups report information by columns so that you can see summary, average, or totals information for the groups. Clicking the button repeatedly further groups your information.
10. **Expand All** - Expands all groups.
11. **Collapse All** - Collapses all groups.
12. **Collapse Grouped Rows** - Collapses the smallest groups.
13. **Copy as Table** - Copies the report data to the Windows Clipboard as delimited text so that it can be pasted into another program.
Using the Manager View task centers

When you click a top-level folder or a button in the navigation pane, a task center displays in the content pane (the right portion of the Manager View window). Task centers provide quick access to lists, options, and tasks related to a specific type of information.

There are seven main task centers in Point of Sale. Each task center displays shortcuts to many menu commands, providing quick access to lists, options, and specific tasks.

The centers with their icons are as follows:

- Customer Center
- Employee Center
- Inventory Center
- Settings Center
- Store Settings Center
- Register Settings Center
- Transactions Center

The following pages introduce you to the various task centers and what can be done in each of them.

Things to know

Do I need to go to the Settings Center first if I want to go to the Store Settings Center or the Register Settings Center?

No, you can go directly to the Store Settings Center or the Register Settings Center by using the tree in the navigation pane.

In the list view, can I sort the lists into a differently?

To sort the list differently, click the column heading of the column that you want to sort by. For example, to sort customers by their last names, click the Last Name column heading. Clicking the heading again will reverse the sort order.
Customer Center
Views
• Display a list of customers, work with existing customer records
• Set customer options
• Print customer mailing labels
Tasks
• Create a new customer record
• View the Customer List Report
• View the Top Performers by Customer Report

Employee Center
Views
• Display a list of employees, work with existing employee records
• Display time clock entries
• Set employee role options
Tasks
• Create a new employee record
• Create a new time clock entry
• View the Top Performers by Employee Report
• View the Cashier Log Report
Inventory Center
Views
• Set tax authority options
• Set sales tax options
• Create and work with categories
• Work with existing departments
• Create and work with items
• Create and work with suppliers
• Create and work with purchase orders
• Create and work with item receipts
• Print item labels
• Set item discount options
• Create and work with inventory transfers
• Work with physical inventories
Tasks
• Create a new item
• Create a new department
• Create a new sales tax
• Create a new supplier
• Create a purchase order with a wizard
• View the Item Movement Report

Settings Center
Views
• Work with existing tax authority options
• Work with existing sales tax options
• Work with existing payment methods
• Configure accounting
• Set store options
• Set role options
• Work with existing registers
• Work with existing line display messages
• Work with existing task pads
• Set receipt formats
Tasks
• Create a new register
• Create a new sales tax
• Create a new task pad
• Create a new payment method
• View the Detailed Sales Report
• View the Register Analysis Report
Register Settings Center
Views
- Work with registers
- Work with line display messages
- Work with existing task pads
- Set receipt formats

Tasks
- Create a new register
- Create a new line display message
- Create a new task pad
- Create a new receipt format
- View the Register Analysis Report
- View the Batch List Report

Store Settings Center
Views
- Work with existing tax authorities
- Work with existing sales tax options
- Work with existing payment methods
- Configure accounting
- Set role options
- Set store options

Tasks
- Create a tax authority
- Create a new sales tax
- Create a new payment method
- Use the Store Setup Wizard
Transactions Center
Views
- Set payment processing options
- Work with Journaled Receipts
- Work with batches

Tasks
- View the Detailed Sales Report
- View the Payment Method Summary Report
- View the Batch Log Report
In this chapter

Providing accessibility

Using keyboard access keys and shortcut keys
- View available access keys in a window or dialog box
- Use an access key in a window or dialog box
- View the available shortcut keys for windows commands

Customizing screen elements
- Hide or show the navigation pane
- Hide or show the preview pane
- Hide or show the toolbar
- Hide or show the status bar
- Change the size of the toolbar icons
In this chapter, continued

Customizing columns and panes
  Arrange the columns of a list in the content pane
  Change the sort order of a list in the content pane
  Change the layout of the capsule report in the content pane
  Size a column in the content pane
  Size a pane
  Size the preview pane
  Show or hide panes
Providing accessibility

Microsoft is committed to making its products and services easier for everyone to use. Both Microsoft Windows and Point of Sale offer features that can help users who have disabilities.

**Important**
If you use assistive technology, be sure to contact your assistive technology vendor before you upgrade your software or hardware to check for possible compatibility issues.

The Windows operating system has many built-in accessibility features that are useful for individuals who have difficulty typing or using a mouse, are blind or have low vision, or who are deaf or hard-of-hearing. The features are installed during Windows installation. For more information about these features, see Help in Windows and visit the Microsoft Accessibility Web site at [www.microsoft.com/enable](http://www.microsoft.com/enable).

**Note**
The information in this topic may apply only to users who license Microsoft products in the United States. If you obtained this product outside of the United States, you can use the subsidiary information card that came with your software package or visit the Microsoft Accessibility Web site.

---

**Things to know**

*Are there more accessible formats available for use by my employees who might need them?*
Yes, you can view an index of accessible product documentation at the Microsoft Accessibility Web site at [www.microsoft.com/enable](http://www.microsoft.com/enable).

*Are there tutorials available that would be helpful in addressing accessibility issues?*
Microsoft offers a series of step-by-step tutorials that provide detailed procedures for adjusting the accessibility options and settings on your computer. This information is presented in a side-by-side format so that you can learn how to use the mouse, the keyboard, or a combination of both. You’ll find these tutorials on your Point of Sale CD.
How do those with hearing impairments use your customer service?

The following is available through a text telephone (TTY/TDD) service:

- For customer service, contact Microsoft Sales Information Center at (800) 892-5234 between 6:30 AM and 5:30 PM Pacific Time, Monday through Friday, excluding holidays.

- For technical assistance in the United States, contact Microsoft Product Support Services at (800) 892-5234 between 6:00 AM and 6:00 PM Pacific Time, Monday through Friday, excluding holidays. In Canada, dial (905) 568-9641 between 8:00 AM and 8:00 PM Eastern Time, Monday through Friday, excluding holidays.

To make POS View more accessible for a specific employee

1. On the People menu, click Employees.

   Or use the Employees Center
   In the Views area, click Employees.

2. Double-click the employee.

3. Under Accessibility:
   - Select the font and button size, Normal or Large, that will best meet this employee’s needs.
   - Select the task pane alignment, Left or Right, that will best meet this employee’s needs.

Important:
You or the employee can further modify the POS View screen. For more information, press F1 (Help) from POS View.
Using keyboard access keys and shortcut keys

**Things to know**

Every window and dialog box in Manager View has access keys. Access keys enable you to change settings and activate buttons in a dialog box without using a mouse. Additionally, windows that have menus offer a selection of shortcut keys. These key combinations give you quick access to some commonly used functions.

**To view the available access keys in a window or dialog box**

- Press ALT.

**To use an access key in a window or dialog box**

- Press ALT plus the underlined access key shown on the menu, command, box, or button that you want to use.

**Note**

The access key for OK is always ENTER, and the access key for Cancel is always ESC. It is not necessary to press ALT before pressing these keys.

**To view the available shortcut keys for menu commands**

1. Press ALT to see the menu access keys.
2. Press ALT plus the access key for the menu that you want to view.

**Note**

Any available shortcut key for the commands on that menu will be listed next to its menu command. For example, the shortcut key for Copy is always CTRL+C.
Customizing screen elements

You can hide and show the panes and toolbars in Point of Sale to suit your needs. The size of the toolbar icons can also be changed.

To show or hide the navigation pane
- On the View menu, click Navigation Pane.

To show or hide the preview pane
- On the View menu, click Preview Pane.

To show or hide the toolbar
- On the View menu, click Toolbar.

To show or hide the status bar
- On the View menu, click Status Bar.

To change the size of the toolbar icons
- On the View menu, click Large Toolbar Icons.

Things to know

Where can I find information about setting up and displaying a custom layout for the capsule reports in My Store window?
You can find information about selecting a custom layout for the capsule reports in Chapter 28, “Working with Capsule Reports.”

Where can I find information about customizing the register function keys in POS View?
You can find information about customizing the register in Chapter 8, “Managing Register and Peripheral Settings.”

Can I change the order of the payment methods for a register in POS View?
Yes, Chapter 8, “Managing Register and Peripheral Settings,” describes customizing the display order of payment methods.
Customizing Manager View and POS View

**Customizing columns and panes**

**To arrange the columns of a list in the content pane**
- Click the column heading that you want to move and drag it to its new location.

**To change the sort order of a list in the content pane**
- On the **View** menu, point to **Arrange By**, and then click the content-pane column heading that you want to sort by.

**Tip:**
You can also click the column heading (such as Last Name or Item Number) to change the sort order.

**To change the layout of the capsule reports in My Store**
- On the **View** menu, point to **Content Pane**, and then click the layout that you want to use.

**To size a column in the content pane**
1. Move your mouse over the right edge of a column heading until the pointer changes to ✈️.
2. Click and drag the edge of the column to the desired width.

**Things to know**

**Where can I find information about customizing task pads for POS View?**
In Chapter 11, “Working with Task Pads,” you can find information about customizing task pads for POS View.

**Can I also set up custom receipt formats?**
Yes, more information on customizing your receipt formats is available in Chapter 9, “Working with Receipt Formats.”
Can I use sounds to make the registers easier for my cashiers to use along with the screen changes?
Yes, you can choose to play unique sounds when an item is added to an order, when a transaction is completed, when a scanned item was not found in the system, when there is a character mismatch in the search box, and when a matching item is found. See Chapter 8, “Managing Registers and Peripheral settings” for instructions on how to add sounds to a register.

What other ways can I customize operations for my cashiers?
Providing task pads that are customized for your employees and your store will make their jobs faster and easier. See Chapter 11, “Working with Task Pads” for details.

To size a pane
1. Move your mouse over the pane divider until the pointer changes to ✤.
2. Click and drag the edge of the pane to the desired width.

To size the preview pane
1. Move the mouse over the line between the content pane and the preview pane until the cursor changes to ✤.
2. Click and drag the edge of preview pane to the desired height.

To show or hide the panes
- On the View menu, click Navigation Pane.
- or-
- On the View menu, click Preview Pane.
Managing Taxes

In this chapter

Creating a tax authority
  Create a tax authority
  Duplicate a tax authority
Selecting or changing a tax authority

Working with existing taxes and tax authorities
  Modify an existing tax authority
  Delete a tax authority

Creating a sales tax
  Create a sales tax
  Duplicate a sales tax

Working with existing sales taxes
  Modify an existing sales tax
  Delete a sales tax
  Set the default sales tax for an item
  Set the sales tax for an item

Marking a customer as tax exempt

Printing itemized sales taxes
Creating a tax authority

To create a tax authority

1. On the Settings menu, point to Store Settings, and then click Tax Authorities.

2. On the toolbar, click New.

   Or use the Store Settings Center
   In the Tasks area, click New Tax Authority.

3. Enter a code and description for the tax authority.

4. In the Tax rate box, enter the percentage that represents the tax rate.

5. In the Fixed amount box, enter any additional, per-transaction fee that should be assessed.

6. Under Tax limits, specify where the tax is limited to a certain price range.

7. Fill in the details of how this tax is calculated using the following table as a guide.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum taxable amount</td>
<td>Enter a value in this box when the tax only takes effect once a certain dollar amount is reached. For example, if a state taxes only items that are priced at $175 or more, enter $175.00.</td>
</tr>
</tbody>
</table>

Things to know

Tax authorities are the governmental bodies that assess taxes in your area. For example, if your revenues are taxed by the city, the county, and the state or province where your store is located, then you would create three tax authorities, one for each taxing body.

Where do I change the sales tax rate?

You must make those changes in the tax authority that assesses the tax. See “Working with existing tax authorities.”

For more information...

Click Help in the Tax Authority window.
Are there any parameters for the Code box or Description box on the Tax Authority window?

The code should be a unique identifier or abbreviation, such as "M" for municipal or "ST" for state. Both the code and the description can be up to 128 characters.

**One of my tax authorities doesn’t tax food except for items that cost more than $20. each. How do I indicate that in my settings?**

In your settings, select the box that indicates that the tax should only be applied to amounts over the minimum of $20.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum taxable amount</td>
<td>Enter a value in this box if the tax should only be applied to that portion of each price. For example, if a city taxes the first $100 of a price, but doesn't tax amounts above that, enter $100.00 in this box.</td>
</tr>
<tr>
<td>Only apply tax to amount over minimum</td>
<td>Select this check box when the tax should be applied to amounts over the minimum amount. In that case, the amount under the minimum will not be taxed.</td>
</tr>
<tr>
<td>Include previous sales taxes in tax calculation</td>
<td>Select this check box if you collect tax for more than one tax authority and the other tax amounts are taxed by this tax authority.</td>
</tr>
<tr>
<td>Use partial dollar method in tax calculation</td>
<td>Select this check box if the partial dollar table should be used to calculate the tax on amounts under one dollar.</td>
</tr>
<tr>
<td>Partial dollar table</td>
<td>Enter the bracket values and the amount of tax that should be charged for each range of values.</td>
</tr>
</tbody>
</table>
I collect taxes for more than one tax authority. One of the authorities collects tax on the other authorities. How do I indicate that?

Select the “Include previous sales takes in tax calculation” check box in the Tax Authority window. In the Sales Tax window, place the name of the authority that collects taxes on other authorities after the others listed.

On the Partial dollar table, where do I obtain the amounts to enter?

The brackets and tax amounts in your partial dollar table should be those specified by the government agency that requires collection of the tax, if any. The Upper Bracket in the Partial dollar table is the last value that is taxed.

To save this tax authority and begin entering information for another, click **Save and New**, or if this is the only tax authority that you want to create, click **Save and Close**.
As with other record types in Point of Sale, you can quickly create a new sales tax authority by duplicating an existing one. This can be especially helpful if you want two tax authorities with similar, complex settings.

**What are some examples of tax authorities?**

You might have one tax authority for the taxes assessed by the city where your store is located and another for the taxes assessed by the state or province. Depending on the items you carry, you could have other, such as those based on food or non-food items.

**To duplicate a tax authority**

1. On the **Settings** menu, point to **Store Settings**, and then click **Tax Authorities**.

   ![Or use the Store Settings Center](image)

   In the **Views** area, click **Tax Authority**.

2. Select the sales tax or tax authority that you want to duplicate.

3. On the toolbar, click **Duplicate**.

4. Enter a new code and description, and make any other changes that are appropriate.

5. To save this tax authority and begin entering information for another, click **Save and New**, or if this is the only tax authority that you want to create, click **Save and Close**.

   **For more information...**

   Click Help in the Tax Authority window.
Working with existing tax authorities

To modify an existing tax authority

1. On the Settings menu, point to Store Settings, and then click Tax Authorities.

   Or use the Settings Center
   In the Views area, click Tax Authorities.

2. Double-click the tax authority that you want to modify.
3. Make changes as needed.
4. Click Save and Close.

To delete a tax authority

1. On the Settings menu, point to Store Settings, and then click Tax Authorities.

   Or use the Settings Center
   In the Views area, click Tax Authorities.

2. Select the tax authority that you want to delete.
3. On the toolbar, click Delete.
Creating a sales tax

To create a sales tax

1. On the Settings menu, point to Store Settings, and then click Sales Taxes.

2. On the toolbar, click New.

   Or use the Store Settings Center
   In the Tasks area, click New Sales Tax.

3. Enter a unique code and description for the sales tax.

4. If applicable, select the Compute this sales tax based on profit (price minus cost) instead of price check box.

   Important
   Select this option only if this sales tax is a profit-based tax. If this sales tax is a price-based tax, selecting this option will cause significant discrepancies in your store’s tax records.

5. Under Included tax authorities, in the Tax Authority column, select the tax authorities that are included in this sales tax. Be sure to list the tax authorities in the order in which their taxes should be applied.

6. For each tax authority, select the Receipt check box if you want that tax amount to be listed individually on receipts. These individual listings will be in addition to the total tax listing.

Things to know

Once tax authorities are in place, you can create the sales taxes that incorporate these tax authorities. You will want one sales tax for every combination of tax authority taxes that must be assessed.

For example, food items might incur a different combination of taxes than non-food items. In that case, you might have a Food sales tax (containing the tax authorities that assess taxes on food items) and a Non-food sales tax (containing the tax authorities that assess taxes on non-food items).

For more information...

Click Help in the Sales Tax window.
Where do I indicate that a customer is tax exempt?
You must do that in the Customer Center because it applies to individual customers. See instructions in “Marking a customer as tax exempt” later in this chapter.

7 To save this sales tax and begin entering information for another, click Save and New, or if this is the only sales tax that you want to create, click Save and Close.

To duplicate a sales tax
1 On the Settings menu, point to Store Settings, and then click Sales Taxes.

2 Select the sales tax or tax authority that you want to duplicate.

3 On the toolbar, click Duplicate.

4 Enter a new code and description, and make any other changes that are appropriate before saving.

For more information...
Click Help in the Sales Tax window.
Working with existing sales taxes

To modify an existing sales tax

1. On the Settings menu, point to Store Settings, and then click Sales Taxes.

   Or use the Settings Center
   In the Views area, click Sales Taxes.

2. Double-click the sales tax that you want to modify.

3. In the table of included tax authorities, take one or more of these actions:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a tax authority to the tax</td>
<td>Click in an empty row in the Tax Authority column, click 📑, and</td>
</tr>
<tr>
<td></td>
<td>then select the appropriate tax authority from the list.</td>
</tr>
<tr>
<td>Change the order of the existing tax authorities</td>
<td>Click in the Tax Authority column and select the tax authorities in their proper order.</td>
</tr>
<tr>
<td>Remove a tax authority</td>
<td>Click in the Tax Authority column for the tax authority that you want to remove, and then select (none).</td>
</tr>
<tr>
<td>Choose to print the tax amount for this tax authority on receipts</td>
<td>Select the check box in the Receipt column.</td>
</tr>
</tbody>
</table>

Things to know

How could I handle a tax situation in which the county levies taxes on all items, but my state levies taxes on revenue from all items except for food?

You could create one sales tax that incorporates both the state and county tax authorities with a second sales tax that only incorporates the county tax authority. You could then assign the first sales tax (state and county) to all non-food items in your store, and the second sales tax (county only) to all food items that are not taxed by the state. When an item is added to a transaction at the register, the appropriate taxes would be applied.
You can choose which of your sales taxes will automatically be assigned to any new items that you create. When the majority of your items are taxed at the same rate, this setting will save you a step. You can, of course, change the sales tax that is assigned to any item. You can even use the Inventory Wizard to change the sales tax that is assigned to a group of items.

**When should I select the default sales tax for new items?**
You must create your sales taxes before you can choose your default sales tax.

---

4. **Click Save and Close.**

### To delete a sales tax

1. On the **Settings** menu, point to **Store Settings**, and then click **Sales Taxes**.

   ![Sales Tax dialog box](image)

   **Or use the Settings Center**
   In the **Views** area, click **Sales Taxes**.

2. Select the sales tax that you want to delete.

3. On the toolbar, click **Delete**.

**Caution**
Deleting a sales tax will alter the chart of accounts that makes it possible for Point of Sale to integrate with accounting software. Consult with your accountant about this change.
It is confusing to me about sales taxes having several tax authorities, each with their own tax rates. Could you give me an example that illustrates what happens?

Sales taxes can contain a number of tax authorities, each with their own tax rates. At the time of sale, the tax amount for each tax authority is calculated separately, rounded to two decimal places for proper accounting, and then added to the other tax amounts. The example in the following table illustrates this calculation.

<table>
<thead>
<tr>
<th>Item</th>
<th>Price</th>
<th>Special State (10%)</th>
<th>State Tax (5%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Food</td>
<td>$1.25</td>
<td>N/A</td>
<td>$0.0625</td>
</tr>
<tr>
<td>Beer</td>
<td>$3.10</td>
<td>$0.31</td>
<td>$0.1550</td>
</tr>
<tr>
<td>Non-food</td>
<td>2.00</td>
<td>N/A</td>
<td>$0.10</td>
</tr>
<tr>
<td><strong>Tax subtotal</strong></td>
<td>$0.310</td>
<td></td>
<td><strong>$0.3175</strong></td>
</tr>
<tr>
<td><strong>Rounded tax</strong></td>
<td>$0.31</td>
<td></td>
<td><strong>$0.32</strong></td>
</tr>
<tr>
<td><strong>Total tax</strong></td>
<td></td>
<td></td>
<td><strong>$0.63</strong></td>
</tr>
</tbody>
</table>

To set the default sales tax for new items

1. On the Settings menu, point to Store Settings, and then click Options.

   ![Or use the Store Settings Center]
   In the Views area, click Store Options.

2. Click the Sales Tax tab.

3. In the Default sales tax box, select the sales tax that will apply to most of your items.

4. To save your changes, click OK.

To set the sales tax for an item

1. On the Inventory menu, click Items.

   ![Or use the Inventory Center]
   In the Views area, click Items.

2. Double-click the item that you want to set the sales tax for.

3. In the Sales tax box, select the appropriate sales tax.

4. Click Save and Close.
Marking a customer as tax exempt _____________

Things to know

Why are some customers tax exempt?
Most customers won’t be tax exempt. However, depending on the laws in your state, some may be. For example, contractors who resell products to the person they are doing work for do not pay sales tax. Otherwise, the product would be taxed twice.

To mark a customer as tax exempt

1. On the People menu, click Customers.

Or use the Customer Center
In the Views area, click Customers.

2. Double-click the customer that you want to modify.

3. Select the Customer is tax exempt check box.

4. Click Save and Close.

For more information...
Click Help in the Customer window.
Printing itemized sales taxes on receipts

To print itemized sales taxes on receipts

1. On the **Settings** menu, point to **Store Settings**, and then click **Sales Taxes**.

   **Or use the Settings Center**
   In the **Views** area, click **Sales Taxes**.

2. Double-click the sales tax that contains the tax authorities you want to list on receipts.

3. Under **Included tax authorities**, select the box in the **Receipt** column for each tax authority that you want to list, and then click **Save and Close**.

4. Repeat Steps 2 and 3 for any other sales taxes that contain tax authorities that you want to list.

**Things to know**

Does the total sales tax assessed on a transaction print on each receipt?
Yes, that is the default setting. You can also print the taxes assessed for individual tax authorities.

**For more information...**
Click Help 🤔 in the Sales Tax window.
Managing Payment Methods

In this chapter

Creating a payment method
  Create a payment method
  Duplicate a payment method

Working with existing payment methods
  Modify an existing payment method
  Delete a payment method
  Make a payment method inactive

Changing the payment method display order

Setting payment options
In this chapter, continued

Setting up a gift card payment method

Creating a currency
  Create a currency
  Duplicate a currency

Working with existing currencies
  Modify an existing currency or exchange rate
  Delete a currency

Checking the default currency
  Check the default currency in Windows XP
  Check the default currency in Windows Visa

Assigning a currency to a payment method

Using the currency calculator
  Set up denominations for a cash payment
  Turn the currency calculator on

Using touchless transactions
Creating a payment method

To create a payment method

1. On the Settings menu, point to Store Settings, and then click Payment Methods.

2. Click New on the toolbar.

3. Enter a code (a short unique identifier) and a description for the payment method.

4. In the Format box, select the format for this payment method.

5. In the Currency box, select the currency and exchange rate that will be supplied when this payment method is used.

   For more information about currencies, see “Creating a currency” later in this chapter.

---

Things to know

Payment methods are the types of payment that your store will accept. You can set up as many payment methods as you want. In addition to a cash payment method, you might have payment methods for checks and debit cards, and one payment method for each credit card that you accept (MasterCard, Visa, and so on).

The options that you set for your payment methods control how each type of payment is handled by your cashiers. For example, you can set the maximum amount that can be accepted for a payment method, or you can choose to prompt cashiers to enter information about customers’ checks.

Tip

Codes are especially useful when several payment methods share the same format. For example, if your store accepts more than one type of credit card, you can create a payment method for each of them. Codes such as VISA, MC, and DISC will help your cashiers quickly identify each payment method.
What are the requirements for a payment method code and description?

A code is a unique combination of up to 17 letters, numbers, and special characters used to identify payment methods accepted by your store. Descriptions can also be up to 17 characters.

How does the Quick key feature work?

If you specify a keyboard key as a quick key, it will move the cursor to this payment method in the Payment list in POS View. For example, the decimal ASCII value for “k” is 107. Typing 107 in the “Quick key in POS” box for checks would speed up transactions by allowing your cashiers to type only “k” and the amount paid by check.

Tip


In one of the Char columns in Chart 1, locate the character that you want cashiers to type; the decimal ASCII value will be in the Dec column for that character.

6  In the Quick key in POS box, type the decimal ASCII value, from 0 to 127, that represents the key that your cashiers can enter to quickly move to the payment box for this payment method.

7  In the Maximum amount box, type the maximum payment, if any, that can be accepted under this payment method.

8  To set advanced options for the payment method, click Advanced.

9  Select the advanced options that you want, and then click OK.
I expect to have many international customers. Can I set up more than one type of cash payment method?

Yes, you might want to set up a cash payment method for the Canadian dollar, the euro, the yen, and so on, depending on your customers. Also, read the following topics in this chapter:

- Creating a currency
- Assigning a currency to a payment method

I selected the “Require signature” check box, but I don’t have a signature capture device. Can I get the signature line to print on a receipt?

If you select the “Require signature” check box and no signature capture device is connected to the register, a signature line will be printed on the receipt.

For more information...

Click Help in the Payment Method window and in the Advanced Options dialog box.

10 To save this payment method and begin entering information for another, click Save and New, or if this is the only payment method that you want to create, click Save and Close.

To duplicate a payment method

1 On the Settings menu, point to Store Settings, and then click Payment Methods.

Or use the Store Settings Center

In the Views area, click Payment Methods.

2 Select the payment method that you want to duplicate.

3 On the toolbar, click Duplicate.

4 Change the code, description, and any other settings as needed.

5 To save this payment method and begin entering information for another, click Save and New, or if this is the only payment method that you want to create, click Save and Close.

Tip

Duplicating a payment method can be especially useful when several payment methods share the same format, such as when your store accepts more than one type of credit card.
To work with payments methods

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Modify a payment method</strong></td>
<td>1 On the Settings menu, point to Store Settings, and then click Payment Methods.</td>
</tr>
<tr>
<td></td>
<td>2 Double-click the payment method that you want to modify, and make any needed changes.</td>
</tr>
<tr>
<td></td>
<td>3 Click Save and Close.</td>
</tr>
</tbody>
</table>

| **Delete a payment method** | 1 On the Settings menu, point to Store Settings, and then click Payment Methods. |
|  | 2 Select the payment method that you want to delete, and then on the toolbar, click Delete. |

**Caution**

Before deleting a payment method, consult with your accountant.

| **Make a method inactive** | 1 On the Settings menu, point to Store Settings, and then click Payment Methods. |
|  | 2 Double-click the payment method that you want to modify. |
|  | 3 Clear the Payment method is active check box. |
|  | 4 Click Save and Close. |
Changing the payment method display order

To change the payment method display order

1. On the Settings menu, point to Store Settings, and then click Options.

   Or use the Store Settings Center
   In the Views area, click Store Options.

2. Click the Payment tab, and then click Display Order.

3. To move a payment method higher in the list, select it, and then click Move Up, or to move a payment method lower in the list, select it and then click Move Down.

4. When the payment methods are in the correct order, click OK.

5. In the Options dialog box, click OK to save your changes.

6. Close and restart Point of Sale on all computers in your store.

Things to know

You can change the order in which your store's payment methods appear in the Payment list in POS View.

Why is the display order important?
Placing your most frequently used payment methods at the top of the list speeds up transactions because cashiers need fewer keystrokes to get to the payment method they need.

Why didn’t my display order change after I set it up?
You probably clicked Cancel instead of OK in the Options dialog box. You also might need to restart Point of Sale.

For more information...
Click Help in the Display Order dialog box.
Setting payment options

Things to know

There are several store options that control how payments are handled in your store. Use these options to turn on the currency calculator, set the payment method display order, enable “touchless” transactions, and configure payment processing.

How do the payment options for this topic differ from the other payment method options?

These payment options apply to all transactions in your store, regardless of the payment method that is used. This information is entered on the Payment tab in the Options dialog box. The others refer to specific payment method settings in the Payment Method window.

For more information...

Click Help in the Options dialog box.

To set payment options

1. On the Settings menu, point to Store Settings, and then click Options.

   Or use the Store Settings Center
   In the Views area, click Store Options.

2. Click the Payment tab.

3. Select, clear, or change options as needed.

   For more information about specific options, click the Help button in the Options dialog box.

4. To save your setting, click OK.
Setting up gift card payments and service

To set up a gift card payment method and configure the service

1. On the Settings menu, point to Store Settings, and then click Payment Methods.

2. On the toolbar, click New.

3. Enter a unique code and description for this type of gift card, such as "GC" and "Gift Card."

4. In the Format box, select Gift card.

5. Set the currency, quick key, maximum amount, and other options to meet your store’s needs.

Things to know

You can issue and accept gift cards after you complete the following steps:
Sign up with a gift card processing service
Set up a gift card payment method and configure the service
Set up the gift card button on at least one task pad

After you have signed up with a gift card processing service, you can set up one or more gift card payment methods in Point of Sale. Setting up the payment method makes the gift card type available in the Payment list in POS View, so that cashiers can accept gift cards as payment.

Depending on your processor and the receipt format you are using, the remaining balance on a gift card can be displayed on receipts. The built-in receipt formats in Point of Sale are set up for this.

If your processor supports it, cashiers may be able to add funds to an existing gift card.
6 Click Advanced.

```
Advanced Options: Gift Card

General
- Allow multiple entries for a single transaction

Verification
- Verify using this service:
  - Bank Name: Merchant Services
    - Setup...

Validation format
- Enter the format for gift card numbers accepted under this payment method. To require a specific number in a certain location, enter the number. To require a digit, enter #. If you don't want to set a format, leave this box blank.
  - Examples:
    - #1234567890123456 requires a 16-digit gift card number starting with #.
    - #1 requires the gift card to start with #, but doesn't set a length for the number.
  - Valid number format: *

Gift card code
- Enter a number or phrase that can be used to issue this type of gift card.
  - Gift card code: TGIC
```

7 In the Advanced Options dialog box, do the following:

- In the Verify using this service box, select the processing service that you have signed up with, and then click Setup to enter the account information provided by your processor.
  - This code must not match any existing item or customer numbers.
- In the Gift card code box, enter a unique number or series of characters that will help you identify this type of gift card when you set up task pad buttons for issuing the cards.

For more information...

Click Help in the Advanced Options dialog box or in the Payment Method window.
During the set up process for gift cards, it asks me to enter information for the payment processing center that I will be using. Where do I get that information?

You should have received a welcome kit, letter, or other information from your payment processor center that includes information from the payment processing center that you need. If you have your Merchant ID, Deployment Token and an active Internet connection, enter the ID and token, and then click the Retrieve Credentials button to auto-populate the remaining fields.

- Set other desired options, and then click **OK** to save the advanced options.

**Tip**

Set up a validation format so that Point of Sale can make sure the number on a gift card matches the numbering scheme you have set.

8. Save the payment method, and then run a Z report on each register.

**Tip**

When you are ready to begin issuing and redeeming gift cards, consider using magnetic stripe reader (MSR) devices at your registers because it makes “touchless” transactions possible for your cashiers.
Creating a currency

To create a currency

1. On the Settings menu, point to Store Settings, and then click Currencies.

2. On the toolbar, click New.

3. Enter a unique code for the currency, such as "EUR," and a description.

4. In the Exchange rate box, enter the exchange rate.

5. In the Locale box, select the locale for the currency you are creating.

6. Check the Preview area to be sure your settings have the desired effect.

7. To save this currency and begin entering information for another, click Save and New, or if this is the only currency that you want to create, click Save and Close.

Things to know

When you define currencies in Point of Sale, you set up the currencies that your store will accept. If you accept currency from another country, the exchange rate will be stored with the currency you create for this purpose.

Once you have currencies defined, you can assign them to payment methods, enabling the exchange rate for the currency, since amounts due are adjusted automatically when a cashier selects a payment method that uses the currency.

For more information...

Click Help in the Currency window.
To duplicate a currency

1. On the Settings menu, point to Store Settings, and then click Currencies.
2. Select the currency that you want to duplicate.
3. On the toolbar, click Duplicate.
4. Type a unique code for the currency.
5. Make other changes as needed.
6. To save this currency and begin entering information for another, click Save and New, or if this is the only currency that you want to create, click Save and Close.

What are the requirements for completing the Code and Description boxes?

A unique code, up to 17 characters long, is required for the currency. The code can be a combination of letters, numbers, and special characters. A typical code would be the three-letter international currency code for this currency, for example, "EUR" or "MXN."

A unique description, up to 25 characters long, is required for the description, for example, "euro" or "Mexican pesos."

Will my cashiers have to figure out the exchange rate for currencies from other countries?

No, once you have created a currency and assigned it to a payment method, amounts due are adjusted automatically when a cashier selects a payment method that uses a particular currency. The cashier will see the balance due in the selected currency.
To work with currencies

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Modify an existing currency or exchange rate | 1. On the Settings menu, point to Store Settings, and then click Currencies.  
2. Double-click the currency that you want to modify.  
3. In the Exchange rate box, enter the new exchange rate, the value in the default currency that one unit of this currency would have if it were exchanged for the default currency.  
4. Make any other desired changes.  
5. Check the Example area to be sure your settings have the desired effect. |

Delete a currency | 1. On the Settings menu, point to Store Settings, and then click Currencies.  
2. Select the currency that you want to delete.  
3. On the toolbar, click Delete. |

Things to know

If the exchange rate changes, can I adjust it?
Yes, you will need to make changes from time to time. Small changes in the rate won’t affect the results much, but sometimes there may be a major up or down movement.

What happens if the currency that I want to delete is associated with a payment method?
If the currency you are deleting is associated with a payment method, the currency for that payment method will revert to the default currency, and the exchange rate will no longer be applied.

For more information...
Click Help in the Currency window.
Managing Payment Methods

Checking the default currency

To check the default currency in Windows XP

1. On the Start menu, (point to Settings) click Control Panel.
2. Double-click Regional and Language Options.
3. Click the Regional Options tab.

To check the default currency in Windows Vista

1. On the Start menu, click Control Panel.
2. Click Clock, Language, and Region.
3. Click Regional and Language Options.

Things to know

Every computer running Windows has a default currency set in Control Panel. To ensure accurate accounting, Microsoft recommends that all registers in the store use the same default currency. The exchange rates for your other currencies will be calculated against this default currency.
Assigning a currency to a payment method

After you have created a currency, you can assign it to a payment method.

To assign a currency to a payment method

1. Create a currency (see separate topic).
2. On the Settings menu, point to Store Settings, and then click Payment Methods.
3. Double-click the payment method that you want to modify.
4. In the Currency box, select the currency for this payment method.
5. To save this currency assignment and begin entering information for another, click Save and New, or if this is the only currency that you want to assign to a payment method, click Save and Close.

Things to know

Once a currency is assigned to a payment method, what happens at the register?
The currency assigned to a payment method brings the exchange rate for that currency into effect at the register. In the Totals pane, the cashier can instantly convert the amount due to show what's due in the other currency.

Where do I find the latest exchange rates to enter in the Currency dialog box?
Use a search engine to locate the latest exchange rates by typing “exchange rate” in the search box.

For more information...
Click Help in the Payment Method window.
Using the currency calculator

The currency calculator is a tool that allows your cashiers to count quantities of bills and coins, rather than adding up the values of bills and coins. For example, a cashier who has four $5.00 bills, seventeen $1.00 bills, fourteen quarters, six dimes, eight nickels, and 36 pennies doesn’t have to do the math to enter a closing amount of $41.86. The currency calculator could reduce till overage and shortage problems simply by reducing counting errors.

There are three main ways that the currency calculator will be helpful:

- Cashiers can enter opening and closing amounts more quickly.
- Counting errors will be kept to a minimum.
- Payments made with a lot of small denominations will be speeded up.

To set up denominations for a cash payment method

1. On the Settings menu, point to Store Settings, and then click Payment Methods.

   Or use the Store Settings Center
   In the Views area, click Payment Methods.

2. Double-click the cash payment method for which you want to set up denominations.

3. Click Advanced.

4. Under Denominations, click Insert to create a row in the table for each denomination you want to set up.

Things to know

The currency calculator is not turned on by default. To use it, you must first set up denominations on one or more of your cash payment methods, and then turn on the calculator in the Options dialog box.

Once enabled, the currency calculator is available to cashiers in three places:

- When entering opening amounts
- On every cash transaction in the Payment pane
- When entering closing amounts

Setting up denominations for a cash payment method identifies the value of the denominations that will be accepted.
For each row, click in the **Description** column, and then type the description of the denomination.

For each row, click in the **Value** column, and then type the value of that denomination.

If you have any extra rows, click the empty row, and then click **Remove**.

Click **OK**, and then save the payment method, or your denominations settings will be lost.

To turn the currency calculator on

1. On the **Settings** menu, point to **Store Settings**, and then click **Options**.

2. Click the **Payment** tab.

3. Select the **Use currency calculator** check box.

You probably clicked Cancel instead of OK on the Advanced Options: Cash dialog box.

What would be an example of possible denominations and values?

For example, you might have rows for penny, nickel, dime, quarter, $1 bill, $5 bill, $10 bill, $20 bill, and $50 bill. For those denominations, your values would be $0.01, $0.05, $0.10, $0.25, $1.00, $5.00, $10.00, $20.00, and $50.00, respectively.

To use the currency calculator, do I need to follow this procedure for other cash currencies?

Yes, if you want to use the currency calculator with those currencies.

For more information...

Click Help ? in the Advanced Options: Cash dialog box.
Using touchless transactions

*Touchless transactions* are transactions processed without touching the keyboard or touch screen. To fully implement touchless transactions, you will need to:

- Set up a scanner and MSR device on each register where touchless transactions will take place.
- Use item labels with bar codes.
- Use bar-coded customer loyalty cards.
- Accept credit cards, gift cards, or both.
- Set up credit card and gift card payment methods (or both) and use validation formats in order to recognize different kinds of cards (such as Visa and Discover Card).
- Set store options for touchless transactions.

### To set store options for touchless transactions

1. On the **Settings** menu, point to **Store Settings**, and then click **Options**.

   **Or use the Store Settings Center**
   In the **Views** area, click **Store Options**.

2. Click the **Payment** tab.

3. Under **Touchless transactions**, select both check boxes.

---

**Things to know**

**Can cashiers make touchless transaction if I do not meet all of the criteria on the right?**

You can come close to touchless transactions. Cashiers will need to touch the screen or keyboard only to add customers to transactions. In Point of Sale stores where bar-coded customer loyalty cards are in use, the cashier can scan the customer’s card, scan the items, and then swipe the customer’s credit or gift card, thus producing quick results.

**Can I have my cashiers post credit and gift card transactions manually but otherwise make touchless transactions?**

If you prefer to have your cashiers post credit and gift card transactions manually, clear the “Process credit card transactions automatically” check box. With this option cleared, cashiers will have to touch the keyboard or touch screen to complete the transaction.
Managing Payment Processing

In this chapter

Understanding payment processing
Understanding the industry
Understanding data security standards
Setting up payment processing
Settling credit and debit transactions
Setting up credit card and debit card payment methods
  Set up credit card payment method
  Set up debit card payment method
Understanding payment processing

The payment processing cycle is divided into two phases, purchase and settlement. If your store accepts credit or debit card payments, you will need to process those payments in order to receive the promised funds. This payment processing, sometimes referred to as electronic draft capture or EDC, includes both authorization at the time of purchase and settlement of transactions with the credit card associations, transaction processors, and acquiring banks.

Microsoft has made arrangements with a number of preferred acquirers (acquiring banks) in order to offer easy integration with payment processing services offered by these acquirers. Setting up this integration involves these steps:

- Creating credit and debit card payment methods in Point of Sale.
- Setting up any hardware you will be using, such as magnetic stripe readers, signature capture devices, and PIN pads.
- Setting up Point of Sale for payment processing.

Once integration is in place, you can perform daily settlement of your credit and debit transactions quickly and easily.

For further details on payment processing, see “Payment Processing” in Manager View Help.

Things to know

Are there fees charged for payment processing?
As a merchant who accepts credit or debit cards, you will find that there are a number of fees associated with payment processing. For more information about these fees, see the “Payment Processing” in Manager View Help.

What is the sharing group?
The sharing group is the debit card network that you have chosen to accept in your store. It is required for debit card acceptance and settlement. Your acquiring bank should provide the information that goes in the Sharing group box in the Setup dialog box.
Understanding the industry

The payment processing industry includes several key players:

- **Cardholder.** The cardholder is the person to whom a credit or debit card is issued.

- **Issuing bank (card issuer).** The issuing bank is the financial institution that holds the contractual agreement with the cardholder and issues the card. The issuing bank holds an issuing license from the card organization that gives them access to a payment and withdrawal network. The role of the issuing bank is to issue cards, establish credit limits, set up PIN numbers, and process customer payments. In addition, the issuing bank is responsible for the marketing and the distribution of the card to its clients.

- **Merchant.** The merchant is any retail outlet that meets the qualifications to accept card payments.

- **Acquiring bank (acquirer).** The acquiring bank (also known as the sponsoring bank) owns contracts with merchants to accept (acquire) transactions from the merchants for processing. The acquiring bank works directly with the merchant or through an independent sales organization (ISO).

- **Transaction processor.** The transaction processor is used by acquiring banks to route transactions to the appropriate bank card organizations for authorization and settlement.

- **Card associations.** Card associations implement marketing programs to support

---

What phone numbers can I call about payment processing?

Phone numbers for Microsoft’s preferred acquirers are listed on the Microsoft Point of Sale Web site at: http://www.microsoft.com/BusinessSolutions/RetailManagementSystem/rms_merchant_services.mspx
the brand, develop new products, and process international transactions. They also set the rules and regulations that must be followed by the member issuing banks. Associations are also known as card organizations or schemes. Major international card associations include Discover, Visa, Eurocard/MasterCard, American Express, and Diners Club.

- **Independent sales organizations (ISOs).** ISOs represent acquiring banks and work with merchants to set up credit card agreements. Often, their fees will include a markup on the discount rates offered by acquiring banks. ISOs can also sell and support the transaction-processing hardware used internally by the merchant. ISOs derive a significant portion of their revenue from the sales and rental of this equipment. ISOs are typically smaller organizations and must be sponsored by an acquiring bank.

If you accept credit card payments in your store, you are required to comply with the Payment Card Industry (PCI) Data Security Standard. This standard has been adopted by most major card brands, including Visa, MasterCard, American Express, Diners Club, Discover Network, and JCB. It sets out twelve requirements that merchants must meet in order to protect cardholder information. For details about these requirements and how Point of Sale can help you comply with the standard, see “About the Payment Card Industry Data Security Standard” in Manager View Help.

What do I do first to obtain credit and debit card processing?

Contact an acquiring bank to obtain a merchant account. See a listing of preferred acquirers at the Retail Management System Web site at: [http://www.microsoft.com/BusinessSolutions/RetailManagementSystem/rms_merchant_services.mspx](http://www.microsoft.com/BusinessSolutions/RetailManagementSystem/rms_merchant_services.mspx) Be sure to mention that you are using Microsoft Dynamics - Point of Sale.

If you intend to accept debit cards using a PIN pad, make arrangements with the acquirer to have an encryption key added to your PIN pad, a process sometimes referred to as "injection" or "key injection."
Understanding the data security standards

If you accept credit card payments in your store, you are required to comply with the Payment Card Industry (PCI) Data Security Standard. This standard has been adopted by most major card brands, including Visa, MasterCard, American Express, Diners Club, Discover Network, and JCB. It sets out twelve requirements that merchants must meet in order to protect cardholder information.

Please see Appendix B for a list of the twelve requirements.

Important

The information in this topic is provided to assist users of Point of Sale in complying with the PCI Data Security Standard. This topic is not intended to replace or stand in place of the Data Security Standard, might not reflect the most recent version of the standard, and should not be exclusively relied upon to comply with the standard or with other requirements set out by your bank. Microsoft strongly recommends reviewing the full text of the current PCI Security Standard at:

http://usa.visa.com/business/accepting_visa/ops_risk_management/cisp.html

Where can I get a copy of Payment Application Best Practice?

You can download Payment Application Best Practices from the Payment Applications page on Visa’s Operations & Risk Management Web site at http://usa.visa.com/business/accepting_visa/ops_risk_management/cisp_payment_applications.html. You can also download a copy of Visa’s PCI Self-Assessment Questionnaire on the same page.
Is the PCI Data Standard required for payment application validation?
While optional for some card brands, compliance with these minimum audit requirements is strongly recommended.

Was the PCI Data Standard considered when developing and testing Point of Sale?
The PCI Data Standard was used as a guideline during the development and testing of Point of Sale.

Point of Sale as a payment application

With integrated payment processing, Point of Sale is considered a payment application. Credit card industry guidelines for the development of payment applications – such as the guidelines set out in Visa's *Payment Application Best Practices* (PABP) publication – are intended to promote more secure payment applications and, in turn, facilitate merchant compliance with the PCI Data Security Standard. Payment applications that have been validated against these development standards minimize the potential for security breaches that lead to fraudulent card use.

Merchant levels and auditing requirements

Most major card brands classify merchants into four merchant levels. These levels are typically based on the merchant's annual card transaction volume, the types of card transactions processed by the merchant, and other risk factors.

Each merchant level carries requirements for auditing for compliance with the PCI Data Security Standard and other card-specific standards. This auditing might involve submission of required documentation, self assessment, network scans, and assessment by qualified independent auditors.

For more information about Visa's merchant levels and audit requirements, visit the Merchants page on the Visa Operations & Risk Management Web site at [http://usa.visa.com/business/accepting_visa/ops_risk_management/cisp_merchants.html](http://usa.visa.com/business/accepting_visa/ops_risk_management/cisp_merchants.html)
What Merchant Level will most users of Point of Sale users fit?

Most users of Point of Sale will fall into Level 4. Typical audit requirements for Level 4 merchants include:

- The completion of an annual self-assessment questionnaire.
- A quarterly network security scan. Using the Internet Protocol (IP) address provided by the merchant, this automated scan remotely reviews the merchant’s networks and Web applications for security vulnerabilities.

<table>
<thead>
<tr>
<th>Merchant Level</th>
<th>Description</th>
</tr>
</thead>
</table>
| 1              | Any merchant, regardless of acceptance channel, who processes over 6 million Visa transactions per year
|                | Any merchant who has suffered a hack or an attack that resulted in a compromise of account data
|                | Any merchant classified as Level 1 by Visa, in its sole discretion, in order to minimize risk to the Visa system
|                | Any merchant identified by any other payment card brand as Level 1 |
| 2              | Any merchant processing 150,000 to 6 million Visa e-commerce transactions per year |
| 3              | Any merchant processing 20,000 to 150,000 Visa e-commerce transactions per year |
| 4              | Any merchant processing fewer than 20,000 Visa e-commerce transactions per year
|                | All other merchants processing up to 6 million Visa transactions per year |
Setting up payment processing

Before you can set up payment processing in Point of Sale, you need to make arrangements with one of Microsoft’s preferred acquirers (card issuers). You can find information about these acquirers on the Point of Sale Web site at www.microsoft.com/pos or a Microsoft Certified Partner can help you get started. You will then receive a welcome letter or packet of information that will give the data that you will need as you go through the steps in this topic.

To set up payment processing

1. On the Settings menu, point to Store Settings, and then click Options.

2. Click the Payment tab.

3. Select Use this payment processing software or service, select your payment processor from the list, and then click Setup.

Things to know

In the setup process, some boxes are colored and some have zeros in them. Does this indicate the required items and number of characters required?

The colored boxes indicate required information and the number of zeros indicates the required number of characters. For example, the Agent bank number is required and must be six characters.

Why can’t I find some of the required items in my welcome letter?

Some items in your welcome letter may have slightly different names from the names in the dialog box. For example, “Acquirer bank identification number” may appear in the bank’s welcome letter as “Bank BIN #.”

Important

If your welcome letter or packet does not contain the information needed to fill in all of the required (yellow-shaded) boxes in the Setup dialog box, contact your acquiring bank for assistance.
Should I change the batch, gateway URL, or gateway port settings?

You should *not* change the batch, gateway URL, or gateway port settings unless instructed to do so by your acquirer, Microsoft partner, or Microsoft Product Support. If you change these settings by mistake, you can click Restore Defaults to return them to their original values.

For more information...

Click Help in the Options dialog box and Help in the Setup: Vital Processing Services dialog box.

4 Type the bank and merchant information provided to you by your acquirer, and then click OK.
Settling credit and debit transactions

Once you have set up payment processing in Point of Sale and have performed some credit or debit card transactions, you can then settle these transactions.

To settle credit and debit transactions

1. On each register, close the batch by running a Z report, and then shut down Point of Sale.
2. On the machine where you want to settle transactions, close the batch by running a Z report, and then switch to Manager View.
4. To view the details of a transaction, double-click the transaction that you want to view.
5. Click Settle.

   If you have a lot of transactions, this could take several minutes. A message will appear when settlement is complete.
6. If error occurred during settlement, click Yes to view the Credit/debit Card Transactions report.
7. To view the report even when there were no errors: On the Reports menu, point to Miscellaneous, and then click Credit/Debit Card Transactions.

Things to know

How often should I settle debit and credit card transactions?
You should do this every day.

Why do I need to shut down Point of Sale to settle the credit and debit transactions?
Shutting down ensures that no additional transactions will be processed while you are settling transactions and reduces the likelihood of conflicts or other problems.

Why don’t I see Settle Card Transactions on my Transactions menu?
The Settle Card Transactions command will appear when you have set up payment processing. Then, you must close and restart Point of Sale.

For more information...
Click Help in the Settle Card Transactions dialog box.
Setting up credit and debit card payments

To set up a credit card payment method

1. On the Settings menu, point to Store Settings, and then click Payment Methods.

2. Review the list of payment methods.
   - If you have existing credit card payment methods, double-click each one and verify that their settings match those described in this procedure.
   - If you do not have existing credit card payment methods, click New on the toolbar.

3. Enter a unique code and useful description for the payment method.

4. In the Format box, select Credit card.

5. Enter or change other settings as needed.

Things to know

If you used the Store Setup Wizard to create your payment methods, you might already have payment methods in place for some credit card issuers, such as Visa and MasterCard. These credit card payment methods are ready for use with payment processing. If you did not create payment methods with the Store Setup Wizard, use the instructions in this topic to create them.

How do validation formats work?

Each credit card association has a number that its account numbers always begin with. For example, Visa cards begin with 4, MasterCard cards begin with 5, and American Express cards begin with 3. A validation format ensures that cashiers are accepting the right type of card for a payment method.
6 Click Advanced.

![Advanced Options: Credit Card dialog box]

- Enter a validation format for credit cards accepted under this payment method.

7 Enter a validation format for credit cards accepted under this payment method.

**Tips**

Set up payment method validation formats so that Point of Sale can validate the numbering scheme used by the credit card service.

Consider using special cash payment methods to record credit card sales amounts if you are not using electronic payment processing or if your payment processing isn’t integrated with Point of Sale. Doing so bypasses the credit card authorization process in Point of Sale.

8 Click OK, and then save the payment method.

9 Repeat this procedure for any other credit cards that your store accepts.

For more information...

- Click the Help button in the Payment Method window and the Help button in the Advanced Options dialog box.
To set up a debit card payment method

1. On the Settings menu, point to Store Settings, and then click Payment Methods.

   Or use the Store Settings Center
   In the Views area, click Payment Methods.

2. Review the list of payment methods.
   - If you have existing debit card payment methods, double-click each one and verify that their settings match those described in this procedure.
   - If you do not have existing debit card payment methods, click New on the toolbar.

3. Enter a unique code and useful description for the payment method.

4. In the Format box, select Debit card.

5. Enter or change other settings as needed.

6. Click Advanced.

There are two types of debit cards. One of them requires the customer to enter a PIN. With other debit cards—commonly referred to as check cards and usually bearing a card service logo—the card can be accepted using either a debit card or credit card payment method.

Why is the new debit payment method not available to the cashiers?
To make new and changed payment methods available to your cashiers, you will need to run a Z report at each register in your store.
Managing Payment Processing

7 In the Debit surcharge box, type any fee that you want to collect from customers for allowing them to use their debit cards.

8 Under Cash back, select the Allow cash back check box if you want to allow customers to pay more than the transaction balance and receive cash back, and then set the maximum cash-back amount, any fee that you want to collect for performing this service, and the payment method that cashiers should use when paying out the cash-back amount.

9 If desired, enter a validation format for debit cards accepted under this payment method.

10 Click OK.

11 In the Payment Method window, click Save and Close.

Why didn’t my advanced settings save even though I clicked OK?
You must also click Save and Close, or your settings will be lost.

Do I need to use electronic payment processing if I add debit cards as a payment method?
While you can choose whether to verify credit transactions using an electronic payment processing service, verification is required when accepting debit cards. This means that you will not be able to process debit card transactions until you have set up electronic payment processing. You will also need to have a PIN pad and magnetic stripe reader (MSR) set up at each register where you accept debit cards.

For more information...
Click Help in the Payment methods window and Help in the Advanced Options dialog box.

Caution
Check the legality of collecting debit surcharges and cash back fees from your customers.
PART 2: STORE MANAGEMENT

Managing the File Center

In this chapter

Opening the File Center

Working with File Center folders
   Add a folder to File Center
   Rename a folder in File Center
   Delete a folder in File Center

Working with File Center files
   Add a file to the File Center
   View or change the properties of a File Center file
   Edit a file in the File Center
   Delete a file in the File Center
   Save a File Center file to the hard disk or another location
   Move a file from one location in the File Center to another

Adding a custom label format

Editing a receipt template from the File Center
In this chapter, continued

Edit a receipt template from File Center
Load your modified template into an existing receipt format
Viewing and storing images in File Center
Preview an image in File Center
Load a picture of an item
Load a picture of a customer
Opening the File Center

You can open File Center from various places in Manager View. For example, in the window for an item or customer, open File Center by double-clicking the picture of the item or customer.

To open File Center from Manager View

- On the Tools menu, click File Center.

Things to know

File Center provides a centralized location where you can view and manage the files in the database, and it enables you to add, remove, and sometimes even edit the files. File Center is set up similarly to Windows Explorer, with files organized into folders in a tree structure. The File Center toolbar provides quick access to the most common file-management tasks.

The types of files stored in File Center include your store logo, item and customer images, label formats, report definition files, receipt templates, saved searches, and other system files. This means that all of these auxiliary files are automatically backed up when you back up your store database.

Tip

Simplify your backup procedures by using File Center to store files other than those used by Point of Sale. Simply add special folders for these files, and then add your personal files to those folders.
Working with File Center folders

To add a folder to File Center

1. In File Center, click the folder where you want to add the new folder.
2. On the toolbar, click New Folder.
3. Type a name for the new folder, and then click OK.

To rename a folder in File Center

1. In File Center, select the folder that you want to rename.
2. On the toolbar, click Rename Folder.
3. Type the new name of the folder, and then click OK.

To delete a folder from File Center

1. In File Center, click the folder that you want to delete.
2. On the toolbar, click Delete.
Working with File Center files

To add a file to File Center

1. In File Center, create or select the folder where you want to add a file.
2. On the toolbar, click Add File.
3. Browse to the location of the file on your hard drive, select it, and then click Open.
4. To change the name or description of the new file, select it, and then click File Properties.
5. Click OK to save the changes, and then click Close to exit File Center.

To view or change the properties of a File Center file

1. In File Center, click the folder where the file you are interested in is located.
2. Select the file, and then click File Properties on the toolbar.
3. Make any needed changes, and then click OK.

Things to know

Do the menus and options change immediately after adding a file to File Center?

In some cases, adding a file to File Center has an immediate effect on the menus or options available to you. For example, adding a report definition file adds a corresponding custom report name to the Reports menu, and adding a label format (with a description) makes the label format available to you when you print labels.

Some file types require action on your part before the files are used by Point of Sale. For example, a store logo will not appear on receipts and reports until you select it in the Store Information dialog box, and a new receipt template won’t go into effect until you select it in a new or existing receipt format.

For more information...
Click the Help button in the File Properties dialog box.
To edit a file from File Center

1. In File Center, click the folder that contains the file that you want to edit.
2. Select the file.
3. On the toolbar, click **Edit File**.
4. Make your changes.
5. On the toolbar, click **Save and Close**.

**Caution**
If you introduce errors into the XML code in a file, the file might fail to load or stop working with Point of Sale.

To delete a file from File Center

1. In File Center, click the folder where the file that you want to delete is located.
2. Select the file.
3. On the toolbar, click **Delete**.

**Caution**
Deleting a File Center file is a permanent operation. Microsoft recommends saving the file to your hard drive or another location prior to deleting it so you will be able to easily recover the file if needed.
To save a File Center file to the hard disk or another location

File Center files are stored in your store database. If you want to put a copy of the file on your hard drive, a CD, or a floppy disk, you can save the file from File Center.

1. In File Center, click the folder where the file that you want to save is located.
2. Select the file that you want to save, and then click Save File.
3. Browse to the location where you want to save the file, and then click Save.

The File Center copy of the file remains in your database, and a new copy is created in the new location.

To move a file from one location in File Center to another

1. In File Center, click the folder that is the current location of the file that you want to move.
2. Select the file that you want to move, and then click File Properties on the toolbar.
3. Select the names of the folder and subfolder where you want the file to be located.

Why am I not allowed to change the properties of a file?
You can only change the properties of files that you or your Microsoft certified partner added to File Center. The files provided with Point of Sale are protected and can’t be modified.

Is there a limit to how many files that I can have in the File Center?
No, but keep in mind that each file in File Center increases the size of your store database, which means it takes longer to update and use.

Why can’t I move some files?
You can only move files that you have added to File Center. The files provided with Point of Sale are protected and cannot be moved.

For more information...
Click the Help button in the File Properties dialog box.
Adding a custom label format to File Center

To add a custom label format to File Center

1. On the Tools menu, click File Center.
2. In the folder list, in the Label Formats folder, click the Address Labels or Inventory Labels subfolder, as appropriate.
3. On the toolbar, click Add File.
4. Browse to the location of the label format file on your hard drive, select it, and then click Open.
5. To make this label format available for label printing, select the file, click File Properties, and then type a description.

Things to know

If you or your Microsoft Certified Partner creates a custom label format outside of Point of Sale—perhaps one designed to work with your label printer—you will need to load the custom .xml or .lbl file into File Center. This will make the label format available to you when you print labels from within Point of Sale.

After I have loaded a new custom label format, how do I make the format available for label printing?

You must enter a description in the File Properties of the selected label. Once you have done this, it will show up as a choice in the Print Labels dialog box.

For more information…

Click the Help button in the File Properties dialog box or Help in the File Center window.
To edit a receipt template from File Center

1. On the **Tools** menu, click **File Center**.
2. In the folder list, in the **Document Templates** folder, click the **Receipt Formats** subfolder.
3. Select the receipt template .xml file that you want to modify.
4. Click **Edit File**.

**Things to know**

If you have experience working with XML coding, you can use the file editor in File Center to modify a receipt template .xml file. However, modifications to an .xml file will *not* have any effect on receipt formats where templates have already been loaded from the .xml file. If you want your edits to be carried into an existing receipt format, you will need to load the modified template into the receipt format again.

**Why doesn’t the .xml file that I want to edit show up in File Center?**

You must first add the .xml file to File Center before you can follow the instructions in this topic. If you want to make changes to a copy of the .xml file instead, save the .xml file to your hard drive, change the file name of the copy on your hard drive, and then add it into File Center again. (If you prefer, you can make your edits in Notepad or your .xml editor while the file is on your hard drive.)
6 On the toolbar, click **Save and Close**.

The existing .xml file in File Center will be overwritten.

**To load your modified template into an existing receipt format**

1 On the **Settings** menu, point to Register **Settings**, and then click **Receipt Formats**.

   ![Or use the Settings Center](image)

   In the **Views** area, click **Receipt Formats**.

2 Double-click the receipt format that you want to modify.

3 Click the tab for the receipt type that should use the modified template.

---

**For more information**...

Click the Help button in the File Center or Receipt Format windows.
4 Click Select Template.

5 In File Center, select the .xml file that you edited, and then click Select.

6 Repeat Steps 3 through 5 for any other receipt types that you want to update.

7 Click Save and Close when finished.

How can I edit a receipt format that has encoding other than UTF-8?
The file editor in File Center can only read .xml files that use UTF-8 encoding. If you want to edit a receipt template that uses another type of encoding (such as Unicode UTF-16), you will need to save it to your hard drive and then use Notepad or another program to save the file with UTF-8 encoding.

For more information...
Click the Help button in the Receipt Format window.
To preview an image in File Center

1. In **File Center**, click the folder where the file that you want to preview is located.
2. Select the file.
3. If the preview of the file is not showing, click **Views** on the toolbar.

To load a picture of an item

1. On the **Inventory** menu, click **Items**.
   
   **Or use the Inventory Center**
   In the **Views** area, click **Items**.

2. Double-click the item to which you want to add a picture.
3. Click the **Picture** button.

**Things to know**

Storing pictures of your items and customers is a great way to customize your Point of Sale experience. Item pictures are helpful at the register.

File Center provides a central location for all of your item and customer pictures. There, you can manage these images, browse through them, and even open them for editing. Because files in File Center are part of your store database, they are backed up with the rest of your store information when you back up your store database.

**Why keep a picture of a customer in the File Center?**

Customer pictures can help you connect with customers, and they can provide security benefits by identifying customers for your cashiers.

**For more information...**

Click the Help button in the File Center window.
Why is there a picture of a ball in the Picture box?
If you click the Picture button (placeholder ball), you will be able to change it to the picture that you want. If a picture for that item has already been select previously, it will be in the Picture box. You can change it by double-clicking the current picture.

For more information...
Click the Help button in the Item window.

4 Click the Items folder, and then click Add File.

5 Browse to the location of the item's picture, select it, and then click Open.

This will copy the file into File Center.

6 Select the file in File Center, and then click Select.
How can I change an existing picture, remove an existing picture, or copy the existing picture?

If a picture is already loaded for the customer, it will appear instead of the Picture button; if you want to change it, double-click the picture, and then find the picture that you want to use.

You can also right-click the image, and then click one of the following options:

- **Change Picture**, to open File Center and select a new picture.
- **Remove Picture**, to remove the picture from the item.
- **Copy**, to place a copy of the image file on the Windows Clipboard, and then paste it to another location or program that accepts this type of file.

For more information...

Click the Help button in the Customer or File Center windows.

---

**To load a picture of a customer**

1. On the **People** menu, click **Customers**.

2. **Or use the Customer Center**
   In the **Views** area, click **Customers**.

3. Double-click the customer that you want to modify.

4. Click the **Picture** button.

5. In **File Center**, click the **Customers** folder.

6. On the toolbar, click **Add File**.

7. Browse to the location of the customer’s picture, select it, and then click **Open**.

   The file will be added to File Center.

8. Select the new file in **File Center**, and then click **Select**.
PART 3: REGISTER MANAGEMENT

8

Managing Register and Peripheral Settings

In this chapter

Creating a register
  Create a register
  Duplicate a register

Working with an existing register
  Modify a register
  Delete a register

Making a device available on a register

Turning receipt journaling on

Customizing register function keys

Using sounds at the register
Creating a register

The first register in your store, Register 1, is created automatically when you run Point of Sale for the first time. Register 1 is usually your store’s main computer and the location of your store database.

Additional registers in Point of Sale will correspond to the points of sale in your store. For example, a drugstore might have a register for each lane, plus one for the film counter.

To create a register

1. On the Settings menu, point to Register Settings, and then click View/Edit Registers.
2. On the toolbar, click New.
3. In the Register Properties window, enter a unique number or use the automatic numbering and description for the new register.
4. In the Auto settings box, select the audio settings that you want for this register.
5. To save database copies of all receipts that are generated on this register, select the Save electronic copies of receipts check box, and then select a receipt format for those journaled receipts.

Things to know

In Microsoft Dynamics - Point of Sale, the word register refers not only to the lane and computer equipment in your store, but also to the database records that contain the settings for the register. These settings include the register number and description, the hardware devices in use at the register, and any receipt formats and line display messages being used by those devices.

Is the location of the store’s database considered a register if it doesn’t process transactions?
Yes, it is considered a register even if it is not actually used to process transactions.
How does the numbering system for registers work?
Each new register created in Manger View is automatically created with a register number that is one digit higher than the last register created.

6 To save this register and begin entering information for another, click **Save and New**, or if this is the only register that you want to create, click **Save and Close**.

For more information...
Click Help on the Register Properties window.
To duplicate an existing register

If you have registers that will share hardware devices such as printers, you can create one register and then use it as a template for additional registers.

1. On the Settings menu, point to Register Settings, and then click View/Edit Registers.

2. Select the register that you want to duplicate.

3. On the toolbar, click Duplicate.

4. Enter a unique register number and description for the new register.

5. Change other settings as needed.

6. To save this register and begin entering information for another, click Save and New, or if this is the only register that you want to create, click Save and Close.

**Things to know**

When I duplicate a register, will the devices and their settings also be copied?

If the register that you are duplicating has devices assigned to it, the device assignments will be copied over when you duplicate the register. Any device properties, such as receipt journaling on printers, will also be duplicated. You may modify these settings after the register is duplicated.

**For more information...**

Click Help in the Register Properties window.
Working with an existing register

To modify an existing register

1. On the Settings menu, point to Register Settings, and then click View/Edit Registers.

   Or use the Register Settings Center
   In the Views area, click Registers.

2. Double-click the register that you want to modify.

3. Make any needed changes.

4. Click Save and Close.

   Tip
   Click once on a register in the content pane, and then preview the available information about the register in the preview pane.

To delete a register

1. On the Settings menu, point to Register Settings, and then click View/Edit Registers.

   Or use the Register Settings Center
   In the Views area, click Registers.

2. Select the register that you want to delete.

3. On the toolbar, click Delete X.

Things to know

Why won’t Point of Sale allow me to modify the devices on a register?

The devices for a register must be made available on the register itself before they can be modified in Manager View.

For more information...

Click Help on the Register Properties window.
Making a device available on a register

Once a device is installed and available on a register in your store, you can change its settings from within Manager View.

1. On the Settings menu, point to Register Settings, and then click View/Edit Registers.

Or use the Register Settings Center
In the Views area, click Registers.

2. Double-click the register where the new device is located.

3. In the Available devices list, select the new device, and then click the right-arrow button to add the device to the Selected devices list.

4. To change the settings for the selected device, click Properties, make changes as needed, and then click OK.

5. Click Save and Close.

Things to know

Why don’t I see the device that I want to make available to a register in the Available devices list?

If the register’s devices do not appear in the Available devices list, you need to open Point of Sale on the register and configure the devices there. After that, you’ll be able to configure the devices from Manager View on any register.

For more information...

Click Help on the Register Properties window.
Things to know

Receipt journaling saves a record of your receipts that can be stored and printed. You can save electronic copies of your store's receipts and X, Z, and ZZ reports in your store database. This will allow you to view or reprint those receipts or view detailed payment information for a transaction. You can choose to journal receipts on certain registers or for certain receipt printers.

Will storing all of my store receipts cause my database to become too large?

Journaling receipts will cause your store database to grow more quickly, so you will want to balance the convenience of journaled receipts against your database storage limitations.

For more information...

Click Help in the Register Properties window or in the Printer Properties dialog box.

To turn receipt journaling on for certain registers

1. On the Settings menu, point to Register Settings, and then click View/Edit Registers.

2. Or use the Register Settings Center

   In the Views area, click Registers.

3. Double-click the register that you want to modify.

4. To turn on receipt journaling for this register, select the Save electronic copies of receipts check box.

   -or-

   To turn on receipt journaling for a specific receipt printer, select the printer in the Selected devices list, click Properties, select the Save receipts to database check box, and then click OK.

   Do not complete both parts of Step 3, or you will have two copies saved to your database.

5. Click Save and Close.

6. Restart Point of Sale on the modified register.
Customizing register function keys

Unless they have been customized, the function keys in POS View will open the menus attached to the keys. For example, pressing F2 will open the Items menu. To streamline transactions and common register tasks, you can choose to have the function keys take a certain action instead. For example, you can customize F2 so that it opens the item list.

To customize the register function keys

1. On the Settings menu, point to Store Settings, and then click Options.

   Or use the Store Settings Center
   In the Views area, click Store Options.

2. On the POS tab, click Function Keys.

3. In the Keys list, select the function key that you want to customize.

4. In the Functions box, select the function that you want the key to perform.

5. Repeat Steps 3 and 4 for any other keys that you want to customize, and then click OK twice.

Things to know

How will I know if a function key has been customized or not?

After a function key has been customized, a triangular indicator will appear on the on-screen function key. This indicator shows you where to touch or click if you want to open the menu. Keyboard users can press CTRL plus the keyboard function key.

Can I customize only some of the function keys?

If you select (none), the function keys will open the function key menu again.

For more information...

Click Help in the Options window or in the POS Function Keys Options dialog box.
You can choose to play unique sounds at the register for each of the following events:

- Item added to order
- Transaction completed
- Scanned item not found
- Character mismatch in search box
- Matching item found

Alternatively, you can choose to play a simple alert tone for each event, or no sounds at all. In a multiple-register store, these audio feedback settings can be set individually for each register.

**To use sounds at the register**

1. On the **Settings** menu, point to **Register Settings**, and then click **View/Edit Registers**.

   **Or use the Register Settings Center**
   
   In the **Views** area, click **Registers**.

2. Double-click the register that you want to choose sounds for.

3. In the **Audio settings** box, select **Full sounds**, **Minimal sounds**, or **No sounds**.

4. Click **Save and Close**.

**Things to know**

**Why should I add sounds to a register?**

It is another way of distinguishing various actions taken at the register to guide cashier's through the transactions. It is also a way of alerting the cashier if something was done improperly or an item wasn’t found.

**Why am I getting a beep for each event after adding audio feedback with full sounds?**

If no sound card is installed on the computer running the register, the system beep will be played for all events unless you have selected the “No sounds” option.

**For more information...**

Click Help (?) in the Register window.
PART 3: REGISTER MANAGEMENT

9

Working with Receipt Formats

In this chapter

Creating a receipt format
  Create a receipt format
  Duplicate a receipt format

Working with existing receipt formats
  Modify a receipt format
  Delete a receipt format

Setting receipt options

Controlling receipt printing
  Assign a receipt format to a printer
  Print a gift receipt
  Print itemized sales taxes on receipts
Creating a receipt format

To create a receipt format

1. On the Settings menu, point to Register Settings, and then click Receipt Formats.

2. On the toolbar, click New.

   **Or use the Register Settings Center**
   In the Tasks area, click New Receipt Format.

3. Enter a unique name and description for this receipt format.

4. For each document type:
   - Select the tab for that document type, and then click Select Template.
   - In File Center, add or locate the .xml template that you want to use, and then click Select.
When an .xml file is set up properly, it can be selected as the template for more than one type of document. For example, in the built-in receipt formats, the four receipt types are drawn from a single .xml file, but the content of the receipts will still vary according to the type of receipt. The X, Z, and ZZ report template for each receipt format is contained in a separate .xml file.

**Can I create my own receipt format or am I limited to those that come with Point of Sale?**

You can create your own receipt formats by selecting templates for each of the document types. Once templates are loaded, you can change the attribute values without affecting the underlying .xml file. You can also modify an existing receipt format either by selecting different templates for each of the document types or by changing attribute values.

5 To save this receipt format and begin entering information for another, click Save and New, or if this is the only receipt format that you want to create, click Save and Close.

**To duplicate a receipt format**

1 On the **Settings** menu, point to **Register Settings**, and then click **Receipt Formats**.

2 Select the receipt format that you want to duplicate.

3 On the toolbar, click **Duplicate**.

4 Enter a unique name and description for this receipt format.
5. Make any other needed changes.

6. To save this receipt format and create another, click **Save and New**, or if this is the only receipt format that you want to create, click **Save and Close**.

---

**Can I create a new receipt template from within a receipt format?**

Yes, you can create a new template by changing the attributes of the current template and then clicking **Save as Template**.

If you want to start from scratch, use Notepad or another text editor to create an .xml file, and then load the .xml file into File Center.

---

**For more information...**

Click Help (?) in the Receipt Format window.
Working with existing receipt formats

Things to know

On the Receipt window, I don’t understand the differences in the tabbed receipt template types. Where is there more information on these types? More information is available in Manager View Help. Click the Help button on the Receipt window to find more information explaining each of the tabs and boxes.

How will deleting a receipt format affect those registers that have been using that receipt format? If you want to delete a receipt format that is in use at any of your registers, you will first need to select a different receipt format for those registers.

For more information...
Click Help in the Receipt Format window.

To modify an existing receipt format

1. On the Settings menu, point to Register Settings, and then click Receipt Formats.

   Or use the Register Settings Center
   In the Views area, click Receipt Formats.

2. Double-click the receipt format that you want to modify.

3. Make any needed changes.

4. Click Save and Close.

To delete a receipt format

1. On the Settings menu, point to Register Settings, and then click Receipt Formats.

2. Select the receipt format that you want to delete.

3. On the toolbar, click Delete.
**Setting receipt options**

You can set options for your printed and journaled receipts (including No Sale and duplicate receipts).

**To set receipt options**

1. On the Settings menu, point to Store Settings, and then click Options.

2. Click the POS tab.

3. In the General area, select or clear the Mark journaled receipts as duplicates and Print “No Sale” receipts check boxes.

4. To save these settings, click OK.

**Things to know**

**Can I print “No Sale” receipts?**
Yes, but you must first set that option on the POS tab in the Options dialog box.

**Are there other receipt options that need to be set before I can use them?**
If you want to print journaled receipts as duplicates, you must also set this option on the POS tab.

**For more information...**
Click Help in the Options dialog box.
Controlling receipt printing

Things to know

Should I be using POS View instead of Manager View when trying to make a register’s devices available?
In a multiple-register store, you can only use Manager View to make a register’s devices available if Point of Sale has been opened on the register at least once. Prior to that, the devices are not part of the store database.

Why can’t I modify the properties when I try to assign a receipt format to a printer?
Before you can modify its properties, the printer must be one of the selected devices for the register.

To assign a receipt format to a printer

1. On the Settings menu, point to Register Settings, and then click View/Edit Registers.

Or use the Register Settings Center
In the Views area, click Registers.

2. Double-click the register where the printer is located.

3. Click the name of the printer, and then click Properties.

4. In the Receipt format box, select the receipt format that you want to use on this device.

To print gift receipts

Cashiers can print a gift receipt for every transaction if you make a simple change to your receipt format.

1. On the Settings menu, point to Registers, and then click Receipt Formats.

Or use the Register Settings Center
In the Views area, click Receipt Formats.

2. Double-click the receipt format that you want to modify.

3. On the Sales tab, scroll down to the Print Gift Receipt attribute.

4. In the Value column for that attribute, replace "False" with "True".
Can I have two receipt formats print from one register?
Yes, by using the “Ask cashier before printing” option to give your cashiers control over which documents print and on which printer. On a register with two printers, this allows you to use two receipt formats (one for each printer) on one register.

Can I print detailed sales tax information on receipts?
By default, the total sales tax assessed on a transaction will print on each receipt. You can also print the taxes assessed by individual tax authorities.

For more information...
Click Help in the Receipt Format window, Register window, or the Sales Tax window.

5  Click Save and Close.

To print itemized sales taxes on receipts

1  On the Settings menu, point to Store Settings, and then click Sales Taxes.

   Or use the Store Settings Center
   In the Views area, click Sales Tax.

2  Double-click the sales tax that contains the tax authorities you want to list on receipts.

3  Under Included tax authorities, select the box in the Receipt column for each tax authority that you want to list, and then click Save and Close on receipts.

4  Repeat Steps 2 and 3 for any other sales taxes that contain tax authorities that you want to list, and then click Save and Close.
Working with Line Display Messages

In this chapter

Understanding line display messages

Creating a line display message
  Create a new line display message
  Duplicate a line display message

Working with existing line display messages
  Modify a line display message
  Delete a line display message

Assigning a line display message to a device
You can use date and time formats in your line display messages to show the current date and time in a variety of arrangements on your line display devices. The following tables describe some of the most commonly used date and time formats and their results. When you create a line display message, type the formats that you want into their own line in the message, and then select the “Format as date/time” check box.

### All-in-one formats (predefined)

<table>
<thead>
<tr>
<th>Format</th>
<th>Example of result</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>4/6/2005</td>
</tr>
<tr>
<td>D</td>
<td>Wednesday, April 6, 2005</td>
</tr>
<tr>
<td>f</td>
<td>Wednesday, April 6, 2005 2:05 PM</td>
</tr>
<tr>
<td>F</td>
<td>Wednesday, April 6, 2005 02:05:08 PM</td>
</tr>
<tr>
<td>g</td>
<td>4/6/2005 2:05 PM</td>
</tr>
<tr>
<td>m</td>
<td>April 6</td>
</tr>
</tbody>
</table>

_A line display message_, sometimes called a pole display message, is text that appears on a piece of display hardware at the register. In most cases, the display is visible to the customer, so line display messages can be greetings, advertisements, or reminders of upcoming events at the store.

**Things to know**

- **Why do my predefined format results differ from some of those in the chart on the right?**
  
  Results of predefined formats will vary depending on the regional options in Control Panel on each register.
Are there other codes that I can use for time and date display? I don't see what I want to use in the tables on the right.

If the result you want is not listed in these tables, you can find other date and time codes on the Microsoft Developer Network (MSDN) Web site (Search keywords: .NET date and time formats)

<table>
<thead>
<tr>
<th>Combination formats (user-defined)</th>
<th>Example of result</th>
</tr>
</thead>
<tbody>
<tr>
<td>M/d/yy</td>
<td>4/6/05</td>
</tr>
<tr>
<td>MM/dd/yyyy</td>
<td>04/06/2005</td>
</tr>
<tr>
<td>ddd MMM d, yyyy</td>
<td>Wed Apr 6, 2005</td>
</tr>
<tr>
<td>ddddd MMMM d, yyyy</td>
<td>Wednesday April 6, 2005</td>
</tr>
<tr>
<td>h:mm tt</td>
<td>2:05 PM</td>
</tr>
<tr>
<td>hh:mm:ss</td>
<td>02:05:08</td>
</tr>
</tbody>
</table>
Creating a line display message

To create a line display message

1. On the Settings menu, point to Register Settings, and then click Line Display Messages.

2. On the toolbar, click New.

3. Enter a name for this message.

4. Click Add to create a line in the message, and then click in the new line to begin entering your text.

5. If you want to apply an effect to this line, choose Blink or Scroll, and then set the timing for the effect, or if you don't want any effects, choose No effects.

6. To have the line interpreted as date and time coding, select the Format as date/time check box.

Things to know

Is there a minimum number of lines required for a line display message?

At least two lines are required for a line display message.

Why is my line display message blank?

If you create a line display message with blank lines and then select that message for a line display device, the line display device will be blank.

I set my line display message to scroll, but only the last line scrolls. Why?

Each line has separate controls. When you have finished the first line, select the line setting that you want for that line. Then, do the same for each successive line. All lines can have the same settings or all different settings, but you must set each line's settings individually.
7 Repeat Steps 4 through 6 for any additional lines you want to include in this message.

8 To save this line display message and begin entering another, click **Save and New**, or if this is the only line display message that you want to create, click **Save and Close**.

**To duplicate a line display message**

1 On the **Settings** menu, point to **Register Settings**, and then click **Line Display Messages**.

Or use the Register Settings Center

In the **Views** area, click **Line Display Messages**.

2 Select the line display message that you want to duplicate.

3 On the toolbar, click **Duplicate**.

4 Type a unique name for the message, make other changes as needed, and then click **Save and Close**.

Can I control the speed of the line display message’s effects, such as scrolling or blinking?

Use the “Effect delay” arrows on the Line Display Message window to adjust the speed of the effect you have chosen.

What displays if I do not designate a line display message?

It depends on what device that you have, but usually if no message is selected for the line display device, the date and time are displayed on the bottom line of the display.
Working with existing line display messages

To modify an existing line display message

1. On the Settings menu, point to Register Settings, and then click Line Display Messages.

Or use the Register Settings Center
In the Views area, click Line Display Messages.

2. Double-click the line display message that you want to modify.

3. Make your desired changes.

4. Click Save and Close.

To delete a line display message

1. On the Settings menu, point to Register Settings, and then click Line Display Messages.

Or use the Register Settings Center
In the Views area, click Line Display Messages.

2. Select the line display message that you want to delete.

3. On the toolbar, click Delete.

Things to know

I don’t want to delete the entire line display message that I already created. How do I delete just one of the lines?

Once you have entered a message, a Remove button displays. Select the line that you want to eliminate, and then click Remove to delete the line.

Can I add a new line to the bottom of a message that I created?

To add a new line to the bottom of the message, click Add in the Line Display Message window, and then click in the line to type your text.

For more information...

Click Help in the Line Display Message window.
Assigning a line display message to a device

To assign a line display message to a specific line display device

1. On the Settings menu, point to Register Settings, and then click View/Edit Registers.

   Or use the Register Settings Center
   In the Views area, click Registers.

2. Double-click the register where the line display device is located.

3. Under Selected devices, click the name of the device, and then click Properties.

4. Select the line display message that you want to appear on this device, and then click OK.

5. In the Register window, click Save and Close.

Things to know

After adding a new register, why can’t I make the register’s devices available?
Make sure that you have opened Point of Sale on the register at least once prior to trying to make the device available. The device is not known to the database before that.

I have devices listed in the Available devices box, but I am unable to access the properties for the device. Why?
Before you can modify its properties, the line display device must be one of the selected devices for the register.

For more information...

Click Help in the Line Register window.
In this chapter

Understanding task pads

Creating task pads
  Create a task pad
  Duplicate a task pad

Working with existing task pads
  Modify a task pad
  Delete a task pad
  Use colors in a task pad
  Assign a task pad to a role

Issuing gift cards from a task pad
  Add a Gift Card button to a task pad
  Set up one of the sample Issue Gift Card buttons on an existing task pad
A task pad is a custom button pad or task list that appears in the task pane in POS View. You can create custom task pads to meet the specific needs of your store. You might even decide to create a series of task pads that define workflows for your cashiers, making what they are supposed to do at the register easier and less ambiguous. You can even use different task pads for different employees by assigning a unique task pad to each employee role. You will find that task pads reduce keystrokes and speed up transaction time by giving cashiers faster access to the tasks that they use most often.

With task pads, you can customize Point of Sale to suit your inventory and procedures. The images on the next pages show three sample task pads that illustrate the flexibility that task pads can provide.

### Understanding task pads

A task pad is made up of task pad buttons, of which there are ten types. The following table describes each type and its purpose.

<table>
<thead>
<tr>
<th>This button type</th>
<th>Is used to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add customer</td>
<td>Quickly add a specific customer to a sales transaction.</td>
</tr>
<tr>
<td>Add item</td>
<td>Quickly add a specific item to a sales transaction.</td>
</tr>
<tr>
<td>External program</td>
<td>See if the buttons will run another program.</td>
</tr>
<tr>
<td>Internet link</td>
<td>Open an HTML page, either locally or on the Internet.</td>
</tr>
<tr>
<td>Issue gift card</td>
<td>Issue a gift card to a customer and apply value to the card.</td>
</tr>
<tr>
<td>Item list</td>
<td>Open a list of items in a specific department or category or from a specific supplier. Open a list of all of your departments, categories, or suppliers. From there, you will have access to the items in those groups.</td>
</tr>
<tr>
<td>POS function</td>
<td>Perform one of the actions that are normally performed via the function menus in POS View.</td>
</tr>
<tr>
<td>Preset Discount</td>
<td>Apply a preset discount to the current line items in the transaction.</td>
</tr>
</tbody>
</table>
How does the Sample 1 task pad work?

The Quick Tasks task pad shown here contains two buttons that lead to other task pads. The Items by Department button is an item list button that opens the Departments task pad shown in Sample 2 below, and the Quick Payments button is a task pad link button that opens the Quick Payments task pad shown in Sample 3.

The www.microsoft.com button is an Internet link button that will open the Microsoft Web site, using the default Internet browser on the register.

The other buttons in this task pad are POS function buttons like those in the task pads provided with Point of Sale.

Can I link a button to another task pad if necessary?

Yes, if you select the Task Pad link” type button.

<table>
<thead>
<tr>
<th>This button type</th>
<th>Is used to</th>
</tr>
</thead>
<tbody>
<tr>
<td>Quick Payment</td>
<td>Total a transaction using a specific payment method and amount.</td>
</tr>
<tr>
<td>Task Pad link</td>
<td>Link to another task pad.</td>
</tr>
</tbody>
</table>

Sample 1 task pad—A mixture of button types
How does the Sample 2 task pad work?

An item list task pad like the one shown here can be automatically generated by Point of Sale. In the sample, we chose to list items by department, but you can also list items by category or supplier.

A department item list allows a cashier to “drill down” to the categories and items in the store. For example, if a cashier selects our Cosmetics department button, an automatically generated task pad appears that lists the categories in the Cosmetics department. From there, selecting a category button will bring up a list of all items in the category.

Note that Point of Sale automatically adds Back and Cancel buttons to the bottom of any task pad that is linked from the startup task pad.
How does the Sample 3 task pad work?

With the exception of the “Other payment” button, all of the buttons in this task pad sample are quick payment buttons. The "exact amount" buttons automatically total the amount of the sales transaction, using the payment method indicated. The green buttons tender the amount of cash shown. As you can see, quick payment buttons can save cashiers keystrokes and time.

The “Other payment” button is a POS function button. It will open the regular Payment list.
Creating task pads

To create a task pad

1. On the Settings menu, point to Register Settings, and then click Task Pads.

   Or use the Register Settings Center
   In the Tasks area, click New Task Pads.

2. On the toolbar, click New.

3. In the Name box, type a name for your task pad.
   This name will be visible to cashiers at the register.

4. In the Layout type box, select the layout for your task pad.

5. Set up the buttons in your task:
   a. Select a button in the preview.
   b. In the Button type box, select the type of button that you want this to be.
   c. Enter any specific information required by the button type.
      For example, click Browse to select an item number for an Add Item button, select the type of list you want to display for an Item List button, or specify the payment method and amount for a Quick Payment button.
   d. Specify captions for the button, and then specify the font and alignment for each caption. For some button types, you can select text (such as item description or...
Can I select text to put on my buttons?

For some button types, you can select text (such as item description or department name) that will be filled in automatically by Point of Sale.

I would like to link to my Web site and to the sites of suppliers and shippers from my main computer. Is that possible with a task pad?

Yes, by selecting the Internet link button type.

Can I add a button to my task pad that opens a list of the items in that department from a specialized register?

Yes, select the Item list option when creating your task pad.

For more information...

Click Help in the Task Pad and File Center windows.

department name) that will be filled in automatically by Point of Sale.

e Select the color of the button.

If you want an image to appear on the button, select Display an image, click Browse to locate the image file in File Center. (In File Center, select the image file, and then click Select.) To position the image on the button, click one of the Alignment buttons (except for 1x10 button pads, which cannot be aligned).

To display a border on button pads (except for 1x10 button pads, which cannot be bordered), select the Display border check box.

Repeat these steps for the other buttons in the task pad.
6 To save your task pad and begin entering information for another, click Save and New, or if this is the only task pad that you want to create, click Save and Close.

**To duplicate a task pad**

1 On the Settings menu, point to Register Settings, and then click Task Pads.

   ![Or use the Register Settings Center](image)
   In the Views area, click Task Pads.

2 Select the task pad that you want to duplicate.

3 On the toolbar, click Duplicate.

4 Enter a unique name for the task pad.
   This name will be visible to cashiers at the register.

5 Change other settings as needed.

6 To save your task pad and begin entering information for another, click Save and New, or if this is the only task pad that you want to create, click Save and Close.

**For more information...**

Click Help (?) in the Task Pad window.

**Having buttons on the task bar for my cashier’s most common tasks, such as creating a new customer or displaying a list, would save a lot of time. Which button type should I select to enable this on a task pad?**

You will want to select the POS function button type.

**Most of my customers pay by credit card. Which button type would enter the exact amount due into the payment box for credit cards?**

Use the Quick Payment button type.

**Most of my customers pay by credit card. Which button type would enter the exact amount due into the payment box for credit cards?**

Use the Quick Payment button type.
Working with existing task pads

To modify an existing task pad

1. On the Settings menu, point to Register Settings, and then click Task Pads.
2. Double-click the task pad that you want to modify.
3. Make any needed changes.
4. Click Save and Close.

To delete a task pad

1. On the Settings menu, point to Register Settings, and then click Task Pads.
2. Select the task pad that you want to delete.
3. On the toolbar, click Delete.

Caution
Before deleting a task pad, make sure that no other task pads are linking to it.

Things to know

Why don’t I see the task pad changes that I made at the registers?
Task pads need to be assigned to an employee role before they will appear. Also, your changes won’t be visible at registers that are using this task pad until the next time that Point of Sale is opened at the registers.

Why am I unable to delete a task pad?
A task pad can only be deleted if it is not currently assigned to a register.

Do I have to delete the current task pad to assign a new task pad to a register?
No, you can assign a new task pad without deleting the old one.

For more information...
Click Help in the Task Pad window.
**To use colors in a task pad**

1. On the **Settings** menu, point to **Register Settings**, and then click **Task Pads**.
2. Double-click the task pad that you want to modify.
3. In the task pad preview, select the button that you want to modify.
4. In the **Color** box, select the color that you want this button to use, or to select or define a color that is not listed, select **Custom**.
5. Repeat Steps 3 and 4 for any other buttons that you want to modify.
6. Click **Save and Close**.

**Important**
Click another button to save your settings.

**To assign a task pad to a role**

1. On the **Settings** menu, click **Role Settings**.
2. For each role, select the appropriate task pad from the list of roles.
3. Click **OK**.

---

**What colors should I use when creating a task pad?**

Assist employees with vision problems by choosing button colors that provide sufficient contrast with the caption color. You can also set up button color schemes that indicate the purposes of the buttons. For example, you could use one color for buttons that add an item to a transaction and another color for buttons that lead to another task pad.

**Why can’t I add color to my 1x10 task list?**

Color is not available for that size task pad only.

---

**For more information...**

Click Help in the Role Settings dialog box and in the Task Pad window.
Issuing gift cards from a task pad

The first procedure below describes how to add a gift card button to any task pad. The second procedure describes how to set up the Issue Gift Card buttons that are already present in the task pads provided with the blank and sample databases in Point of Sale.

**To add an Issue Gift Card button to a task pad**

1. On the **Settings** menu, point to **Register Settings**, and then click **Task Pads**.

   **Or use the Register Settings Center**
   In the **Views** area, click **Task Pads**.

2. Double-click the task pad that you want to modify.

   ![Cashier Task: Task Pad](image)

   **Note:**
   Things to know
   To issue gift cards, you need at least one task pad to have an Issue Gift Card button. Without an Issue Gift Card button, cashiers will not be able to offer gift cards to customers.
   An Issue Gift Card button cannot be set up until you have signed up with a gift card processor and set up a gift card payment method.

   **For more information...**
   Click Help in the Task Pad and File Center windows or click in the Advanced Options dialog box.
3 Select the task pad button that you want to set up for issuing gift cards.

4 In the **Button type** box, select **Issue gift card**.

5 In the **Gift card code** box, enter the code that you specified in the **Advanced Options** dialog box for the gift card payment method, or click **Browse** to choose from a list.

6 In the **Caption** boxes, select the captions that you want to appear on the face of the button. If you select (custom caption), replace that text in the **Caption** box with the text you want.

7 If desired, select the button color and choose an image to display on the button.

8 Click **Save and Close**.

**To set up one of the sample Issue Gift Card buttons on an existing task pad**

1 On the **Settings** menu, point to **Register Settings**, and then click **Task Pads**.

2 Double-click the task pad that you want to modify (see sidebar).
Why don’t my color choices show up on the buttons that I created?
You must click another button to save your choices first.

Why can’t I find the image that I want to use for an Issue Gift Card button?
You must first add it to File Center before you can add it to a button.

For more information...
Click Help in the Task Pad and File Center windows or click in the Advanced Options dialog box.

6 Select the Issue Gift Card task button.
7 Change the Button type to Issue gift card.
8 In the Gift card code box, enter the code that you specified in the Advanced Options dialog box for the gift card payment method, or click Browse to choose from a list.
9 In the Caption boxes, select the captions that you want to appear on the face of the button. If you select (custom caption), replace that text directly in the Caption box with the text that you want.
10 If desired, change the button color and choose an image to display on the button.

Important
Click another button to save your button settings.

11 Click Save and Close.
PART 4: INVENTORY MANAGEMENT

12

Working with Items

In this chapter

Creating items
  Create an item
  Duplicate an item
Creating serial numbers for items

Working with existing items
  View the list of items
  Modify an existing item
  Delete an item

Using the Inventory Wizard to modify multiple items

Importing information with the Import Wizard
Creating items

To create an item

1. On the Inventory menu, click Items.
2. On the toolbar, click New.

Or use the Inventory Center
In the Tasks area, click New Item.

3. On the General tab, type a unique item number and description for the item and, if needed, modify the bar code number that is automatically filled in for you.

Tip
Keep the item descriptions fairly short so that they will print properly on receipts.

Things to know

An item is a product sold by your store. It refers to actual physical items, of course, but it can also mean intangible products, such as services offered by your store or handling fees that you charge. Item records in Point of Sale contain a lot of information ranging from the most basic information, such as item number, to detailed quantity and pricing information, to settings that regulate how the item is ordered and sold.

There are three item types:

- **Standard** items are tracked in inventory and are usually assigned a department and category to assist in analyzing productivity and profits.

- **Noninventory** items, such as shipping charges or gift wrapping charges, are not tracked in inventory.

- **Serial numbered** items are inventory items that have one or more serial numbers assigned, such as bicycles.
4 In the **Item type** box, select the type of item that you want to create.

5 Type or select other information as needed.

6 To save this item and begin entering information for another, click **Save and New**, or if this is the only that you want to create, click **Save and Close**.

---

**Tip**

Entering information about the physical location of an item in the **Bin location** box on the **General** tab can speed up physical inventory counting.

---

**To duplicate an item**

1 On the **Inventory** menu, click **Items**.

---

**Or use the Inventory Center**

In the **Views** area, click **Items**.

2 Select the item that you want to duplicate.

3 On the toolbar, click **Duplicate**.

4 Type a unique item number and description for the new item.

5 Make any other desired changes.

6 To save this item and begin entering information for another, click **Save and New**, or if this is the only item that you want to create, click **Save and Close**.

---

**Are there item number requirements?**

A unique item number, up to 35 characters long, is required for each item. If your store uses a scanner, make sure your item numbers are at least 3 characters long, or they will not scan properly.

**What kinds of details should be entered in the Details 1, 2, and 3 box?**

Use these spaces to record additional item attribute information, such as size or color.

**Will the discounts associated with an item also be duplicated?**

To prevent inadvertent discounts, any discounts associated with an item are not duplicated in the new item.

---

**For more information...**

Click Help in the Item window.
Creating serial numbers for items

To create serial numbers for serial-numbered items:

1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to create serial numbers for.

3. Click the Serial Numbers tab.

4. Choose the number of serial numbers each of these items will have.

5. Click New.

6. Create a serial number or set of serial numbers manually by entering the numbers in the Serial number or prefix 1, Serial number or prefix 2, and Serial number or prefix 3 boxes, as appropriate, and then click OK.

   - or -

   Create several serial numbers automatically by following these steps:

   a. Use the Serial number or prefix 1, Serial number or prefix 2, and Serial number or prefix 3 boxes to enter any numbers or codes that you want to precede each serial number.

Things to know

A serial-numbered item can have up to three serial numbers. For example, a cell phone might have a serial or model number for the phone, a number for the SIM card, and a telephone number. When a serial-numbered item is added to a transaction, the cashier is prompted to enter each of the item's serial numbers.

If you want, you can require the first serial number for the item to be unique. In that case, for our example, you might want the telephone number to be the first serial number.

Only items of the serial-numbered type can have serial numbers.

How can I convert a standard item to a serial-numbered item?

To convert a standard item to a serial-numbered item, click the General tab, and then choose Serial numbered in the Item type box.
How can I delete a serial number that I don’t want?
On the Serial Numbers tab in the Item window, select the serial number that you want to delete, and then click Delete.

All of the new serial numbers have a status of “Available.”

How can I indicate “Sold” when an item is sold?
The status is automatically changed to Sold when the serial-numbered item is included in a sales transaction.

For example, if each serial number should start with JDX-04, enter that in the correct Serial number or prefix box.

b Select the **Automatically generate serial numbers** check box.

c In the **Number to create** box, specify the number of items you are creating serial numbers for.

d Check the box next to the **Auto-number S/N from** line for each serial number, and then type the correct starting number.

e Click **OK**.

**Caution**
If you specify a prefix (as described in Step 6a) but do not set a starting number, Point of Sale will use the prefix itself as the serial number for each serial number it creates. Be sure to set a starting number (as described in Step 7d).
Working with existing items

To view the list of items
- On the Inventory menu, click Items.

To modify an existing item
1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to modify.
3. Make the needed changes.
4. Click Save and Close

To delete an item
1. On the Inventory menu, click Items.
2. Select the item that you want to delete.
3. On the toolbar, click Delete.

Caution
Because of its effect on accounting integration and the transaction data included in reports and purchase histories, it is best to make your unused items inactive instead of deleting them.
Using the Inventory Wizard to modify items

Things to know

With the Inventory Wizard, you can modify information for a selection of items, all at one time. You can update item prices, price levels, sale prices and dates, and in-stock quantities. You can also assign sales taxes to items or make items active or inactive. You can choose to modify:

- All items in your store.
- Items in specific departments or categories.
- Items that meet certain filter criteria that you specify.
- Only those items that you choose.

With any of these options, the wizard prepares a list of items and displays it in the Inventory Wizard Results window. You can add or remove items, make changes to the values you've chosen to modify, export the item list, and finally choose to update the inventory information in your store database.

To modify multiple items using the Inventory Wizard

1. On the Inventory menu, click Inventory Wizard.
2. Follow the instructions in the wizard. When you click Finish on the final page of the wizard, the Inventory Wizard Results window will appear.
3. Take one or more of the following actions:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add items to the list</td>
<td>On the toolbar, click Add Items.</td>
</tr>
<tr>
<td>Remove an item from the list</td>
<td>Click the item, and then click Remove Items on the toolbar.</td>
</tr>
</tbody>
</table>
| Import new information into the item list | • On the toolbar, click Import.  
• Click Browse to select the import file.  
• Specify the type of file you are importing, and then click OK. |
| Export the item list to a text file | • On the toolbar, click Export.  
• Click Browse to locate the folder where you want to create the export file, type a name for the file, and then click Save.  
• Click OK. |
What happens when I import new information into the item list?
The existing contents will be overwritten. For a successful import, be sure that the imported file has the same columns and order as are shown in the Inventory Wizard Results window.

Where do I specify how I want to handle the rounding of prices?
When updating item prices, you can specify rounding options on the Round Prices page in the Inventory Wizard.

Can I review or change my settings before I click Finish?
Yes, click the Back button to review or change your settings on the previous wizard pages.

<table>
<thead>
<tr>
<th>Make changes to the item data</th>
<th>In the row for each item, click in a column with a column header that begins with <strong>New</strong>, such as <strong>New Item Price</strong>, and then type the new value.</th>
</tr>
</thead>
</table>

4. When you’re ready to update the information in your store database with the new values in the item list, click **Update Inventory** on the toolbar.

-or-

If you don’t want to update the database, close the window and discard the new values by clicking **Close** on the **File** menu.
Importing information with the Import Wizard

With the Import Wizard, you can import information from text files (usually .txt or .csv files) generated in another program, such as Microsoft Office Excel. The wizard enables you to import items, customers, suppliers, or physical inventory counts.

1. In the other program, save your file as a text file. This can usually be done by clicking **Save As** or **Export** on the **File** menu and then specifying the .txt or .csv file format in the **Save As Type** box.

2. In Manager View, on the **File** menu, click **Import Wizard**.

3. Follow the wizard instructions.

---

**Things to know**

**What kinds of files will the Import Wizard accept?**

In addition to tab-delimited and comma-separated files, the Import Wizard accepts files in which the columns of information are delimited (separated) by spaces or semicolons. It also accepts files with fixed-width columns.

**How can I assure that I get good import results?**

For best results, you will want to do a bit of research before you import. Become familiar with the type of information the Import Wizard requires and accepts, and make sure your import file is set up accordingly.

---

**Caution**

If you do a test run in the wizard to see the available options, avoid actually importing your test file into your store database by clicking **Cancel** on the Preview page of the wizard.

---

**For more information...**

Click Help on any of the Import Wizard pages. You might also want to do a test run in the wizard to see the options that are available.
In this chapter

Changing item numbers
Changing item information
Setting serial numbered options
Setting the bar code type for an item
Entering the bin location of an item
Controlling how items are sold
Changing item numbers

An item number is a unique code that identifies the item and enables you and your employees to look up the item quickly.

Even if your store doesn’t need complex item numbers, you might want to number your items so that they’ll be grouped (sorted) in useful ways in item lists, or include certain characters in certain item numbers so you can use report filters or the Find window to view information about those items.

In addition to the Point of Sale item numbers and bar code numbers, items can also have other numbers (aliases) associated with them.

**To change an item number**

1. On the **Inventory** menu, click **Items**.

   ![Or use the Inventory Center](image)
   
   In the **Views** area, click **Items**.

2. Double-click the item that you want to modify.

3. On the **General** tab, in the **Item number** box, type the new item number.

   ![Caution](image)
   
   Your item numbers must be at least three characters long, or they won’t scan properly.

4. Click **Save and Close**.

---

Things to know

Each item in your store database will have an item number. You can start numbering from 001 and count up from there, or you can set up a numbering scheme that conveys information about your items. The following diagram shows a segmented item number that does just that.

**KS-10039-A**

- Department
- Item Number
- Supplier
- Category

An item number can be up to 35 characters long.

**For more information…**

Click Help (?) in the Item window.

---

Working with Items
Changing item information

Custom information for each item is grouped together on the General tab.

To change item information

1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to modify.

3. On the General tab, take one or more of the following actions:
   - In the Description box, type a new, brief description of the item.
   - In the Extended description box, type a different or longer description of the item.
   - In the Detail line 1, Detail line 2, and Detail line 3 boxes, type whatever attributes you have chosen to track.
   - In the Notes box, type any item reminders.

4. Click Save and Close.

Things to know

An item’s custom information includes:

- **Description.** Enter basic information about the item, such as brand name and model. Keep descriptions fairly short so they will print properly on receipts.

- **Extended description.** Enter more comprehensive information about the item. For example, you might want to use abbreviations in the description that could be spelled out in the extended description.

- **Detail lines 1, 2, and 3.** Use to record information such as size, style, color, or other miscellaneous item attributes.

- **Notes.** Use for special item reminders or records.

Can I find an item with this item information by using the Find command?

Yes, you can use any of this information to locate items.

Tip

You can display this information when the item is added to a transaction at the register. On the Settings menu, point to Store Settings, and then click Options.
Setting serial number options

Things to know

Use the following information to make your serial number selections for Step 3.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow serial number creation at the register</td>
<td>Allows cashiers to create serial numbers as they sell a serial-numbered item.</td>
</tr>
<tr>
<td>Require serial numbers when receiving inventory</td>
<td>Requires the person receiving inventory to specify serial numbers for all serial-numbered items.</td>
</tr>
<tr>
<td>Require unique serial numbers</td>
<td>Requires each serial number for an item to be unique for Serial Number 1 for each item.</td>
</tr>
</tbody>
</table>

For more information...
Click Help (?) in the Options dialog box.

1. On the Settings menu, point to Store Settings, and then click Options.

Or use the Store Settings Center
In the Views area, click Store Options

2. Click the Serial Numbers tab.

3. Select the options that will best meet your needs. See the table at the left for further explanation.

4. To save your changes, click OK.
Setting the bar code type for an item

When it comes to ringing up sales, Point of Sale will accept virtually any bar code that can be scanned by your scanners. If you need to print your own item labels, though, you will need to select one of the bar code types described in the following table. Be sure to select a type that is supported by your label printer.

<table>
<thead>
<tr>
<th>Bar Code Type</th>
<th>Typical Uses</th>
</tr>
</thead>
<tbody>
<tr>
<td>Codabar</td>
<td>Used in specialized applications, such as blood banks and libraries</td>
</tr>
<tr>
<td>Code 128</td>
<td>Full ASCII bar code used in a variety of applications</td>
</tr>
<tr>
<td>Code 39</td>
<td>Very commonly used, good for inventory tracking, also called &quot;Code 3 of 9&quot;</td>
</tr>
<tr>
<td>Code 93</td>
<td>Used when very small symbols are desired</td>
</tr>
<tr>
<td>EAN 128, 13, 13 Plus 2, 13 Plus 5, 8, 8 Plus 2, 8 Plus 5</td>
<td>Used for retail product labeling outside of the United States, with EAN 13 being the standard</td>
</tr>
<tr>
<td>Extended 39</td>
<td>Similar to Code 39 with support for all 128 ASCII characters, scanners may need to be switched to extended mode</td>
</tr>
<tr>
<td>Extended 93</td>
<td>Similar to Code 93 with support for all 128 ASCII characters</td>
</tr>
<tr>
<td>Interleaved 2 of 5</td>
<td>Numeric only, used in the shipping and medical industries, on game tickets, and on master cartons in retail</td>
</tr>
<tr>
<td>MSI Plessey</td>
<td>Numeric only, used in libraries and for retail grocery shelf marking</td>
</tr>
<tr>
<td>PostNet</td>
<td>Used for mailing applications, such as coding bulk mail and other envelopes</td>
</tr>
</tbody>
</table>

Things to know

A *bar code* is a series of lines and spaces that represent numbers or characters. There are many types of bar codes, also called *symbologies*, with more being created every day. The type you use in your store will depend on several factors, including the equipment you have, the type of merchandise you carry, and whether or not you will be printing your own item labels.

What would you recommend as a bar code type if I am not concerned with hardware or other considerations?

If hardware or other considerations don’t apply in your situation, Microsoft recommends the use of Code 128 or Code 39 bar codes.
Do I need to use a bar code type?
You only need to select a bar code type if you will be printing your own item labels.

How do I know what type of bar code is right for my store?
The type of bar code that is right for your store will depend on the item numbers that you are using (such as the bar codes applied to items by suppliers or manufacturers) and on the types of bar codes supported by your scanners. If you are using your own item numbering scheme, Microsoft recommends the use of Code 128 or Code 39 bar codes.

For more information...
Click Help in the Item window.

<table>
<thead>
<tr>
<th>Bar Code Type</th>
<th>Typical Uses</th>
</tr>
</thead>
<tbody>
<tr>
<td>RM4SCC</td>
<td>Used for mail sorting in the United Kingdom, also called &quot;Royal Mail&quot;</td>
</tr>
<tr>
<td>Standard 2 of 5</td>
<td>Numeric only, mostly made obsolete by Interleaved 2 of 5</td>
</tr>
<tr>
<td>UPC A, A Plus 2, A Plus 5</td>
<td>Used for retail product labeling, only in the United States and Canada</td>
</tr>
<tr>
<td>UPC E</td>
<td>Designed to fit into the EAN code system, allows EAN codes to be read in the United States and Canada</td>
</tr>
</tbody>
</table>

To set the bar code type for an item
1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to modify.
3. Click the Options tab.
4. In the Bar code type box, select the bar code type that you want to use.
5. Click Save and Close.
Entering the bin location of an item

To enter the bin location of an item

1. On the Inventory menu, click Items.

2. Double-click the item that you want to enter a bin location for.

3. In the Bin location box on the General tab, enter the item's physical location in your store.

4. Click Save and Close.

Things to know

What is a bin location?
Point of Sale provides a place for you to record the bin location of each item. This is a name, number, or code that tells you where in your store the item is physically located. It can refer to a bin, shelf, refrigerator case, area in your store, or any other location that meets your needs.

For more information...
Click Help in the Item window.
Controlling how items are sold

To control the way specific items are sold

1. On the Inventory menu, click Items.

2. Double-click the item that you want to modify.

3. Click the Options tab.

4. Select or clear the options that are appropriate for this item.

5. Click Save and Close.

For more information...

Click Help (?) in the Item window.
In this chapter

Changing item quantities
Changing the re-order and restock settings
Entering supplier-specific reorder information
  Update the supplier information for a specific item
  Entering supplier-specific reorder information
Changing item quantities

Point of Sale automatically adjusts item quantities when transactions are processed and inventory is received. Manager View provides a variety of ways to control these automatic adjustments and to manually change your item quantities.

To change the in-stock quantity for a specific item

1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item for which you want to update the quantity.

3. Click the Inventory tab.

4. In the In stock box, type the new quantity.

5. Click Save and Close.

Things to know

Can I manually adjust quantities in Point of Sale?

Although Point of Sale automatically adjusts item quantities when transactions are processed and when inventory is received, you can change the in-stock quantity on the Inventory tab of the Item window. Point of Sale records the change as a manual adjustment.

Where can I view the manual adjustments to in-stock quantities?

Manual adjustments to in-stock quantities can be displayed in the Item Movement Report by clicking Choose Columns in the report window toolbar, selecting Manual Adjustments, and then clicking OK.

For more information...

Click Help in the Item window.
Changing the reorder and restock settings _____

Things to know

What is the difference between the reorder point and the restock level?
The reorder point is the quantity at which an item should be ordered. The restock level is the target quantity for the item. You can use these settings in combination to automate your purchase ordering. For example, let us say that you have an item with a reorder point of 5 and a restock level of 50. When you use the Purchase Order Wizard to generate purchase orders based on reorder information, if this item’s in-stock quantity has fallen to 5, the item will be added to the order for its supplier with the ordered quantity set to 45 (the number of items needed to bring the in-stock quantity back up to 50).

For more information...
Click Help in the Item window.

To change the reorder and restock settings for a specific item

1. On the Inventory menu, click Items.

Or use the Inventory Center
In the Views area, click Items.

2. Double-click the item that you want to modify.

3. Click the Inventory tab.

4. In the Reorder point box, type the quantity that indicates the point at which you want to reorder the item.

5. In the Restock level box, type the quantity that you want to stock to when an order is placed.

6. Click Save and Close.
Working with Aliases, Substitutes, and Tagalong Items

_ Entering supplier-specific reorder information_

**Things to know**

**What is meant by supplier-specific reorder information?**

Supplier-specific reorder information includes the supplier price, supplier item number, supplier tax rate information, and minimum order and master pack quantity requirements. There are two ways to update this information:

- By specific item
- By specific supplier

**Will supplier prices be automatically updated when we receive purchase orders?**

Depending on your store options, supplier prices will be updated automatically upon receiving the purchase orders.

---

For more information...

Click Help in the Supplier window.

---

**To update the supplier information for a specific item**

1. On the Inventory menu, click Items.

   **Or use the Inventory Center**
   In the Views area, click Items.

2. Double-click the item that you want to modify.

3. Click the Inventory tab.

4. Under Suppliers, update the information in the Supplier Item No., Min. Order, MPQ, Supplier Price, and Tax Rate columns for each of the item’s suppliers.

5. Click Save and Close.
To update the item information for a specific supplier

1. On the Inventory menu, click Suppliers.

2. Double-click the supplier that you want to modify.

3. Click the Items tab.

4. Update the information in the Supplier Item No., Min. Quantity, MPQ, Tax Rate, and Supplier Price columns for each of the supplier’s items.

5. Click Save and Close.

If I use the Purchase Order Wizard to create purchase orders based on reorder information, how are both the reorder and restock levels and the MPQ settings met?

When you use the Purchase Order Wizard to create purchase orders based on reorder information, the wizard used the minimum order and MPQ (master pack quantity) settings in conjunction with the item’s reorder point and restock level. For example, if an item has a restock level of 25 and an MPQ of 20, the wizard might have to set the order quantity at 40 (2 increments of the MPQ) in order to meet both requirements.

For more information...
Click Help in the Item window.
In this chapter

Creating and deleting an alias
   Create an alias for an item
   Delete an item alias

Adding and removing a substitute item
   Add a substitute item
   Remove a substitute item

Adding a tagalong item for an item
Creating and deleting an alias

To create an alias for an item

1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to create an alias for.

3. Click the Aliases tab, and then click New.

4. Type the alternate item number (characters) that you want to use as the alias, and then click OK.

   ![New Alias dialog box]

To delete an item alias

1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to delete an alias from.

3. Click the Aliases tab, click the alias that you want to delete, and then click Delete.

Things to know

Aliases are alternative or easier-to-remember versions of item numbers or descriptions. They are included in item searches at the register. Aliases are useful in searches for an item when the exact name is not known. For example, if an item's description is "Ball cap," but cashiers usually think of it as a "baseball cap," it helps to create an alias using the more common name. This allows the cashiers to search for "baseball cap" to view information or to add it to a transaction.

Aliases can also be used when the UPC code for an item has changed, but some items are in stock that use the old UPC code. When an item with an old UPC is scanned at the register, the old UPC is recognized as an alias for the item, and the item is added to the transaction correctly.

For more information...

Click Help in the New Alias dialog box.
Adding or removing a substitute item __________

Things to know

A substitute is an item that can be sold in place of another item. For example, if your store is running a special on one item and you can see that you are not going to have enough inventory to meet the demand for the item, you can set up a substitute item that can be offered to customers instead.

How can cashiers use substitute information?

With substitutes defined for an item, your cashiers can suggest alternate purchases when the item a customer is looking for is out of stock or cannot be located. Cashiers can view substitute items in POS View and add them to sales transactions.

For more information...

Click Help in the Add Items dialog box or click F1 at the register.

To add a substitute to an item

1. On the Inventory menu, click Items.

Or use the Inventory Center
In the Views area, click Items.

2. Double-click the item that you want to create a substitute for.

3. Click the Substitutes tab, and then click Add.

4. In the Add Items dialog box, select the item or items that you want to use as substitutes.
If I remove an substitute from an item will it delete the substitute item from the store database?
No, the item remains in the database.

5 Click Select.
   The item will be added to the Selected Items list.

6 When you have finished selecting substitutes, click OK.

7 Click Save and Close.

To remove a substitute item

1 On the Inventory menu, click Items.

2 Double-click the item that you want to remove a substitute from.

3 Click the Substitutes tab, click the substitute item that you want to remove, and then click Remove.

For more information...
Click Help in the Add Items dialog box or click F1 at the register.
Adding a tagalong item

To add a tagalong item

1. On the Inventory menu, click Items.

2. Double-click the item to which you want to add a tagalong item.

3. Click the Options tab.

4. Select the Tagalong item check box.

5. Click Browse, select the item that you want to use as the tagalong item, and then click OK.

6. In the Tagalong quantity box, type the quantity (more than zero) of tagalong items that should be included with this item.

7. Click Save and Close.

Things to know

What is a tagalong item?
A tagalong item is one that is automatically included in a transaction when another item is sold, such as items sold in sets like pajama tops and bottoms.

You can use tagalong items to offer bonus or gift-with-purchase items to your customers. You can also use tagalong items for collecting deposits on recyclable items such as bottles by creating a noninventory item for the deposit, with the deposit amount set as the price of the item, and then add it as a tagalong item to the recyclable item. When a customer brings an empty recyclable item back to your store, you process a return of the tagalong and refund the deposit.

Why am I having a problem finding the tagalong item that I want to add?
Before you can attach a tagalong item, the item must exist in your store database.
Managing Departments and Categories

In this chapter

Creating a department and its categories
  Create a department and its categories
  Create a category in an existing department
  Duplicate a department or category

Working with departments and categories
  Modify an existing department or category
  Delete a department or category
  Move a category to a new department

Assign an item to a department or category
Creating a department and its categories

To create a department and its categories

1. On the Inventory menu, click Departments.
2. On the toolbar, click New.
3. Type a unique code for the department, such as 600-BG-001PZ for Board Games.
4. Type a name for the department.
5. On the File menu, click Save.
6. To create a category in this department, click New.

Things to know

In a large store, the benefits of organizing inventory into departments and categories might seem obvious. For example, a department store might have a Juniors department, with categories within that department for Clothing, Accessories, Footwear, and Sleepwear.

Even small stores can take advantage of these benefits, though. For example, a wine shop owner might create departments for wine groups, such as Reds and Whites, with categories for varieties such as Cabernet and Riesling. Alternatively, the owner might prefer a department for each wine-producing region, such as Washington, Italy, and France, with categories for specific vineyards.

For more information...
Click Help in the Department and Category windows.
In what way does using departments and categories make my store run more smoothly?

Organizing your inventory into departments and categories can help cashiers locate items at the register, and it can also streamline your reporting.

When creating your departments and categories, keep in mind that the Inventory Wizard and other features in Point of Sale provide ways to automate tasks by department or category. For example, you can organize report data by department and category. This allows you to track sales and other information for very specific groups of items.

Can I use the same code for a category that I have already used in a different department?

No, each code must be unique.

7 In the **Category** window, type a name and unique code for the category, and then click **Save and Close**.

![Category window](image)

8 Repeat Steps 6 and 7 for any other categories.

9 To save this department and begin entering information for another, click **Save and New**, or if this is the only department that you want to create, click **Save and Close**.

**To create a category in an existing department**

1 On the **Inventory** menu, click **Categories**.

2 On the toolbar, click **New**.

3 Type a unique code for the category, such as "ACC" for accessories.

4 Type a name for the category.

5 Click **Browse**, select the appropriate department, and then click **OK**.
To save this category and begin entering information for another, click Save and New, or if this is the only category that you want to create, click Save and Close.

To duplicate a department or category

1. On the Inventory menu, click either Departments or Categories.

Or use the Inventory Center
In the Views area, click either Departments or Categories.

2. Select department or category that you want to duplicate.
3. On the toolbar, click Duplicate.
4. Type a unique code for the new department or category.
5. Make any other needed changes.
6. To save this department or category and begin entering information for another, click Save and New, or if this is the only department or category that you want to create, click Save and Close.

Is there a limit on the number of characters in a department or category code?
The code can contain a maximum of 17 characters.

Is there a limit on the number of letters in a department or category name?
A name can contain a maximum of 30 characters.

When I duplicate a department, will its categories and items also be duplicated?
When you duplicate a department, categories and items in the original department are not duplicated.

For more information...
Click Help in the Department and Category windows.
Working with departments and categories

Things to know

If I delete a department or category, will the items also be deleted?
When you delete a department, the items assigned to that department will not be deleted.
When you delete a category, the items assigned to that category will not be deleted. Instead, they will be assigned directly to the department to which the category belonged.

To modify an existing department or category

1. On the Inventory menu, click either Departments or Categories.

   Or use the Inventory Center
   In the Views area, click either Departments or Categories.

2. Double-click the department or category that you want to modify.

3. Make changes as needed.

4. Click Save and Close.

To delete a department or category

1. On the Inventory menu, click either Departments or Categories.

   Or use the Inventory Center
   In the Views area, click either Departments or Categories.

2. Select the department or category that you want to delete.

For more information...
Click Help in the Department and Category windows.
If I delete a department, are its categories also deleted?
Yes, if you delete a department, its categories are also deleted. The items assigned to the department and its categories will remain.

Can I delete a category from within the department it belongs to?
Yes, by doing the following: On the Inventory menu, click Departments, and then double-click the department. In the list of categories, select the one that you want to delete, and then click Delete.

To move a category to another department
1. On the Inventory menu, click Categories.

Or use the Inventory Center
In the Views area, click Categories.

2. Double-click the category that you want to move.

3. Click Browse.

4. Select the department to which you want to move the category, click OK, and then click Save and Close.

Caution
If you delete a department, it will be more difficult for you to generate reports on those items as a group.
Assigning an item to a department or category

Things to know

Can I assign an item to a category but not a department?
No, categories must be part of departments, but you can assign an item to a department without assigning it to a category.

I want to split one of my departments into two or more smaller departments. Can I move the categories and all of their items to these new departments?
Yes, you can move a category and all its items to another department if you need to create smaller departments.

For more information...

Click Help (?) in the Item window and Help (?) in the Departments and Categories dialog boxes.

To assign an item to a department or category

1. On the Inventory menu, click Items.

2. Double-click the item that you want to assign to a department or category.

3. Click the Browse button next to the Department box.

4. Select the correct department, and then click OK.

5. Click the Browse button next to the Category box.

6. Select the correct category, and then click OK.

7. Click Save and Close.

Or use the Inventory Center
In the Views area, click Items.
PART 4: INVENTORY MANAGEMENT

17

Managing Supplier Information

In this chapter

Creating a supplier
  Create a supplier
  Duplicate a supplier
  Create suppliers by importing supplier information

Managing item information
  Manage item information for a supplier
  Update order information

Working with supplier information
  Modify an existing supplier
  Delete a supplier
  Set a minimum order amount for a specific supplier
In this chapter, continued

Contacting a supplier
  Send an e-mail message to a supplier from Manager View
  View a supplier’s Web page
  Locate a supplier’s contact information
Creating a supplier

**To create a supplier**

1. On the Inventory menu, click Suppliers.
2. On the toolbar, click New.

**Or use the Inventory Center**

In the Tasks area, click New Supplier.

3. On the General tab, type the supplier's name, a unique supplier code, and other supplier information.

**Things to know**

Point of Sale allows you to store basic contact information for your suppliers. You can also print address labels for suppliers, send them e-mail messages, and view their Web sites from within Point of Sale.

With the Import Wizard, you can import supplier information from text files (usually .txt or .csv files) generated in another program, such as Microsoft Office Excel.

What is meant by a unique supplier code?

The code can contain numbers and letters, with a maximum of 17 characters and should be a logical and easily recognized number or letters, such as, "NT" for Northwind Traders.

**Caution**

If you plan to integrate QuickBooks with Point of Sale, make sure to use the same supplier codes in both programs.

4. To save this supplier and begin entering information for another, click Save and New, or if this is the only supplier that you want to create, click Save and Close.
To duplicate a supplier

1. On the Inventory menu, click Suppliers.
2. Select the supplier that you want to duplicate.
3. On the toolbar, click Duplicate.
4. Type a unique code and name for the supplier.
5. Make other changes as needed, and then click Save and Close.

To create suppliers by importing supplier information

1. In the program where your supplier information is located, save your file as a text file. This can usually be done by clicking Save As or Export on the File menu and then specifying the .txt or .csv file format in the Save As Type box.
2. In Manager View, on the File menu, click Import Wizard.
3. Follow the wizard instructions.

Caution

If you do a test run in the wizard to view the available option, avoid actually importing your test file into your store database, by clicking Cancel on the Preview page of the wizard.

When I duplicate a supplier, are the items and reorder information also duplicated?

When you duplicate a supplier, the original supplier’s items and supplier-specific reorder information are not duplicated.

What kinds of files will the Import Wizard accept?

In addition to tab-delimited and comma-separated files, the Import Wizard accepts files in which the columns of information are delimited (separated) by spaces or semicolons. It also accepts files with fixed-width columns.

For more information...

Click Help in the Supplier window or any of the Import Wizard pages.
Managing Supplier Information

Managing item information for a supplier

To manage item information for a supplier

1. On the Inventory menu, click Suppliers.
2. Double-click the supplier that you want to modify.
3. Click the Items tab.
4. Take one or more of the following actions:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add items to the supplier</td>
<td>On the toolbar, click <strong>Add Items</strong>, select the item or items that you want to associate with this supplier, and then click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Set supplier-specific reorder information for a listed item</td>
<td>Click in the appropriate column in the row for a specific item. Enter the supplier’s item number, minimum order quantity, master pack quantity, tax rate, and price.</td>
</tr>
<tr>
<td>Remove an item from the supplier</td>
<td>Select the item that you want to remove, and then click <strong>Remove Items</strong>.</td>
</tr>
</tbody>
</table>

**Important**
Removing an item from a supplier eliminates the association between the item and the supplier, including any reorder information.
Several of my suppliers offer discounts if I meet a certain minimum order. How can I use Point of Sale to help me with this?

If a supplier requires a minimum order amount or offers a discount when a certain minimum is met, you can record that minimum order amount in Point of Sale. To set a minimum order quantity for each of the supplier’s items, you can set supplier-specific reorder information. Refer to this information to make sure your purchase orders meet the supplier’s minimum requirements. In the Supplier window in the “Min. order amount” box, type the minimum dollar value, before tax, of an order placed with this supplier.

For more information...
Click Help in the Item and Supplier windows.

To update order information

<table>
<thead>
<tr>
<th>Item information for a specific supplier</th>
<th>Supplier information for a specific item</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 On the Inventory menu, click Suppliers.</td>
<td>1 On the Inventory menu, click Items.</td>
</tr>
<tr>
<td>2 Double-click either the supplier or the item that you want to modify.</td>
<td>3 Click the Items tab.</td>
</tr>
<tr>
<td>3 Click the Items tab.</td>
<td>3 Click the Inventory tab.</td>
</tr>
<tr>
<td>4 Update the information in the Supplier Item No., Min. Quantity, MPQ, Tax Rate, and Supplier Price columns for each of the supplier’s items or each of the item’s suppliers.</td>
<td></td>
</tr>
<tr>
<td>5 Click Save and Close.</td>
<td></td>
</tr>
</tbody>
</table>
ManagingSupplier Information

Working with supplier information

**To modify an existing supplier**

1. On the **Inventory** menu, click **Suppliers**.
2. Double-click the supplier that you want to modify.
3. Make the needed changes, and then click **Save and Close**.

**To delete a supplier**

1. On the **Inventory** menu, click **Suppliers**.
2. Select the supplier that you want to delete.
3. On the toolbar, click **Delete**.

**Caution**

Deleting a supplier also removes the association between that supplier and its items, including reorder information. The items themselves are not deleted.

**To set a minimum order amount for a specific supplier**

1. On the **Inventory** menu, click **Suppliers**.
2. Double-click the supplier that you want to modify.
3. In the **Min. order amount** box, type the minimum dollar value, before tax, of an order placed with this supplier, and then click **Save and Close**.

---

**Things to know**

Does deleting a supplier, affect accounting integration?

Yes, for example, suppliers (vendors) cannot be deleted from Microsoft Office Accounting Professional 2007 if they are already associated with a purchase order or other accounting record.

Can I delete a supplier if it is listed in an open or partially received purchase order?

You should never delete a supplier if it is listed in an open or partially received purchase order.

For more information...

Click Help in the Supplier window.
Contacting a supplier

Things to know

Can I send an e-mail message to a supplier from within Point of Sale?
Yes, Point of Sale makes it easy for you to do this from the Supplier window. See instructions on the right.

Why do I need the supplier’s Web page?
You may need to research items or other information from time to time. Point of Sale provides a link directly from the Supplier window. See instructions on the right.

To send an e-mail message to a supplier from Manager View

1. On the Inventory menu, click Suppliers.
2. Double-click the supplier that you want to contact.
3. If you haven’t already done so, type the supplier’s e-mail address in the E-mail box.
4. On the Actions menu, click Send E-mail, or click the E-mail button next to the E-mail box.
5. Compose and send the e-mail message as you normally would.

To view a supplier’s Web page

1. On the Inventory menu, click Suppliers.
2. Double-click the supplier whose Web page you want to view.
3. If you haven’t already done so, type the supplier’s Web address in the Web page box.
4. Click the Web page button next to the Web address.

To locate a supplier’s contact information

1. On the Inventory menu, click Suppliers.
2. Double-click the supplier that you want to contact.
PART 4: INVENTORY MANAGEMENT

18

Managing Item Messages

In this chapter

Creating an item message
  Create an item message
  Duplicate an item message

Working with existing item messages
  Modify an existing item message
  Delete an item message
  Add an item message to an item
Creating an item message

An item message is a reminder to your cashiers to take a certain action when they sell a specific item.

To create an item message

1. On the Inventory menu, click Item Messages.
2. On the toolbar, click New.
3. Type a title for the message.
4. If this message involves an age restriction, type the minimum age in the Age limit box.
5. Type the text of the message in the Message box.
6. To save this item message and begin entering information for another, click Save and New, or if this is the only item message that you want to create, click Save and Close.
To duplicate an item message

1. On the Inventory menu, click Item Messages.
2. Select the item message that you want to duplicate.
3. On the toolbar, click Duplicate.
4. Type a unique title for the message and modify the other settings as needed.
5. To save this item message and begin entering information for another, click Save and New, or if this is the only Item message that you want to create, click Save and Close.

Things to know

Are there any special considerations for item message titles?
Since the title will be visible to your cashiers, it should be no more than 30 characters and contain text that is meaningful to them, such as "Battery Reminder" or "Age Restriction for Alcohol."

What should my item messages include?
Your item message can be up to 255 characters. It is best to limit the message to only the essentials that the cashier needs to know to up-sell extras like batteries or to remind them of the age or other restrictions on certain items, such as guns, ammunition, explosives, tobacco, and alcohol.
Working with existing item messages

Things to know

If I delete an item message will it affect all items to which this message has been added?
Yes, items that used to prompt cashiers to take some action will no longer do so.

For more information...
Click Help in the Item Message window.

To modify an existing item message
1. On the Inventory menu, click Item Messages.
2. Double-click the item message that you want to modify.
3. Make changes as needed.
4. Click Save and Close.

To delete an item message
1. On the Inventory menu, click Item Messages.
2. Select the item message that you want to delete.
3. On the toolbar, click Delete.

Caution
Cashiers may not see a reminder to verify restrictions on an item if an item message is deleted.

Managing Item Messages  203
To add an item message to an item

1. On the Inventory menu, click Items.

   ![Image](image.png)

   Or use the Inventory Center
   In the Views area, Items.

2. Double-click the item to which you want to add an item message.

3. Click the Options tab.

4. In the Item message box, select the item message that you want to add to this item.

5. Click Save and Close.

Will the [DATE] code for item messages restricting the sale of items by age need to be changed every year?

When you create the item message, you specify the minimum age of the customer, and then insert a [DATE] code into the message that Point of Sale uses to generate the last birth date that satisfies the specified minimum age.

For example, for an alcoholic item, you might specify a minimum age of 21 and then, in the text of the item message, include the [DATE] code, like this:

   The customer can purchase this item if born on or before [DATE].

Why can’t I add an item message to an item?

You probably haven’t added the item message to the store database yet.
Managing Purchase Orders, Inventory Transfers, and Item Receipts

In this chapter

Understanding orders
Creating purchase orders and inventory transfers
Creating an item receipt
Working with existing orders
  Modify an existing order
  Delete an order
Export an order to a file or another program
Specify a different delivery address for an order

In this chapter, continued

Mark a purchase order or inventory transfer as placed
Send purchase order in an e-mail message

Applying a formula to the information in an order
Viewing orders
Setting purchase order options
Receiving orders
Closing an order without receiving
Issuing inventory transfers
Generating inventory reports
Printing labels for received inventory
Understanding orders

**Purchase Orders.** The flexibility and features offered by Point of Sale can accommodate a variety of purchase ordering processes. You can continue your current system — perhaps replacing some manual steps with Point of Sale automation — or you can start from scratch, taking full advantage of the features in Point of Sale to streamline your ordering.

For example, some managers might prefer to do all of their ordering over the Internet or by phone, only entering order information into Point of Sale when an order is received. Others might want to manage every aspect of ordering, from creating the order to printing labels for the items received, from within Point of Sale. Point of Sale easily accommodates either of these approaches, or something in between.

Here is an overview of purchase ordering in Point of Sale:

1. Create a purchase order, either manually or by using the Purchase Order Wizard

   With the Purchase Order Wizard, you can create purchase orders automatically, based on stock levels or recent sales.

2. Mark the order as placed, then send the order to the supplier

3. When the order comes in, receive the order using an item receipt

Orders can be received in either POS View or Manager View.

Powerful features such as item scanning and on-the-fly addition and pricing of ordered or received items give you maximum efficiency.
How much of the Point of Sale purchase order or inventory transfer process do I need to adopt for my store?

The flexibility and features offered by Point of Sale can accommodate a variety of purchase ordering and inventory transferring processes. You can continue your current system, perhaps replacing some manual steps with Point of Sale automation, or you can start from scratch, taking full advantage of the features in Point of Sale to streamline your ordering and transferring. For example, some managers might prefer to do everything over the Internet or by phone, only entering order or transfer information into Point of Sale when an order is received. Others might want to manage every aspect of ordering, from creating the order to printing labels for the items received, from within Point of Sale. Point of Sale easily accommodates either of these approaches, or something in between.

**Inventory Transfers.** You can use inventory transfers to move inventory into and out of your store without processing sales or purchase orders. This is most commonly done when transferring inventory from one store to another, but you might also use inventory transfers to return stock to a supplier, to move stock into the store from a storage or distribution facility, or to move seasonal or damaged stock out of the store.

The inventory transfer window has three modes. The available toolbar buttons, menu commands, and summary fields (statistics) will vary depending on which mode you’re in. The inventory transfer modes are:

- **New** – The window will be in this mode when you create a new inventory transfer.
- **Edit** – The window will be in this mode when you modify an existing inventory transfer, or when you click the Edit button while issuing or receiving a transfer.
- **Issue/Receive** – The window will be in this mode when you are issuing an inventory transfer out or receiving an inventory transfer in. You can get to this mode from an inventory transfer that you are creating or editing by clicking the Issue or Receive button on the toolbar.
Creating orders

Things to know

Can I add an inactive or noninventory item to a purchase order or inventory transfer?

If you want to add an inactive or noninventory item to your purchase order, or if you want to order an item for which the “Item cannot be placed on purchase orders” option has been selected (on the item’s Options tab), you will first need to change the settings of the item.

What makes an effective title for a purchase order or an inventory transfer?

Some title is required for each purchase order or inventory transfer. Include dates or other information in your titles that help you remember the purpose of your purchase orders or inventory transfers.

To create a purchase order or inventory transfer

1. On the Inventory menu, point to Purchase Orders, and then click New Purchase Order.

2. On the General tab, type a unique number for this order and give it a title.

3. To select the appropriate supplier, click Order From.

4. Type your store’s address or another delivery address directly into the Ship To box, or click the Ship To button to select a customer.

5. Fill in other information as needed.

6. Click the Items tab, and then click Add Items.

Things to know

Can I add an inactive or noninventory item to a purchase order or inventory transfer?

If you want to add an inactive or noninventory item to your purchase order, or if you want to order an item for which the “Item cannot be placed on purchase orders” option has been selected (on the item’s Options tab), you will first need to change the settings of the item.

What makes an effective title for a purchase order or an inventory transfer?

Some title is required for each purchase order or inventory transfer. Include dates or other information in your titles that help you remember the purpose of your purchase orders or inventory transfers.
You can use the Purchase Order Wizard to create purchase orders or the Inventory Transfer Wizard to create inventory transfers quickly for:
- All items in your store.
- Items in specific departments or categories.
- Items that have reached their reorder points (stock levels that signal that ordering is necessary).
- Items from certain suppliers.
- Items that have been sold recently.
- Items that meet certain filter criteria that you choose.

With any of these options, the wizards add the appropriate items to purchase orders (one order per supplier included in your criteria) or inventory transfers, and opens them for you to review, modify as needed, place, and print.

For more information...

Click the Help button in the Purchase Order and Inventory Transfer windows.

Note

Purchase orders created in Point of Sale are not copied into Microsoft Office Accounting Professional 2007 during synchronization. If you prefer to have all of your purchase orders in that program, you can still use Point of Sale to receive inventory against those purchase orders. Create the purchase orders in Office Accounting, and then create an item receipt in Point of Sale. Associate the two by typing the purchase order number into the Accounting reference box in the item receipt. During synchronization, the item receipt is copied into Office Accounting and automatically associated with the Office Accounting purchase order.

7 In the Add Items dialog box, double-click each of the items that you want to order or transfer, specify the quantities that you are ordering or transferring, and then click OK.

8 To print the order or transfer, click Print on the toolbar.

9 To indicate that the order or transfer has been placed with the supplier, click Mark As Placed.

10 To save this purchase order or inventory transfer and begin entering information for another, click Save and New, or If this is the only purchase order or inventory transfer that you want to create, click Save and Close.
To create a purchase order or inventory transfer using wizards

- On the Inventory menu, point to Purchase Orders, and then click Purchase Order Wizard, or on the Inventory menu, point to Inventory Transfers, and then click Inventory Transfer Wizard.

To duplicate a purchase order or inventory transfer

1. On the Inventory menu, point to Purchase Orders or Inventory Transfers, and then click View/Edit Purchase Orders or View/Edit Inventory Transfers.

2. Click the purchase order or inventory transfer that you want to duplicate.

3. On the toolbar, click Duplicate.

4. Change the order number and title, and make any other changes that are needed to customize the order to your current situation.

5. To save this order and begin entering information for another, click Save and New, or if this is the only order that you want to create, click Save and Close.

Why didn’t the Purchase Order Wizard or Inventory Transfer Wizard create a purchase order and inventory transfer?

The wizard only creates an order if it determines there is inventory meeting the criteria that you entered into the wizard.

How does wizard handle the minimum quantity and master pack quantities (MPQ) options?

If you previously specified a minimum quantity, the wizard will order the minimum order quantity, even if it is greater than the minimum required to bring the item’s in-stock quantity up to the restock level.

If you previously specified a master pack quantity, the wizard will order the smallest multiple of the MPQ that will bring the item’s in-stock quantity up to the restock level. For example, if the item has a restock level of 25 and an MPQ of 20, the wizard might have to set the order quantity at 40 in order to meet both requirements.
Creating an item receipt

1. On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.

2. Double-click the purchase order that you want to receive.

3. On the toolbar, click Receive.

An item receipt will open that contains information for all of the items in the purchase order.

4. Enter the received quantities by typing quantities in the Received column.

For more information...

Click the Help button in the Purchase Order and Item Receipt windows.
To save the item receipt so that you can make changes to it later, click **Save and Close**.

**To create an item receipt from a purchase order when receiving an entire order**

1. On the **Inventory** menu, point to **Purchase Orders**, and then click **View/Edit Purchase Orders**.

   **Or use the Inventory Center**
   
   In the **Views** area, click **Purchase Orders**.

2. Double-click the purchase order that you want to receive.

3. On the toolbar, click **Receive**.
   
   An item receipt opens that contains information for all of the items in the purchase order.

4. On the toolbar, click **Receive All**.
   
   The quantities in the **Received** column will be updated to match the quantities in the **Order Qty**. column.

5. To update the quantities in your database, click **Update Inventory**.

For more information... Click the Help button in the Purchase Order and Item Receipt windows.
To create an item receipt from the main window in Manager View

1. On the Inventory menu, click Item Receipts.
2. On the toolbar, click New.
3. In the Delivery date box, type or select the date that the order was received or entered, depending on your store policy.
4. In the Item receipt number box, enter a unique number for this item receipt, or decide to use the number that has been pre-filled.
5. In the Reference number (or Accounting reference number) box, enter any information you want recorded with this item receipt, such as the Office Accounting purchase order number.
6. Click the Browse button next to the Supplier box to select the supplier who sent the items or leave it blank if you prefer.
7. Click the Browse button next to the Purchase order number box to select the purchase order for the shipment or leave this box blank.

Or use the Inventory Center
In the Views area, click Item Receipts.

How do I add an inactive or noninventory item to the item receipt or receive an item for which the “Item cannot be placed on purchase order” option has been selected?
In the Add Items dialog box, click Quick Scan, enter the item number, and then click Accept.

What happens to the status of the purchase order when I update the inventory?
Updating the inventory will close the item receipt and, if one is associated, change the status of the purchase order to Partial or Closed, as appropriate.

Can I accept inventory from a supplier who is not yet in the database?
If the supplier who sent the items does not yet exist in the store database, you must create the supplier record before you can associate it with the item receipt.
If applicable, take one or more of the following actions:

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add items to the item receipt</td>
<td>On the toolbar, click <strong>Add Items</strong>. In the <strong>Add Items</strong> dialog box, double-click each of the items received, specify the quantities received, and then click <strong>OK</strong>.</td>
</tr>
<tr>
<td>Create a new item and add it to</td>
<td>On the toolbar, click <strong>Add Items</strong>, and then click <strong>New</strong>.</td>
</tr>
<tr>
<td>the item receipt</td>
<td></td>
</tr>
<tr>
<td>Receive items using a scanner</td>
<td>On the toolbar, click <strong>Add Items</strong>, and then click <strong>Quick Scan</strong>.</td>
</tr>
<tr>
<td>Indicate that the ordered</td>
<td>On the toolbar, click <strong>Receive All</strong>.</td>
</tr>
<tr>
<td>quantities for all items have</td>
<td></td>
</tr>
<tr>
<td>been received</td>
<td></td>
</tr>
<tr>
<td>Enter or change the received</td>
<td>Click the box in the <strong>Received</strong> column for the item, and then type the received quantity.</td>
</tr>
<tr>
<td>quantity for an individual item</td>
<td></td>
</tr>
<tr>
<td>Enter or select serial numbers</td>
<td>Click the box in the <strong>Received</strong> column for a serial-numbered item, and then click the magnifying glass.</td>
</tr>
</tbody>
</table>

**Do I use an item receipt when receiving inventory on an inventory transfer in?**

Item receipts are not used when you receive an inventory transfer.

**Some items that I received are not in the Add Items list. Why is that? How do I remedy the situation?**

If an item has since been barred from being placed on purchase orders, or if it has since been marked as inactive, it will not be available in the Add Items dialog box. Instead, type the received quantity in the Received column in the Item Receipt.

**For more information...**

Click the Help button in the Item Receipt window.
Can I save a partially completed item receipt?
The Item receipt number box is the only required field in the item receipt. This means that at any point after entering the item receipt number, you can save the item receipt and work on it later. To do so, click Save and Close on the toolbar.

For more information...
Click the Help button in the Item Receipt window.

11 To save this item receipt and begin entering information for another, click Save and New, or if this is the only item receipt that you want to create, click Save and Close.
To duplicate an item receipt

1. On the Inventory menu, click Item Receipts.
2. Click the item receipt that you want to duplicate.
3. On the toolbar, click Duplicate.
4. If needed, change the order number and make any other changes that are needed to customize the item receipt to your current situation.
5. To save this item receipt and begin entering information for another, click Save and New, or if this is the only item receipt that you want to create, click Save and Close.

Can I order information into an item receipt automatically?
Yes, when you select a purchase order by clicking the Browse button next to the “Purchase order number” box.

How do I clear the current purchase order number and items in a duplicate item receipt?
You can clear the contents by clicking the Eraser button located to the right of the “Purchase order number” box.

For more information...
Click the Help button in the Item Receipt window.
## Working with existing orders

### Things to know

**Why can’t I update my closed purchase orders?**

Unless the “Allow edit of closed purchase orders” option has been selected in the Options dialog box, available from the Settings (then Store Settings) menu, you can only modify open purchase orders. Use caution, however, if the order is open but has already been placed (sent to the supplier), because your changes will not appear in the placed order.

**How can I remove items from a purchase order, inventory transfer, or item receipt?**

Select the item in the list, and then click Remove Selected Items on the toolbar.

<table>
<thead>
<tr>
<th>To modify...</th>
<th>A purchase order</th>
<th>An inventory transfer</th>
<th>An item receipt</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.</td>
<td>On the Inventory menu, point to Inventory Transfers, and then click View/Edit Inventory Transfers.</td>
<td>On the Inventory menu, click Item Receipts.</td>
</tr>
<tr>
<td>2</td>
<td>Double-click the purchase order, inventory transfer, or item receipt that you want to modify.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>Make changes as needed</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>Click <strong>Save and Close</strong>.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Why can’t I delete a purchase order?
Only open purchase orders—orders where no goods have yet been received—can be deleted. Partially received purchase orders can be closed instead.

Can I export a purchase order, inventory transfer, or item receipt that can be read by Microsoft Office Word or Internet Explorer?
Yes, you can export all of them.

To delete...

<table>
<thead>
<tr>
<th>A purchase order</th>
<th>An inventory transfer</th>
<th>An item receipt</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 On the Inventory menu, point to Purchase Orders, and then click Purchase Orders.</td>
<td>On the Inventory menu, point to Inventory Transfers, and then click View/Edit Inventory Transfers.</td>
<td>On the Inventory menu, click Item Receipts.</td>
</tr>
<tr>
<td>2 Select the purchase order, inventory transfer, or item receipt that you want to delete.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 On the toolbar, click Delete X.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

To export a file to another program...

<table>
<thead>
<tr>
<th>A purchase order</th>
<th>An inventory transfer</th>
<th>An item receipt</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.</td>
<td>On the Inventory menu, point to Inventory Transfers, and then click View/Edit Inventory Transfers.</td>
<td>On the Inventory menu, click Item Receipts.</td>
</tr>
<tr>
<td>2 Double-click the purchase order, inventory transfer, or item receipt that you want to export.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Since only the customer’s primary address is available in the purchase order, how can I ship to a customer’s shipping address?

If you want the order to go to one of the customer’s shipping addresses, you will have to type the address into the Ship To box or change the customer’s primary address.

3 On the File menu, point to Export, point to the type of export that you want to perform, and then click the appropriate file format.

To specify a different delivery address for...

<table>
<thead>
<tr>
<th>A purchase order</th>
<th>An inventory transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.</td>
<td>On the Inventory menu, point to Inventory Transfers, and then click View/Edit Inventory Transfers.</td>
</tr>
<tr>
<td>2 Double-click the purchase order or inventory transfer that you want to modify.</td>
<td></td>
</tr>
<tr>
<td>3 Type the address directly into the Ship To box, or click the Ship To button to select a customer.</td>
<td>To change the address that you are transferring from, type the address directly into the Transfer From box. -or- To change the address that you are transferring to, type the address into the Transfer To box, or if this is an inventory transfer out, click the Transfer To button to select a supplier.</td>
</tr>
</tbody>
</table>
When should I mark inventory transfers as placed?
It depends on whether it is a transfer in or a transfer out. An inventory transfer in should be marked as placed when it is sent or communicated to the store or other entity that will be sending inventory to your store. An inventory transfer out can be marked as placed right away.

Can I receive a purchase order or inventory transfer even if it has not been placed?
If you try to receive or issue an inventory transfer or receive a purchase order that has not been placed, Point of Sale will notify you of the problem. You can choose to receive or issue the order anyway.

<table>
<thead>
<tr>
<th>To mark as placed...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A purchase order</strong></td>
</tr>
<tr>
<td>1 On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.</td>
</tr>
<tr>
<td>2 Double-click the purchase order or inventory transfer that you want to modify or edit.</td>
</tr>
<tr>
<td>3 On the toolbar, click Mark As Placed.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To send in an e-mail message...</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>A purchase order</strong></td>
</tr>
<tr>
<td>1 On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.</td>
</tr>
<tr>
<td>2 Select the purchase order, inventory transfer, or item receipt that you want to send in e-mail.</td>
</tr>
<tr>
<td>3 On the File menu, point to Export, point to To an E-mail Message, and then click the file format that you want to use.</td>
</tr>
</tbody>
</table>
How can I adjust the printout of my purchase order, inventory transfer, or item receipt?

Your first opportunity to make adjustments is in the Print Preview window, which displays when you click Print on the purchase order, inventory transfer, or item receipt toolbar. You may also make adjustments in the Printer Settings window, which you can reach from the Print Preview toolbar.

4. Enter a name for the file that will be embedded in or attached to the e-mail message, and then click Save.

5. In the e-mail message, type an e-mail address and send the message.

To print...

<table>
<thead>
<tr>
<th>A purchase order</th>
<th>An inventory transfer</th>
<th>An item receipt</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.</td>
<td>On the Inventory menu, point to Inventory Transfers, and then click View/Edit Inventory Transfers.</td>
<td>On the Inventory menu, point to Item Receipts.</td>
</tr>
<tr>
<td>2. Double click the purchase order, inventory transfer, or item receipt that you want to print.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3. On the toolbar, click Print.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4. To view or change the printer settings, click Printer Settings.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>5. Click Print if you are satisfied with the view.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>6. Specify the pages and the number of copies that you want to print, and then click OK.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Applying a formula to the information in an order

### Things to know

**How do I apply a formula to indicate that the supplier is offering a discount on certain items?**

By using the Apply Formula dialog box, you can indicate that the supplier is reducing the cost of certain items or all items. By applying the formula your cost will be reduced by the amount that you specified and for the items that you specified.

This option is only available if a value in an editable column is selected. The formula can be based on other information about the items.

**How can I round values when applying a formula to a tax rate?**

You can't because the options related to rounding calculated values are not available if you are applying a formula to a tax rate.

### To apply a formula to the information in...

<table>
<thead>
<tr>
<th>A purchase order</th>
<th>An inventory transfer</th>
<th>An item receipt</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong> On the <em>Inventory</em> menu, point to <em>Purchase Orders</em>, and then click <em>View/Edit Purchase Orders.</em></td>
<td>On the <em>Inventory menu, point to Inventory Transfers</em>, and then click <em>View/Edit Inventory Transfers.</em></td>
<td>On the <em>Inventory menu, point to Item Receipts.</em></td>
</tr>
<tr>
<td><strong>2</strong> Double click the purchase order, inventory transfer, or item receipt to which you want to apply a formula, and then click the <em>Items</em> tab.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>3</strong> If items have not yet been added to the order, transfer, or item receipt, click <em>Add Items</em>, double-click each of the items that you want to order, transfer, or receive, specify an order or received quantity for each item, and then click <em>OK.</em></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>4</strong> Click a box in the <em>Item Cost</em> or <em>Tax Rate</em> column where you want to apply a formula.</td>
<td>Click a box in the <em>Item Cost</em> or <em>Tax Rate</em> column where you want to apply a formula.</td>
<td>Click a box in the <em>New Price</em> or <em>Item Cost</em> column where you want to apply a formula.</td>
</tr>
</tbody>
</table>
Should I round by 1 my calculated prices? Is it better to round up or down or not at all when applying a formula?

If you want all your calculated prices to end in the same digits (such as .99, .95, .59, etc.), select the “Round calculated values to” option, and then type the amount to round to in the box. Click “Round values up” or “Round values down” to specify whether to round up or down.

If you don’t want to round your calculated prices up or down, select the “Do not round calculated value” option.

See the topic on “Understanding rounding and calculations” in Chapter 28, “Managing Your Prices and Costs” to help you make this decision.

For more information...

Click the Help button in the Apply Formula dialog box.

6 Click Apply Formula.

7 In the Apply Formula dialog box, enter information about the adjustment that you want to make.

8 Set your rounding options.

9 Choose to apply the formula to the selected box or to the entire column, and then click OK.

10 Review the results of the formula, and if you are not satisfied, you can make manual adjustments or revert to the previous values by closing the purchase order, item receipt, or inventory transfer without saving your changes.
Managing Purchase Orders, Inventory Transfers, and Item Receipts

Viewing orders

To view...

<table>
<thead>
<tr>
<th>A purchase order</th>
<th>An inventory transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong> On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders. Note the purchase order’s status in the Status column (Open, Closed, or Partial)</td>
<td>On the Inventory menu, point to Inventory Transfers, and then click View/Edit Inventory Transfers. Note the inventory transfer’s type in the Type column (In or Out).</td>
</tr>
<tr>
<td><strong>2</strong> Double-click the purchase order or inventory transfer that you want to view.</td>
<td></td>
</tr>
</tbody>
</table>

**Things to know**

Can I view only open purchase orders in the Purchase Orders list?

By sorting the Status column of the purchase order list, you can more easily locate the open purchase orders. You can sort the purchase order list by any column in the content pane. For example, you can easily locate all open purchase orders for a certain supplier, all orders placed on a certain date, and so on.
**Viewing the history of an order**

Where do I view the history of an item receipt?

It is included on the History tab with the associated purchase order.

After I placed a purchase order for an item, I marked the item as inactive. The item has now arrived but it is not listed in the Item Receipt window. How do I include it as received?

If an item was marked inactive after a purchase order was placed for the item, it will not be available in the Add Item dialog box accessed from the Item Receipt window. Instead, type the received quantity in the Received column of the item receipt itself. This is also true if an item was barred from being placed on purchase orders after the order was already placed.

---

**To view the history of a...**

<table>
<thead>
<tr>
<th>A purchase order (including item receipts)</th>
<th>An inventory transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong> On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.</td>
<td>On the Inventory menu, point to Inventory Transfers, and then click View/Edit Inventory Transfers.</td>
</tr>
<tr>
<td><strong>2</strong> Double-click the order or transfer that you want to view.</td>
<td></td>
</tr>
<tr>
<td><strong>3</strong> Click the <strong>History</strong> tab.</td>
<td></td>
</tr>
</tbody>
</table>

---

For more information...

Click the Help button in the Inventory Transfer window or the Purchase Order window.

---

4 To view the details of a specific item receipt, double-click the item receipt number.
### Setting purchase order options

To set purchase order options

1. On the **Settings** menu, point to **Store Settings**, and then click **Options**.

   ![Or use the Settings Center](image)

   **Or use the Settings Center**
   
   In the **Views** area, click **Store Settings**, and then click **Store Options**.

2. Click the **Inventory** tab.

3. Select or clear the options that are appropriate for your store.

4. To save your changes, click **OK**.

---

**Things to know**

Use options to control editing of closed purchase orders and the way in which supplier prices are updated when received.

Will my supplier prices from closed item receipts be automatically updated?

Only if you select the “Update supplier prices from item receipts” check box on the Inventory tab.

I prefer to manually update the Cost values. What settings provide for this?

You must select None for the Cost update method on the Inventory tab.
Things to know

When receiving a partial order, the Add Items and Receive Item dialog boxes offers some features worth noting for item receipts and inventory transfers:

- You can click “Items carried by” to view only those items carried by the supplier specified on the item receipt or inventory transfer.
- You can click Quick Scan to scan the items that you are receiving.
- You can enter received quantities directly in the Received column.

If an item in an inventory transfer or purchase order has since been marked as inactive, it will not be available in either the Add Items or Receive Items dialog box. Instead, type the received quantity in the Received column of the item receipt or inventory transfer.

<table>
<thead>
<tr>
<th>To receive...</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>An entire purchase order</td>
<td>An entire inventory transfer in</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.</td>
<td>On the Inventory menu, point to Inventory Transfers, and then View/Edit Inventory Transfers.</td>
</tr>
<tr>
<td>2</td>
<td>Double-click the purchase order or inventory transfer that you want to receive.</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>On the toolbar, click Receive. An item receipt will open that contains information for all of the items in the purchase order.</td>
<td>Click the Items tab to review the ordered or transferred items.</td>
</tr>
<tr>
<td>4</td>
<td>On the toolbar, click Receive All. The quantities in the Received column will be updated to match the quantities in the Order Qty. column.</td>
<td>On the toolbar, click Receive, and then click Receive All to receive the entire transfer in.</td>
</tr>
</tbody>
</table>

If you are ready to update the quantities in your database, click Update Inventory.
Will it cause problems in Point of Sale if I accept items for a purchase order that was not marked as placed?
In most cases, it is safe to receive the order. The only time you wouldn’t want to proceed is when your store’s processes or recordkeeping rely on an accurate record of which orders have been placed.

### For more information...
Click Help (?) in the Purchase Order, Item Receipt, or Inventory Transfer windows.

### To receive...

<table>
<thead>
<tr>
<th><strong>To receive</strong></th>
<th><strong>A partial purchase order</strong></th>
<th><strong>A partial inventory transfer in</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.</td>
<td>On the Inventory menu, point to Inventory Transfers, and then View/Edit Inventory Transfers.</td>
</tr>
<tr>
<td>2</td>
<td>Double-click the purchase order or inventory transfer that you want to partially receive.</td>
<td>Click the Items tab to review the ordered or transferred items.</td>
</tr>
<tr>
<td>3</td>
<td>On the toolbar, click Receive. An item receipt will open that contains information for all of the items in the purchase order.</td>
<td>Enter the received quantities either by typing quantities in the Received column or by clicking Add Items on the toolbar.</td>
</tr>
<tr>
<td></td>
<td>On the toolbar, click Receive, and then type the received quantities in the Received column, or click Receive Items on the toolbar to enter the received quantities using the Receive Items dialog box.</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>If you are ready to update the quantities in your database, click Update Inventory.</td>
<td></td>
</tr>
</tbody>
</table>

Managing Purchase Orders, Inventory Transfers, and Item Receipts 229
Closing an order without receiving items

Occasionally, you might want to close a purchase order without receiving the items it contains. In that case, you can mark the purchase order as closed.

To close a purchase order without receiving items

1. On the Inventory menu, point to Purchase Orders, and then click View/Edit Purchase Orders.
2. Double-click the open or partially received purchase order that you want to close.
3. On the toolbar, click Mark as Closed.

Things to know

Can I receive items against a closed purchase order?

By default, once a purchase order is closed, you can no longer receive inventory using that purchase order number. If ordered items are received after a purchase order is closed, you can either create a new purchase order to receive them against, or you can receive them using an item receipt that is not associated with a particular purchase order.

If you want to be able to receive items against closed purchase orders, set the “Allow edit of closed purchase orders” option.
Issuing inventory transfers

To issue an entire inventory transfer out

1. On the Inventory menu, point to Inventory Transfers, and then click View/Edit Inventory Transfers.
2. Double-click the inventory transfer that you want to issue.
3. Click the Items tab and review the ordered items.
4. Click Issue All on the toolbar.
5. To update the quantities in your database, click Update Inventory.

To issue a partial inventory transfer out

1. On the Inventory menu, point to Inventory Transfers, and then click View/Edit Inventory Transfers.
2. Double-click the inventory transfer that you want to partially issue.
3. Click the Items tab and review the items.
4. Click Issue on the toolbar.
5. Enter the issued quantities either by typing the quantities in the Issued column or by clicking Issue Items.
6. To update the quantities in your database, click Update Inventory on the toolbar.

Things to know

You should issue an inventory transfer out when you have packaged, shipped, or delivered the requested merchandise. If you are ready to send some of the items in an inventory transfer but not all, you can partially issue the order in Point of Sale.

The Issue Items dialog box offers some features worth noting:

- You can click “Items carried by” to view only those items carried by the supplier specified on the General tab of the inventory transfer.
- You can click Quick Scan to scan the items that you are receiving.
- You can enter received quantities directly in the Issued column.

If an item in an inventory transfer has since been marked as inactive, it will not be available in the Issue Items dialog box. Instead, type the issued quantity in the Issued column of the inventory transfer itself.
Generating inventory order reports

To generate the Purchase Order report

1. On the Reports menu, point to Inventory, and then click Purchase Order.

2. Make selections in the Report window to choose the purchase orders that you want to view.

To generate the Inventory Transfer reports

1. On the Reports menu, point to Inventory, and then click Inventory Transfer In or Inventory Transfer Out.

2. Make selections in the Report window to choose the inventory transfers that you want to view.

To generate the Inventory Receipts report

1. On the Reports menu, point to Inventory, and then click Inventory Receipts.

2. Make selections in the Report window to choose the item receipts that you want to view.

Things to know

The report window consists of four panes:

- The report filter settings pane, where you specify the records that you want to display in this report.
- The print settings pane, which allows you to specify the width of the printed report.
- The current report filter pane, which displays the filter criteria currently in effect.
- The report header pane, which displays the store logo and name, the report title, and the date the report was generated.
- The report grid displays the selected records, groups, and summary information.
To print labels for...

<table>
<thead>
<tr>
<th>A purchase order or item receipt</th>
<th>An inventory transfer</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>1</strong> Receive the purchase order or inventory transfer (if any).</td>
<td>In the inventory transfer, click <strong>Print Labels</strong> on the toolbar.</td>
</tr>
<tr>
<td><strong>2</strong> In the item receipt, click <strong>Print Labels</strong> on the toolbar.</td>
<td>In the inventory transfer, click <strong>Print Labels</strong> on the toolbar.</td>
</tr>
<tr>
<td><strong>3</strong> Review the print list. If you want to remove an item from the list, click the item, and then click <strong>Remove</strong>.</td>
<td><strong>3</strong> Review the print list. If you want to remove an item from the list, click the item, and then click <strong>Remove</strong>.</td>
</tr>
<tr>
<td><strong>4</strong> Set the number of labels that should be printed for each item in the print list.</td>
<td><strong>4</strong> Set the number of labels that should be printed for each item in the print list.</td>
</tr>
<tr>
<td><strong>5</strong> Select the label format that you want to use, and then click <strong>Print</strong>.</td>
<td><strong>5</strong> Select the label format that you want to use, and then click <strong>Print</strong>.</td>
</tr>
</tbody>
</table>

**Important**

If you are using a label printer, be sure to select a compatible label format.
To print labels from the Tools menu for...

<table>
<thead>
<tr>
<th>A purchase order</th>
<th>An inventory transfer</th>
<th>An item receipt</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 On the Tools menu, click Print Labels.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 In the Choose the items the labels are for box, select By purchase order. In the Choose the items the labels are for box, select By inventory transfer. In the Choose the items the labels are for box, select By item receipt.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3 Click Browse to view a list of purchase orders, select the purchase order that you want, and then click OK. Click Browse to view a list of inventory transfers, select the inventory transfer that you want, and then click OK. Click Browse to view a list of item receipts, select the item receipt that you want, and then click OK.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>4 Review the print list. If you want to remove an item from the list, click the item, and then click Remove.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

For more information...
Click the Help button in the Print Labels dialog box.

I want to update and print labels of my inventory from an inventory transfers, but I can’t find the button. Where is it?

The Inventory Transfer window has three modes: New, Edit, and Receive/Issue. Some actions can only be performed when the window is in a particular mode. For example, the Receive All, Edit, Update Inventory, and Print Labels buttons are only available in the Receive mode (after you have clicked Receive on an inventory transfer).
When I print item labels from the main window will the items automatically populate to the list of labels that I want to print?

Yes, when you select the purchase order, inventory transfer, or item receipt that you want, the items will automatically be added to the list of items to print.

5  Set the number of labels that should be printed for each item in the print list.

6  Select the label format that you want to use, and then click Print.

For more information...

Click the Help button in the Print Labels dialog box.
PART 4: INVENTORY MANAGEMENT

20

Managing Physical Inventories

In this chapter

Creating a physical inventory
   Create a physical inventory
   Create a physical inventory by using the Physical Inventory Wizard
   Duplicate a physical inventory

Working with existing physical inventories
   Modify an existing purchase order
   Delete a physical inventory
   Enter the bin location of an item

Counting and entering your physical inventory
   Print a physical inventory for use as a count sheet
   Export a physical inventory to a file or other program
   Import a physical inventory from a handheld scanner or other program
   Enter counted quantities manually
In this chapter, continued

Calculating discrepancies in item counts
Updating your store data with counted quantities
Creating a physical inventory

To create a physical inventory

1. On the Inventory menu, point to Physical Inventories, and then click New Physical Inventory.

   Or use the Inventory Center
   In the Views area, click Physical Inventory, and then click New.

2. Type a unique reference number and description for this physical inventory.

3. Click Add Items.

4. In the Add Items dialog box, double-click each of the items that will be counted, and then click OK.

Things to know

In Point of Sale, physical inventory refers to a list of the items you plan to count. This list, sometimes called a count sheet, can be printed out or exported to another program for use during a physical inventory count. After the count is complete, you can return to Manager View and use this list to enter the counted quantities, calculate any discrepancies, and update the in-stock quantities in your store database.

In the Physical Inventory window you can:

- Create or edit a list of items for a physical count
- Print the item list for counting
- Type the item counts directly into the list
- Import a list of item counts in a text file
- Calculate discrepancies between the item quantities in the store database and the quantities in your physical count
With the Physical Inventory Wizard, you can generate a physical inventory for:

- All items in your store.
- Items in specific departments or categories
- Items from specific suppliers
- Only those items for which a specific supplier is the primary supplier
- Items that haven't been counted since the date that you specify

With any of these options, the Physical Inventory Wizard adds the appropriate items to the count sheet and opens the created physical inventory for you to review, modify as needed, print, or enter counted quantities into.

Can the Physical Inventory Wizard import a count from a handheld scanner or other program?

Yes, using the Physical Inventory Wizard with a handheld scanner is an especially effective way of tracking your physical inventory.

5 To save this physical inventory and begin entering information for another, click **Save and New**, or if this is the only physical inventory that you want to create, click **Save and Close**.

To create a physical inventory by using the Physical Inventory Wizard

1 On the **Inventory** menu, point to **Physical Inventories**, and then click **Physical Inventory Wizard**.

2 On the **Welcome** page, click **Next**.

3 Select **Open a physical inventory form containing the items I select**, and then click **Next**.

4 Follow the instructions in the remaining pages of the wizard.
To duplicate a physical inventory

Duplicating a physical inventory can save you time. For example, if an existing physical inventory covers a certain department and it is time to count the items in that department again, you can duplicate the existing physical inventory record.

1. On the Inventory menu, point to Physical Inventories, and then click View/Edit Physical Inventories.

2. Select the physical inventory that you want to duplicate.

3. On the toolbar, click Duplicate.

4. Change the reference number and description and make other changes as needed.

5. To save this physical inventory and begin entering information for another, click Save and New, or if this is the only physical inventory that you want to create, click Save and Close.

For more information...

Click Help in the Physical Inventory window and in the Add Items dialog box.
Working with existing physical inventories

Things to know

Does deleting a physical inventory affect item quantities?
No, deleting a physical inventory has no effect on item quantities. It only removes the record of that particular physical inventory count.

How can I add bin locations to my inventory list?
Bin locations can be entered on the Physical Inventory (General tab) window in the Bin Location column for each item.

To modify an existing physical inventory

1. On the Inventory menu, point to Physical Inventories, and then click View/Edit Physical Inventories.

   [Or use the Inventory Center]
   In the Views area, click Physical Inventory.

2. Double-click the physical inventory that you want to modify.

3. Make the needed changes.

4. Click Save and Close.

To delete a physical inventory

1. On the Inventory menu, point to Physical Inventories, and then click View/Edit Physical Inventories.

2. Select the physical inventory that you want to delete.

3. On the toolbar, click Delete

For more information...
Click Help in the Physical Inventory window.
Counting and entering your physical inventory

To print a physical inventory for use as a count sheet

1. On the Inventory menu, point to Physical Inventories, and then click View/Edit Physical Inventories.

   ![Or use the Inventory Center]
   In the Views area, click Physical Inventory.

2. Double-click the physical inventory that you want to print.

3. On the toolbar, click Print.

   This will generate a report that you can print as your count sheet.

   ![Tip]
   Speed up physical inventory counting by using a handheld scanner. You can export your Point of Sale physical inventory count sheets to your scanner, use the scanner to count your items, and then import the counts into Point of Sale.

4. In the Physical Inventory (Detailed) report window, click Print on the toolbar.

5. In the Print dialog box, specify the number of copies that you want to print, and then click OK.

Things to know

After creating a physical inventory, you can print it out and use it as you perform your physical inventory count. The printed form will have space where you can write in your actual counted quantities.

Can I adjust and sort the columns in the list of items in the physical inventory before I print it?

You can always make such adjustments to columns in Point of Sale lists. Click the column headers to sort the list of items into the order that will be most useful to you as you count. For example, to sort by the item’s location in your store, click the Bin Location column header. To display the columns in a different order, click and drag a column header to the desired location.
Is there a way to export my Point of Sale inventory to another program so that I can continue to do my counts as I have in the past?

Yes, Point of Sale offers this as an alternative so that you can continue to use your previous method for counts. See details in the procedure on the right.

Will Point of Sale export my physical inventory to a program that opens .txt files?

Yes, to export to a program, such as Notepad, that will open .txt files, point to To a Program while exporting, and then click Tab-delimited (.txt).

Why do I get the Summary report instead of the Detailed report when I print?

If you print a physical inventory after you've calculated discrepancies, the Physical Inventory (Summary) report will appear instead of the Physical Inventory (Detailed) report.

To export a physical inventory to a file or to another program

1. On the Inventory menu, point to Physical Inventories, and then click View/Edit Physical Inventories.

   ![Or use the Inventory Center](image)

   In the Views area, click Physical Inventory.

2. Double-click the physical inventory that you want to export.

3. On the toolbar, click Print.

   This will generate a report that you can export.

4. In the Physical Inventory (Detailed) report window, click File, point to Export, and then click the export method that you want to use.
To import a physical inventory count from a handheld scanner or other program

1. If you are using a handheld scanner, follow the instructions from the manufacturer of the device to connect it to your computer and transfer the count information to your hard drive.

2. If the count information isn’t already in a text file, convert it to the .txt format.

   In most programs, this is done by clicking Save As or Export on the File menu and then specifying the text (*.txt) file format.

3. Open Manager View.

4. On the Inventory menu, point to Physical Inventories, and then click Physical Inventory Wizard.

5. Follow the instructions in the wizard for importing a count from a text file. For more information, click the Help button in the wizard.

   Once the count is imported into Point of Sale, you can open it like any other physical inventory and use it to calculate discrepancies and update your store information.

Why should I perform regular counts of my physical inventory?

Performing regular counts of the actual inventory in your store allows you to monitor shrinkage, the difference between the recorded value of your inventory and the retail value of the actual inventory of the store. In other words, you have shrinkage when your recorded item counts are less than your actual item counts. With the automation it provides, Point of Sale can help you perform these counts more frequently so that you are able to respond to shrinkage problems as they occur.

For more information ...

Click Help in the Physical Inventory window or Help in any of the pages of the Physical Inventory Wizard.
How do I get my counted quantities into Point of Sale if I used a count sheet to enter quantities?

This is very easy to do. If you have written your counted quantities on a printout of the physical inventory or any other type of count sheet, you can type those counted quantities into Manager View. See the instructions on the right.

If I have already counted the items that I am adding to a physical inventory, can I enter the counts to the Add Items dialog box instead of going through the entire process?

Yes, if you have already counted the items that you are adding, you can type the item counts directly into the Add Items dialog box.

For more information ...

Click Help in the Physical Inventory window.

To enter counted quantities manually

1. On the Inventory menu, point to Physical Inventories, and then click View/Edit Physical Inventories.

Or use the Inventory Center

In the Views area, click Physical Inventory.

2. Double-click the physical inventory that you want to modify.

3. For each item in the list, click the box in the Counted column, and then type the counted quantity for that item.

4. Click Save and Close or click Calculate to calculate discrepancies.
### Calculating discrepancies in item counts

**To calculate discrepancies in your item counts**

1. On the **Inventory** menu, point to **Physical Inventories**, and then click **View/Edit Physical Inventories**.

   **Or use the Inventory Center**
   In the **Views** area, click **Physical Inventory**.

2. Double-click the physical inventory that you want to calculate.

3. If you haven’t already done so, enter counted quantities for each item in the list.

4. On the toolbar, click **Calculate**.

   The item counts in the list will be compared to the in-stock quantities in the store database, and then the results will appear in the Physical Inventory window.

---

**Things to know**

When your physical inventory count is complete and you have entered or imported your counted quantities, Point of Sale will calculate any discrepancies between the item quantities in your store database and the actual item counts in your store.

**Why are some of the items missing after I calculate?**
Entries that do not have discrepancies will be hidden.

**If errors were made in counting, how can I edit the count?**
Click Recount, and then change the counts as necessary.

---

Managing Physical Inventories  247
5 Review any discrepancies, and then take one or more of the following actions.

<table>
<thead>
<tr>
<th>To do this:</th>
<th>Do this:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Make changes to the counted</td>
<td>On the toolbar, click <strong>Recount</strong>, and then type the corrected counts in</td>
</tr>
<tr>
<td>quantities</td>
<td>the <strong>Counted</strong> column.</td>
</tr>
<tr>
<td>Save the physical inventory</td>
<td>On the <strong>File</strong> menu, click <strong>Save</strong>, or click <strong>Save and Close</strong> on the</td>
</tr>
<tr>
<td></td>
<td>toolbar.</td>
</tr>
<tr>
<td>Update your inventory with the</td>
<td>On the toolbar, click <strong>Update Inventory</strong>.</td>
</tr>
<tr>
<td>counted quantities</td>
<td></td>
</tr>
</tbody>
</table>

After I calculated, the information in the Physical Inventory window changed. What the new columns of information mean?

In the item list, the quantities in your store database will be listed in the Expected column, with any differences between those numbers and the counted quantities shown in the Discrepancy and Discrepancy (%) columns.

Summary information is also displayed after you click Calculate. This information details the discrepancies in total quantity and total value between your store database and the results of your physical inventory.

For more information...
Click Help in the Physical Inventory window.
Updating store data with counted quantities

To update your store information with the counted quantities in a physical inventory

1. On the Inventory menu, point to Physical Inventories, and then click View/Edit Physical Inventories.

Or use the Inventory Center
In the Views area, click Physical Inventory.

2. Double-click the physical inventory that you want to use to update your store information.

3. Click **Calculate** to calculate the discrepancies between the recorded quantities and the actual counted quantities.

4. On the toolbar, click **Update Inventory**.

**Things to know**

*Is the database automatically updated when I click Update Inventory?*
Yes, the quantities in your store database will be changed to reflect the counted quantities, and the status of the physical inventory will be changed to Closed.

*How can I edit the Physical Inventory window after I click Update Inventory?*
You can no longer edit the physical inventory. The information is now permanent and cannot be undone.

For more information...
Click Help (?) in the Physical Inventory window.
Managing Your Customers

PART 5: CUSTOMER MANAGEMENT

21

Managing Customers

In this chapter

Creating a customer
  Create a customer
  Duplicate a customer

Working with existing customer records
  Modify a customer record
  Delete a customer

Using automatic customer numbering

Entering custom customer information
  Set up custom customer fields
  Add or view custom customer information

Importing customers from another source

Finding a customer
  Find a customer in the Customer List
  Find a customer using Find
In this chapter, continued

Assigning a customer to a price level

Setting customer options
  Set a discount for a customer
  Mark a customer as tax exempt

Generating and viewing reports and history
  Generate a Customer List
  View a report showing all customers
  View a report of the top performers by customer
  View a customer’s purchase history

Communicating with customers
  Send an e-mail message to a customer from Point of Sale
  Look up a customer’s phone number

Managing a customer’s shipping address
Creating a customer

To create an customer

1. On the People menu, click Customers.
2. On the toolbar, click New.

Or use the Customer Center
In the Tasks area, click New Customer.

3. Enter a unique customer number for this customer, or use the customer number supplied by Point of Sale.
4. Enter a first or last name (or both) for the customer.
5. Enter other information as needed.

6. To save this customer and begin entering information for another, click Save and New, or if this is the only customer that you want to create, click Save and New.
Why duplicate a customer?
As with other record types in Point of Sale, you can quickly create a new customer by duplicating an existing customer. This functionality can be especially useful when your customers are divided into one or more groups. For example, you might duplicate one customer who is assigned to price level B so that the new customer will be assigned automatically to price level B. Or, if you offer a customer loyalty program, you might set up a customer record that you can use as a template for creating new customers in the loyalty program.

Who can create a customer record?
To create an employee, you must provide Windows Administrator credentials for the computer where the store database is located. If you are already logged on to that computer as an Administrator, this will be done automatically.

To duplicate an existing customer

1. On the People menu, click Customers.

   Or use the Customer Center
   In the Views area, click Customers.

2. Select the customer that you want to duplicate.

3. On the toolbar, click Duplicate.

4. Change the customer number to a number that is not already being used.

   Tip
   If you clear the existing customer number, the next available number will be filled in automatically when you save the new customer’s information.

5. Make any other changes that are necessary, such as changing the customer name and contact information.

   Note
   When you duplicate a customer, the original customer’s purchase history is not duplicated.
### Working with existing customer records

#### Things to know

**What happens to the purchase history for a deleted customer?**
Deleting a customer deletes the purchase history for that customer. This information cannot be recovered once it has been deleted.

The transactions involving a deleted customer will still exist, but they will no longer be associated with the customer.

**Does deleting a customer affect accounting integration?**
Yes, for example, customers cannot be deleted from Microsoft Office Accounting Professional 2007 if they are already associated with an invoice or other accounting record.

**For more information...**
Click Help in the Customer window.

#### To modify a customer record

1. On the People menu, click Customers.

   ![Or use the Customer Center](image)
   In the Views area, click Customers.

2. Double-click the customer that you want to edit or modify.

3. Make the needed changes.

4. Click Save and Close.

#### To delete a customer

1. On the People menu, click Customers.

2. Select the customer that you want to delete.

3. On the toolbar, click Delete.

   ![To quickly delete a customer](image)
   To quickly delete a customer, select the customer, and then press CTRL+D.
Using automatic customer numbering

Unless you enter a customer number manually, Point of Sale will automatically assign numbers to your customers as you create them. You can set the next customer number, and you can change the format for customer numbers.

To set up automatic numbering

1. On the Settings menu, point to Store Settings, and then click Options.

   Or use the Store Settings Center
   In the Views area, click Store Options.

2. Click the Customers tab.

   ![Image of Customer Numbering Options]

   **Things to know**

   **How can I keep customer numbers from being confused with item numbers?**

   You can customize your numbering system by using the Customer number format box. A custom number format also ensures that customer numbers and other ID numbers do not overlap. This is especially important if your store uses scannable customer cards to identify your customers.

   If you don’t want to use a customer number format, be sure to clear the “Customer number format” box.

   **Why are there gaps in my customer numbering?**

   When you create a new customer, the customer number that is automatically filled in for you will not be used again, even if you close the customer record without saving. For this reason, you might see gaps in your customer numbering.
3 In the **Customer number format** box, change the current customer number format by typing any letters or numbers that you want to include in every customer number.

For example, you might want to start each number with a C or several zeros. Enter a pound sign (#) for each digit that you want Point of Sale to fill in for you.

If you don’t want to use a customer number format, clear the **Customer number format** box.

Keep in mind, though, that formatted customer numbers are less likely to be confused with item numbers.

4 In the **Next customer number** box, type the number that you want assigned to the next customer that is created.

This will not renumber any existing customers, and entering a number that is already in use will not have any effect.

5 Check the sample and make sure that your customer number format looks the way you want it to look.

---

**Things to know**

**What combinations of characters can I include in a format number?**

You can use any combination of characters in your format. Include a # in any position where you want a digit to be filled in and incremented automatically. See the table below for format examples.

<table>
<thead>
<tr>
<th>If you want your customer numbers to look like this:</th>
<th>Enter this format:</th>
</tr>
</thead>
<tbody>
<tr>
<td>CUST0025</td>
<td>CUST####</td>
</tr>
<tr>
<td>CUST0117</td>
<td></td>
</tr>
<tr>
<td>9990025</td>
<td>999####</td>
</tr>
<tr>
<td>9990117</td>
<td></td>
</tr>
</tbody>
</table>

**Tip**

The largest number that can be entered in this field is 2,147,483,647. Point of Sale recommends that you specify a “Next customer number” that is significantly smaller than this to leave room for future customer numbers.
Entering custom customer information

**To set up custom customer fields**

1. On the Settings menu, point to Store Settings, and then click Options.

2. Click the Customers tab.

3. In the Custom fields table, click the box for the field name that you want to change. For example, to modify the name of the first date field, click the first box in the Date column.

4. Type the new name of the field.

5. Repeat Steps 3 and 4 for any other field names that you want to change, and then click OK.

**Things to know**

Point of Sale provides 15 fields (boxes) where you can type custom information about a customer. These fields are located on the Additional Information tab in the customer window. There are:

- Five text fields that can hold information such as names, color preferences, or loyalty-program membership information.
- Five numeric fields that can hold information such as sizes or the number of children the customer has.
- Five date fields that can hold information such as birthdays, anniversaries, or expiration dates.

First, set up these fields by giving them names, and then use them to record whatever information is useful to you.

For more information...

Click Help in the Options dialog box.
What is a good business use of this customized information?
You can use the Find command on the Edit menu or a customized report to locate customers having specific information in these custom fields. For example, you could find customers who have soccer, football, basketball, baseball, etc. listed as a hobby. Then, you could do targeted marketing for your yearly sale on sports equipment and clothing.

To add or view custom customer information

1. Set up the custom fields as described in the preceding procedure.
2. On the People menu, click Customers.
3. Double-click the customer that you want to add or view special information for.
4. Click the Additional Information tab.
5. View the information displayed or enter any custom text, numbers, and dates that you want to store about this customer.

For more information...
Click Help in the Customer window.
Finding a customer

You can find customers in the customer list simply by scrolling through the list. If your list is too large for this to be practical, you can search for the customer.

**To find a customer in the customer list**

1. On the People menu, click Customers.

   ![Or use the Customer Center](image)
   In the Views area, click Customers.

2. Sort the list by clicking on one of the column headers.

3. Scroll through the list until you find the customer you are looking for.

4. To view or modify the customer, double-click the row for that customer.

**To find a customer using Find**

1. On the toolbar, click Find.

2. In the Look for box, select Customers.

3. In the Search for this text box, enter the text that you want to find.

4. In the In these fields box, select the fields where you want to look for your text.

   For example, if you are searching for a customer using his last name, select Name fields only.

5. Click Find Now.

6. To view or modify the customer, select the customer, and click Edit.

---

**Things to know**

How can I search for all customers in a particular zip/postal code?
Select “Address fields only” from the “In these fields” list, and then type the zip/postal code in the “Search for this text” box.

How can I find all customers who work for a particular company?
Select “Company field only” from the “In these fields” list, and then type the company name in the “Search for this text” box.

How can I find a customer who visited the store within the last week?
To find customers with transactions between certain dates, select the “Last visit between” option and then use the down-arrows to select the beginning and ending dates from the calendars.
Assigning a customer to a price level

Point of Sale allows you to establish up to four price levels for each of your items.

To assign a customer to a price level

1. On the People menu, click Customers.

   Or use the Customer Center
   In the Views area, click Customers.

2. Double-click the customer that you want to modify.

3. In the Price level box, select the price level that you want to apply to this customer.

4. Click Save and Close.

Tip

As an alternative to assigning customers to a price level, you can instruct your cashiers to apply a price level to a transaction in certain situations. In this way, you can use a price level for customers who are not in your store database. To take advantage of this feature, consider assigning some of your employees to the Supervisor or Manager roles, because only employees in those roles can adjust item prices or apply discounts.

Things to know

Why assign price levels?

*Price levels* allow you to charge different prices for different customers, such as when you offer special prices to your best customers, to customers who belong to loyalty programs, or to customers in certain groups, such as senior citizen or Internet customers. Using price levels involves assigning your special customers to a price level and defining the price levels for each of your items.

For more information...

Click Help in the Customer window.
Setting customer options

You can set a customized discount for a special customer. For example, you might offer a special discount to a customer who purchases over a certain amount annually or to one who was dissatisfied after a previous visit.

To set a discount for a customer

1. On the People menu, click Customers.

   Or use the Customer Center
   In the Views area, click Customers.

2. Double-click the customer that you want to modify.

3. In the Discount box, type the discount percentage that you want this customer to have.

   For example, to give the customer a 10% discount, type 10.

4. Click Save and Close.

To mark a customer as tax exempt

1. On the People menu, click Customers.

   Or use the Customer Center
   In the Views area, click Customers.

2. Double-click the customer that you want to modify.

3. Select the Customer is tax exempt check box under Customer Options.

4. Click Save and Close.

Things to know

Will a customer always get a discount after it is set on the General tab?

Once a discount has been set for a customer, each item sold to that customer will automatically ring up at its discounted price.

If you do not want to give a customer a discount on every purchase, you can discount the item instead.

If a customer should no longer be tax exempt, what should I do?

Find the customer and clear the “Customer is tax exempt” check box on the General tab under Customer Options.

For more information...

Click Help in the Customer window.
Generating and viewing reports and history

To generate a Customer List report

1. On the Reports menu, point to Customers, and then click Customer List.
2. Make selections in the Report window to specify the customer information that you want to view.

To view a report showing all customers

- On the Reports menu, point to Customers, and then click Customer List.

Or use the Customer Center
In the Tasks area, click View Customer List.

For more information...
Click Help in the Customer List window.

My Customer List report is very large. Is there a way to quickly find a customer from the list?
To the left of the Customer List report there is a filter that you can use to limit the results.

Can I preview what I print before print from the report?
Yes, on the toolbar, click Print Preview.

For more information...
Click Help in the Customer List window.
Can I e-mail the report to someone from Manager View? Yes, use the Export button on the toolbar and select “To an E-mail message.”

Can I eliminate the unnecessary panes for printing purposes? Yes, in the View menu clear the views that you would like to eliminate before you print. If you only want to clear the Header pane, on the toolbar click Show/Hide Header.

Can I e-mail the report to someone from Manager View?

1. On the Reports menu, point to Customers, and then click Top Performers by Customer.

2. In the Report Filter Settings pane, select the Date Range for the top performers, and then click Refresh.

To view a report of the top performers by customer

Or use the Customer Center

In the Tasks area, click View Top Performers by Customer.

For more information...

Click Help in the Report window.

Tip

If you plan to print, in the “Print settings” area, select the “Fit to page width” check box to print all columns on the page.
Where can I find a summary of a customer’s purchase history?

The Purchase History tab displays a list of the items purchased by a customer, as well as summary information about the customer’s transactions.

What items are tracked in the Purchase History summary?

You will be able to see:

- When the customer last visited the store
- How many times the customer has visited the store
- How much the customer spent
- How much the customer has saved on discounts

To view a customer’s purchase history

1. On the People menu, click Customers.

Or use the Customer Center

In the Views area, click Customers.

2. Double-click the customer that you want to view.

3. Click the Purchase History tab.

For more information...
Click Help (?) in the Customer window.
Communicating with customers

Things to know

Why compose e-mail messages to customers from Point of Sale instead of an e-mail program?
You already have the customer’s e-mail information entered in a record. You also have ready access to other information that you may want to access to include in the e-mail message.

To send an e-mail message to a customer from within Point of Sale

1. On the People menu, click Customers.

   Or use the Customer Center
   In the Views area, click Customers.

2. Double-click the customer that you want to contact.

3. If you haven’t already, type the customer’s e-mail address in the E-mail box.

4. Click the E-mail button.

5. Compose and send your e-mail message as you normally would.

To look up a customer’s phone number

1. On the People menu, click Customers.

   Or use the Customer Center
   In the Views area, click Customers.

2. Sort or scroll through the list of customers until you find the one that you want.

3. View the customer’s phone number in the Phone column.

For more information...

Click Help in the Customer window.
Managing a customer’s shipping addresses

In Point of Sale, you can store one or more shipping addresses for each customer. This makes it easy for you to offer gift shipping and other delivery alternatives to your customers.

To manage a customer’s shipping addresses

1. On the People menu, click Customers.

2. Double-click the customer whose shipping addresses you want to manage.

3. Click the Shipping Addresses tab.

Things to know

What should I enter as the customer’s main address?

Only the customer’s main address (the address entered on the General tab of the Customer window) can be printed using the Print Labels command (available on the Tools menu). For this reason, the types of mailings and shipments that you send to your customers will dictate which address you enter as the customer’s main address. For example, if you regularly send flyers or other mailings to your customers, then you will want to enter the customer’s standard mailing address as the main address. But, if you will only print labels for package shipments, then you might want to enter the customer’s primary shipping address as their main address. This distinction will be especially important for customers with post office boxes.
4 Take one or more of the following actions:

<table>
<thead>
<tr>
<th><strong>To do this:</strong></th>
<th><strong>Do this:</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a shipping address</td>
<td>Click New, and then fill in the new shipping address.</td>
</tr>
<tr>
<td>Copy the customer's main address</td>
<td>Click New, click Use Customer Address, and then make any desired changes.</td>
</tr>
<tr>
<td>Modify an existing shipping address</td>
<td>Select the shipping address that you want to change, click Edit, and then make your changes.</td>
</tr>
<tr>
<td>Set a shipping address as the primary shipping address</td>
<td>Select the shipping address that you want to make primary, and then click Set As Primary.</td>
</tr>
<tr>
<td>Delete a shipping address</td>
<td>Select the shipping address that you want to delete, and then click Delete.</td>
</tr>
</tbody>
</table>

**Things to know**

What is an easy way to send a gift or other item to someone in the same household as the customer?

A timesaving method of sending items to another resident of the customer’s house, such as a spouse, child, or roommate, is by clicking New and then Use Customer Address. Now, you only need to change the name in the shipping address, thus saving lots of typing.

For more information...

Click Help (?) in the Customer window.
PART 6: EMPLOYEE MANAGEMENT

22

Managing Employees

In this chapter

Creating an employee record
  Create employee record
  Duplicate employee record

Working with existing employee records
  Modify an existing employee record
  Delete an employee

Assigning roles and permissions
  Assign an employee to a role
  Assign a task pad to a role
In this chapter continued

Using the time clock
  View the list of time clock log entries
  Generate the Time Clock Report
  Create a time clock entry
  Duplicate a time clock entry
  Modify a time clock entry
  Delete a time clock entry

Controlling the way cashiers work

Setting limits on specific employees
Creating an employee record

To create an employee record

1. On the People menu, click Employees.
2. On the toolbar, click New.

Or use the Employee Center
In the Tasks area, click New Employee.

3. In the Employee window, enter the employee’s name, contact information, and a unique employee ID.

4. Click Password, type the new password in both the Password and Confirm Password boxes, and then click OK.

Things to know

With Microsoft Dynamics - Point of Sale, you can manage your employees in the following ways:

- Store basic information about each employee
- Record logon passwords and IDs
- Record the hours each employee works
- Generate reports on your employees’ register activity
- Customize POS View for each employee
- Set employee security roles
- Set options that control employee workflow
- Manage the security of your store information by regulating employee access
- Address accessibility needs

For more information...

Click the Help button in the Employee window.
What credentials are required to create, edit, delete, or duplicate an employee?

For tasks involving an employee’s user account—such as when you create a new employee or make ID, password, or role changes for an existing employee—you will need to provide Windows Administrator credentials for the computer where you are performing the task. If you are running Windows XP and are not already logged on as an Administrator, you will be prompted for Administrator credentials. If you are running Windows Vista and you did not run Point of Sale as an Administrator, you will need to restart Point of Sale.

If you are performing these tasks from an additional (register) computer in the store, you might also be prompted to enter Administrator credentials for the database computer.

For more information…

Click the Help button in the Employee window.

5 Enter other information about the employee.

6 To save this employee and begin entering information for another, click Save and New, or if this is the only employee that you want to create, click Save and New.

To create a new employee record only when you are in the Employee window, press CTRL+N.

To duplicate an employee record

1 On the People menu, click Employees.

Or use the Employee Center

In the Views area, click Employees.

2 Select the employee that you want to duplicate.

3 Change the employee’s name, ID, and other identifying information.

4 Click Password, type the new password in both the Password and Confirm Password boxes, and then click OK.

5 Make any other necessary changes.

6 To save this employee and begin entering information for another, click Save and New, or if this is the only employee that you want to create, click Save and New.
Working with existing employee records

To modify an existing employee record

1. On the People menu, click Employees.
2. Double-click the employee that you want to edit or modify.
3. Make your changes.
4. Click Save and Close.

To delete an employee

1. On the People menu, click Employees.
2. Select the employee that you want to delete.
3. On the toolbar, click Delete.

To quickly delete an employee, select the employee, and then press CTRL+D or DELETE.

What should I do with data for former employees?
You may wish to change the password for former employees to prevent them from logging on to Point of Sale. This is preferable to deleting employees from your database so that you can preserve the transaction histories and other records involving those former employees.

For more information...
Click the Help button in the Employee window.

Managing Employees 273
Assigning employee roles and rights

Point of Sale provides four predefined employee roles:
- Owner
- Manager
- Supervisor
- Cashier

These roles provide security for your store by allowing you to restrict access to certain Point of Sale features, and they help you enforce store policies by preventing certain actions from being taken. See Appendix A in the Cashier’s Guide for a print version of this information.

To assign an employee to a role

1. On the People menu, click Employees.
2. On the toolbar, click New.
3. In the Role Assignment section of the Employee window, click Rights to see what rights are associated with a role.
4. In the list of the Role box, select the role that you want to assign to this employee.
5. Click Save and Close.

Things to know

Does an employee’s role have to match the employee’s actual title?

All of the employees assigned to each role will have the same rights. For this reason, you might assign an employee to a role despite a difference between the employee’s actual job title and the name of the role in Point of Sale. For example, you might assign a trusted cashier to the Supervisor role in order to give her access to more Point of Sale functionality than you give to your other cashiers, even though their job titles are the same. Conversely, you might assign an assistant manager to a Cashier or Supervisor role to keep him from accessing the Manager View desktop or other Point of Sale features. By default, each new employee that you create is assigned to Cashier, the role with only basic rights.
To assign a task pad to a role

1. On the Settings menu, click Role Settings.

2. For each role, select the appropriate task pad from the list.

For more information...
Click the Help button in the Employee window or Help in the Role Settings dialog box.

Why assign different task pads to different employee roles?

You can create custom task pads to meet the specific needs of your employees. You might even decide to create a series of task pads that define workflows for your cashiers, making what they’re supposed to do at the register easier and less ambiguous.

Additionally, you can use different task pads for different employees by assigning a unique task pad to each employee role. You’ll find that task pads reduce keystrokes and speed up transaction time by giving cashiers faster access to the tasks they use most often.
Using the time clock

Things to know

Point of Sale provides a time clock where your employees can record their time worked. Employees clock in and out in POS View, and you can view, edit, and create reports about their work hours in Manager View.

The work hours for each employee are saved as a separate time clock entry, with one entry for each day worked. The entries are listed together in Manager View, so you have a fast and easy way to monitor employee time. You can also generate the Time Clock report.

Some employees don’t have access to a register, so how do they clock in?

Time clock entries are usually created in POS View when employees clock in and out on their registers. But, you can also create time clock entries in Manager View if some employees, such as stockers, don’t have access to a register.

To view the list of time clock log entries

1. On the People menu, click Time Clock.

   Or use the Employee Center
   In the Views area, click Time Clock.

2. Take one or more of the following actions:
   - To view entries for a specific role, click the header of the Role column, and then scroll to the role you want.
   - To view entries for a specific employee, click the header of the First Name or Last Name column, and then scroll to the employee you want.
   - To view entries for a specific day, click the header of the Time In or Time Out column, and then scroll to the day you want.

To generate the Time Clock Report

1. On the Reports menu, point to Miscellaneous, and then click Time Clock.

2. Make selections in the report window to specify the time clock information that you want to view.
To create a time clock entry

1. On the People menu, click Time Clock.
2. On the toolbar, click New.
   
   Or use the Employee Center
   In the Tasks area, click New Time Clock.

3. In the Employee name box, select the employee you are creating a time clock entry for.
4. Under In, enter the date and time that the employee began working.
5. Under Out, enter the date and time that the employee stopped working. If the employee has not yet clocked out, clear the check box next to Date.

To save this time clock entry and begin entering information for another employee, click Save and New, or if this is the only time clock entry that you want to create, click Save and Close.
To duplicate a time clock entry

1. On the People menu, click Time Clock.

Or use the Employee Center
In the Views area, click Time Clock.

2. Double-click the time clock entry that you want to duplicate.

3. On the toolbar, click Duplicate.

4. Click Save and Close.

To modify a time clock entry

1. On the People menu, click Time Clock.

Or use the Employee Center
In the Views area, click Time Clock.

2. Double-click the time clock entry that you want to modify.

3. Make changes as needed.

4. Click Save and Close.

To delete a time clock entry

1. On the People menu, click Time Clock.

2. Select the time clock entry that you want to delete.

3. On the toolbar, click Delete X.

What should I do if an employee enters something incorrectly when clocking in or out?
You can modify the incorrect information by accessing the logged information and editing it. See “To modify a time clock entry” on the right.

I see an entry where the time elapsed is marked “Invalid Time.” What does that mean?
Someone has entered incorrect time information. You can edit the information to correct it.

For more information...
Click the Help button in the Time Clock window.
Controlling the way cashiers work

Managing Employees

The store options available in Point of Sale enable you to be very specific about what your employees can do, cannot do, and must do, especially when combined with the controls that you can put in place by carefully assigning your employees to roles. In the POS Workflow Options dialog box, you can elect to:

- Prompt cashiers to add a customer on each transaction.
- Require cashiers to add a customer on each transaction.
- Display out-of-stock messages when items with insufficient in-stock quantities are added to transactions.
- Prevent the sale of items that are out of stock.
- Require cashiers to log on before each transaction.
- Require opening and closing amounts to be entered before a batch can be closed.
- Prompt cashiers for transaction details on each transaction.
- Automatically start the next transaction when the cash drawer is closed.

**Things to know**

**What should I do for customers who do not want to be in the customer list?**
Consider creating a generic “walk-in customer” to add to transactions when a customer chooses not to be in your customer list.

**How do I indicate that I want cashiers to be able to run Z reports without entering opening and closing amounts?**
Clear the “Require opening and closing amounts before closing a batch” option and they will be able to.

**How can I make a transaction automatically end when the cash drawer closes for the transaction?**
When the “Start next transaction when drawer is closed” option is selected, closing the cash drawer automatically dismisses the Post Transaction dialog box at the register, ending the transaction.
To set options to control the way cashiers work

1. On the Settings menu, point to Store Settings, and then click Options.
   
   Or use the Store Settings Center
   In the Views area, click Store Options.

2. On the POS tab, click Workflow.

3. Select or clear the options that are appropriate for your store.

4. Click OK when you are finished selecting options, and then click OK again to close the Options dialog box.

For more information...
Click Help in the POS Workflow Options dialog box.

On phone orders, cashiers are allowing for orders on items that are out of stock. How can I control this?
Select the “Do not allow sale of out-of-stock items“ option if you do not want to allow cashiers to include out-of-stock items in transactions.

I want the cashiers to enter comments about most transactions. How can I encourage that?
Select the “Prompt for details on each transaction“ option in the POS Workflow Options dialog box.

For more information...
Click Help in the POS Workflow Options dialog box.
Setting limits for a specific employee

In addition to limiting the amounts by which an employee can be over or short in their register on a daily basis, you can set the maximum monetary values of the noncash and return transactions that they can process.

To set over, short, floor, and return limits for a specific employee

1. On the People menu, click Employees.

   Or use the Employee Center
   In the Views area, click Employees.

2. Double-click the employee that you want to modify.

3. In the appropriate boxes, type the over, short, floor (noncash value), and return limits that you want to impose for this employee.

4. Click Save and Close.

For more information...
Click Help in the Employee window.

Things to know

Other than setting limits here, what other ways are there to place limits on employee actions and activities?

You can place other limits on employee actions and activities by assigning them to different roles. You can also regulate cashier workflow by putting certain Point of Sale options into effect.

If want to restrict a specific employee from being able to open a cash drawer, how would I do that?

Select (none) for the Cash drawer option under Register properties.

If want to restrict a specific employee from being able to open a cash drawer, how would I do that?

Select (none) for the Cash drawer option under Register properties.

For more information...
Click Help in the Employee window.
Managing Store Transactions

In this chapter

Working with batches and transactions
  View the list of batches
  View the list of batch properties

Working with journaled transaction
  Turn receipt journaling on
  Open a journaled receipt in the Receipt Viewer
  View payment information
Working with batches and transactions

**Points to know**

Point of Sale transactions are organized into batches. A batch is a collection of transactions processed on a single register. Manager View offers you two ways to see your transaction data:

- **Batches list.** To open this list, click View Batches on the Transactions menu.
- **Transactions with Journaled Receipts list.** If you have chosen to save electronic copies of your store’s receipts, these journaled receipts will appear in the Transactions with Journaled Receipts list. To open this list, click View Journaled Receipts on the Transactions menu.

You can also open these lists from the Transaction Center. Folders in the navigation pane let you view only the batches or transactions for a specific time period. To view more detailed information about one of the records in the list, double-click it.

**To view the list of batches**

1. On the Transactions menu, click View Batches.
2. In the navigation pane, under Batches, select a subfolder to control which transactions appear in the list.
   
   If no batches appear in your list, selecting All Dates will provide batches from which to select.
3. Double-click a batch in the list to view batch properties.

**To view batch properties**

1. On the Transactions menu, click View Batches.

   **Tip**
   
   If the navigation pane is not showing, click Navigation Pane on the View menu. The folders there will help you filter the batches list and more quickly locate the batch you want.

2. In the navigation pane under Batches, select a subfolder to control which batches appear in the list.

   If no batches appear in your list, selecting All Dates will provide batches from which to select.
How many batches should I expect to generate each day?

It depends entirely on the number of cashiers or registers you have on a given day. For example, a busy five-lane store with two shifts of cashiers would generate 10 batches each day, plus one more for the back-office computer where administrative tasks are handled.

How do the Batch Detail and Transaction tabs differ?

Batch Detail tab shows you payment and opening and closing amount information for the batch. The Transactions tab shows you the transactions and reports that are included in the batch.

What should I do if no batches appear in my batch list?

If no batches appear in your list, you might want to select All Dates.

3 Double-click the batch that you want to view, and then take one or more of the following actions:

<table>
<thead>
<tr>
<th>To do this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Copy batch detail information to a file</td>
<td>1 Use the SHIFT, CTRL, and arrow keys to select the rows that you want to copy, and then click <strong>Copy</strong> on the <strong>Edit</strong> menu.</td>
</tr>
<tr>
<td></td>
<td>2 In the file where you want the information, click <strong>Paste</strong> on the <strong>Edit</strong> menu or press CTRL+V.</td>
</tr>
<tr>
<td>Open a transaction in the Receipt Viewer</td>
<td>1 Click the <strong>Transactions</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>2 Double-click the receipt or report that you want to view.</td>
</tr>
</tbody>
</table>
Managing Store Transactions

_______ Working with journaled transactions

To turn receipt journaling on

You can save electronic copies of your store’s receipts and X, Z, and ZZ reports in your store database. This will allow you to view or reprint those receipts or view detailed payment information for a transaction. Journaling receipts will cause your store database to grow quickly, so you will want to balance the convenience of journaled receipts against your database storage limitations.

You can choose to journal receipts on certain registers or for certain receipt printers.

1. On the Settings menu, point to Register Settings, and then click View/Edit Registers.

2. Double-click the register that you want to modify.

3. To turn on receipt journaling for this register, select the Save electronic copies of receipts check box.

   - or -

   To turn on receipt journaling for a specific receipt printer, select the printer in the Selected devices list, click Properties, select the Save receipts to database check box, and then click OK.

4. Click Save and Close.

5. Restart Point of Sale on the modified register.

Things to know

A journaled transaction is a transaction with a receipt that is saved to the store database. You enable this receipt journaling when you set up the registers. Once that is done, you can use the Receipt Viewer to view the receipts and X, Z, and ZZ reports in your database.

How can I see my journaled transactions if the transaction list is empty?

If your transaction list is empty, try clicking the All Dates folder in the navigation pane. It is possible that receipt journaling might not be turned on. To turn it on, follow the steps in the procedure on the right.

Or use the Register Settings Center

In the Views area, click Registers.
To open a journaled receipt in the Receipt Viewer

1. On the Transactions menu, click View Journaled Receipts to view the list of journaled transactions.

   Or use the Transaction Center
   In the Views area, click Journaled Receipts.

2. Double-click the receipt or report that you want to view.

Can I limit (filter) the journaled receipts that I see in the Journaled Receipt list?
In the navigation pane, under Journaled Receipts, select a subfolder to control which transactions appear in the list. Expand the Transactions folder, expand the Journaled Receipts folder, and then select the date folder that meets your needs.

Why do I have two copies of each receipt in my database?
If you turn on receipt journaling for both the register and the specific receipt printer, two copies of each receipt will be saved to your database. Only turn receipt journaling in one place per register.

For more information...
Click Help in the Receipt Viewer window.
To view payment information

If you have receipt journaling turned on, you can view information about the payments received in a given transaction.

1. On the Transactions menu, click View Journaled Receipts.

   ![Or use the Transaction Center](Image)
   In the Views area, click Journaled Receipts.

2. Double-click the receipt for the transaction that you are interested in.

3. On the toolbar, click Payment Information.

   ![Payment Information dialog box](Image)
   Transaction number: 1032
   Payment method: Cash
   Payment amount: $97.50

Can I edit the information in the Payment Information dialog box?

This information cannot be edited.

Why are there parentheses around the Payment amount?

If the receipt describes the change returned to the customer, the amount appears as a negative number in parentheses.

For more information...

Click Help [?] in the Payment Information dialog box.
Managing Reports

In this chapter

Introducing Point of Sale reports

Generating a report
  Generate a report from the Reports menu
  Generate a report from the Reports list
  Generate a report from a capsule report in My Store view

Working with existing reports
  Change data within a report
  Copy report data as text
  Copy report data as a table
  Refresh the Report window
  Save changes to the settings of a built-in report

Exporting a report
  Export a report to a file
  Export a report to an e-mail message
  Export a report to another program
  Export a report to Microsoft Office Excel
In this chapter, continued

Printing a report
  Print a report
  Preview a report before printing
Introducing Point of Sale reports

Microsoft Dynamics - Point of Sale comes with more than 30 built-in reports. You can quickly generate these reports and gain access to a wide variety of information about the current operation and status of your store. Monitor every aspect of your store, from inventory, to pricing, to customer demographics, to employee hours.

Report content and layout can be modified to suit your needs:

- Choose the columns of information that appear, and set the size and location of those columns.
- Change the sort order.
- Group information into collapsible sections so that summary, average, or totals information displays for each section.
- Filter so that information appears only for select records in your database.

If you want to save more than one version of a report, such as having an Item Movement report for each of several set time periods, you can create custom reports. You can create powerful custom reports that offer a great deal of unique information by making just a few simple changes to a built-in report. Your store’s custom reports appear together on the Reports menu in Manager View.

Capsule reports are the reports that appear when you first open Manager View. These brief reports give you a snapshot of your store’s activity and status. Use capsule reports to customize the My Store view so that the information you need most is only a glance away.

Things to know

Types of reports. There are three main types of reports:

- **Built-in reports** (those that come with Point of Sale)
- **Custom reports** (those that you create for special purposes)
- **Capsule reports** (those that appear in the My Store view that are snapshots of your store’s activities)

Report window. The report window consists of five areas:

- The report filter settings pane, where you select the records to display.
- The print settings pane, which allows you to specify the width of the printed report.
- The current report filter pane, which displays the current filter criteria.
- The report header pane, which displays the store logo and name, the report title, and the report’s date.
- The report grid, which
Generating a report

To generate a report from the Reports menu

- On the Reports menu, point to the type of report, and then click the report that you want to view.

  For example, to generate the Price List report, point to Items, and then click Price List.

**Note**

Every report is loaded into the report window. The name of the report window changes to match the open report, such as Customer List Report window or Purchase Order Report window.

To generate a report from the Reports list

1. In the navigation pane, click Reports.
   - The list of reports appears in the content pane.
2. Double-click the report that you want to view.

To generate a report from a capsule report in My Store view

1. In the navigation pane, click My Store.
2. On the title bar of the capsule report that you want to expand, click Launch Report in Full View.

For more information...

Click Help in any report window.

Things to know

Where can I generate reports?

Point of Sale provides three places to generate reports.
- From the Reports menu
- From the Reports list
- From a capsule report

Where is information for generating X, Z, and ZZ reports located?

You will need to switch to POS View. Information about generating those reports can be found by clicking Help (F1) and locating them in the Help index. Or, you can find information in the Cashier’s Guide.

For more information…

Click Help in any report window.
Working with reports

The reports in Point of Sale not only report your store information, they provide a way to get to your information and make changes.

To change data from within a report
1. Within a report, hover over a row of data that interests you until the mouse pointer changes to a small hand.
2. Double-click the row.
3. In the window that opens, make your changes.
4. Click Save and Close.
5. Click Refresh on the View menu to refresh the report.

To copy report data as text
1. In the report window, select the row or rows that you want to copy.
2. On the Edit menu, click Copy.
3. Switch to the file and place the insertion point where you want to paste the report data.
4. On the Edit menu, click Paste or press CTRL+V. The data from the selected rows will be pasted into the file.

Things to know

Can I change any of the data in a report?
You will be able to display an edit window for suppliers, departments, categories, customers, descriptions, codes, items, and so on. Some data (such as some numerical data) is not editable.

Why does the edit window change?
The window that appears depends on the type of data that you select in the report. For example, if you double-click supplier data, you will see the Supplier window, while if you double-click an item number, you will see the Item window.
To copy report data as a table

1. In the report window, on the Edit menu, click Copy as Table.

2. Switch to the file where you want to paste the report data and move the insertion point to the correct location.

3. On the Edit menu, click Paste or press CTRL+V.
   All of your report data will be pasted into the file as a text-only table.

To refresh the report window

- On the View menu, click Refresh.
  - or -
  
  Click the Refresh button in the left part of the window.

To save changes to the settings of a built-in report

1. Generate the report that you want to modify, and then make your desired changes.

2. On the File menu, click Save Settings.
  - or -
  On the toolbar, click Save Settings.

3. When prompted, click Yes to confirm that you want to overwrite the report settings.
   The next time you generate this report, it will use your new settings.
Things to know

Your documentation says that I can export to Microsoft Office Excel, but I do not see a command for that in Point of Sale?
The “To Microsoft Excel” command will only be available if Microsoft Office Excel is installed on your computer.

I can’t find my reports that I exported to Microsoft Office Excel or to other programs. Where did they go? I am sure that I saved them.
Although the file that opens in Microsoft Excel or another program will have a name, such as Cashier Log.csv or Detailed Sales.txt, it has only been saved in a temporary location on your hard drive. To save the file permanently, click Save As on the File menu in the program that you exported to. If you want, you can give the file a different name.

Exporting a report

You can export Point of Sale report data to a file on your hard drive, to another program, or as an attachment to an e-mail message.

To export a report to a file

1. On the File menu of the report window, point to Export, point to To a File, and then click the file format that you want to export to.
2. Enter a name for the file.
3. Browse to the folder where you want to save the file.
4. Click Save.

To export a report to an e-mail message

1. On the File menu of the report window, point to Export, point to To an E-mail Message, and then click the file format that you want to attach to the e-mail message.
   
   For example, if you are exporting a Price List report and you click Comma-separated (.csv), then Price List.csv will be attached to a new e-mail message.
   
   2. Enter an e-mail address and any message text, and then send the message as you normally would.
To export a report to another program

- On the File menu of a report, point to Export, point to To a Program, and then click the file format that is associated with the program that you want to use.

For example, if you click Tab-delimited (.txt) and Notepad is the program associated with .txt files, then your report will be exported to Notepad.

To export a report to Microsoft Office Excel

- On the File menu of a report window, point to Export, and then click To Microsoft Excel.

What type of files can be exported from Point of Sale?

You can export the following file format types:
- comma-separated (.csv)
- tab-delimited (.txt)
- HTML (.htm)
- XML (.xml)

Can I copy and paste data into another file instead of exporting it?

Yes, as an alternative to exporting a report, you can copy the report data to the Windows Clipboard, and then paste it into a document, spreadsheet, or other file. See specific information earlier in this chapter for completing this procedure either as text or as a table.

For more information...

Click Help in any report window.
Printing a report

To print a report

1. On the toolbar of the report window, click Print.

2. Specify the pages and number of copies to print.

3. Click OK.

Tip

To compress the width of the printed report to fit on a single page, select “Fit to page width” in the Print settings pane of the report window.

Things to know

Is there a difference between printing from the report window as opposed to the Preview window?

When you print a report from the Preview window, one copy of the entire report will be printed. If you want to select certain pages to print, or if you want to print multiple copies of the report, print from the report window instead.

For more information...

Click Help in the Print dialog box.
To preview the report before printing

1. On the File menu of the report window, click Print Preview.

2. Take any or all of the following actions:
   - Resize the preview window by clicking and dragging the border.
   - Zoom in or out by clicking .
   - Click one of the page display buttons to change the number of pages that you see.
     For example, clicking the button will display four pages.
   - View other pages in the report by using the arrow buttons to change the number in the Page box.
   - If you are not satisfied with the way the report will print, click Close and make changes to the filter, columns, or groups, as needed.

3. When you are ready to print, click Print .

Things to know

My report is too wide to fit on one page? How can I get to fit on one page?

If you maximized the report window, your report will be too wide to fit on one page. Restore the report window to its default width prior to printing.

Selecting the “Fit to page width” option will also keep your report to the size of the page.
Displaying Reports

In this chapter

Sizing the report window
  Maximize the report window
  Make the report window larger or smaller

Showing or hiding report information
  Show or hide the report header
  Show or hide the report filter settings
  Show or hide the current report filter

Working with report columns
  Choose the columns to display in a report
  Change the width of a column in a report
  Change the sort order of a report
  Move information in a report
  Group information in a report
  Change the order of grouped information in a report
There are a number of ways to make all of your report data fit into the report window. This topic explains how to resize the window.

To maximize the report window

- In the title bar of the Report window, click Maximize.

To make the report window larger or smaller

1. Move your mouse over one border of the report window until your mouse changes to ✤.  
2. Click and drag the border to the desired width or height.

Tip

If you drag a corner of the window, the window will get larger or smaller in two directions at once.
Showing or hiding report information

To show or hide the report header
- In any report, on the View menu, click Report Header.
- or -
  On the toolbar, click Show/Hide Header.

To show or hide the report filter settings
- On the View menu, click Report Filter Settings.

To show or hide the current report filter
- On the View menu, click Current Report Filter.

Things to know

Which elements of the report window can I customize?
Screen elements that are currently visible will be indicated by check marks on the View menu. You can turn these screen elements off by clicking their corresponding commands, or turn them on when they are hidden by clicking their commands again.

The customizable screen elements are:

- **Report Header** - The title area just above the report.
- **Report Filter Settings** - The pane on the left side of the report window, where the report filter controls are located. Your current filter settings are not affected by hiding this pane.
- **Current Report Filter** - The area of the screen just above the report title, where your currently applied filter is displayed.
________ Showing or hiding report information

**Things to know**

*Which elements of the report window can I customize?*

Screen elements that are currently visible will be indicated by check marks on the View menu. You can turn these screen elements off by clicking their corresponding commands, or turn them on when they are hidden by clicking their commands again.

The customizable screen elements are:

- **Report Header** - The title area just above the report.
- **Report Filter Settings** - The pane on the left side of the report window, where the report filter controls are located. Your current filter settings are not affected by hiding this pane.
- **Current Report Filter** - The area of the screen just above the report title, where your currently applied filter is displayed.

**To show or hide the report header**

- In any report, on the View menu, click Report Header.

- or -

On the toolbar, click Show/Hide Header.

**To show or hide the report filter settings**

- On the View menu, click Report Filter Settings.

**To show or hide the current report filter**

- On the View menu, click Current Report Filter.
Working with report columns

Things to know

Some columns of information are more important, and I would like them to appear first in the report. Can I make that happen in Point of Sale?

Not only can you choose the columns that appear, but you can arrange them in the order that is most useful to your business. First, you will need to choose your columns, and then you can click the header of the most important column and drag it to the beginning of your report. Continue the process until your report gives you useful results. See specific instructions on the right.

To choose the columns to display in a report

1. In the report window, click Choose Columns.

2. Select the check boxes for the columns that you want in your report, clear the check boxes that you do not want, and then click OK.

To change the width of a column

1. Move your mouse over the right edge of the heading of the column that you want to modify until the pointer changes to ➔.

2. Click and drag the edge of the column to the desired width.

To change the sort order of a report

- Click the column heading of the column you want to sort by. Click it again to sort the report into the opposite order.

To move a column in a report

- Click the heading of the column that you want to move, and then drag it to its new location.

For more information...

Click Help ? in the Report Column Chooser dialog box.
How does sorting by grouped columns differ from sorting by ungrouped columns?
When you sort by an ungrouped column, the information within the existing groups is sorted rather than the whole report.

Grouped columns remain sorted together. You can reverse the sort order of these columns, but that is all.

What is the advantage to grouping information in a report?
With careful column arrangement, you can group the information in your report and see summary, average, or totals information for each group. Choose to group by one column to see only the major divisions in the report, or group by up to four additional columns to create collapsible sections of information within each group.

To group information in a report

1. Move the columns that you want to group to the left side of the report.

2. On the View menu, point to Group by Columns, and then click the columns that you want to group. To stop grouping information, click No Grouping.

Tip
You can also access the grouping options by clicking “Group by Columns” on the toolbar. Click repeatedly to group additional columns or to stop grouping.

To change the sort order of grouped information in a report

1. If you want to sort by columns other than the currently grouped columns, ungroup the columns, move columns to new locations as desired, and then group the information again.

2. Click the column heading of the column that you want to sort by. Click the column heading again to sort the information into the opposite order.

Tip
Arrange your columns, and then use “Group by Columns” to group your report information and view summary or totals information.
Filtering Reports

In this chapter

Working with report filters

Filtering by date
  Select a single date filter
  Select a new date-range filter

Setting up simple report filters
  Filter by employee, customer, or supplier
  Filter by department and category
  Filter by item number
  Restore the default filter

Setting up advanced report filters
Working with report filters

By default, most of the built-in reports in Point of Sale gather information from your entire store database. This means that the report data is unfiltered. You can consider an unfiltered report as a starting point, and then set up a report filter that will pare down the information in the report and allow you to see only the information you need at any given time. For example, you can generate a Price List report for your whole store with a click of your mouse. From there, it is a simple matter to filter the report so that you see Price List information for a specific department, category, or supplier, or even for a select few items.

The current filter settings of a report appear in the current report filter area above the report title.

The current report filter is:

((Date Sold >= 7/21/2006 12:00:00 AM) AND (Date Sold <= 7/21/2006 11:59:59 PM))
Filtering by date

Things to know

Some reports show information for the last month only. Can I choose to view one of those reports for a longer or shorter period of time?

All date range filtered reports have a default setting; you can change the filter on these reports to suit your needs. Some reports use a single-date filter only. You can only change the day of the report on those.

To select a new date in a single-date filter

1. Under Report Filter Settings in the left part of the report window, click in the Report date box.

   ![Report Filter Settings]

2. Use the calendar to select the new date.

3. Click Refresh.

To select a new date-range filter

1. Under Report Filter Settings in the left part of the report window, click in the Date range box.

2. Select the predefined date range that you want to use, or click Custom to set your own start and end dates.

3. Click Refresh.

For more information...
Click Help in any report window.
Setting up simple report filters

To filter by employee, customer, or supplier

1. Under Report Filter Settings in the left part of the report window, in the Choose the type of filter box, select Customer, Employee, or Supplier, as appropriate.

2. Type the name of the customer, employee, or supplier that you want to filter for or click Select to select from a list.

3. Click Refresh.

To filter by department and category

1. Under Report Filter Settings in the left part of the report window, in the Choose the type of filter box, select Department/Category.

Things to know

Many of the reports in Point of Sale provide one or more simple report filters. The available filters will vary by report. For example, only reports that contain customer information will offer the customer filter.

You can filter by any of the following:
- Department
- Category
- Employee
- Customer
- Supplier
- Item number

What report has all of the simple report filters so that I can experiment with the various types?

If you want to experiment with report filtering, the Detailed Sales report offers all of the simple filters described above. Locate the report on the Reports menu by pointing to Sales, and then clicking Detailed Sales.
Why don’t I see my changes in the report data?
You may need to click Refresh.

After I have filtered built-in reports, can I go back to the original settings?
Yes, in the same place that you selected a different filter, you can select to return it to the default settings. See instructions on the right.

Why use an advanced filter instead of a simple filter?
Advanced filtering allows you to select the database records to be included in the report because you can filter by precise, detailed information. For example, you can generate a Customer List report that includes only those customers who live in a specific Zip or postal code.

For more information...
Click Help in any report window.

2 Select the department and then category, if desired, in the department that you want to filter for.
3 Click Refresh.

To filter by item number
1 Under Report Filter Settings in the left part of the report window, select Item Selection.
2 Click Select to view a list of items, double-click each of the items for which you want to filter, and then click OK.
3 Click Refresh.

To restore the default filter on a report
1 Under Report Filter Settings in the left part of a report window, click in the Choose the type of filter box.
2 Click Default.
3 Click Refresh.
Setting up advanced filters

You can filter report data for a wide variety of information using an advanced report filter.

To set up an advanced filter

1. Under Report Filter Settings in the left part of the report window, in the Choose the type of filter box, select Advanced.

2. Click Modify Filter.

3. Review any existing criteria, and if a criterion no longer applies, select it, and then click Remove.

4. Under Define more criteria, select the field to search in.

The available fields will vary by report.

5. In the Condition box, select the relationship between the field and the value.

   **Note**
   You can select negative conditions, such as “Does not contain,” in order to exclude certain records from the report.

6. In the Value box, type the data that you want to filter for or exclude, and then click Add to List.

7. Repeat Steps 4 through 6 for any additional criteria that you want to define.

8. If you want to filter for records that meet all of the criteria, select the Combine all criteria with AND check box, or if you want to filter for records that meet any of the criteria, clear that check box.

**Things to know**

Advanced filters are made up of criteria that represent the tests a database record must pass in order to be included in the report. For example, if you create a criterion that tests for items that are not inactive, then only active items will be included in the report. You can define several criteria in an advanced filter, so you can get very specific about what will be included in the report.

Each criterion contains the field to be tested and the condition and value that must be met or matched for the record to meet the criterion. For example, you can look for descriptions (the field) that contain (the condition) certain text (the value).

**For more information...**

Click Help in the Advanced Report Filter dialog box.
Does Point of Sale search for whole words in its advanced search or will it also include results that are included as parts of other words?

When you filter for text, Point of Sale does not search for whole words. For example, a "contains" filter for "car" in a description field will return not only records with the word "car" in their descriptions but also "care" and "scary."

9 When all criteria have been defined, click OK to return to the report window, and then click Refresh.

Tip

Filtering for a phrase will return records that contain any of the words in the phrase. For example, a filter for "large red" will return records that contain "large" and records that contain "red." To search for records that contain both "large" and "red," you need to enter "large AND red" in the Value box.

For more information...

Click Help in any report window or Help in the Advanced Report Filter dialog box.
PART 8: REPORT MANAGEMENT

27

Managing Custom and Capsule Reports

In this chapter

Working with custom reports
- Create a custom report from a built-in report
- Generate a custom report from the Reports menu
- Save changes to the settings of a custom report
- Delete a custom report

Working with capsule reports
- Switch to the My Store view
- Refresh a the My Store view
- Display or change a capsule report in My Store
- Open a the full version of a capsule report

Setting up the capsule report layout
A custom report is a customized version of one of the built-in reports that are included in Point of Sale. With custom reports, you can save several variations of the same report and have quick access to the display options and filter settings that you need in different situations. For example, you might want to use the built-in Price List report to view prices for your whole store, and then use custom Price List reports to view prices for certain departments. Or, you might have three custom Detailed Sales reports that show totals information by the week, month, and year.

Even simple changes to a report, such as showing different columns or moving a column farther left in the report, can significantly change the information provided by the report. For example, the built-in Detailed Sales report shows total sales information by department, for the current day. By choosing to display the Date Sold column and then moving that column to the left-most position in the report, you can see total sales information by date instead.

Change the report filter by selecting This Week in the Date range box and then clicking Refresh, and your custom report will include an additional six days of sales data, plus show the totals for the week.

**To create a custom report from a built-in report**

1. Generate the report that you want to use as the basis for your custom report.
2. Change the display options, filter settings, and information grouping, as desired.

**Things to know**

**Why am I unable to find the custom report that I generated?**

You need to save the settings for your custom report just as you did for the changes that you made to your built-in reports.

**Why is the Custom command disabled on my Reports menu?**

Until you have saved some custom reports, this command will be inactive. Once you have saved custom reports, you can view them by pointing to Custom in the Reports menu, and then selecting the report in the Reports list.
Can I customize a built-in report to be specific to a particular department or category?

Yes, you can create a custom report for each department or category by saving a variation of a more generic built-in report. For example, if you want a custom report that shows the Price List for your shoe department, you would generate the built-in Price List report, filter the report so that only shoe department information is included, and then save the report settings as a custom report. You might call this new report Shoe Price List.

For more information...

Click Help in any report window and Help in the Save Settings as Custom Report dialog box.

3 On the File menu, click Save Settings as Custom Report.

4 Enter a name for the custom report.

5 Click OK.

Note

This name will appear on the Reports menu (on the Custom submenu), in the Reports list, and in the title area of the report.

The custom report will be created and available for your future use. See an example custom report below.
Things to know

How will I know that my custom report was actually created?
Once you have created your custom report, you can find it in the Reports list.

I have too many custom reports that are no longer useful. Can I delete them?
Yes, if you no longer need a custom report, delete it. You cannot delete built-in reports, however. See instructions on the right for deleting a custom report.

To generate a custom report from the Reports menu
- On the Reports menu, point to Custom, and then click the report that you want to view.

To generate a report from the Reports list
1  In the navigation pane, click Reports.
   The list of reports appears in the content pane.
3  Double-click the custom report that you want to view.

To save changes to the settings of a custom report
1  Generate the custom report that you want to modify, and then make your changes.
2  On the File menu, click Save Settings.
   - or -
   On the toolbar, click Save Settings.

To delete a custom report
1  In the navigation pane in Manager View, click Reports.
2  Select the report that you want to delete.
3  On the toolbar, click Delete ✗.
When you first open the Manager View of Point of Sale, the My Store view appears, with a selection of capsule reports in the content pane. A capsule report is a brief, summary version of a standard Point of Sale report, designed to give you a quick overview of the activity in your store.

**To switch to the My Store view**

- In the navigation pane folder tree, click **My Store**.
- or -
- In the navigation pane button area, click **My Store**.

The My Store screen with the currently selected capsule reports appears.

**To refresh the My Store view**

- On the **View** menu, click **Refresh**.

**To display or change a capsule report in My Store**

You can choose the capsule reports that appear in My Store.

1. In the title bar of the capsule report that you want to change, click **Select Capsule Report**.
2. Select the report that you want to view, and then click **OK**.

---

**Things to know**

**Are capsule reports shortcuts to full versions of the report?**

You can open the full version of a capsule report with a click of your mouse, so the capsule reports can act as shortcuts to your most frequent reporting tasks. However, it also serves as a summary of information for a quick analysis of store activity.

**Because cashiers are ringing up sales on an ongoing basis, how can I be sure that my capsule reports are up to date?**

The data in the Manager View window is automatically refreshed whenever you change views or update a record. However, because cashiers can ring up sales while you are performing administrative tasks on another computer, you might want to refresh manually from time to time. For example, you might want to see the latest sales data in your capsule reports.
How many capsule reports can I add to My Store?
You can have up to six capsule reports. Some My Store layouts may provide you with room for more data than others. See “Setting up the capsule report layout” on the next page for more details.

Do I have to use capsule reports?
No, but you will find that they help you make valuable analyses in a variety of ways. You can see all of the data that you find most relevant for your store all on one page.

Are capsule reports in My Store customizable?
Yes, you choose the reports that will appear. You can also arrange them in the layout that best meets your needs.

For more information...
Click Help (?) in any report window and Help (?) in the Select a Report dialog box.

3 Repeat Steps 1 and 2 for any other capsule reports that you want to change or add.

To open the full version of a capsule report
- On the title bar of the capsule report you want to expand, click View Full Report.

See an example of the full version of a capsule report below.
Setting up the capsule report layout

You can choose from one of seven possible layouts available for the My Store capsule reports.

To set up the capsule report layout

- On the View menu, point to Content Pane, and then click the layout that you want to use.

Examples of each layout are shown below.

![Layout 1](image1.png) ![Layout 2](image2.png)

![Layout 3](image3.png) ![Layout 4](image4.png)

![Layout 5](image5.png) ![Layout 6](image6.png) ![Layout 7](image7.png)

Things to know

I changed my capsule report layout and one that I already had displayed disappeared. Why?

If you currently have more capsule reports showing than the new layout allows, the extra capsule reports will be dropped. If a report is dropped that you want to display, you can put it in place of one of the remaining reports. Similarly, if you have fewer reports showing than the new layout allows, new capsule reports will be displayed in the extra spaces in the content pane. You can then change those reports to others that better meet your needs.
Managing Prices and Costs

In this chapter

Understanding prices and costs
Understanding rounding and calculations
Changing the regular price or cost of a specific item
Using the a wizard to modify multiple items
Setting a profit margin for a specific item
Using price levels
  Assign a customer to a price level
  Define price levels for an item
Putting an item on sale
Understanding prices and costs

Point of Sale provides a variety of ways to manage your item prices and costs. You can set prices and costs for individual items, use the Inventory Wizard to adjust prices and costs in bulk, or let Point of Sale automatically update your cost information based on your received inventory.

Prices. Each item in your store database can have several prices associated with it. These prices include the regular price, three price-level prices, the manufacturer’s suggested retail price (MSRP), and a temporary sale price. You can create a discount pricing schedule for each item.

Profit margin. A profit margin is the percentage of the item’s price that is profit:

\[
\text{Profit margin} = \frac{\text{Price} - \text{Cost}}{\text{Price}} \times 100
\]

Things to know

How are the price, cost, and profit margin related?

In Point of Sale, the cost and price values are associated with the profit margin value. This relationship is described in the following table.

<table>
<thead>
<tr>
<th>If you change this value</th>
<th>This value will change automatically</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price</td>
<td>Profit margin</td>
</tr>
<tr>
<td>Cost</td>
<td>Profit margin</td>
</tr>
<tr>
<td>Profit margin</td>
<td>Price</td>
</tr>
</tbody>
</table>

For example, if you have an item with a price of $20.00, a cost of $10.00, and a 50% profit margin, and you change the price to $25.00, the profit margin is automatically updated to 65%. If you change the cost to $12.00, the profit margin is automatically updated to 40%. And if you change the profit margin value to 40%, the price is automatically updated to $16.67.
Point of Sale performs rounding in several situations.

**Rounding in the Inventory Wizard**

The Inventory Wizard includes options that let you round all updated prices to realistic retail values. For example, suppose you want to discount a certain category of items by 10%, but your policy is to have all prices end with 99 cents. The Inventory Wizard will let you set the ending digits of the prices, and then choose whether the adjusted prices will be rounded up or down.

This feature is designed to adjust partial-dollar amounts in prices, such as by changing $1.67 to $1.99. If you specify an ending amount that is greater than $0.99, Point of Sale will round up or down to the nearest ten (or nearest hundred, for ending amounts over $9.99), and then add the ending amount that you specified. For example, $8.57 rounded up to end in $1.23 will become $11.23.

Experiment with different settings; you can always make manual price adjustments in the Inventory Wizard Results window, or you can close the window without updating your database and then run the wizard again with different settings.

**Rounding in discounted prices**

When Point of Sale applies percentage discounts to item prices, it calculates the new price using multiple decimal places and then rounds to two decimal places. For example, an item priced at $10.95 that is discounted by 10% will ring up at $9.86 ($10.95 - $1.095 = $9.855, which rounds to $9.86). As you can see, this rounding method typically works out in the store’s favor.
Rounding in sales tax calculations

Sales taxes can contain a number of tax authorities (such as county and state), each with their own tax rates. At the time of sale, the tax amount for each tax authority is calculated separately, rounded to two decimal places for proper accounting, and then added to the other tax amounts. The example in the following table illustrates this calculation.

<table>
<thead>
<tr>
<th>Item</th>
<th>Price</th>
<th>County Tax (10%)</th>
<th>State Tax (5%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item 1</td>
<td>$1.25</td>
<td>$0.125</td>
<td>$0.0625</td>
</tr>
<tr>
<td>Item 2</td>
<td>$3.10</td>
<td>$0.310</td>
<td>$0.1550</td>
</tr>
</tbody>
</table>

| Tax subtotal | $0.435 | $0.2175 |
| Rounded tax  | $0.44  | $0.22   |
| Total tax    | $0.66  |         |

Does rounding ever work in favor of the customer?

In the case of Mix and Match item discounts, scenarios occasionally arise that work out in the customer’s favor. For example, suppose you create an item discount that grants a 4% discount when 5 or more $100 items are purchased, and an 8% discount when 10 or more of the same items are purchased. If a customer bought 15 items, you might expect this calculation:

\[(5\times100\times0.96)+(10\times100\times0.92) = 1,400.00\]

What actually happens is that Point of Sale averages the discounted prices of all 15 items in order to show a single, rounded-to-two-digits individual price in the transaction (in this case, $93.33). That price is then multiplied by the quantity sold, 15, to give an extended price of $1,399.95. The result is a win for your customers, but a slight one.
Changing the price or cost of a specific item ___

Things to know

If I change the regular price, will it affect Price Level A, B, or C prices?
You can change one without affecting the others. You can set three different price levels for each item in addition to the regular price, and then assign price levels to specific customers or to individual transactions.

For more information...
Click Help in the Item window.

To change the regular price of a specific item

1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to modify.

3. Click the Pricing tab.

4. Type a value in the Price box.

5. Click Save and Close.
Using a wizard to modify multiple items

With the Inventory Wizard, you can modify information for a selection of items, all at one time. You can update item prices, price levels, sale prices and dates, and in-stock quantities. You can also assign sales taxes to items or make items active or inactive. You can choose to modify:

- All items in your store
- Items in specific departments or categories
- Items that meet certain filter criteria that you specify
- Only those items that you choose

With any of these options, the wizard prepares a list of items and displays it in the Inventory Wizard Results window. You can add or remove items, make changes to the values you've chosen to modify, export the item list, and finally choose to update the inventory information in your store database.

To use the Inventory Wizard to modify multiple items

1. On the Inventory menu, click Inventory Wizard.
2. Follow the instructions in the wizard.
3. When you click Finish on the final page of the wizard, the Inventory Wizard Results window will appear.
4. Complete one or more of the actions from the following table.

Things to know

Do I have to update the store database with the results shown in the Inventory Wizard Results window?
No, you can choose to update selected records or discard all of the changes.

Can I print a list of my changes?
Yes, you can print the list from the Inventory Wizards Results window.

For more information...

Click Help in the Inventory Wizard Results window.
**What happens to the information in an item list if I import new information?**

The existing contents of the item list will be overwritten. The imported file must have the same columns and order as the current list.

**If I export to an existing file, will it also overwrite the content in the file?**

Yes, so if there is data that you do not want to lose in the file, give the file a different name.

**What types of files can I export?**

The exported file can be a tab-delimited (.txt), comma-delimited (.csv), or XML (.xml) file.

---

### To do this | Do this
---|---
Add items to the list | • On the toolbar, click **Add Items**.
Remove an item from the list | • Click the item, and then click **Remove Items** on the toolbar.
Import new information into the item list | 1. On the toolbar, click **Import**.
2. Click **Browse** to select the import file.
3. Specify the type of file you are importing, and then click **OK**.
Export the item list to a text file | 1. On the toolbar, click **Export**.
2. Click **Browse** to locate the folder where you want to create the export file.
3. Type a name for the file, and then click **Save**.
4. Click **OK**.
Make changes to the item data | • In the row for each item, click in a column heading that begins with **New**, such as **New Item Price**, and then type the new value.

5. When you are ready to update your store database with the new values, click **Update Inventory** on the toolbar, or if you don’t want to update the database, close the window and discard the new values by clicking **Close** on the **File** menu.

---

For more information...

Click Help (?) in the Add Items dialog box.
Setting a profit margin for a specific item

Point of Sales can calculate the price of an item based on a certain profit margin.

To set a profit margin for a specific item

1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to modify.

3. Click the Pricing tab.

4. In the Profit margin box, type the profit margin that you would like to earn, and then press TAB.

5. Click Save and Close.

Things to know

If I know that I want specific profit margin on an item, will Point of Sale calculate the sell price for me?

Yes, if you enter the cost of the item and the profit you require, Point of Sale will automatically calculate the price that you will need to sell it at.

How can I calculate the profit margin if I know the price I will sell the item for and the cost of the item?

If you set the price and cost of an item, the profit margin will be calculated automatically.

For more information...

Click Help in the Item window.
Using price levels

Price levels allow you to charge different prices for different customers, such as when you offer special prices to your best customers, to customers who belong to loyalty programs, or to customers in certain groups, such as senior citizen or Internet customers. Using price levels involves assigning your special customers to a price level and defining the price levels for each of your items.

To assign a customer to a price level

1. On the People menu, click Customers.

2. Double-click the customer that you want to assign to a price level.

3. On the General tab in the Price level box, select the appropriate price level.

4. Click Save and Close.

For more information...

Click Help in the Customer window.
To define the price levels for an item

1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to modify.

3. Click the Pricing tab, and then type the appropriate prices in the Price level A, Price level B, and Price level C boxes.

4. Click Save and Close.

If customers are not in the store database, how can I apply a price level?

As an alternative to assigning customers to a price level, you can instruct your cashiers to apply a price level to a transaction in certain situations. In this way, you can use a price level for customers who are not in your store database. To take advantage of this functionality, consider assigning some of your employees to the Supervisor or Manager roles, because only employees in those roles can adjust item prices or apply discounts.

For more information...

Click Help in the Item window.
Putting an item on sale

Things to know

Can I put an item on sale for a set period of time and then have it return to its regular price?
You can temporarily reduce the price of an item and set the sale schedule for the price reduction. During the sale, when the item is rung up by a cashier, it will automatically ring up at the sale price. When the sale expires, the item will once again ring up at its regular price.

For more information...
Click Help in the Item window.

To put an item on sale

1. On the Inventory menu, click Items.

Or use the Inventory Center
In the Views area, click Items.

2. Double-click the item that you want to put on sale.

3. Click the Pricing tab, and then select This item is on sale.

4. Type the sale price, and then select the start and end dates for the sale.

5. Click Save and Close.
PART 9: PRICE AND COST MANAGEMENT

Managing Discounts

In this chapter

Understanding discounts

Creating discounts
  Create an item discount
  Create a preset discount
  Create a discount for a specific customer
  Duplicate an item or preset discount

Working with existing discounts
  Modify an existing discount
  Make a preset discount inactive
  Set the item discount that is associated with an item
  Change the items associated with a preset discount
  Change the list of associated items in an item discount
  Delete an item or preset discount

Setting up a quantity discount pricing schedule
In this chapter, continued

Preventing discounts
  Prevent manual discounts on a specific item
  Prevent an employee from applying discounts
Understanding discounts

Point of Sale provides several ways to offer discounts to your customers. These discounts are in addition to the variety of prices that you can assign to each item (price levels and sale prices), so you will be able to design a pricing and discount scheme for your store that is as simple or as sophisticated as you need it to be.

<table>
<thead>
<tr>
<th>Type of discount or reduction</th>
<th>Purpose of discount</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customer discount</td>
<td>Automatically discount all transactions for a specific customer.</td>
<td>A florist didn’t use the right flowers in an order, so the florist sets a 10% discount for the customer to get him to come back again.</td>
</tr>
<tr>
<td>Item discount (Mix and Match, unit pricing, and Buy X, Get Y)</td>
<td>Discount an item automatically when it is added to a transaction that meets the conditions of the discount.</td>
<td>A bookstore offers a 20% discount to customers who purchase more than four paperbacks in a single transaction.</td>
</tr>
<tr>
<td>Quantity discount pricing schedule</td>
<td>As with a Mix and Match item discount, discount a single item when purchased in quantity.</td>
<td>To encourage sales, a store owner sets up a quantity discount pricing schedule for a discontinued item.</td>
</tr>
</tbody>
</table>

Things to know

If I want to move large quantities of a discontinued product, what would be an effective discount strategy?

A quantity discount would work well when you want to move large quantities.

What type of discount would be applied to exceptionally good customers?

A customer discount works as a very personalized discount that is given for specific reasons to special customers. For example, a certain contractor is a home improvement store’s best customer, so the store owner sets a 15% customer discount that is applied automatically to all of the contractor’s transactions.
What would be an effective discount to use when a customer provides the cashier with proof that the same product is cheaper at another store.

In this case, you would probably want to make a one-time price adjustment, which the manager would enter manually.

What kind of discount should I use when I want to discount damaged goods?

A preset discount would work well in this situation. You would authorize the cashiers to use the preset on any damaged merchandise.

How do item discounts differ from customer discounts?

Item discounts are applied to a specific item and will benefit any customer who purchases the item. Customer discounts apply to the individuals regardless of what they purchase.

<table>
<thead>
<tr>
<th>Type of discount or reduction</th>
<th>Purpose of discount</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preset discount</td>
<td>Make a discount available to cashiers when a certain item is added to a transaction.</td>
<td>Every Tuesday, the cashiers in a wine shop apply a preset discount that sells local wines at 10% over cost.</td>
</tr>
<tr>
<td>Transaction discount</td>
<td>Manually apply a discount to a transaction in progress.</td>
<td>Faced with an angry customer, a supervisor applies a 10% discount to the customer’s current transaction.</td>
</tr>
<tr>
<td>Line item discount</td>
<td>Manually apply a discount to a line item in a transaction in progress.</td>
<td>An antiques dealer convinces a customer to buy two pieces by discounting the price of one piece.</td>
</tr>
<tr>
<td>Price level</td>
<td>Provide varying prices for an item.</td>
<td>The owner of a crafts shop sets up price levels for her walk-in, Internet, and business customers.</td>
</tr>
</tbody>
</table>
### Type of Discount or Reduction

<table>
<thead>
<tr>
<th>Type of Discount or Reduction</th>
<th>Purpose of Discount</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Price adjustment</td>
<td>Manually change the price of a line item in a transaction in progress.</td>
<td>To avoid being undersold, an electronics store manager types a one-time lower price for a television into the transaction pane.</td>
</tr>
<tr>
<td>Sale price</td>
<td>Put a specific item on sale for a set period of time.</td>
<td>A department store owner preparing for a Labor Day sale uses the Inventory Wizard to set sale prices for all items in the Housewares department.</td>
</tr>
</tbody>
</table>

**Tip**

Only employees in certain roles can change prices and apply transaction and line item discounts at the register. If you want employees to have access to these features, you will need to assign them to the Supervisor or Manager role. Item, customer, and preset discounts are applied regardless of the employee’s role.

Is there a type of discount that would be most effective with an irate customer?

Set up a preset discount that allows cashiers to discount a transaction in progress by a certain percentage.

If a store owner wanted to reduce overstocked items or promote a new item, what would be an appropriate discount strategy?

Mix and Match, unit pricing, and Buy X, Get Y item discounts work well in these situations. For example, a store owner might want to offer a Buy 2, Get 1 Free special to promote a new item in the store. Or, to reduce overstock, a store owner might offer unit pricing on several styles of glassware.
Creating discounts

**Item Discount.** An item discount will be applied automatically to its associated items when they are added to transactions. This is true regardless of the rights of the employee who processes the transaction.

There are three types of item discounts:

- **Mix and Match: Unit price** - Provides a pricing schedule for items that are purchased in quantity. You must specify the number of associated items that customers must purchase in order to receive one of the prices that you specify in each row in the Item Discount window. Customers will receive the discount price for the price level they are assigned to.

- **Mix and Match: Percent off** - Provides a discount schedule for items that are purchased in quantity. You must specify the number of associated items that customers must purchase in order to receive one of the percentage discounts that you specify in each row. Customers will receive the discount for the price level they are assigned to.

- **Buy X, Get Y** - Provides a special price for additional items when a certain number of items are purchased at the regular price. You must specify the number of associated items the customer must purchase at the regular price in order to receive the quantity you specify at the discount price.

**Things to know**

If a customer buys four items when only three are required for the unit price or percent off discount, how do I make sure that the extra item is sold at the discounted price, too?

When you create the item discount, select the “Discount odd items” check box.

In the Buy X, Get Y type of item discount, what should I do if I want to offer the additional items for free?

If you want customers to receive the additional items free, specify $0.00 as the discount price.

**For more information...**

Click Help in the Item Discount window or Help in the Add Items dialog box.
To create an item discount

1. On the Inventory menu, point to Discounts, and then click Item Discount.

   Or use the Inventory Center
   In the Views area, click Item Discounts.

2. On the toolbar, click New.

3. Enter a unique description for the item discount.

4. In the Type box, select the type of item discount that you want to create, and then type the settings for the discount.

5. Click Add.

6. Select the items that you want to discount, and then click OK.

7. To save this item discount and begin entering information for another, click Save and New, or if this is the only item discount that you want to create, click Save and Close.
How can I tell if a line item has a discount applied to it? A line item that has had a discount applied to it appears in bold in the transaction pane.

How does the current price differ from the regular price? The regular price is the price in the store database. The current price is the price currently set on a line item in a transaction.

Preset discount. A preset discount is not automatically applied to its associated items. Instead, it is applied according to the policies that you set for your store. For example, you can create a preset discount that can be applied to damaged goods, one that can be selectively applied to the items in a certain department or category, or one that can be applied when the customer is a senior citizen.

There are four types of preset discounts:

- **Amount off current price**—Discounts the current prices (in a transaction) of the associated items by the amount that you specify.
- **Percent off regular price**—Discounts the regular prices of the associated items by the percentage that you specify.
- **Markup from cost**—Discounts the associated items by marking their prices up from cost by the percentage that you specify.
- **Profit margin**—Discounts the associated items by temporarily setting their profit margin to the percentage that you specify.

**To create a preset discount**

1. On the **Inventory** menu, point to **Discounts**, and then click **Preset Discounts**.
2. On the toolbar, click **New**.
3. Type a unique description for the preset discount.

For more information... Click Help in the Preset Discount window.
How can I create a discount for senior citizens as a store policy?
A “Percent off regular price” preset discount would allow cashiers to apply a discount if a customer is over a certain age. Setting price levels is another option.

Will items that are added to a transaction after a preset discount is applied also receive the discount?
A preset discount will only be applied to the line items currently in the transaction that meet the conditions of the preset discount. Items added to the transaction after the preset discount is applied will not be discounted unless the preset discount is applied again.

For more information...
Click Help in the Item Discount or Preset Discount windows.

4 In the Type box, select the type of preset discount that you want to create, and then type the settings for the discount.

5 If you do not want this discount to be available to cashiers at this time, select the This discount is inactive check box.

6 Under Items to discount, take one of these actions:
   • Select All items.
   • Select the type of group, such as Items in certain departments, and then select the groups for which this discount should available.

7 To save this preset discount and begin entering information for another, click Save and New, or if this is the only preset discount that you want to create, click Save and Close.

Tip
Create task pad buttons to make it easier for cashiers to apply preset discounts.
With a customer discount, does every item that the customer purchases get discounted?
Yes, once a discount has been set for a customer, each item sold to that customer will automatically ring up at the discounted price.

Could a customer discount apply to a customer who purchases over a certain amount annually?
Yes, Point of Sale makes this type of discount possible.

Where can cashiers view the savings that a customer received on a transaction?
At the left bottom of the POS View screen under the function keys, you can see the amount discounted and how much was saved.

**To create a discount for a specific customer**

You can set a customized discount for a special customer.

1. On the People menu, click Customers.

   **Or use the Customer Center**
   In the Views area, click Customers.

2. Double-click the customer that you want to set a discount for.

3. In the Discount box, type the discount percentage that you want this customer to have.
   For example, to give the customer a 10% discount, type 10.

4. Click Save and Close.
To duplicate an item or preset discount

Duplicating a discount allows you to create similar discounts quickly. The items associated with your original discount will be automatically associated with the new discount.

1. On the **Inventory** menu, point to **Discounts**, and then click **Item Discounts** or **Preset Discounts**, as appropriate.

2. Select the discount that you want to duplicate.

3. On the toolbar, click **Duplicate**.

4. Modify the description and any other settings as needed.

5. Add or remove associated items, as needed.

6. To save this discount and begin entering information for another, click **Save and New**, or if this is the only discount that you want to create, click **Save and Close**.

**Note**

Some preset discounts are based on the prices and costs that are set in the store database for the associated items. Since the prices that appear in a transaction are subject to other adjustments, such as sale prices or item or customer discounts, applying a preset discount might actually raise the price of an item in a transaction.
Working with existing discounts ________________

Why make a preset discount inactive?
Making a preset discount inactive makes the discount unavailable to cashiers but leaves the discount in your store database for future use.

I made a preset discount inactive. How do I activate it again?
To make the discount active again, clear the “This discount is inactive” check box.

For more information...
Click Help in the Item Discount or Preset Discount windows.

To modify an existing discount

1. On the Inventory menu, point to Discounts, and then click Item Discounts or Preset Discounts, as appropriate.
2. Double-click the discount that you want to modify.
3. Make your changes to the discount settings.
4. Change the Items to discount list, as needed.
5. Click Save and Close.

To make a preset discount inactive

1. On the Inventory menu, point to Discounts, and then click Preset Discounts.
2. Double-click the preset discount that you want to make inactive.
3. Select the This discount is inactive check box.
Are price levels an alternative to discounts?
Price levels are another way to give price considerations to valued customers. Price levels allow you to charge different prices for different customers, such as when you offer special prices to your best customers, to customers who belong to loyalty programs, or to customers in certain groups, such as senior citizen or Internet customers. Using price levels involves defining the price levels for each of your items.

For more information...
Click Help in the Item Discount or Preset Discount windows.

4 Click Save and Close.

To set the item discount that is associated with an item

1 On the Inventory menu, click Items.

Or use the Inventory Center
In the Views area, click Item.

2 Double-click the item that you want to modify.

3 On the Pricing tab, under Item discounts, perform one of these actions:
   - To clear the current discount, select No item discount.
   - For a Mix and Match item discount, select Mix and Match, and then select the item discount from the list.
   - To select a Buy X, Get Y item discount, select Buy X, Get Y, and then select the item discount from the list.
How does Point of Sale apply a percentage to a discount when it calculates?
Point of Sale calculates the new price using multiple decimal places and then rounds to two decimal places. See more about rounding and decimal places in Chapter 29, “Managing Prices and Costs.”

If I offer a preset discount for certain departments, can I also include items that are not assigned to a department?
Yes, by selecting the “Not assigned” check box in the list of departments. This option is also available for categories and suppliers.

For more information…
Click Help in the Item Discount window.

- To use a custom quantity discount, select **Use this quantity discount pricing schedule**, and then specify the quantity that must be purchased for a customer to receive one of the prices that you entered for each row. If you want odd items to receive the discount, select the **Discount odd items** check box.

4 Click **Save and Close**.

**To change the items associated with a preset discount**

1 On the Inventory menu, point to Discounts, and then click Preset Discounts.

2 Double-click the preset discount that you want to modify.

3 Under Items to discount, perform one of these actions:
   - To make the discount available for all items in your store, select **All items**.
Managing Discounts

How can I stop offering an item discount for a specific item?
There are two ways to “turn off” an item discount:

- By modifying the item
- By removing the item from the list of items in the item discount.

To change the list of associated items in an item discount

1. On the Inventory menu, point to Discounts, and then click Item Discounts.

2. Double-click the discount that you want to modify.

3. Under Items to discount, perform one or more of these actions:
   - To remove an item, select it, and then click Remove.

For more information...
Click Help in the Preset Discount window or Help in the Add Items dialog box.
• To add one or more items, click Add. In the Add Items dialog box, select the items that should receive this discount.

4 Click Save and Close.

To delete an item or preset discount

1 On the Inventory menu, point to Discounts, and then click Item Discounts or Preset Discounts, as appropriate.

2 Select the discount that you want to delete.

3 On the toolbar, click Delete 🗑.

Since I have finished using a certain discount, is it okay to delete it?
Yes, item and preset discounts can be deleted. In the case of preset discounts, you can choose to make the discount inactive instead. See the procedure earlier in this chapter.

For more information...
Click Help 🎨 in the Preset Discount window or Help 🎨 in the Add Items dialog box.
Setting up a quantity discount pricing schedule

A quantity discount pricing schedule is a table of prices that offers customers reduced prices based on the number of items that they purchase. For example, you might offer a slightly reduced price to a customer who purchase 5 or more of an item. There are two ways to set up these discount schedules:

- Create a Mix and Match unit pricing item discount.
- Set up a discount schedule for an individual item.

Typically, setting up item discounts is preferable and will save you time, because an item discount can be applied to as many or as few items as you want.

For more information...
Click Help in the Item Discount or Preset Discount windows.

To set up a discount schedule for a specific item

1. On the Inventory menu, click Items.

   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to modify.

3. Click the Pricing tab.

4. Under Item Discounts, select Use this quantity discount pricing schedule.

5. In the Quantity column, specify the number of items that customers must purchase in order to receive one of the prices that you enter in Price A, Price B, or Price C.

Customers receive the discount price for the price level they are assigned to. In the example below, two of the items at regular sale price are $124.99 each. Those assigned to Price A would pay $120.00 each for the same two items.
Preventing discounts

Can I allow line item and transaction discounts on some but not all items?
You can turn off the manual discount feature for items that should not be discounted by cashiers.

What is the easiest way to be sure that an employee cannot make manual discounts at the register?
Assign the employee to the Cashier role.

For more information...
Click Help in the Item window.

To prevent manual discounts on a specific item

1. On the Inventory menu, click Items.
   
   Or use the Inventory Center
   In the Views area, click Items.

2. Double-click the item that you want to modify.
3. Click the Options tab.
4. Select Item is not discountable at the register.
5. Click Save and Close.
To prevent an employee from applying discounts

You can use employee roles and rights to prevent certain employees from applying line item and transaction discounts or reducing prices in a transaction.

1. On the People menu, click Employees.

2. Double-click the employee that you want to modify.

3. In the Role box, select Cashier.

4. Click Save and Close.

Do I need to assign my cashiers to a new role if I want them to be able to apply discounts?

If you want to allow a previously restricted employee to apply discounts, assign the employee to the Supervisor or Manager role. Item, customer, and preset discounts are applied regardless of the employee’s role.

Who can make role changes?

To assign an employee to a different role, you must provide Windows Administrator credentials for the computer where you are working. If you are running Windows XP and you are not already logged on as an Administrator, you will be prompted for Administrator credentials. If you are running Windows Vista and you did not run Point of Sale as an Administrator, you will need to restart Point of Sale.

For more information...

Click Help in the Employee window.
PART 10: ACCOUNTING MANAGEMENT

30

Integrating with Accounting

In this chapter

Integrating with an accounting program
Integrating with Office Accounting 2007
Setting up network accounting integration
  Enable multi-user access in Office Accounting 2007
  Install and run Remote Accounting Setup on the accounting computer
  Run the Accounting Integration Wizard on the Point of Sale computer
Synchronizing with Point of Sale
  Set synchronization options
  View the Synchronization Error Report
  Sort the error report
  Refresh the error report
  Print the error report
  Resolve a synchronization error
In this chapter, continued

Verify that a synchronization error has been resolved
Delete an error that you don’t want to resolve
Synchronize your information manually with Office Accounting 2007
Turn off automatic synchronization

Integrating with Intuit QuickBooks
Posting to accounting for QuickBooks
Importing information from QuickBooks
Providing automatic access to QuickBooks
Point of Sale offers integration with two accounting programs: Microsoft Office Accounting Professional 2007 and Intuit QuickBooks.

Integration with Microsoft Office Accounting is virtually seamless, with automatic and nearly instantaneous exchange of data between the two programs. With QuickBooks integration, you choose regular times to post your Point of Sale data to your QuickBooks accounts.

**To set up accounting integration**

1. On the Settings menu, point to Configure Accounting.

   Or use the Settings Center
   Click Configure Accounting.

2. Follow the instructions in the Accounting Integration Wizard.

   Tip
   If you want to stop sharing information with your accounting software, select “I don’t want to set up accounting integration” when the wizard asks what accounting package you want to use.

---

**Things to know**

After installing both Point of Sale and your accounting software, you can run the Accounting Integration Wizard to integrate the two programs. With the wizard, you can:

- Specify the company file that contains your store’s accounting information
- Specify the password that Point of Sale will use to connect to your accounting software
- Match the general ledger accounts in your company file to posting categories in Point of Sale

Can I access the Accounting Integration Wizard from the Store Setup Wizard?

Yes, from the Settings menu, click Store Setup Wizard, and then click Accounting Integration.
You can integrate Microsoft Office Accounting Professional 2007 with Point of Sale by running the Accounting Integration Wizard. In the wizard, you will indicate that Office Accounting 2007 is your accounting software, select your company file, specify the password that Point of Sale will use to access your accounting information, and map internal Point of Sale accounts called *posting categories* to the accounts you have set up in Office Accounting.

**Note**

You cannot integrate with Microsoft Office Accounting Professional 2007 while it is in Accountant Transfer mode (meaning the company file is closed to changes while an accountant reviews the file). If you attempt to do so, the integration will fail and you will need to restart Point of Sale.

**Synchronizing data and resolving conflicts**

The Accounting Integration Wizard performs an initial exchange of information between the two programs. This exchange is called *synchronization*. During initial synchronization, item, supplier, customer, and tax information in the two programs is compared, and any unique records in either program are sent to the other.

For example, suppose you have customers A, B, C, and D in Point of Sale and customers 1, 2, 3, and 4 in Office Accounting 2007. After synchronization, you will have customers A, B, C, D, 1, 2, 3, and 4 in both programs.
Integrating with Accounting

However, if you have customer 1 in Point of Sale and customer 1 in Office Accounting, the wizard has no way to tell which record is the "right" one, or if both are. Such conflicts will be reported to you in the Synchronization Error Report. After you resolve the problem, the updated information will be picked up during the next synchronization.

Once integration is in place, synchronization continues. Transactions and item receipts processed in Point of Sale are posted to accounting, and changes made to item, customer, supplier, or tax information in one program are transferred to the other. Note that after initial synchronization only new, changed, or deleted records are synchronized; the full lists of records are not compared again.

Once integration is in place, synchronization continues. Transactions and orders processed in Point of Sale can be posted to accounting, and changes made to item, customer, supplier, or tax information in one program can be transferred to the other.

Caution

If you have been using Microsoft Office Accounting Express 2007, you should exercise care in the Accounting Integration Wizard when you map accounts to the Point of Sale posting categories. Some additional accounts might be necessary due to the inventory tracking that is possible in Microsoft Office Accounting Professional 2007. If you have doubts about what accounts to select, consult with an accountant.

Will the synchronization process interfere with store operations?

Because synchronization occurs in the background, people using either program will usually not notice that it is happening.

Will I be able to integrate Point of Sale and Office Accounting if they are installed on different computers?

If you have Office Accounting 2007 and Point of Sale installed on different computers, you can still integrate the two programs, provided that the two computers are on the same network. To do so, you need to enable multi-user access in Office Accounting, and then install and run Remote Accounting Setup on the accounting computer. For more information, see “Setting up network accounting integration” later in this chapter.

For more information...

Click the Help button in the wizard.
Will synchronization happen automatically or only when I tell the computer to synchronize?

You choose whether synchronization happens automatically (recommended) or only when you specifically request it. With automatic synchronization, it usually takes less than a minute for changes made in one program to show up in the other.

Where is the POS Connector add-in that I used for integrating previous releases?

It is no longer necessary. The Accounting Integration Wizard is all that is needed to map your chart of accounts to the posting categories. The POS Connector menu in Small Business Accounting has been replaced by the Office Accounting 2007 toolbar in Manager View.

How items are synchronized

For items, two fields in Point of Sale, item number and description, are compared to two fields in Microsoft Office Accounting Professional 2007, item name and UPC/SKU.

On initial synchronization in the Accounting Integration Wizard, if the data in one of the fields matches the data in either of the fields in the other program, an error will be reported. This is because both an item number and a description are required in Point of Sale, but only an item name is required in Office Accounting; the synchronization service accordingly uses both Point of Sale fields to determine if a record is unique.

- An item in Office Accounting 2007 will be created in Point of Sale as follows:

- An Inventory item will be a Standard item in Point of Sale, and a Non-inventory item will be a Noninventory item. (Kit and Service items will not be created in Point of Sale.)

- The item name will become the item description in Point of Sale.

- The UPC/SKU will become the item number in Point of Sale.

- If a UPC/SKU is not set in Office Accounting, an item number will be generated automatically. This number will be added to the item in both programs.

An item in Point of Sale will be created in Office Accounting 2007 as follows:
• A Standard or Serial-numbered item will be an Inventory item in Office Accounting, and a Noninventory item will be a Non-inventory item.

• Point of Sale serial numbers will not be visible in Office Accounting.

• The item number will become the UPC/SKU in Office Accounting.

• The item description will become the item name in Office Accounting.

Once the items are synchronized, inventory quantity changes in either program – either through sales, transfers, or purchase ordering – will be reflected in both programs.

If two items that are in conflict represent different products, simply change the piece of information that is causing the conflict. For example, if an item number in Point of Sale is already in use in Office Accounting 2007 as the UPC/SKU for a completely different item, you can change either the item number in Point of Sale or the UPC/SKU in Office Accounting. After the next synchronization, both items will exist in both programs.

If the two items that are in conflict are, in fact, the same item, make sure the item information in Office Accounting 2007 is complete and accurate, and then delete the item from Point of Sale. On the next synchronization, the item will be re-created in Point of Sale.

What fields are compared when records are synchronized?
The following tables show what fields are compared during synchronization:

| -Items- |
|-----------------|------------------------|
| Originates in Point of Sale | Becomes in Office Accounting |
| Item number | UPC/SKU |
| Item description | Item name |

<table>
<thead>
<tr>
<th>Originates in Office Accounting 2007</th>
<th>Becomes in Point of Sale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item name</td>
<td>Item description</td>
</tr>
<tr>
<td>UPC/SKU</td>
<td>Item number</td>
</tr>
</tbody>
</table>

If there is no UPC/SKU in Office Accounting, a new item number will be generated automatically and entered in both programs.
How customers are synchronized

For each customer, Point of Sale requires a customer number and either a first or last name. Microsoft Office Accounting Professional 2007 is set up to have companies as customers rather than individuals, so it requires only a single, all-in-one field customer name. A customer ID field is optional.

On initial synchronization in the Accounting Integration Wizard, the first and last names of Point of Sale customers are concatenated (strung together) and then compared to the customer names in Office Accounting 2007. If any exact matches are found, they are reported as errors. For example, a customer in Point of Sale with first name "Isabel" and last name "Martins" will be reported as an error if the customer "Isabel Martins" already exists in Office Accounting. Conversely, a customer with "Isabel" as the first name and a blank last name would not be reported as a conflict. Point of Sale customer numbers are also compared to any Office Accounting customer IDs that are in use.

After initial synchronization, a customer added to Office Accounting 2007 will be created in Point of Sale as follows:

- A customer name with at least one space in it will be split into first and last names in Point of Sale, and a unique customer number will be assigned. For example, a customer named "Northwind Traders" would become a customer with first name "Northwind" and last name "Traders" in Point of Sale. If this split name does not meet your needs, you can put the whole company name into the last name field in Point of Sale. It will still synchronize properly with the Office
A customer name with no spaces in it will become the customer's last name in Point of Sale, and a unique customer number will be assigned.

A new customer in Point of Sale will be created in Office Accounting 2007 as follows:

- The customer's first and last names will be concatenated and used as the customer name in Office Accounting.
- The customer number will become the customer ID in Office Accounting. This ID will not be visible unless you have selected the “Use customer ID” check box. To set this option, click Preferences on the Company menu in Office Accounting, and then click the Customers tab.

### Customer purchase history

A customer’s Point of Sale purchase history is sent to Office Accounting 2007 during initial synchronization, and any later Point of Sale purchases are appended to the customer’s Office Accounting record when the transactions are synchronized. However, if sales are performed in Office Accounting, including online sales, the customer's history in Point of Sale is *not* updated. Changes to the store’s item quantities are communicated in both directions (meaning a sale performed in Office Accounting will show up as reduced quantities in Point of Sale), but Office Accounting sales cannot be viewed in Point of Sale, either in customer history or as journaled receipts.

<table>
<thead>
<tr>
<th>Suppliers</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Originates in</td>
<td>Becomes</td>
<td></td>
</tr>
<tr>
<td>Point of Sale</td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td></td>
<td>Office</td>
<td>Office</td>
</tr>
<tr>
<td></td>
<td>Accounting</td>
<td>Accounting</td>
</tr>
<tr>
<td>Supplier name</td>
<td>Vendor name</td>
<td>Supplier name</td>
</tr>
<tr>
<td>Supplier code</td>
<td>Vendor ID</td>
<td>and supplier code</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sales taxes and tax authorities</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Originates in Point of Sale</td>
<td>Becomes</td>
<td></td>
</tr>
<tr>
<td></td>
<td>in</td>
<td>in</td>
</tr>
<tr>
<td></td>
<td>Office</td>
<td>Office</td>
</tr>
<tr>
<td></td>
<td>Accounting</td>
<td>Accounting</td>
</tr>
<tr>
<td>Tax authority</td>
<td>Tax code</td>
<td></td>
</tr>
<tr>
<td>Tax authority code</td>
<td>Name of tax code</td>
<td></td>
</tr>
<tr>
<td>Tax authority description</td>
<td>Tax code description</td>
<td></td>
</tr>
</tbody>
</table>

Accounting 2007 record as long as the first name field is blank.
Resolving customer conflicts

If two customers that are in conflict represent different people or companies, resolve the conflict by making a small change to the customer name in either program. After the next synchronization, both customers will appear in both programs.

If two customers that are in conflict are, in fact, the same person or company, make sure the information in Office Accounting 2007 is complete and accurate, and then delete the customer in Point of Sale. On the next synchronization, the customer will be re-created in Point of Sale.

How suppliers are synchronized

For each supplier, Point of Sale requires both a supplier code and a supplier name. Microsoft Office Accounting Professional 2007 only requires a vendor name, with a vendor ID field being optional. On initial synchronization in the Accounting Integration Wizard, Point of Sale supplier names are compared to Office Accounting 2007 vendor names, and Point of Sale supplier codes are compared to any Office Accounting vendor IDs that are in use. If any matches are found, a conflict is reported.

After initial synchronization, a vendor added to Office Accounting 2007 will be created as a supplier in Point of Sale as follows:

• The vendor name will be used as both the supplier name and supplier code.

A new supplier in Point of Sale will be created as a vendor in Office Accounting 2007 as follows:
• The supplier name will become the vendor name in Office Accounting.

• The supplier code will become the vendor ID in Office Accounting. This ID will not be visible unless you have selected the “Use vendor ID” check box. To set this option, click Preferences on the Company menu in Office Accounting, and then click the Vendors tab.

Resolving supplier and vendor conflicts

If a Point of Sale supplier and an Office Accounting 2007 vendor that are in conflict are different people or companies, resolve the conflict by making a change to the supplier name or code in Point of Sale or to the vendor name or ID in Office Accounting. After the next synchronization, both suppliers will exist in Point of Sale and both vendors will exist in Office Accounting.

If a supplier and vendor that are in conflict are, in fact, the same person or company, make sure the information in Office Accounting is complete and accurate, and then delete the supplier in Point of Sale. On the next synchronization, the supplier will be re-created in Point of Sale.

How item receipts are synchronized

In Point of Sale, the only required information in an item receipt is the item receipt number. In Microsoft Office Accounting Professional 2007, item receipts are required to be associated with a specific vendor. When a Point of Sale item receipt is sent to Office Accounting, the Office Accounting item receipt will have a number generated by Office Accounting, but the Point of Sale item receipt number will appear in

Do I have control over when synchronization occurs?

You choose whether synchronization happens automatically (recommended) or only when you specifically request it.

How long does it take for changes made in one program to show up in the other during automatic synchronization?

With automatic synchronization, it usually takes less than a minute for changes made in one program to show up in the other.
I don’t see any open item receipts that have been sent to Office Accounting 2007 from Point of Sale. Why is that?
Only closed Point of Sale item receipts are sent to Office Accounting.

Are the item receipts that originate in Office Accounting 2007 supposed to be sent to Point of Sale?
No, they are not sent to Point of Sale.

You can associate a Point of Sale item receipt with an Office Accounting 2007 purchase order. Simply enter the number of the Office Accounting purchase order into the Accounting reference box in the Point of Sale item receipt. Provided the supplier in the Point of Sale item receipt matches the vendor in the referenced Office Accounting purchase order, the Office Accounting item receipt will automatically be associated with the purchase order during synchronization.

Only closed Point of Sale item receipts are sent to Office Accounting 2007, and only if they are closed after the initial synchronization is performed. Closed item receipts that exist in the store database at the time of initial synchronization are not sent to Office Accounting.

The resulting item receipts in Office Accounting will be open until a vendor bill is generated for them. Item receipts that originate in Office Accounting 2007 are not sent to Point of Sale.

**Resolving item receipt conflicts**

Because the item receipts in the two programs do not share a single item receipt number, a conflict between item receipt numbers is not possible. However, an item receipt might still fail to synchronize. This is because the synchronization of item receipts is dependent on all of the information included within the item receipt: the items listed, the selected supplier, and so on. If any of the included information fails to synchronize, then the item receipt
I have a tax agency in Office Accounting 2007 that is not associated with any tax codes, so how can it be represented in Point of Sale?

A tax agency in Office Accounting 2007 that is not associated with any tax codes will not be represented in Point of Sale.

Why don’t I see the same level of tax detail in Office Accounting 2007 that I see in Point of Sale? Am I missing something?

Point of Sale sales taxes can contain very specific rules about how and when the taxes are applied. For example, a 10% sales tax might be applied to only the first $50 of a transaction total. This level of detail is not replicated in Office Accounting 2007, where only the fact that $5 was collected for a certain sales tax levied by a certain tax agency is significant.

I have a tax agency in Office Accounting 2007 that is not associated with any tax codes, so how can it be represented in Point of Sale?

A tax agency in Office Accounting 2007 that is not associated with any tax codes will not be represented in Point of Sale.

How sales taxes and tax authorities are synchronized

The synchronization of sales taxes and tax authorities is somewhat complex. This is because Point of Sale uses two record types to manage tax information, while Microsoft Office Accounting Professional 2007 uses three.

In Point of Sale, tax authorities (records that both specify tax rates and represent specific tax agencies) are listed in sales taxes (records that can be associated with specific items or transactions).

In Office Accounting, tax agencies are associated with one or more tax codes (records that specify tax rates), which are listed in sales tax groups (records that can be associated with specific invoices, sales orders, and quotes).

These records are synchronized as follows:

- A tax authority that originates in Point of Sale becomes a tax code in Office Accounting 2007. The tax authority’s code becomes the name of the tax code.

The new tax code is temporarily associated with a tax agency called "POS tax agency," with a quarterly payment term. In order to pay collected taxes to the actual tax agency, you will need to modify the Office Accounting tax code by selecting the correct tax agency.
Why did one of my tax authorities fail to be created in Office Accounting 2007?

In rare cases, Point of Sale tax authorities (and subsequently any sales taxes that contain those tax authorities) will fail to be created in Office Accounting 2007 due to an Office Accounting exception error. The cause of this error is usually the absence in Office Accounting of a sales tax liability account (such as Sales Tax Payable) with the account number of 2300. Consult with your accountant about adding an account with this number, perhaps as a subaccount of your regular tax liability account. Without it, synchronization will be incomplete.

Once account 2300 exists, you can resolve the synchronization errors by making small changes to your Point of Sale tax authorities. This will place the tax authorities into the list of records to be updated during the next synchronization.

- A sales tax that originates in Point of Sale becomes a sales tax group in Office Accounting 2007, with any associated tax authorities showing up as associated tax codes. The sales tax code becomes the name of the sales tax group. The sales tax description is not used in Office Accounting.

Point of Sale sales taxes can contain very specific rules about how and when the taxes are applied. For example, a 10% sales tax might be applied to only the first $50 of a transaction total. This level of detail is not replicated in Office Accounting 2007, where only the fact that $5 was collected for a certain sales tax, levied by a certain tax agency, is significant.

- A tax code that originates in Office Accounting 2007 becomes a tax authority in Point of Sale. The name of the tax code becomes both the tax authority’s code and description.

The tax code’s underlying association with a tax agency can be made more apparent in Point of Sale by including the tax agency name in the description of the tax code.

If a tax code contains a rate schedule, the Point of Sale tax authority is set to the rate that is currently in effect. When a new rate takes effect in Office Accounting, the rate in Point of Sale will automatically be updated during synchronization.

A sales tax group that originates in Office Accounting 2007 becomes a sales tax in Point of Sale, with any associated tax codes showing up as associated tax authorities. The name of the sales
If a tax authority fails to synchronize, will the associated sales tax also fail?

The synchronization of sales taxes is dependent on the included tax authorities. If any of the included tax authorities fails to synchronize, then the sales tax will also fail to synchronize. Once you resolve the underlying error, the sales tax will be sent to accounting automatically during the next synchronization.

- The tax group becomes both the sales tax code and the sales tax description.
- A tax agency in Office Accounting 2007 that is not associated with any tax codes will not be represented in Point of Sale.

If you delete a tax authority in Point of Sale, the corresponding tax code in Office Accounting 2007 will only be deleted if it has not yet been used. Otherwise, it will be marked as inactive. If you delete a sales tax in Point of Sale, there is no corresponding action in Office Accounting.

**Item taxes**

In Office Accounting 2007, each line item in a sales invoice has an associated item tax. For Point of Sale transactions this item tax will be set to "POS Item Tax," with a note in the Memo field that explains that any sales taxes for the items were collected in Point of Sale.

If any of the information in a tax record that is required to be unique matches the corresponding data in the other program, an error will be reported. If the records that are in conflict represent different taxes or tax agencies, simply change the piece of information that is causing the conflict. For example, if a sales tax code in Point of Sale is already in use in Office Accounting 2007 as the name of a sales tax group for a different sales tax, you can change either the sales tax code in Point of Sale or the sales tax group name in Office Accounting. After the next synchronization, both sales taxes will exist in both programs.

If the two tax records that are in conflict are, in fact, the same tax or tax agency, you will need to determine which program contains the more...
Are sales generated in Office Accounting 2007 reflected in Point of Sale?

Aside from updating item quantities as appropriate, sales generated in Office Accounting 2007, including online sales, are not reflected in Point of Sale. For example, suppose a customer purchases an item from your Web store and you process that sale in Office Accounting. After synchronization, Point of Sale will show the reduced in-stock quantity for the item purchased, but the transaction will not be listed in the customer’s purchase history in Point of Sale and no receipt will be available in the store database.

Complete information. Office Accounting 2007 tax records cannot be deleted, so you might be tempted to delete the Point of Sale record and let the Office Accounting record transfer into Point of Sale. Keep in mind, though, that sales taxes in Point of Sale can contain detailed information about how the tax is applied (such as tax amounts that are only applied to a portion of a sales amount). For this reason, you might want to make one of the records unique so that both will continue to exist separately. You can stop using the Office Accounting record; once you’ve paid out all taxes owed for that record, the tax record that originated in Point of Sale can become the controlling record.

For example, suppose you have a sales tax group in Office Accounting 2007 that is named "State" and a sales tax in Point of Sale that has "State" as its code or description. Suppose you can’t delete the Office Accounting sales tax group because it is already associated with at least one invoice, and you don’t want to delete the Point of Sale sales tax because it contains the detailed rules for applying the tax to sales transactions. When the conflict between these two records is reported to you, you can resolve it by changing the name of the Office Accounting sales tax group to "StateOld." When you synchronize the programs again, a new "StateOld" sales tax will be created in Point of Sale (which you will never use), and a new "State" sales tax group will be created in Office Accounting.

How transactions are synchronized

Sales transactions
When synchronizing transactions, Point of Sale posts each transaction to Microsoft Office Accounting Professional 2007 as invoices.

The following transaction information is recorded in Office Accounting 2007:

- The Point of Sale transaction number (included in the invoice document in the Reference box)
- The line items in the transaction, including the quantity sold and the item prices charged
- The customer associated with the transaction, or "POS Customer" if a specific customer is not added to the transaction
- The sales taxes collected and their associated tax authorities
- Any discounts applied to the transaction
- The payments received for the transaction

**Invoice information**

The Office Accounting 2007 invoice for a Point of Sale transaction will include line items for the each of the following:

- Line items in the transaction
- Taxes collected as part of the transaction (one line item per tax authority)
- Debit card surcharges collected as part of the transaction
- Gift cards issued or redeemed during the transaction

In addition to the invoice data, the appropriate general ledger accounts are updated to reflect the
Does a Cash Sale invoice require a Received Payment document?
A Cash Sale invoice is settled immediately, which means no Received Payment document is required.

How are discounts shown in invoices in Point of Sale indicated in Office Accounting?
Any discount shown in an invoice is set as an amount rather than a percentage. The amount is calculated based on the item price stored in Office Accounting rather than the price that was shown in the transaction.

Transactions that are paid using a single payment method are synchronized as Cash Sale invoices, with the payment method set to match the payment method used in Point of Sale. A Cash Sale invoice is settled immediately, which means no Received Payment document is required.

Transactions that are paid using multiple payment methods are synchronized as regular invoices. Each invoice will have a Received Payment document for each of the payment methods used in the transaction. If multiple payments are received in a transaction using a single payment method (such as when a customer pays with two different MasterCard credit cards), those payments will be combined into a single Received Payment document.

Gift cards
As mentioned above, gift cards issued or redeemed during a Point of Sale transaction are included as line items in the corresponding invoice in Microsoft Office Accounting Professional 2007. However, when a gift card is issued in Point of Sale, it is not really considered an item sale. Instead, when the issued card is reported to Office Accounting 2007, the money received from the customer is placed in the Undeposited Funds account (or whichever account
Why isn’t a gift card issued in Point of Sale considered an item sale?

It isn’t considered an item sale because the store “owes” the value of the card to the cardholder.

When a gift card is used as payment in a Point of Sale transaction, it is not handled like other payment methods. Instead, the gift card liability account is debited the amount of the payment (effectively a credit), while the asset account representing the value of the in-stock merchandise in the store is debited the amount of the payment (effectively a debit).

Similarly, when a gift card is used as payment in a Point of Sale transaction, it is not handled like other payment methods. Instead, the gift card liability account is debited the amount of the payment (the liability is reduced, effectively a credit), while the asset account representing the value of the in-stock merchandise in the store is debited the amount of the payment.

The following table illustrates these account relationships. (Note that the asset accounts do not reflect profit. The markup on the items purchased using the gift card represents the store’s profit.)

<table>
<thead>
<tr>
<th>Transaction</th>
<th>Undeposited Funds</th>
<th>Gift card Liability</th>
<th>Value of Merchandise</th>
<th>Total Asset</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting value</td>
<td>$0</td>
<td>$0</td>
<td>$30</td>
<td>$30</td>
</tr>
<tr>
<td>Gift card issued</td>
<td>$30</td>
<td>$30</td>
<td>$30</td>
<td>$30</td>
</tr>
<tr>
<td>Gift card redeemed</td>
<td>$30</td>
<td>$0</td>
<td>$0</td>
<td>$30</td>
</tr>
</tbody>
</table>
Debit cards

Debit card transactions are synchronized in the same way as transactions involving other payment methods. The only difference is the handling of any debit card surcharges (such as fees you charge customers for allowing them to use debit cards or fees you charge for providing cash back). Each fee that is collected in a transaction will be listed as a line item in the invoice in Microsoft Office Accounting Professional 2007. The fees will be credited to the "Debit card surcharge" and "Debit card cash back surcharge" accounts that you specified in the Accounting Integration Wizard.

Returns

Return transactions are synchronized similarly to sales transactions, except that Credit Memo documents are created in Microsoft Office Accounting Professional 2007 instead of invoices. If a refund is issued to the customer using a single payment method, a Cash Credit Memo is created and settled immediately, with no Refund document created. If the refund is issued using multiple payment methods, a Refund document is created for each payment method.

Voids

When a Point of Sale transaction is voided, the effects of the transaction in Microsoft Office Accounting Professional 2007 are reversed. Any accounts that were adjusted are adjusted back, and any associated invoices and Received Payment documents are voided.

Cash Payouts

In Microsoft Office Accounting Professional 2007, there is no transaction type that corresponds to the
Integrating with Accounting

Cash Payout transaction type in Point of Sale. For this reason, cash payouts will not have associated payment documents. Instead, they will be reflected only in journal entries, with the payout amounts added to the "Cash payout" expense account that you specified in the Accounting Integration Wizard.

Resolving transaction conflicts
Transaction conflicts will not occur, but transactions can fail to synchronize. This is because the synchronization of transactions is dependent on all of the information included within the transaction: the items listed, the sales taxes collected, and so on. If any of the included information fails to synchronize, then the transaction will also fail to synchronize. Once you resolve the underlying error, the transaction will be sent to accounting automatically during the next synchronization.

Transactions will fail to synchronize in these cases:

- When items with identical item numbers or descriptions (duplicates) are entered in both Point of Sale and Office Accounting 2007
- If the Office Accounting 2007 database is busy (reported in the Synchronization Error Report).
- If you are trying to post transactions for a fiscal year hasn’t yet been set up in Office Accounting 2007 (reported in the Synchronization Status window).
- If Office Accounting 2007 is in Accountant Transfer mode, meaning the company file has been closed to changes while it is being reviewed by an accountant (reported in the Synchronization Status window).

How can I resolve a conflict when a new item comes into inventory and one employee, unaware of the actions of another employee, adds the item in POS View while the other employee adds the same item into Office Accounting 2007 using the same item number?

Assuming that the item was subsequently included in a sales transaction, at the time of the next synchronization, the duplicate items will be detected and will fail to synchronize. As a result, the transaction involving the Point of Sale item will also fail to synchronize. Modify one of the items or delete the Point of Sale item, and then the transaction will synchronize.

Why can’t I receive a file back from my account when I am in Accountant Transfer mode?

While Office Accounting 2007 is in Accountant Transfer mode, you should turn off automatic synchronization. Otherwise, the synchronization service will interfere with receiving the company file back from the
Setting up network accounting integration

Things to know

To set up accounting integration over the network, you need to complete the following:

- On the accounting computer, enable multi-user access in Office Accounting 2007, and then install and run Remote Accounting Setup on the accounting computer.
- On the Point of Sale computer (with the store database), run the Accounting Integration Wizard.

If Microsoft Office Accounting Professional 2007 and Point of Sale are installed on different computers, some additional set up is required.

To enable multi-user access in Office Accounting 2007

2. Select Enable, and then click OK.

**Important**

For proper synchronization, make sure the system time on the two computers is the same.

To install and run Remote Accounting Setup on the accounting computer

1. Insert the Point of Sale CD into the disk drive.
2. Click Install Remote Accounting Setup, and then follow the instructions in the Installation Wizard.
3. On the Start menu, point to Microsoft Dynamics – Point of Sale, and then click Remote Accounting Setup.

**Caution**

Be sure to make a note of the synchronization password you specify.
To run the Accounting Integration Wizard

1. On the Point of Sale computer (computer with the store’s database), open Point of Sale, and then switch to Manager View.

2. On the Settings menu, click Configure Accounting.

   Or use the Settings Center
   Click Configure Accounting.

3. Follow the instructions in the wizard.

   **Important**
   Be sure to specify that Office Accounting 2007 is your accounting package, that it is installed on a different computer, and then select the check box indicating that you have enabled multi-user access and completed Remote Accounting Setup. Also, enter the same password that you specified in Remote Accounting Setup.

**Things to know**

Can I integrate Office Accounting 2007 and Point of sale if they are installed on different computers?

Yes, you can still integrate the two programs as long as the two computers are on the same network.
Synchronizing with Office Accounting 2007

Things to know

You can control whether data is automatically synchronized with Microsoft Office Accounting Professional 2007. You can also set the amount of time that synchronization errors are saved.

During synchronization of data between Point of Sale and Office Accounting 2007, errors and warnings might be generated. The number of errors is shown in the Synchronization Status window, but you must view the Synchronization Error Report to see the details of the errors.

Errors can occur for a number of reasons:

- Conflicts between the names or IDs of the records being synchronized
- Records in one program not having the minimum data that is required in the other
- Corrupted data
- Network connection problems

To set synchronization options

1. On the Settings menu, point to Office Accounting 2007, and then click Options.
2. Select or clear the check boxes, as desired.
3. Click Apply or OK to save your changes.

Or use the Settings Center
Click Configure Accounting.

To view the Synchronization Error Report

1. On the Settings menu, point to Office Accounting 2007, and then click Synchronization Error Report.
2. In the table, click the specific error you want to view.

Details about the error appear in the lower part of the report window.

To sort the error report

- In the table, click the heading of the column you want to sort by. Click the heading again to reverse the sort order.
To refresh the error report

1. If desired, click **Synchronize Now** on the toolbar, and then wait for synchronization to complete.
2. On the toolbar, click **Refresh**.

To print the error report

- On the toolbar of the report window, click **Print**.

To resolve a synchronization error

1. In the table in the error report, click the specific error you want to view.
   
   Details about the error will appear in the lower part of the report window.

2. To open the record that is causing the problem, click the blue ID number under either **Originating Application** or **Source of Error**.

3. Make changes to the record as needed, and then click **Save and Close**.

To verify that an error has been resolved

- In the error report, click **Synchronize Now**, wait for synchronization to complete, and then click **Refresh**.

The error report will update with any new errors. Errors that have been successfully resolved will be removed from the report.

---

The details of the error will tell you which program the problem record originated from, what problem occurred, and any available information about the cause. It is then up to you to resolve the error. This can usually be done in one of these ways:

- Modify the Point of Sale record, the Office Accounting record, or both. Make whatever changes are needed to resolve the conflict between the two programs. For example, if an item number you are using in Point of Sale is already in use in Office Accounting, you can change the item number in either program and then resynchronize the data.

- Delete the Point of Sale record.

Records that exist in only one program are automatically sent to the other program as new records the next time you synchronize data.

For example, if an item in Point of Sale has the description "Red shirt," it will conflict with an item
To delete an error that you don't want to resolve

- Select the error, and then click **Delete**.

**Caution**

Deleted errors will not be reported again and cannot be recovered.

To synchronize your information manually with Office Accounting 2007

By default, Point of Sale automatically synchronizes your store information and the information in Microsoft Office Accounting Professional 2007. You can also choose to manually synchronize your information.

- On the **Settings** menu, point to **Office Accounting 2007**, and then click **Synchronize Now**.

**Important**

For proper synchronization, make sure the system time on the two computers is the same.

To turn off automatic synchronization

1. On the **Settings** menu, point to **Office Accounting 2007**, and then click **Options**.
2. Clear the **Perform automatic synchronization** check box.
You integrate Point of Sale with QuickBooks by running the Accounting Integration Wizard. In the wizard, you will retrieve your QuickBooks company file, retrieve the QuickBooks chart of accounts, and then assign the posting categories in Point of Sale to the appropriate accounts in your QuickBooks chart of accounts. You will also select the QuickBooks bills account that will be used to pay suppliers, and you can, if desired, import QuickBooks information about items, customers, or suppliers into the Point of Sale store database.

Once accounting integration is set up, QuickBooks commands will be added to the Settings menu in Manager View. You can use those commands to post closed Point of Sale batches and item receipts to QuickBooks on whatever schedule works best for your store. You can also periodically import QuickBooks information about items, customers, or suppliers into the store database.

**Important**

Make sure your QuickBooks vendor names are not more than 30 characters long. If they are, they will be truncated when you import them into Point of Sale, which might lead to errors when you post closed item receipts.
Posting to accounting for QuickBooks

Things to know

Once you have integrated QuickBooks with Point of Sale, you can begin posting closed Point of Sale batches to that program. Posting a batch means sending the financial information included in that batch, such as cost of goods sold and payment amounts received, to your accounting software. This information is then included in your regular accounting processes. Post often enough to keep your accounting information up to date.

If you want, you can also post closed item receipts to QuickBooks.

In the Post to Accounting dialog box, I don’t see the batch that I want to post. How can I get it?

Only closed batches appear in the Post to Accounting dialog box. If you have open batches that you want to post, you will first need to close the batches by running Z reports on your registers.

To post to accounting

1. On the Settings menu, point to QuickBooks Accounting, and then click Post to Accounting.

2. Select the batches that you want to post using any or a combination of these methods of selecting batches:
   - Select batches individually by selecting the check box for each batch.
   - Select all batches by clicking All.
   - Select batches for a certain date range by clicking Select by Date and then selecting start and end dates for the range.
   - Clear all check marks by clicking None.

3. If you want to post closed item receipts, select the Include item receipts check box.

Important

If you did not specify an account for supplier bills when you set up the accounting integration, Point of Sale will warn you that the item receipts will not be posted. To post only closed batches, click Yes in the message. To cancel posting and select the supplier bills account, click No, and then run the Accounting Integration Wizard again by clicking Configure Accounting on the Settings menu.
Can I post a batch more than once?
Yes, batches can be posted more than once. This gives you the chance to correct errors and then update the posted information.

What is the cause of posting errors that indicate that transactions are not in balance?
Posting errors indicating that transactions are not in balance are most often the result of incorrect account assignments. Run the Accounting Integration Wizard again to correct the assignments.

I keep getting errors when I post closed item receipts. What causes this?
If any of your QuickBooks vendor names exceed 30 characters, you might encounter errors when posting closed item receipts. Vendor names must exactly match the supplier names in your store database, and Point of Sale supplier names can only be 30 characters long.

4 Click Post.
Depending on the size and number of batches, posting may take several minutes

5 Review the results:
• If you want to save the results to a text file on your hard drive, click Save As, switch to the folder where you want the file to be located, enter a name for the file, and then click Save.
• When you are done reviewing or saving the results, click Close.

Note
If you are running Windows Vista, you must run QuickBooks as a Windows Administrator. Close QuickBooks, and then restart the program by right-clicking the program name on the Start menu and then clicking “Run as administrator.”
### Importing information from QuickBooks

1. Set up QuickBooks accounting integration. For more information, see “Integrating with an accounting program” earlier in this chapter.

2. On the Settings menu, point to QuickBooks Accounting, and then click Import from QuickBooks.

3. Select the boxes for the types of information that you want to import.

4. Click Import.
   
   Depending on the amount of data that you are importing, this may take several minutes.

5. Resolve any import conflicts that appear.

   If a record already exists in Point of Sale, you can choose to:
   
   • Skip the record.
   • Update the store database with the QuickBooks information. The existing record in the store database will be overwritten with the QuickBooks information for that record.
   • Create a new record in the store database using a number or code generated by Point of Sale.
   • Create a new record in the store database using a number or code that you specify.

#### Things to know

**Should I import all of my information at once or in any particular sequence when integrating with Intuit QuickBooks?**

Microsoft recommends either importing all information at once or importing information in this order: terms, suppliers (vendors), customers, and then items.

**What happens if I skip a record when importing?**

The record will not be imported, but you can import it later.

**Can I instruct Point of Sale to always take the same action as just selected when a record already exists? If so, how?**

Yes, by selecting the “Apply this option to other import conflicts like this” check box. This option is not available if you choose to create a new record using a number or code that you specify.

#### Note

To import information from QuickBooks, QuickBooks needs to be running and you need to be logged in to your company file as a QuickBooks administrator.
Providing automatic access to QuickBooks

Things to know

What advantage does it offer to provide Point of Sale automatic access to QuickBooks?

It saves time and assists in seamless integration. Also, QuickBooks doesn’t need to be running when you post to accounting.

1. Log in to your QuickBooks company, click Preferences on the Edit menu, and then click Integrated Applications.

2. Click the Company Preferences tab, select Microsoft Dynamics – Point of Sale, and then click Properties.

3. Select the Allow this application to read and modify this company file check box, and then select the Allow this application to login automatically check box.
PART 11: DATABASE MANAGEMENT

31

Creating and Working with the Store Database

In this chapter

Understanding database creation
Using the Create Database Wizard
Entering the database connection settings
Backing up your store database
Locating database computer information
  Find the database computer name
  Locate the port used by Point of Sale

In this chapter continued
Checking the database
  Check the store database
  Check the store database as part of a daily routine

Deleting a database or database transactions

Reindexing the store database

Working with database queries
  Create and save a query
  Open and run a query
  Export the results of a query

Preventing database disasters

Turning the backup reminder off

Understanding store database restoration

Running the Restore Database Wizard

Enabling C2 auditing in Microsoft SQL Server

Reviewing C2 audit trace log files
Point of Sale is designed to work with a single store database. When you first set up the program, you create a new database and then begin adding your store information to that database. In most cases, this initial database will be the only store database that you will need. Creating a database involves these steps:

- Run the Create Database Wizard
- Exit Point of Sale on all computers in your store.
- On the main computer, start Point of Sale as an administrator, and then, in the Logon dialog box, click Change Connection and specify the new database. This will direct Point of Sale to communicate with the newly restored database. When the new database connection is established, you will be prompted to add this computer (register) to the database.
- Depending upon the type of database you’ve created (blank or sample), either the Store Setup Wizard or the Create Password Wizard will appear. You will need to provide a certain amount of required information in the wizard.
- On each of your registers, change the database connection settings.

**Things to know**

Can I start over when creating my database?
In most cases, the initial database you create will be the only store database that you will need; however, you can redo your initial database or create a sample database.

I would like to set up a sample database for my employees to use while learning Point of Sale. Do I use the instructions in this chapter for that also?
If you are considering creating a new database simply for use as you practice using Point of Sale, you should set up practice mode instead. For more information see Chapter 1, “Using Practice Mode.”

Can I use more than one database at a time in my store?
To avoid information conflicts and other problems, all registers must be using the same database.
Creating a database is a multiple-step procedure. See the previous topic, “Understanding Database Creation,” for more on the process.

1. On the **Tools** menu, point to **Database**, and then click **Create Database Wizard**.

2. On the **Welcome** page, read the information, and then click **Next** if you want to proceed.

3. On the **Database Type** page, choose to create either a blank database or a database that contains sample information, and then, if you’ve chosen to use a sample database, select the sample information that you want to use.

4. On the **Database Name** page, enter a name for your new store database.

   This name should be something that has meaning for you, such as Database_June05.

5. On the **Finish** page, take note of the actions that will be required on each computer running Point of Sale, and then click **Finish**.

### Note

If you are running Windows XP and you are not already logged on as an Administrator, you will be prompted for Administrator credentials. If you are running Windows Vista and you did not run Point of Sale as an Administrator, you will need to restart Point of Sale.
Enter the database connection settings

1. Exit Point of Sale, and then restart.

2. In the Logon dialog box, click Change Connection.

3. In the Computer name box, type the name of the computer that holds the database that you want to connect to.

4. Click Advanced if you want to specify a communications port or a different instance of Microsoft SQL Server™.

How do I find the computer name?
You can find the name of the computer by right-clicking My Computer on the Start menu or desktop, clicking Properties, and then clicking the Computer Name tab.

Where do I find the port number?
Use Notepad to browse to the location where Point of Sale was installed (the default is c:\Program Files\Microsoft Dynamics - Point of Sale). Select the RmsSecured.config file. The number of the port that Point of Sale is using will be located in the code. See more details in the specific topic later in this chapter.

For more information...
Click the Help button in the Change Database Connection or Logon dialog boxes.
5 Click **OK**.

Point of Sale will attempt to connect to the database computer.

If you are prompted for credentials for that computer, type the user name and password of a user who is a member of the Windows Administrators group on that computer.

6 In the **Database name** dialog box, type or select the name of the database that you want to use.

7 If you are prompted to add this computer as a register, specify the register number, and then click **OK**.

8 If the Create Password Wizard appears, click **Next** to begin setting or resetting the passwords for the owners and employees in the new database.

9 Repeat this procedure on any other registers in your store.

**Important**

To avoid information conflicts and other problems, all registers must be using the same database.

---

**What happens to any previous passwords that may have been used when I create a new database?**

For your security, any existing passwords in a restored database are reset.

---

**For more information...**

Click the Help (?) button in the Select Database dialog box or the Help button in any page of the Create Password Wizard.
Microsoft strongly recommends performing daily backups of your store database. This is very easy to do and can save you tremendous amounts of time and money in the event of a natural disaster, sudden power outage, or serious computer problem. Keep your backup files in a safe place, preferably at a location other than your store.

To back up your store database

1. Open Manager View on the main computer where the store database is located.
2. On the File menu, click Backup.
3. In the first message, confirm that Point of Sale is not running on other computers in the store, and then, in the second message, choose whether to check the database before backing it up.
4. In the Database Backup dialog box, browse to the folder where you want to create your backup file.
5. Type a name for the backup (.bck) file. This name should identify the date, time, or circumstances of the backup.
6. Click Save.

Note
You can only back up your database on the computer where the database is located, but once the backup file is created, you can copy to another location.
Things to know

What is the default location for Point of Sale installation?
By default, the installation folder is `c:\Program Files\Microsoft Dynamics - Point of Sale`.

Should I save or close after viewing the port number?
Because you are only viewing the number, be sure to close RmsSecured.config without saving.

Where should I look in the code for the port number?
You will look for a number where it says `<port>`.
For example, if the file says "<port>1976</port>" then your port number is 1976.
If you previously set up a practice database, make sure that you locate the production port number rather than the practice one.

To find the database computer name
1. On the database computer, click the Start button, right-click My Computer, and then click Properties.
2. Click the Computer Name tab.

To locate the port used by Point of Sale
1. On the Start menu, point to (All) Programs, point to Accessories, and then click Notepad.
2. On the File menu, click Open.
3. In the Files of type box, select All Files.
4. Browse to the folder where Point of Sale was installed.
5. Select RmsSecured.config, and then click Open.
6. Locate the port number in the `<port>` entry in the file.
7. On the File menu, click Close. If you are asked if you want to save changes, click No.

Caution
Do NOT change the port number in RmsSecured.config. Doing so could cause Point of Sale to stop working.
Checking the database

Checking the database analyzes the allocation and structural integrity of all of the objects in the database and performs a physical consistency check on database tables and indexed views. Point of Sale does not fix any errors; it only notifies you of existing problems so that you can quickly find solutions.

Microsoft recommends that you check the database before you back up your database. This will ensure that any database errors are not transferred to your backup (which could make restoring from the backup impossible). Checking the database can take a while, so you might prefer to perform this task once a week instead of prior to each day’s backup.

**To check the database**

- On the **Tools** menu, point to **Database**, and then click **Check**.

**To check the database as part of a daily backup routine**

1. On the **File** menu, click **Exit**.
2. When you are asked if you want to back up your database, click **Yes**.
3. When you are asked if you want to check your database, click **Yes**.

**Things to know**

**What do I do with the information found when the database is checked?**

Any problems found during the check of the database will be shown in a report. A Microsoft Certified Partner or someone with experience administering Microsoft SQL Server databases can help you interpret this information and determine what corrective action to take. For more information about database checking and repair, see the Microsoft Developer Network (MSDN) Web site. (Search keywords: database checking and repair).

**Other than my regular database check, can I perform a check when there are database slowdowns or other problems?**

You can check the store database whenever you see a need; however, keep in mind that checking the database can take a while.
Deleting a database or database transactions __

If there are any unused store databases on your server, you can use Point of Sale to delete them.

**Caution**
Deleting a store database is a permanent operation. The database cannot be recovered.

**To delete a store database**

1. On the **Tools** menu, point to **Database**, and then click **Delete**.
2. Select the database that you want to delete, and then click **Delete**.

**To delete all transactions from the store database**

- On the **Tools** menu, point to **Database**, and then click **Delete All Transactions**.

**Caution**
The Delete All Transactions command deletes transaction data, customer purchase histories, journaled receipts, time card entries, purchase orders, item receipts, and inventory transfers. The information is permanently deleted. You should back up your database before performing this action, because restoring from a backup is the only way to recover your transaction data.

**Things to know**

The transaction data that is kept in the store database provides the comprehensive history and reporting features that make Point of Sale such a valuable tool for your store. Microsoft does not recommend removing this data.

However, there are a few circumstances when you might want to delete your transaction data. For example, you might have a small set of initial practice transactions that have been entered into a new Point of Sale system, or you might want to purge transaction data from a database that has grown too large to be salvaged in other, less drastic ways. Keep in mind, though, that there is no way to choose which transaction data to delete; it’s all or nothing.

I no longer need the practice database that I used during training. Can I delete it?
Yes, but you may want to keep it for training new employees.
Reindexing the store database

When you reindex your store database, the indexes for the tables in the database are rebuilt.

To reindex the store database

1. Back up your store database.
2. On the Tools menu, point to Database, and then click Reindex.
3. In the confirmation dialog box, click Yes.

Important

Reindexing is not usually required. You should perform this operation only if instructed to do so by a Microsoft Certified Partner or Microsoft Product Support.

Things to know

Can a Manager or Supervisor perform the reindex of the store database?

Only Owners can reindex the database. With the exception of the Backup command, the commands on the Database submenu (on the Tools menu) are only available to employees assigned to the Owner role.

When you reindex the database while working at the database computer, you will need to provide Windows Administrator credentials for that computer. If you are running Windows XP and you are not already logged on as an Administrator, you will be prompted for Administrator credentials. If you are running Windows Vista and you did not run Point of Sale as an Administrator, you will need to restart Point of Sale.
To create and save a query

1. On the Tools menu, point to Database, and then click Query Tool.

2. On the Query tab, enter the text of your query.

3. On the File menu, click Save.

4. Browse to the folder where you want to store your query, type a name for your query, and then click Save.

**Important!**

Only users experienced in SQL Server and database programming should use the Query Tool to alter the database. Errors introduced when altering the database in this way may cause Point of Sale to stop working, and deleted data is not recoverable. Tip: Use Find instead.

Things to know

You can use queries to view specific information, modify database information, and perform advanced maintenance tasks on the database. The Query Tool provides for direct queries to the store database. Queries are SQL scripts, constructed using Transact-SQL statements. These scripts are stored as files, usually with the *.sql extension. Whenever you run a query, you make a specific request for information from the SQL Server database. You can retrieve, modify, or delete data.

What does a query look like and how do I decode it?

This is a sample SQL query:

```
SELECT * FROM Item WHERE Quantity > 0 and Cost > 10
```

It requests all item records in which the in-stock quantity field has a value greater than 0 and the cost field has a value greater than 10.
To open and run a query

1. On the Tools menu, point to Database, and then click Query Tool.
2. On the File menu within the Query Tool, click Open.
3. Browse to and select the query that you want to run, and then click Open.
4. On the toolbar of the Query Tool, click Run.

The results of your query will appear on the Result tab.

To export the results of a query

1. After running a query as described above, click Export on the File menu.
2. Browse to the folder where you want to save the query results, specify a file name, and then click Save.

Why don’t my query results use the same field and table names and organization that are in the Point of Sale interface?

Queries must use the field and table names in the store database rather than the field names that you see in the windows and dialog boxes in Point of Sale. Many of the fields in the database contain internal database ID numbers instead of codes or numbers that you might see in Point of Sale. For example, departments are represented by internal, sequential ID numbers. In order to use these numbers, you will have to determine the relationship between the internal ID numbers and the codes that you have chosen.

Similarly, query results show information as it is organized in the database. Since some of the fields in the store database are there in anticipation of future releases of Point of Sale, you might see column headers that use unfamiliar terminology.
Preventing database disasters

Successful and efficient recovery from a disaster (such as a power failure, equipment failure, or natural disaster) is only possible if you are prepared. This means choosing a backup strategy and then sticking to it. Here are some things to consider:

- Set up a backup schedule that reflects the activity in your store and your sensitivity to lost data.
- Check your database periodically to ensure that you aren't transferring database errors to your backups. Some errors could make the backup useless because it will be impossible to restore from the backup.
- Develop a plan for tracking and storing your backup files. If you back up to CD or tape, you will also want a plan for recycling your backup media. Microsoft recommends storing your backups at a location other than your store in fireproof containers.
- Occasionally verify the quality and consistency of your backup files by using them to restore the database. To protect the integrity and accessibility of your "live" database, this procedure is best done on a test machine.
- Keep paper records in addition to your electronic ones.

Things to know

How often should I back up files to be safe?
In general, Microsoft recommends daily backups, but that might not be frequent enough for a store that can’t afford to re-enter (or lose) a whole day’s transaction data.

For example, a busy, multilane store that accepts credit card payments might need more frequent backups than a single-lane, cash-only store.

Why is it important to keep paper records in addition to the electronic backup?
This paper trail can be used to re-enter lost transaction information, plus it can be useful as evidence in the event of credit card chargebacks or customer inquiries.
Turning the backup reminder off

Microsoft strongly recommends that you back up regularly. For this reason, you will be given the opportunity to back up your store database whenever you close Point of Sale. If you prefer, you can turn this reminder off.

**To turn the backup reminder off**

1. On the Settings menu, point to Store Settings, and then click Options.
2. Click the Backup tab.
3. Do one of the following:
   - Select the **Do not show backup reminder at exit** check box to turn the reminder off.
   - or-
   - Clear the **Do not show backup reminder at exit** check box to turn the reminder on
4. To save your changes, click OK.

---

**Things to know**

Is the backup reminder really a necessary business practice?

You have the option to turn the reminder off and on. With all you have to do in running your store, this small reminder may save you a lot of future grief. If you do not back up your store database each time you close Point of Sale, you may be at risk for losing irrereplaceable information in the event of a natural disaster or any kind of system problem, such as a computer crash or hard-drive malfunction.

For more information...

Click the Help button in the Options dialog box.
Understanding store database restoration

If you have been performing regular backups of your store information, you can recover your data if anything ever goes wrong with your store database.

Important

When you restore transactions performed after the backup file was created will be lost. Contact a Microsoft Certified Partner or Microsoft Product Support for assistance prior to restoring. They might be able to solve your database problem without losing your recent transaction information.

After you restore the database, you must then set up each computer in your store so that it can communicate with that database. Complete these steps:

- Run the Restore Database Wizard to build a new database from your backup (.bck) file.
- Exit Point of Sale on all computers in your store.
- On the main computer, start Point of Sale and change the database connection settings, directing Point of Sale to communicate with the newly restored database.

When the new database connection is established, the Create Password Wizard runs automatically. For security reasons, you must provide new passwords for all employees in the restored database. Employees can change their passwords when they next log on to Point of Sale.

- On each of your registers, start Point of Sale, and then change the database connection settings.

Things to know

Our store database was damaged in a recent flood. What should I do?

If you have been making regular backups to a computer and keeping them in a location away from the store, you will have only lost the transactions performed since the last backup file was created. You can use the Restore Database Wizard to recover your database files.

Do I need to complete all of the pages in the Create Password Wizard?

For security reasons, you must complete the Owner Information page and, if there are other employees present in the database, the Reset Passwords page in order to run the software. You can skip the other pages in the wizard if you wish.
Running the Restore Database Wizard

To run the Restore Database Wizard

1. On the Tools menu, point to Database, and then click Restore Database Wizard.
2. On the Welcome page, read the information, and then click Next if you want to proceed.
3. On the Database Name page, type a name for your restored store database.
4. On the Backup File page, click Browse to locate the most recent backup (.bck) file for your store database.
5. On the Finish page, take note of the actions that will be required on each computer running Point of Sale, and then click Finish.

Note
To restore a database, you must be working at the database computer. If you are running Windows XP and you are not already logged on as an Administrator, you will be prompted for Administrator credentials. If you are running Windows Vista and you did not run Point of Sale as an Administrator, you will need to restart Point of Sale.

Things to know

What else do I have to do to restore the store database besides run the Restore Database Wizard?
Restoring your store database is a multiple-step process. This topic only covers one portion of that process. For more information about the other steps that are involved, see “Understanding store database restoration” earlier in this chapter.

Can I use the same name that I used on the previous store database?
Unless you delete the previous store database, you cannot use the name that your store database had before. Choose a new that has meaning for you, such as Database_June06.

For more information...
Click the Help button in any of the Restore Database Wizard pages.
C2 refers to a security rating for computer software that was established by the U.S. National Computer Security Center (NCSC). It specifies that individuals must log on with a password, that an audit mechanism must be in place, and that access to audit data must be limited to authorized administrators.

To enable C2 auditing using SQL Server Management Studio Express

1. On the Start menu, point to (All) Programs, point to Microsoft SQL Server 2005, and then click SQL Server Management Studio Express.

2. In the Connect to Server dialog box, specify the following settings:

<table>
<thead>
<tr>
<th>Box name</th>
<th>Setting to enter or select</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server type</td>
<td>Database Engine</td>
</tr>
<tr>
<td>Server name</td>
<td><code>server_name\instance_name</code> where <code>server_name</code> equals the name of the computer where SQL Server is installed and <code>instance_name</code> equals the name of the instance of SQL Server that Point of Sale is using (typically, MSPOSINSTANCE)</td>
</tr>
<tr>
<td>Authentication</td>
<td>Windows Authentication</td>
</tr>
</tbody>
</table>

3. Click Connect.

4. In SQL Server Management Studio, right-click the instance that you specified in Step 2, and then click Properties.

5. In the Server Properties window, click Security.

Things to know

How can I meet Requirement 10 of the PCI Data Security Standard using Microsoft SQL Server?

The audit trail specified in Requirement 10 can be achieved by enabling C2 auditing in Microsoft SQL Server. When enabled, this C2 auditing provides a detailed audit trail for the types of events covered by Requirement 10 of the PCI Data Security Standard. Auditing does not prevent system attacks, but it is a vital aid in identifying intruders and attacks in progress and diagnosing attack footprints.

What tools do I need to enable C2 auditing in SQL Server?

The following tools will enable the audit:

- SQL Server Management Studio Express (available for download at http://www.microsoft.com/downloads)
- `sqlcmd` command-line utility
What happens if the audit log file reaches its size limit?

C2 Audit Mode data is saved in a log file in the Data directory for your database. If the audit log file reaches its size limit of 200 megabytes, SQL Server will create a new file, close the old file, and write all new audit records to the new file. This process will continue until the Data directory fills up or auditing is turned off.

6. Under Login auditing, select Both failed and successful logins.

7. Under Options, select Enable C2 audit tracing.

8. Click OK.

9. In SQL Server Management Studio, right-click the instance and click Stop, and then right-click the instance and click Start.

To enable C2 auditing using the command-line utility

**Important**

In the command lines that follow, be sure to substitute the correct instance name for "MSPOSINSTANCE" and the correct database name for "MSPOS".

1. On the Start menu, click Run, type cmd, and then click OK.

2. Type or copy the following lines into the command window, pressing ENTER after each line:

   sqlcmd -E -S .\MSPOSINSTANCE -d MSPOS -Q"sp_configure 'show advanced options', 1"

   sqlcmd -E -S .\MSPOSINSTANCE -d MSPOS -Q"reconfigure with override"

   sqlcmd -E -S .\MSPOSINSTANCE -d MSPOS -Q"sp_configure 'c2 audit mode', 1"

   sqlcmd -E -S .\MSPOSINSTANCE -d MSPOS -Q"reconfigure with override"
What happens if the Data directory runs out of space?
C2 Audit Mode saves a large amount of event information, so the database log file can grow quickly. If the Data directory runs out of space, SQL Server will shut itself down. If auditing is set to start up automatically, you must free up disk space for the audit log before you can restart the instance of SQL Server.

3 Type or copy the following line into the command window, and then press ENTER:
   `sqlcmd -E -S .\MSPOSINSTANCE -d MSPOS -Q"sp_configure"

4 In the table that appears, confirm that the run_value for the c2 audit mode option is set to 1 (turned on).
In the event of a suspected attack or security breach for the store database, which trace files are important to check?

Some columns in the trace files that might be of particular interest are the EventClass column, which identifies the recorded auditable event; the TextData column, which contains the command (typically a stored procedure or SQL statement) that was executed in the database; the NTUserName and NTDomainName columns, which identify the user who ran the command; the ObjectName and DatabaseName columns, which identify the table, view, or stored procedure that was manipulated or invoked; and the StartTime column, which records when the command was issued. Of secondary interest might be the RoleName, TargetUserName, TargetLoginName, and DBUserName columns. Not all columns are populated for each event.

The C2 auditing in SQL Server captures a lot of information for each audited event, including an account of all grant/revoke/deny access checks and a record of all points where the database owner decided to grant access. You can view this information by reviewing the audit trace files.

If there is a suspected attack or security breach, the security administrator will need to determine what's going on in the database. To guarantee a complete audit trail, the administrator must maintain the audit trail indefinitely. Locating a security violation might require comparisons between older log files.

To review a trace audit file using SQL Server Management Studio Express

1. In SQL Server Management Studio Express, connect to the SQL server and database instance.
2. Right-click the instance, and then click Stop.
3. On the File menu, point to Open, and then click File.
4. Open the folder where the Point of Sale data and trace files are located (typically, C:\Program Files\Microsoft SQL Server\MSSQL$MSPOSINSTANCE\Data).
5. Use the dates within the file names to locate the trace (.trc) file you want, select it, and then click Open.

The trace file will open in SQL Profiler where you can view event details.
6. When you are done reviewing, close it the file, and then right-click the instance and click Start.
In this chapter

Creating and changing a label format
  Create a label format
  Make changes in an already existing format

Printing item labels

Printing address labels for customers and suppliers
Creating a label format involves setting the dimensions for the label and specifying the objects, or elements, in the format. For example, a price label might have objects for your store name or logo, the item number or bar code, the regular price in normal font, and the sale price in boldface font.

**Important**

Due to their special requirements, you cannot use Point of Sale to create or modify label formats for certain label printers. Instead, follow the instructions in the documentation provided by the printer manufacturer. For information on making these customized label formats available in Manager View, see “Add a custom label format to File Center” in Chapter 7.

1. On the Tools menu, click Print Labels.
2. Click New Format.
3. On the Label Design tab, type a unique name for the format.
4. Specify the dimensions of the labels that will use this format.
5. For each object that you want to include in the format:
   a. Click New Object on the toolbar.
   b. In the Type box, select the type of object that you want to create.
If I want to print item labels that have bar codes, do I have to use a dedicated label printer?

If you want to print item labels that have bar codes, Microsoft recommends using a dedicated label printer. Label printers tend to be faster than Windows printers, and some Windows printers are not capable of rendering high-quality bar codes.

Label printers that are compatible with Point of Sale include Eltron® label printers, Zebra® label printers, and Cognitive’s Barcode Blaster Advantage LX. A Microsoft Certified Partner can help you select the label printer that is right for your store.

For more information...
Click Help in the New Label Format window.

8 Click the Page Layout tab, and then type the margins and number of rows and columns for each sheet of labels.
Can I use a custom label created outside of Point of Sale?

If you or a Microsoft Certified Partner creates a custom label format outside of Point of Sale, perhaps one designed to work with your label printer, you will need to load the custom .xml or .lbl file into File Center. This will make the label format available to you when you print labels from within Point of Sale. For more information, see Chapter 7, “Managing the File Center.”

9 To save this label format and begin entering information for another, click Save and New, or if this is the only label format that you want to create, click Save and Close.

To make changes to an existing format

1 On the Tools menu, click Print Labels.

2 In the Choose the label format box, select the label format that you want to modify.

3 Click Edit Format.

4 Make any desired changes.

5 To modify any of your objects, select the object in the Preview, and then change its settings.

6 To remove an object, select it, and then click Delete Object on the toolbar.

7 Click Save and Close.
Printing item labels

Things to know

The Inventory Labels tab provides a way for you print item labels. You can print labels for a single item, or you can select multiple items to print labels for.

You can select the number of labels to be printed and specify a format for the labels.

What driver should I use if I am going to use a label printer?

Use the generic text driver provided with Microsoft Windows instead of the printer driver provided by the device manufacturer.

Why don’t any items appear in the print list after I’ve made my selections?

If no items appear in the print list after you have made your selection, it is because no items are associated with the selected record. For example, you might have selected an empty purchase order.

To print item labels

1. On the Tools menu, click Print Labels.
2. On the Inventory Labels tab, in the Choose the items the labels are for box, choose to select items by number, department and category, supplier, purchase order, item receipt, inventory transfer, or other filter criteria.
3. Click Browse, and then take the appropriate action as described in the following table.

<table>
<thead>
<tr>
<th>To print labels by this</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item number</td>
<td>Double-click each of the items that you want to print labels for, and then click OK. You can return to the Add Items dialog box to add more items to the list without overwriting other items.</td>
</tr>
</tbody>
</table>
Can I print labels more than one group of items at a time?
Yes, by clicking group. Browse again to select the next group. The items associated with the additional record will be added to the print list.

Can I print a label for a single item from the Item window?
Yes, you can print from the Item window by clicking the Print Labels button on the toolbar.

<table>
<thead>
<tr>
<th>Department and category</th>
<th>Double-click the department, and then double-click the category (if any).</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier</td>
<td>Double-click the supplier.</td>
</tr>
<tr>
<td>Purchase order</td>
<td>Select the order status, and then double-click the purchase order.</td>
</tr>
<tr>
<td>Item receipt</td>
<td>Select the order status, and then double-click the item receipt.</td>
</tr>
<tr>
<td>Inventory transfer in or out</td>
<td>Select the order status, and then double-click the purchase order.</td>
</tr>
<tr>
<td>Filter criteria</td>
<td>In the <strong>Find</strong> dialog box, perform a basic or advanced search to locate items using likely criteria, select the items you want to print labels for, and then click <strong>Select</strong>. The selected items will be added to the print list. Perform additional searches as needed. When the print list is complete, close the <strong>Find</strong> dialog box.</td>
</tr>
</tbody>
</table>

4. Review the list of items that labels will be printed for. To remove an item, select the item, and then click **Remove**.

5. Under **Label format**, select a compatible label format.

6. Under **Number of labels per item**, select the number of labels that you want to print for each item.

For more information...
Click Help in the New Label Format window or in the Add Items or Find dialog boxes.
What does the Print Start Position refer to? What do I do there?
This is where you select the location of the first label that you will be printing. Click the up or down arrows to specify the row and column of the first label.

Can I limit the number of labels that I print to the items that I have in stock only?
You can choose to print a fixed quantity of labels for each item in your list, or you can print a label for each item you have in stock. Select “One per item in stock” from the “Number of labels per item” box. The value in the Print Quantity column will change to reflect the in-stock quantity for each item in the list.

For more information...
Click Help in the New Label Format window or in the Add Items or Find dialog boxes.

7 To preview the labels you will be printing, click Print Preview, and then take any or all of the following actions
- Resize the preview window by moving your mouse over a window border until it changes to , and then click and drag the border.
- Zoom in or out by clicking .
- Change the number of pages that are displayed by clicking one of the page display buttons. For example, clicking the button will display four pages.
- View other pages in the preview by using the arrow buttons to change the number in the Page box.
- If you are not satisfied with the way the labels will print, click Close and make changes as needed.
- When you are ready to print, click Print .

-or-

To print labels on the default printer without previewing them first, click Print.

To print labels for a specific item
1 On the Inventory menu, click Items.
2 Double-click the item that you want to print labels for.
3 On the toolbar, click Print Labels.
4 In the Print Labels dialog box, specify the number of labels, the label format, and then click Print.
Printing address labels

You can print address labels for customers or suppliers.

To print address labels

1. On the Tools menu, click Print Labels, and then click the Address Labels tab.

2. In the Choose who to print labels for box, select Customers or Suppliers, as appropriate.

3. Click Filter.

4. In the Find dialog box, perform a basic or advanced search to locate customers or suppliers meeting likely criteria, select the customers or suppliers you want to print address labels for, and then click Select.

The selected customers or suppliers will be added to the print list. To add more customers or suppliers to the print list, perform additional searches as needed.

When the print list is complete, close the Find dialog box.

Things to know

Are there any different requirements for using a label printer instead of a printer?

If you are using a label printer, be sure to select the label format specifically designed for your printer. Also, use the generic text driver provided with Microsoft Windows instead of the printer driver provided by the device manufacturer.

For more information...
Click Help in the Print Labels dialog box.
5 Review the list of customer or supplier labels that will be printed. If you want to remove a customer or supplier from the list, select it, and then click Remove.

6 Under **Label format**, select the label format. If you are using a label printer, be sure to select a compatible label format.

7 Under **Number of labels**, select the number of labels that you want to print for each customer or supplier, and then click **Print**.

8 In the **Print Preview** dialog box, take any or all of the following actions:
   - Resize the preview window by moving your mouse over a window border until it changes to ➞, and then click and drag the border.
   - Zoom in or out by clicking 🕵️.
   - Change the number of pages that are displayed by clicking one of the page display buttons. For example, clicking the 📑 button will display four pages.
   - View other pages in the preview by using the arrow 🖹️ buttons to change the number in the **Page** box.
   - If you are not satisfied with the way the labels will print, click **Close** and make changes to the label format as needed.
   - When you are ready to print, click **Print 📑**. The labels will be sent to your default printer.

---

**Where can I find more information using the Find dialog box?**

For more help with the Find dialog box, click Help in the dialog box.

**I’m using a label printer. How can I know for sure that the label format that I selected is compatible?**

Print some test labels and make sure your scanner can read them. For more information, contact a Microsoft Certified Partner or Microsoft Product Support.
Appendix: Names and Paths for POS View Function Task Pad Buttons
Understanding names and paths for task pad __

The following table shows the Point of Sale function names available in the task pad designer and the path—via menus and task lists—to the corresponding functions in POS View.

<table>
<thead>
<tr>
<th>Function Name in Task Pad Window</th>
<th>Path in POS View</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Item Comment</td>
<td>Transaction &gt; Edit Line Item &gt; Add Comment</td>
</tr>
<tr>
<td>Calculator</td>
<td>Tools &gt; Calculator</td>
</tr>
<tr>
<td>Cancel Transaction</td>
<td>Transaction &gt; Cancel Transaction</td>
</tr>
<tr>
<td>Cash Drop</td>
<td>Tasks &gt; Drop/Payout &gt; Cash Drop</td>
</tr>
<tr>
<td>Change Quantity</td>
<td>Transaction &gt; Edit Line Item &gt; Change Quantity</td>
</tr>
<tr>
<td>Clear Customer</td>
<td>Customer &gt; Clear</td>
</tr>
<tr>
<td>Closing Amounts</td>
<td>Tasks &gt; Open/Close &gt; Closing Amounts</td>
</tr>
<tr>
<td>Currencies</td>
<td>Tools &gt; Currencies</td>
</tr>
<tr>
<td>Customers by Name</td>
<td>Customer &gt; By Name</td>
</tr>
<tr>
<td>Customers by Number</td>
<td>Customer &gt; By Customer No.</td>
</tr>
<tr>
<td>Customers by Phone</td>
<td>Customer &gt; By Phone Number</td>
</tr>
<tr>
<td>Discount All Line Items</td>
<td>Transaction &gt; Edit Transaction &gt; Discounts &gt; Discount Current Line Items</td>
</tr>
<tr>
<td>Discount Item</td>
<td>Transaction &gt; Edit Line Item &gt; Discount Item</td>
</tr>
<tr>
<td>Discount Transaction</td>
<td>Transaction &gt; Edit Transaction &gt; Discounts</td>
</tr>
<tr>
<td>Drop/Payout</td>
<td>Tasks &gt; Drop/Payout</td>
</tr>
<tr>
<td>Edit Line Item</td>
<td>Transaction &gt; Edit Line Item</td>
</tr>
<tr>
<td>Edit Transaction</td>
<td>Transaction &gt; Edit Transaction</td>
</tr>
<tr>
<td>Feature</td>
<td>Command</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>Enter/Exit Practice Mode</td>
<td>Tools &gt; Enter Practice Mode</td>
</tr>
<tr>
<td></td>
<td>Tools &gt; Exit Practice Mode</td>
</tr>
<tr>
<td>Enter/Exit Return Mode</td>
<td>Return &gt; Enter Return Mode</td>
</tr>
<tr>
<td></td>
<td>Return &gt; Exit Return Mode</td>
</tr>
<tr>
<td>Exit</td>
<td>Tasks &gt; Exit</td>
</tr>
<tr>
<td>Find</td>
<td>Tools &gt; Find</td>
</tr>
<tr>
<td>Find Customers</td>
<td>Customer &gt; Search</td>
</tr>
<tr>
<td>Find Items</td>
<td>Items &gt; Search</td>
</tr>
<tr>
<td>Find Transactions</td>
<td>Tasks &gt; Find Receipts</td>
</tr>
<tr>
<td>Graphs</td>
<td>Tools &gt; Graphs</td>
</tr>
<tr>
<td>Hold/Recall</td>
<td>Transaction &gt; Hold</td>
</tr>
<tr>
<td></td>
<td>Transaction &gt; Recall</td>
</tr>
<tr>
<td>Items by Description</td>
<td>Items &gt; By Description</td>
</tr>
<tr>
<td>Items by Number</td>
<td>Items &gt; By Item Number</td>
</tr>
<tr>
<td>New Customer</td>
<td>Customer &gt; New</td>
</tr>
<tr>
<td>New Item</td>
<td>Items &gt; New</td>
</tr>
<tr>
<td>No Sale</td>
<td>Transaction &gt; No Sale</td>
</tr>
<tr>
<td>Open/Close</td>
<td>Tasks &gt; Open/Close</td>
</tr>
<tr>
<td>Opening Amounts</td>
<td>Tasks &gt; Open/Close &gt; Opening Amounts</td>
</tr>
<tr>
<td>Payout</td>
<td>Tasks &gt; Drop/Payout &gt; Payout</td>
</tr>
<tr>
<td>Printer On/Off</td>
<td>Tasks &gt; Printer On; Tasks &gt; Printer Off</td>
</tr>
<tr>
<td>Remove Item</td>
<td>Transaction &gt; Remove Line Item</td>
</tr>
<tr>
<td>Reprint Last Receipt</td>
<td>Tasks &gt; Reprint Last Receipt</td>
</tr>
<tr>
<td>Return by Customer</td>
<td>Return &gt; By Customer</td>
</tr>
<tr>
<td>Menu Item</td>
<td>Path</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------</td>
</tr>
<tr>
<td>Return by Receipt</td>
<td>Return &gt; By Receipt</td>
</tr>
<tr>
<td>Return Line Item</td>
<td>Transaction &gt; Edit Line Item &gt; Return Item</td>
</tr>
<tr>
<td>Shipping Address</td>
<td>Customer &gt; Shipping Address</td>
</tr>
<tr>
<td>Substitutes</td>
<td>Items &gt; Substitutes</td>
</tr>
<tr>
<td>System</td>
<td>Tools &gt; System</td>
</tr>
<tr>
<td>Tax/No Tax</td>
<td>Transaction &gt; Edit Line Item &gt; Select Sales Tax</td>
</tr>
<tr>
<td>Total</td>
<td>Total</td>
</tr>
<tr>
<td>Time Clock</td>
<td>Tools &gt; Time Clock</td>
</tr>
<tr>
<td>Transaction Details</td>
<td>Transaction &gt; Edit Transaction &gt; Details</td>
</tr>
<tr>
<td>Transaction Taxes</td>
<td>Transaction &gt; Edit Transaction &gt; Taxes</td>
</tr>
<tr>
<td>Transaction-level Discounts</td>
<td>Transaction &gt; Edit Transaction &gt; Set Transaction-level Discounts</td>
</tr>
<tr>
<td>View/Edit Customer</td>
<td>Customer &gt; View/Edit</td>
</tr>
<tr>
<td>View/Edit Item</td>
<td>Items &gt; View/Edit</td>
</tr>
<tr>
<td>Void</td>
<td>Tasks &gt; Void</td>
</tr>
<tr>
<td>X Report</td>
<td>Tasks &gt; Open/Close &gt; X Report</td>
</tr>
<tr>
<td>Z Report</td>
<td>Tasks &gt; Open/Close &gt; Z Report</td>
</tr>
<tr>
<td>ZZ Report</td>
<td>Tasks &gt; Open/Close &gt; ZZ Report</td>
</tr>
</tbody>
</table>
Appendix: Payment Card Industry Data Security Standard
Build and Maintain a Secure Network

Requirement 1: Install and maintain a firewall configuration to protect data

- What’s covered: Firewalls, routers, network protocols, port security, security policies, and connection restrictions
- How Point of Sale can help: By default, Point of Sale database communications take place over a dedicated port. While any open port poses some risk, the use of a dedicated port balances that risk against the convenience and cost benefits of automated communications.

Requirement 2: Do not use vendor-supplied defaults for system passwords and other security parameters

- What’s covered: Passwords, wireless security, dedicated servers, and non-console administrative access
- How Point of Sale can help: Point of Sale uses Windows-based authentication. This means that the accounts that you and your employees use to log on to Point of Sale inherit the password and other security policies in place on your computer or network.

Protect Cardholder Data

Requirement 3: Protect stored data

- What’s covered: Restrictions on storing cardholder data, data encryption and key management requirements, and account number masking
- How Point of Sale can help: Credit card numbers on Point of Sale receipts are masked so that only some of the digits show. All sensitive data is encrypted in the store database and can’t be viewed. In other words, Point of Sale makes compliance with Requirement 3 automatic.
Requirement 4: Encrypt transmission of cardholder and sensitive information across public networks

- What’s covered: Cryptography and encryption techniques (SSL, PPTP, IPSec), wireless network security, and cardholder information in e-mail messages
- How Point of Sale can help: Credit card numbers on Point of Sale receipts are masked so that only some of the digits show. In the store database, credit card numbers are encrypted and cannot be viewed.

Wireless connections are not recommended when using Point of Sale. If you intend to use one, be sure to secure your access point or router by changing the default administrator name, password, and SSID. You should also turn on WPA or WEP encryption, as appropriate, and consider other security measures, such as filtering MAC (physical) addresses, disabling network name broadcasting, and assigning static IP addresses to devices.

Maintain a Vulnerability Management Program

Requirement 5: Use and regularly update antivirus software

- What’s covered: Viruses and antivirus software
- How Point of Sale can help: By default, Point of Sale database communications take place over a dedicated port. While any open port poses some risk, the use of a dedicated port balances that risk against the convenience and cost benefits of automated communications.

Requirement 6: Develop and maintain secure systems and applications

- What’s covered: Security patches, coding practices, and change control procedures
- How Point of Sale can help: The security of Point of Sale has been extensively tested, and the software passed Microsoft’s rigorous internal security audit. Customers on service plans are notified when product updates and service packs become available.
Implement Strong Access Control Measures

Requirement 7: Restrict access to data by business need-to-know

- What’s covered: Restricting access to data and user security settings
- How Point of Sale can help: Point of Sale provides four predefined employee roles. These roles provide security for your store by allowing you to restrict access to certain features in Point of Sale. Only employees assigned to the Manager and Owner roles have access to sensitive store data.

Requirement 8: Assign a unique ID to each person with computer access

- What’s covered: User authentication, password management, remote access, and security policy
- How Point of Sale can help: Point of Sale requires a unique ID for each employee, and Point of Sale user accounts and passwords are subject to the authentication requirements set out in your Local Security Policy.

Requirement 9: Restrict physical access to cardholder data

- What’s covered: Facility entry controls; employee identification and visitor monitoring; physical access to hardware and network jacks; and storage, distribution, and destruction of paper and electronic media that contain cardholder data
- How Point of Sale can help: See Chapter 31, “Working with the Store Database” along with Manager View Help, “About security and loss prevention” for some ideas on making your store more secure.

Regularly Monitor and Test Networks

Requirement 10: Track and monitor all access to network resources and cardholder data

- What’s covered: Logging mechanisms, tracking user activity, audit trails and history, synchronizing system clocks, and log reviews
• How Point of Sale can help: With Point of Sale reports, you can watch for unusual activity, such as unusual sales figures, high numbers of returns, and so on. For example, the Cashier Log report shows a summary of the activities performed by each cashier, while a daily Z report shows detailed information about the transactions that took place on a register. For information about creating a complete audit trail, see Chapter 6, “Enable C2 auditing in Microsoft SQL Server.”

Requirement 11: Regularly test security systems and processes

• What’s covered: Security testing, network vulnerability scans, penetration testing, intrusion detection and prevention, and file integrity monitoring

• How Point of Sale can help: As with Requirement 10, Point of Sale provides a number of reports that will help you watch for unusual activity.

Requirement 12: Maintain a policy that addresses information security

• What’s covered: Distribution and maintenance of store security policies; development of daily operational security procedures; technology usage policies; assignment to employees of responsibilities for information security; employee screening; third-party contractual obligations; and incident and alert response planning

• How Point of Sale can help: This requirement is not really related to software features or settings, but you can use employee roles in Point of Sale to help regulate access to sensitive information in the store database. Only employees assigned to the Owner and Manager roles have access to information about received payments.